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Chapter 1. Classes and Objects

About Classes and Class Objects

Instead of repeating the same configuration for components that have similar requirements, you can
create the basic configuration for those components as a template to use as a configuration starting
point for each.

The CIMPLICITY tools that provide this capability are Classes and Objects.

Item

Description

Classes

A Class is a template that:

* Provides a flexible structure to quickly configure objects with similar requirements.
* Includes attributes, points (data items), actions, events, scripts, and CimEdit screens.

A class can be exported in a single .soc file.
A custom help file can be created with third party tools and also associated with the class.

Beginning in CIMPLICITY 9.5, there are Composite Classes and Objects. Classes can reference other
classes. You can modify a class dynamically and you can also delete a class dynamically if there are no
references to the class or no object instances of that class with composite references to the class. Read
more about Composite Classes here (page 79).

Objects

As many objects as needed can be created based on a single class template. An Object is one instance that
is created using a class as a template. An object can be whatever you define it to be. Object configuration
takes advantage of the work that went into creating the class. This can greatly reduce repetition that would
otherwise be required if configuration for each object was done independently. If a value that was entered
as a default value for a class is changed for a selected object in that class, the object's value will not be
overwritten if the default class value is changed.

(1) Important: It isextremely important for you to understand CIMPLICITY project configuration
before you begin to configure classes and objects. If you have, you will find that class/object
configuration is straightforward. If you have not, you will most likely run into problems.

Overview: Class Instantiation Process

Class. Class Configuration

Configuring features for aclassis similar to configuring features in a project. The class includes
some additional functionality to enable a class developer to create a flexible template that can serve
as the basis for many objects.
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» Features included in a class templ ate.
* Class dialog box.
* Classes listed.

FeaturesIncluded in a Class Template

The following features can be included in class template.

Tool Use
1 Attributes | Numeric or string placeholders to which values will be assigned when instantiating the object.
(page | (variables)| Provide the flexibility required to insure that the class has the range of possible values among
12) objects that are created from the class. Note: When you configure the class, you specify how the
attribute can and will be dealt with by an object designer.

2 Data Data items make use of the attributes' flexibility by Incorporating attributes in their definitions. There
(page | items are the templates for points that will be instantiated when objects are created.
22)
3 Scripts/ Scripts, actions and events can include data items in their configuration.
(page | Actions/
53) Events

Scripts | Apply to all objects in the class..

Actions | Apply to all objects in the class

Events [ Apply to all objects in the class for triggering actions.
4 CimEdit A CimEdit screen that includes one or more class objects can be associated with a Class. Any of
(page | Graphic the CimEdit graphic class objects can be used on an object screen; one can be selected as the
73) File default. Any of the CimEdit graphic class objects can also incorporate data items that hold the

place for the class objects' instantiated points.

5 Composite| Composite members are references to other classes. They can have their own data items, events,
(page | Members | and actions.
79)

=l

Note: A Helpfile, which isacustom file designed to provide help during object creation.

Class Dialog Box

Class entries are made in a Class dialog box.

Field

Use

Faceplate

The faceplate screen is a screen you can add to the class. When the class has a faceplate associated
with it, anytime you left click on a class object in a screen its does a popup of the faceplate screen, and
assigns the $OBJECT variable on the faceplate with the $OBJECT variable value of the class object that
was clicked on. The faceplate screen is automatically shown with a dialog border, and basically does the
same thing that the PPS global faceplate script did.
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Field Use

Class The class version is automatically incremented when there is a structural change to the class. This include
Version adding or removing data items, and composite members. The class editor can also manually assign to
version also. When doing class imports, if the version of the class is lower than the current class version,
there will be a warning that you are importing a lower version number over a higher version number.

ClassesListed

Classes that have been created are listed in the Workbench right pane. These classes can be exported
from projects or imported into projects.

Object: Object Configuration

A class object isaquickly created set of project features that are included in its class template.

* Object based on class.
* Object dialog box.
* Objects listed.

Object Based on Class

Objects can be created using any class as its template.

Object Dialog Box

Entries to define a class object are made in an Object dialog box. Fields and tabs that are included in
the dialog box are based on the selected Class configuration.

ObjectsListed

Objectsthat are created are listed in the Workbench right pane.

I nstantiation: Features Enabled

Each object includes afull set of features instantiated from the class on which it was created.

« Attribute placeholders are replaced by values that are associated with class objects.
« Dataitems are replaced by points whose ID's include an object ID prefix.

« Scriptswhose ID's include a class ID prefix are applied to the object.

« Actions whose ID's include an object prefix are listed in the Event Manager.

» Events whose ID's include an object prefix are listed in the Event Manager.

» CimEdit/CimView screens that incorporate selected class containers are available.
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Because a point classis atemplate for objects that may be created in remote as well aslocal projects,
it isessential that you plan the classto anticipate al possible object requirements.

A brief checklist includes the following setup considerations. Beginning with CIMPLICITY 9.5,

Composi

te Classes are supported.

Determineif the:

Application in the production facility, if more than one object (process) appears to have similar requirements.

PLC layout is consistent among the objects (where applicable).

Data to be collected is identical. Note: The values do not have to be identical.

Layout of how memory is stored in the devices from which data is collected.

Calculations needed for the data are identical.

CIMPLICITY features, e.g. points, scripts, actions and events, required to collect and calculate data.

Open a Class Dialog Box

Open a Class Dialog Box

Option
2.1 (page
9)

Create a new class

Option
2.2 (page
10)

Open an existing Class dialog box.

Option 1. Create a New Class

1. Select Project>Classesin the Workbench left pane.

2. Do the following.

A

Click File>New>0Object on the Workbench menu bar.

B

Click the New Object button on the Workbench toolbar.

In the Workbench left pane:
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Either Or

Double click Classes. a. Right-click Classes.
b. Select New on the Popup menu.

D a. In the Workbench right pane.
a. Right-click anywhere.
b. Select New on the Popup menu.

E | Press Ctrl+N on the keyboard.

The New Class dialog box opens using any of the above methods.

3. Right-click Classes.

4. Select New on the Popup menu.

5. Right-click anywhere.

6. Select New on the Popup menu.

7. Enter aunique name for the class In the Class I D field.

The Class ID

* Islimited to 32 characters.

+ Can be composed of:

* Alphanumeric characters.

« Underscores.

» Must begin with an alphabetic character.
+ Cannot have spaces.

8. Click OK.

Option 2. Open an Existing Class Dialog Box

1. Select Project>Classes in the Workbench |eft pane.
2. Select aclass in the Workbench right pane.

3. Do thefollowing.

A | Click Edit>Properties on the Workbench menu bar.

B | Click the Properties button on the Workbench toolbar.

C | In the Workbench left pane:
a. Right-click Classes.
b. Select Properties on the Popup menu.

D | In the Workbench right pane, double click a class.
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| E | Press Alt+Enter on the keyboard.

4. Right-click Classes.

5. Select Properties on the Popup menu.

Class Configuration

Class Configuration

Y ou can configure a class and create objects from the class using the Class and Object dialog boxes.
Y ou can aso use CIMEdit.

Before you begin, you should be familiar with your object requirements. Determine how the class
will be applied and the possible range of values for the objects created from the class. Y ou can aso
use Composite Classes to facilitate the creation of other classes and objects.

(1) Important: You can modify aclass dynamically and you can also delete a class dynamically if
there are no references to the class or no object instances of that class with composite references to
the class.

What you configure for the class depends on the purpose for the class. In general, once you have
mapped out a plan you can configure the options for the class in any order.

Before you configure a class, you should be familiar with how to configure each of the featuresin a
CIMPLICITY application.

General Tab in the Class Dialog Box

When you open the Class dialog, it defaults to the Gener al tab, as shown below.

This field... | Contains this...

Description | Brief description of the class you are creating.

Graphics CimEdit screen name that will be associated with the class. The selected CimEdit screen contains the

file source objects that are available to object designers.
Default Name of the CimEdit group object that displays as the default when a class object is dragged to a new
Graphic CimEdit screen. Result: When an object that is created from the class is dragged from the Workbench into

a new CimEdit screen, a class object graphic, which is linked to the class source graphic display
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Faceplate Specifies the CimEdit screen name. if the screen object used for a class has a mouse up event, this
entry overrides the mouse up action that would have been created for the class faceplate behavior. There
continues to be a faceplate menu item in the right mouse click menu for the screen object at runtime. The
faceplate field can be left blank. It is not a required field.

Help file: Custom help (.hlp) file associated with a class. The help file assists bject designers when they are
configuring point objects based on the point class. In order to make the help file specific to the class
you are creating, it is recommended that you write the help file after you configure the other class
components. Result: When an object designer presses F1 or clicks Help in the Object dialog box, the
table of contents for the specified help file displays.

Pre create | See 3.1.3, Pre Create Script (page 57).

script

Post See 3.1.4, Post Create Script (page 58).

create

script

Class The default entry is 0. Enter 1 to prompt the system to increment the class version each time data

Version members, or a composite member, is added.

1. Type or select entries for each of the fields, as follows:

2. Click Apply.
3. Select the other tabs and enter or select data as required. Click the buttons below for
information.
1 Class attributes.
(page
12)
2 Data items.
(page
22)
3 Scripts, actions and events.
(page
53)
4 CimEdit class screens.
(page
73)
5 Class help file.
(page
79)
6 Composite Members.
(page
79)

1. Class Attributes

1. Class Attributes
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* Overview: Class attributes.
* Overview: Attribute included in an instantiated point.
« Configuration: Class attributes.

Overview: Class Attributes

Class attributes:

« Can be used to drive the way that objects are created and store information.
« Provide the tool s that enable an object designer to quickly enter custom specifications when
creating objects from a selected class.

One or more attributes will be used throughout the class configuration.

=
-

CIMPLICITY class attributes.

D

=
&F

[
N

Class attribute configuration.

,_\/-\
o
2e
[{e]
@D

Overview: AttributeIncluded in an I nstantiated Point

Attributes provide

Class: Attribute configuration.

Object: Object configured.

(@} EE\W @EZD

Instantiated: Attributes in Point Properties dialog boxes.
(page
14)

1. Class: Attribute Configuration

Attributes that are CIMPLICITY pre-defined or custom attributes are configured for the class and
assigned to dataitems. If a class references another class (Composite Classes), the class that does the
references will have the attributes of the class that is being referred to.

Attribute Configuration

Attributes are created and configured in an Attribute dialog box. Values can be assigned at this level
or at the object level.
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Example
An analog attribute, named LHI GHCRI Tl CAL is created in the TANKYV class.

Two attribute features are as follows.

1 | Data type | Analog

2 | Prompt HIGH CRITICAL Note: The prompt will be the field label in the Object dialog box.

Attribute Assignment
Attributes are assigned to dataitems.
Example

The attribute LHI GHCRI TI CAL is assigned as an expression to the $Al ar m Hi gh field for adataitem
LEVEL.

1. Object: Object Configured

Once an object is created attributes can be assigned values in its Object dialog box.

Object Created
A classis selected to create an object.
Example

A class object created from the class TANKYV is named: STATIONOA4.

Attribute Value Assigned

Fields that represent the configured attributes display in the Object dialog box that opens when the
object is created.

Values that are entered in the Object dialog box fields will be assigned to instantiated points.
Note: Dataitem configuration will determine which points are assigned which attributes.
Example

5000 isentered inthe HIGH CRITICAL field for the STATIONO4 object.

1. Instantiated: Attributesin Point Properties Dialog Boxes
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Values that are entered in the Object dialog box display as read-only values for assigned instantiated

points.

Example

The Alarm High field for the instantiated point LEVEL displays the read-only 5000 value.

Configuration: Class Attributes

1.1 CIMPLICITY class attributes.

-
N
D

[N
bm"

Class attribute configuration.

1.1. CIMPLICITY Class Attributes

CIMPLICITY classesinclude default CIMPLICITY attributes, which are listed on the Attributes tab
in the Class dialog box.

(1) Important: Default CIMPLICITY attributes begin with $.

CIMPLICITY class attributes are;

Class Attribute

Provides the:

$ADDRESS

Base address for data items.

J/ Important: $ADDRESS can also be used to support address adjustment expressions.

$ALARM_CLASS

Default alarm class for data items with alarms. If not specified: Alarms will not be created for the
data items (object points). Note: The class developer can change $SALARM_CLASS from Optional
to Required to override this default behavior.

$DESCRIPTION

Default description for all data items.

$DEVICE_ID Default Device ID for all data items.

J/ Important: Each class object supports one device ID only.
$EU_LABEL Default engineering units label for all data items.
$LEVEL Default security level for all data items.

$RESOURCE_ID

Default Resource ID for all data items.

$SCREEN_ID

Default Screen ID for all data items.

$TYPE

Displays static objects that cannot be modified on the object configuration screens. The objects
display as disabled.




Advanced Features | 1 - Classes and Objects | 16

1.2. Class Attribute Configuration

1.2. Class Attribute Configuration

Class attributes are created through the Attributes tab in the Class dialog box and defined in the
Attribute dialog box.

1.2.1 Open an Attribute dialog box.

1.2.2 Define a class attribute.
(page
17)

1.2.1. Open an Attribute Dialog Box

Buttons on the Attributes tab enable you to open an Attribute dialog box for a new or existing
attribute.

* New attribute.
* Existing attribute.
* Duplicate attribute.

Note: You can delete any attribute by selecting an ID and clicking Delete.

=

New Attribute

1. Click New on the Attributes tab in the Class dialog box.

The New Attribute dialog box opens.

2. Select an ID inthe Field ID dropdown list.

Note: If aField ID isaready listed on the Expressionstab, it will not be included in the
dropdown list.

3. Click OK.
Result: An Expression dialog box for the new field expression opens.

Existing Attribute Properties

4. Select an existing attribute.

5. Click Properties.
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Result: The Attribute dialog box with specifications for the existing attribute opens.

Duplicate Attribute

6. Select an existing attribute.
7. Click Duplicate.
A Duplicate Attribute dialog box opens.

The selected source data item displays.

8. Enter aunique name for the Destination attribute.

9. Click OK.

The Attribute dialog box with specifications for the source attribute opens.

1.2.2. Class Attribute Definition

Configuration: Attribute.

Result: Object dialog box.

SHEE

1. Configuration: Attribute
The attribute dialog box provides the tools to define the following.

« Definition: Attribute
« Definition: Attribute fields for the Object dialog box.

Definition: Attribute

Thetop part of the dialog box provides fields for you to define the attribute. Y our definition can
provide default values and determines the options available to an object designer when creating an
object from the class.

Open either anew or existing Attribute dialog box in which you will fill in or modify the top part.

Specifications are as follows.
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rect O, 31, 20, 51 (page 18)

rect 0, 59, 20, 79 (page 18)

rect 1, 83, 21, 103 (page 18)
rect 216, 82, 236, 102 (page 19)

1 Value

2 Data type

3 Instantiation type

Reference

(Optional) Enter the default value for the attribute.

Acceptable values:

» Must be within the range for the attribute type
* Arelimited to 80 characters.
« Cannot contain the vertical bar ‘| character.

2 | Data type

Select the data type of the value from the drop-down list:

Datatypes are:

» Analog
* Boolean
* String

3 | Instantiation type

Select the option from the drop-down list that will control how a user will deal with the attribute
when an object is being created:

Option When an object is created, a user:

Hidden Will be in the class object; however, it will not be listed in the Object dialog box.
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Optional Can override a class default value, if there is one. The attribute does not have to be specified to create
the object.
Readonly Will be listed in the Object dialog box; however, the field will be disabled, preventing users from editing it.
Required Must provide a value for this attribute. Failure to provide a value when creating an object will generate an
error.
Static
« Cannot change the value.
« All objects of this class will have the same value for this attribute.
» The value does not display in the Object dialog box.
Static
Display « Cannot change the value.
« All objects of this class will have the same value for this attribute.
» The value displays as a read-only field in the Object dialog box.
4 | Reference

Check Reference if you want to identify the value of this attribute as the value of another attribute.

|5/ Note: The Valuefield in the Attribute dialog box must contain the attribute ID of the value to be

referenced.

Definition: Attribute Fields for the Object Dialog Box

An object designer configures an object based on the class you are creating in an Object dialog box.
The specifications you make in the Object Builder Group of the class attribute's Attribute dialog box
determine where and how the attribute appears in the Object dialog box.

1. Open the appropriate Attribute dialog box (if it is not open), in which you will fill in or modify
the fields in the Object Builder box.

2. Fill inthe fields as follows.

rect -5, 117, 21, 143 (page 20)
rect -5, 141, 21, 167 (page 20)
rect -4, 168, 22, 194 (page 20)
rect -4, 197, 22, 223 (page 20)
rect -4, 225, 22, 251 (page 21)

1

(page
20)

Prompt

2
(page
20)

Help string
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Browser type

Order

Property page
a
1

E o N E oo
Cio o
[(e]
© o) ©

1| Prompt

(Optional) A meaningful description that is up to 20 characters.
Y our entry appears as the field name for the class attribute in the Object dialog box.

The class attribute ID appears as the field name if there is no entry.

2 | Help string

(Optional) A tip up to 80 characters.

Y our entry appears as atool tip in the Object dialog box when the user places the cursor over
the field.

3 | Browser type

(Optional) A user has access to the selected browser in the Object dialog box.

The Browser's button will appear to the right of the field in the Object dialog box.

Browser Options | Button that will display

Alarm Class

Resource

Device

Role

Point

User

Port

4 | Order

The order in which the field will appear on the Object dialog box tab in the field.

« Lower numbers appear before higher numbers.
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» Class attributes with the same order number (for the same tab) are sorted al phabetically by
Prompt (field name).

5 | Property page

Selects the tab on which the attribute will display in the Object dialog box as follows.

Do one of the following.
+ Select the General which is the default tab.

Note: The General tab, has alimit of 8 attributes (fields).

=

CIMPLICITY attributes can be moved to another tab make room on the General tab for Custom
attributes.

« Enter anew name. The name you enter will appear as atab in the Object dialog box.

Note: Additiona tabs have alimit of 9 attributes each.

L=

3. Click OK or Cancedl.

OK A new class attribute is added to the list of attributes and existing attributes are modified. In addition:
« Existing objects based on this class are reevaluated to reflect the new class structure.

« You will be prompted to configure new required values for each existing object.

» Expressions that contain an existing attribute are re-evaluated.

« Points are modified when a configuration update is performed on the project.

Cancel | Cancels the procedure.

4. Continue creating the attributes that should be included in the class.
a. Result: Object Dialog Box

When an Object dialog box is opened for a class object, the attribute's location and
specifications reflect entries in the Attribute dialog box.

Field in: Purpose in:

Class Attribute Dialog Box | Object Dialog Box

1 | Both the: Specifies the:

* Prompt * Field Label

* Order « Order in which the field displays on the Attribute dialog box tab.
2 | Both the: Control the:

» Data Type « Data type allowed for the field value

* Instantiation Type « If a field entry is optional or required
3 | Property Page Tab that the attribute is located on.

4 | Help String Tool tip that displays then the mouse hovers over the attribute field.
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2. Data Items

2. Data ltems

» Overview: Dataitem configuration.
 Overview: Dataitem instantiated into a point.
« Configuration: Dataitems.

Overview: Data item Configuration

A dataitem is adefinition that becomesa CIMPLICITY point when an object is created from the
class.

‘!\’
o e
[0

Data item configuration (basic).

N
N
=

N
(N

Data item expressions.

N
w

Address adjustment expressions.

D

~
SE|

A dataitem:

+ Can be used in any application that supports points, for example:

« Database Logger

* Event Editor

* BCE

« Point Control Panel

* CimView

» Other CIMPLICITY Software Options

+ Can include a subset of expressions of type: string or numeric. Note that a limited number of
string substitutions and numeric expressions are supported.

« Displays in the Workbench right pane as a point with its associated object.

Overview: Data ltem Instantiated into a Point

Dataitems are instantiated into CIMPLICITY points, as follows.

A Class: Data item configuration.

(page
23)
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Object: Object created.

Instantiation: Data item to point.
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1. Class: Data ltem Configuration

Dataitems are configured in Data Item dialog boxes that are opened through the Class dialog box.
Example

An analog data item named LEVEL is created.

Note: Dataitem ID's (page 24) are listed on the Data Items tab in the Class dial og box.

1. Object: Object Created

A classis selected to create an object.
Example
A class abject created from the class TANKS is named: STATIONOL.

1. Instantiation: Data |tem to Point

Data items are instantiated into points for the new object.

Workbench

The instantiated points are listed in the Workbench right pane.
Example

STATIONOL instantiated points are listed in the Workbench.

The dataitem LEVEL instantiated into a class object point is named: STATIONO1.LEVEL.

Point Properties Dialog Box

An object's Point Properties dialog box can include several fields that class/object configuration
have caused to be read-only.

Example
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Severa dataitems have been entered in the LEVEL Data Item dialog box.

Those fields in the STATIONOL.LEVEL Point Properties dialog box are read-only.

Configuration: Data items

2.1 Data item Configuration (Basic)

N
N

Data item expressions.

D

[68)
8|

2.3 Address adjustment expressions

Lﬁ%
o
@
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7

2.1. Dataltem Configuration (Basic)

2.1. Data Item Configuration (Basic)

The basic configuration for dataitemsis very similar to point configuration.

The core issue in the basic configuration is to be aware of what happens when the dataitem is
instantiated into a point.

N
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Open a Data Item dialog box.
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E
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N
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Resource configuration.

N
L2p
(0]

N
[N
w

Data Item fields in Data Item dialog boxes.
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String substitutions.
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Device data item Device ID and Address
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Device data item memory usage options.

a
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2.1.1. Open a Data Item Dialog Box
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Buttons on the Data Items tab enable you to open a Data Item dialog box for a new or existing data
item.

rect 15, 217, 92, 239 (page 25)
rect 99, 218, 176, 240 (page 25)
rect 184, 218, 261, 240 (page 26)

* New dataitem.
* Existing data item.
* Duplicate data item.

New Data ltem

Each new dataitem representsa CIMPLICITY point definition. Points are created when an object is
created. The points are associated with the object.

1. Select the Data Itemstab in the Class dialog box.
2. Click New.

A New Data Item dialog box opens.

3. Identify the new dataitem as follows.

Field / Radio Description
Button
Data Item A unique name for the data item. The data item template will become a point for a class

object. The Data Item ID:
* Is limited to 16 characters.
» Can be composed of
» Uppercase alphabetic characters,
* Numeric characters and
» Underscores.
» Must begin with an alphabetic character.
« Cannot contain spaces.

Device/Virtual Selected device or virtual data item definition will become a device or virtual point.

Analog/Boolean/ | Selection for Data item class will be the point's class for an object.
Text

4. Click OK.

Result: The Data Item dialog box opens. The available tabs and options in the dialog box
depend on your Type and Class selections.

Existing Data Item Properties
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5. Select an existing data item.
6. Click Properties.
Result: The Data Item dialog box with specifications for the existing data item opens.

Duplicate Data Item

7. Select an existing data item.
8. Click Duplicate.
A Duplicate Data Item dialog box opens.

The selected source data item displays.

9. Enter a unique name for the Destination data that adheres to the dataitem ID requirements
(page 25).

10. Click OK.

The Data Item dialog box with specifications for the source data item opens.

2.1.2. Resource Configuration

A Dataltem dialog box does not include a Resour ce I D field.
The resource is assigned to the object in the Object dialog box.

Theresourceisincluded, asfollows, for instantiation.

A Class: Data item configuration
(page
26)

B Object: Object defined.
(page
27)

C Instantiation: Point properties result.
(page
27)

1. Class: Data ltem Configuration

A resource cannot be entered for adataitem.

Thereisno Resource I D field in the Data Item dialog box.
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Example

A Dataltem dialog box named LEVEL has no Resource I D field.

1. Object: Object Defined

A Resource ID isentered at the object level.

Object Created

Class objects are created from the class.

Example

A class object created from the class TANKR is named: STATIONOG.
Attribute Value Assigned

A Resource ID must be entered in the Object dialog box.

Example

The STATIONO6 Object dialog box has TANKS entered in the Resour ce I D field.

1. Instantiation: Point Properties Result

A Resource | D field in the Point Properties dialog box, displays the resource ID that is assigned to
the object.

Example

The Resource ID field inthe STATIONO6.LEVEL Point Properties dialog box displays the TANKS
resource.

2.1.3. Data ltem Fieldsin Data Item Dialog Boxes

Data Item Fields
Fields that take pointsin a Point Properties dialog box, take dataitems in a Data Item dialog box.

The following occurs when a data item is selected for a Data Item field.

A Class: Fields for data items.
(page
28)
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Object: Object created.

Instantiation: Point properties result.
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1. Class: Data ltem Configuration

Data items can be entered in data item fields.

CIMPLICITY automatically inserts { SOBJECT} . before the dataitem ID.

{ $OBJECT} will become the object name when the dataitem is instantiated into a point.
Example

InaLEVEL dataltem dialog box , data items are selected for the Safety point and Availability
trigger fields.

The field entrieswith CIMPLICITY's { $OBJECT} additions are as follows.

Field Data Item Entry

1 | Safety point {$OBJECT}.SAFETY

2 | Availability trigger | {$OBJECT}.HEATERIN

1. Object: Object Created

Class objects are created from the class.
Example

A class object created from the class TANKS is named: STATIONOL.
1. Instantiation: Point Properties Result

All point fields in the object's Point Properties dialog boxes display read-only instantiated points.
Example

In the Point Properties dialog box, the Safety point and Availability trigger fields for the
instantiated STATIONOL1.LEVEL point are as follows.

Field Instantiated Point

1 | Safety point STATIONO1.SAFETY




‘ 2 ‘ Availability trigger | STATIONO1.HEATERIN

2.1.4. Sring Substitutions

* Overview: String substitutions.
« Configuration: String substitution.

Overview: String Substitutions
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String substitutions provide the capability to customize text values at the object level.

String Substitution Sour ces

Sources for string substitutions are available for the following.

« All class attributes.

|=/ Note: If an attribute isnot initially atext type, it is treated as atext type when it isused as a
string substitution.

* CIMPLICITY predefined variables, which are:

Variable Description Example (When Instantiated)
$OBJECT | Object ID STATIONO1

$ID ID of the data item | LEVEL.

$CLASS | Class ID TANKS

Limitations. String substitution

Nested substitution is not supported.

Example

Y ou have created the following variables:

VAR1="{VAR2}"

VAR2="HELLO WORLD."

Y ou enter the string substitution {VAR1}

The expression after substitution will bethe string "{VAR2}".
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The expression will not be reevaluated to yield the result "HELLO WORLD."

Configuration: String Substitution:

gpage
30)

A Class: Data item configuration

jpage
31)

B Object: Object defined.

jpage
31)

C Instantiation: Point properties result.

1. Class: Data ltem Configuration

Enter string substitutions in any of the following fieldsin a Data Item dialog box.

Use brackets {} to enclose substitution entries.

Data Item Type

Fields Supporting String Substitution

All

Description Safety Point Screen Availability Trigger Measurement Units Label

All Analog and Boolean

Point Enumeration

Derived Expression Reset Point
Device Address Device ID
Point Alarm Alarm Message Alarm Class Deviation Point
Text Initialization value
Example

The description for aLEVEL dataitem that is entered in the Description field on the Data Item

dialog box>General tab includes two string substitutions.

The description is as follows.

{$OBJECT} level in{LH GHCRI Tl CAL} gallon water heater.

Where

{$0BJIECT} isthe CIMPLICITY predefined variable.

{LHI GHCRI TI CAL} isacustom analog attribute for the Alarm High value.
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1. Object: Object Defined
String values can be entered in the Object dialog box.

Object Created
Class objects are created from the class.
Example

A class object created from the class TANKYV is named: STATIONOA4.

Attribute Value Assigned

Valuesthat are entered in the fields created from the class attributes will replace the string
substitution attributes entered in the Data Item dialog boxes.

Example
A class object created from the class TANKYV is named: STATIONO4

Vaueswill replace the string substitutions that were entered in the LEVEL Data Item dialog
box>Description field are the following.

String Substitution | Value

1 | (SOBJECT) STATIONO4

2 | (LHIGHCRITICAL) | 5000

1. Instantiation: Point Properties Result

Fields in instantiated Point Properties dialog boxes display instantiated values for string substitutions.
Fields that display some substitutions continue to be enabled so they can be edited at the instantiated
point level.

Example

The Description field in the instantiated STATIONO4.LEVEL Point Properties dialog box displays
the substituted values. The field is read-write so these values can be changed.

String Substitution | Value

1 | ($OBJECT) STATIONO4

2 | (LHIGHCRITICAL) | 5000
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2.1.5. Device Data Item Device ID and Address

The Data Item dialog box Device tab provides the flexibility to use the class template for different
object requirements.

» Device D field.
+ Addressing.

Device D Field

A Dataltem dialog box for a device does not include a Device I D field.
The device is assigned to the object in the Object dialog box.

(1) Important: Each object can support only one device.

The deviceisincluded, as follows, for instantiation.

A Class: Data item configuration
(page
32)

B Object: Object defined.
(page
32)

C Instantiation: Point properties result.
(page
33)

1. Class: Data ltem Configuration

A device cannot be entered for adataitem.
Thereisno Device I D field in the Data Item dialog box.
Example

A device Data ltem dialog box hamed VLVBP has no Device I D field.

1. Object: Object Defined

A DeviceID isentered at the object level.
Object Created

Class objects are created from the class.
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Example

A class object created from the class TANKS is named: STATIONOL.
Attribute Vaue Assigned

A Device ID must be entered in the Object dialog box.

|5/ Note: If you plan to create device dataitems and objects already exist, enter adevice ID in each
Object dialog box before you create the device dataitems. If you do not, you will not be able to apply
the changes to the class. Y ou can change the device at anytime.

Example

The STATIONO1 Object dialog box has TRIPLEXDEV entered in the Device I D field.

1. Instantiation: Point Properties Result

A Device I D field, which is read-only in the Point Properties dialog box, displays the device ID that
is assigned to the object.

Example

The Device ID read-only field in the STATIONO1.VLVBP Point Properties dialog box displays the
TRIPLEXDEV device.

Addressfield
An address does not have to be entered in a Data Item dialog box for a device data item.

An addressis instantiated with an object as follows.

A Class: Data item configuration
(page
33)

B Object: Object created.

(page
34)

C Instantiation: Point properties result.

jpage
34)

1. Class: Data Item Configuration

An address does not have to be entered in the Address field for adevice dataitem but if an addressis
entered:
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* |t overrides an address entry in the Object dialog box.
* |t is applied to the instantiated point for every object {$OBJECT}.<point ID> in the class.

* Do not configure the BADDRESS ADJdataitem. A Device Base address should only be specified
at Class leve attribute or Object level attribute when instantiated or modified at Object properties.

Example

The Addressfield in adevice Data ltem dialog box for a device dataitem named VLVBP has no
entered address.

1. Object: Object Configuration

A different base address can be entered for each object in the class.
Object Created

Class objects are created from the class.

Example

A class abject created from the class TANKS is named: STATIONOL.
Attribute Value Assigned

An addressis entered in the Address field in the Object dialog box.
Example

STATIONOL is assigned the %5R address.

1. Instantiation: Point Properties Result

The read-only Addressfield in the instantiated point's Point Properties dialog box displays, in the
following priority, the address entered in the:

1. Data Item dialog box.
2. Object dialog box.
Example

The read-only Addressfield in the STATIONO1.VLVBP Point Properties dialog box displays
the %5R address entered in the Object dialog box.
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|=/ Note: If adifferent address, e.g. %8R was entered in the STATIONO1.VLVBP Data ltem
dialog box, that address would display in the Point Properties dialog box.

The Addressfield for other STATIONO1 object points display %5R or addresses entered in
their Dataitem dialog box.

2.1.6. Device Data Item: Memory Usage Options

The Device tab in the Data Item dialog box provides Just-In-Time as an additional memory usage
option.

Memory options for instantiated points perform as follows

* Delay load
* Just-In-Time
+ Standard Memory Load

Delay L oad
Delay loadis available in point configuration to help conserve memory.

The point is not loaded into memory in the Point Manager or Devcom at project startup. Rather, the
point is loaded into memory only when it is demanded by an application. When the point ceases to be
demanded it will be unloaded from memory in the Point Manager and Devcom.

Class: Data item configuration

Instantiation: Point properties result.

Benefits and disadvantages: Delay Load

1. Class: Dataitem Configuration
When Delay Load is checked in a Data Item dialog box
* Just-In-Time is disabled.
* A scan rate is required.
1. Instantiation: Point Properties Result

Delay Load is read/write in the object's Point Properties dialog box, whether or not it is checked in
the Data Item dialog box.



Advanced Features | 1 - Classes and Objects | 36

1. Benefits and Disadvantages: Delay Load

Delay Load benefits and disadvantages are the same whether the point isincluded in an instantiated
object or is created in the project's Workbench. They are as follows.

Benefits Disadvantages Non-Supported Functions

» Loaded when « Slower access « Trend buffering
needed « Configuration updates » Alarming

* No memory can be lengthy on larger » Cannot be used within another point's configuration,
usage until point systems e.g. Safety point, Trigger, Availability Trigger point, etc.
is loaded « Trigger settings and Alarm « Cannot be used in a calculation point equation

» Written to point options are not available
database

« Available in point
list

« Definition can be
modified

Just-In-Time

When Just-In-Time (JIT) is checked, data item instantiated point configuration is created by the Point
Manager when an application requests it.

When the application is done, the data item is removed from the Point Manager. It is not written to
the point database.

JIT Data ltems can be used in:

« CimView,

« Point Control Panel,
* Trending, and

* Scripting.

(1) Important: Change approvalis not supported with Just-In-Time points.

A Class: Data item configuration
(page

37)

B Instantiation: Point properties result.
(page

Benefits and disadvantages: Just-In-Time

FHE




1. Class: Data ltem Configuration

When Just-In-Time is checked:

 Delay Load is disabled.
* A scan rate is required.

1. Instantiation: Point Manager Result
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An instantiated object does not list a point for the Just-In-Time dataitem in the Workbench.

Example

The dataitem VLVBP in aclass TANKR was configured to be a Just-In-Time point. It is not
included in the instantiated point list when an object is created from the class.

1. Benefits and Disadvantages: Just-in-Time

Just-In-Time benefits and disadvantages are as follows.

Benefits

Disadvantages

Non-supported Functions

« Created on
demand when
needed

* No memory
usage until point
is created

* Project uses less
disk space

« Point database is
reduced

* Not available in point lists

* Slowest access

« Device points only

« Does not reside in point
database

« Definition cannot be
modified

* Exclusive to classes

« Trigger settings and Alarm
options are not available

Note: Are not recommended for
points that are accessed often.

« Trend buffering

» Alarming

« Attribute set

« Analog deadband

» Cannot be used within another point's configuration,
e.g. Safety point, Trigger, Availability Trigger point,
etc.

« Cannot be used in a calculation point equation

» Cannot use another point within its configuration, e.g.
Safety point, Trigger, Availability Trigger point, etc.

» Cannot be marked as an enterprise point.

Standard Memory L oad

When Delay Load and Just-In-Time check boxes are clear in a Data Item dialog box, an instantiated
point has standard memory usage.

Standard memory load benefits and disadvantages are the same whether the point isincluded in an
instantiated object or is created in the project's Workbench. They are as follows.

Benefits

Disadvantages

Non-supported Functions
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None—all functions

« Accessible any time « Uses memory in point database supported
» Quick access * Project uses more memory
» Written to point « Configuration updates can be lengthy on larger

database systems

« Available in point list
« Definition can be
modified

2.2. Data Item Expressions

2.2. Data |tem Expressions

Dataitem expressions are evaluated from class using object attributes or constants to derive the value
of adataitem field.

Note: The dataitems become points when the object is instantiated.

 Overview: Dataitem expressions.
« Configuration: Dataitem expressions.

Overview: Data Item Expressions

As aresult, the apoint that is instantiated for different objects from a single data item can include

different valuesin the samefield, e.g. Alarm High or Setpoint Low. If a value was entered directly
into adataitem field, that value will be the same read-only value for every point instantiated from
that data item.

Example

How the value of the Alarm High field for a single dataitem is determined depends on whether or
not it was assigned an expression or avalue.

» Alarm High field assigned an expression.

* A dataitem includes an expression for the Alarm High field.

» Thevaue for the Alarm High field is entered in the Object dialog box for three class objects.
* Thevaueinthe Alarm High field for each instantiated point is as follows.

OBJECT1 | 5000

OBJECT2 | 2500

OBJECTS | 15000

» Alarm High dataitem field assigned a value.
* Thevaue entered in the Alarm High field in a Data Item dialog box is 5000.
* Thereis no configuration at the Object level for the Alarm High field.
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» Thevauein the Alarm High field for each instantiated point is as follows.

OBJECT1 | 5000

OBJECT2 | 5000

OBJECTS3 | 5000

Note: A classattributeisastring. Asaresult the attribute cannot be entered in fields that require
umeric entries, e.g. the Alarm Limits field on the data item's alarm tab.
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Configuration: Data Item Expressions
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1 Open an Expression dialog box.
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Data item: Additional expression examples.
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2.2.1. Open an Expression Dialog Box

Buttons on the Expressions tab in the Data Item dialog box enable you to open an Expression dialog
box for anew or existing Field ID.

rect 113, 181, 190, 207 (page 40)
rect 33, 181, 110, 207 (page 39)

- New Field ID.
« Existing Field ID

|5/ Note: You can delete any field ID by selecting an ID and clicking Delete. If you delete data item
expressionsin aclass, there will not be any changes made to existing dataitems. They will keep their
last values. However, the changes will apply to any new data items you create.

New Field ID

1. Click New on the Expressions tab in the Data Item dialog box.

A New Expression dialog box opens.
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2. Select afield ID in the dropdown list.

=) Note: If the field has already been configured for the dataitem, it will not be included in the

=

list.

3. Click OK.
Result: An Expression dialog box for the new field ID opens.

Existing Field Properties

4. Select an existing field ID.

5. Click Properties.

The Expression dialog box with specifications for the existing field opens.

2.2.2. CIMPLICITY Field ID's

$ALARM_DELAYDelay interval (seconds) for al alarm states.If SALARM_DELAY isassigned to
adataitem with delay fields for other alarm states (e.g. SALARM_HIGH_DELAY),

1. SALARM_DELAY isevaluated first.
2. Specific alarm delay entries are evaluated next and override SALARM_DELAY values.

2.2.3. Field ID Expression Configuration

The Expression dialog box provides the fields either one operand or two operands connected by an
operator.

» Numeric entries.
« Attribute entries.
* Expression with two operands

Numeric Entries

An Expression for afield ID that is assigned to a dataitem can be a number. The number will be
entered in the selected field for the dataitem’s instantiated point in every object created from the
class.

A Class: Expression configuration.
(page
41)
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Object: Object creation.

Instantiation: Point properties result.

@) E o}
le]
L’im E o
[(e]
(0] [¢’]

1. Class: Expression Configuration

The number that should be assigned to the field is entered in the Fir st operand>Number field in the
Expression dialog box.

Example

Every instantiated point for adataitem, LEVELRES, in the TANKYV class should have a5 second
alarm delay for the Warning Low (Lo) alarm.

5isentered asthe First operand for the SWARNI NG_LOW DELAY field.

1. Object: Object Creation

When a number only is used in the expression, object level entries for that field will not affect the
points that instantiated from the selected data item.

Example
An object STATIONOS is created from the TANKYV class.

1. Instantiation: Point Properties Result

The number entered in the Expression dialog box displaysin selected field in the instantiated point's
Point Properties dialog box.

Example

The STATIONO5.LEVELRES Point Properties dialog box has 5 seconds entered in the Delay alarm
field for the Warning Low (Lo) alarm level on the Alarm Options tab.

Attribute Entries

An Expression for afield ID that is assigned to a dataitem can be an attribute (page 17). The
valueis entered at the object level each object can have a different value.

A Class: Expression configuration.

jpage
42)
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Object: Field values entered.

Instantiation: Point properties result.
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1. Class: Expression Configuration

All of the class analog attributes are listed in the Attribute ID fields' dropdown list. Any of those
attributes can be applied to the selected field.

Example

The Alarm High value for adataitem, LEVEL, in the TANKN class may be different for each
object.

In order to apply avalue entered at the object level, the LEVEL Expressions list includes the
$ALARM_HIGH field, which has the custom attribute LHI GHCRI TI CAL as the expression.

1. Object: Field Vaues Entered

When an attribute is selected as a data item's field expression, the dataitem's field value is assigned
at the object level

Object Created
Class objects are created from the class.
Example

A class object created from the class TANKN is named: STATIONOL.

Field Expressions Assigned Values

Vaues that are entered in the Object dialog box fields will be applied to the instantiated points that
have the attributes applied to field ID's.

Example

5000 is entered inthe HIGH CRITICAL field, which isthe prompt (page 20) for the
LHI GHCRI Tl CAL attribute.

1. Instantiation: Point properties Result
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The value entered for the attribute in the Object dialog box displays in the Point Properties dialog
box associated field.

Example

Expression with Two Operands
Expression versatility is expanded by using two operands instead of just one.

Operands can include:

» Two numbers.
» Two attributes.
» One attribute and one number.

Operatorsthat are available to create the expression are:

Operator | Description
Minus
* Times
/ Divided by
+ Plus
< Less an
<> Not equal to
= Equal to
> Greater than
none No operand (Disables the second operand)

2.2.4. Data Item: Additional Expression Examples

» Example: Alarm Enable
» Example: $DATA | TEM EXI STS

Example: Alarm Enable

Note: When the enable state fields are included for a data item, an object designer can enable/disable
theincluded alarm levels for each object.

The instantiated analog point for a data item named LEVELEXP requires:

* Four alarm states for some objects.
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» Alarm High and Alarm Low states only for other object.

A Class: Data item configuration.
(page

44)

B Object: Object defined.

(page

44)

C Instantiation: Point properties result.
(page

45)

1. Class: Data ltem Configuration

Two analog attributes are created that will display as fields in the Object dialog box.

The attributes are as follows.

Field ID Field Name for Attribute Dialog Box

A | SWARNING_HIGH_ENABLED | WARN HIGH ON

B | SWARNING_LOW_ENABLED | WARN LOW ON

Field ID's are assigned to the LEVELEXP dataitem.

Field ID Expression Example

A | SWARNING_HIGH_ENABLED | WARNHIGHON analog attribute.

B | SWARNING_LOW_ENABLED [ WARNLOWON analog attribute.

1. Object: Object Defined
Two objects are defined in the TANKYV class.

STATIONOS
One object, STATIONO5, requires all alarm states.

A valuethat is greater than O isrequired to enable the alarm states.

1lisentered for each

STATIONO4

One object, STATIONO4, requires only the Alarm High and Alarm Low alarm states.
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The value O isrequired to disable the alarm states.

O isentered for each

1. Instantiation: Point Properties Result
The alarm state values for the instantiated points reflect the entries in the Object dialog box.

STATIONOS

STATIONOS.LEVELEXP has four enabled alarm states.

STATIONO4

STATIONO4.LEVELEXP has Alarm High and Alarm Low only enabled.

A dataitem can beincluded or excluded from being instantiated into a point based on the expression
in an assigned $DATA_| TEM EXI STS field ID.

Example: $SDATA_ITEM_EXISTS

A classincludes dataitems, that will be instantiated into points based on which control valveis
selected for an object.

The data items require the following control valves.

Data Item | CVALVEO1 | CVALVEO2 | CVALVEO3

TANKO1 | X

TANKO2 X

TANKO3 X

One dataitem will be instantiated into a point for each object; the dataitem that is instantiated
depends on which valve is selected for that object.

A Class: Data item configuration.

(page
46)

B Object: Object defined.

(page
46)

C Instantiation: Point properties result.

(page
46)
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1. Class: Data ltem Configuration
In the class configuration dataitems will be assigned to the same attribute.

Attribute Created

An analog attribute, CVALVE, is created that will be used to identify the Valve that should be selected
for each dataitem.

Note: The Prompt in the Attribute dialog box will be CONTROL VALVE.

Data Item Configuration
Three TANK dataitems are created.

Thefirst dataitem, TANKOL is assigned $DATA_| TEM EXI STS, with the following expression to
associated Control Valve 1 with TANKO1.

Field Example Value Assigned

First operand Attribute ID | CVALVE

Operator =

Second operand | Number 1

Two additional dataitems are assigned the field ID, $DATA | TEM EXI STS.

The three data items and expressions for $DATA_| TEM EXI STS are as follows.

Data Item | $DATA_ITEM_EXISTS Expression

TANKO1 | CVALVE=1

TANKO2 | CVALVE=2

TANKO3 | CVALVE=3

1. Object: Object Defined

2 isentered inthe CONTROL VALVE field for an object, STATIONO2.

1. Instantiation: TANK Points Existing

TANKO2 isinstantiated for the STATIONOL object.

TANKO1 and TANKO3 do not exist for that object.
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2.3. Address Adjustment Expressions

Address adjustment expressions provide a powerful tool that automates applying addresses to devices
at the object level.

Address adjustment expressions are computed against the base $ADDRESS attribute value that is
entered for an object.

 Overview: Address adjustment.

« Configuration: Numeric $ADDRESS_ADJ entry.

« Configuration: Attribute SADDRESS_ADJ entry.

+ Additional base addresses.

* Do not configure SADDRESS_ADJif aclass dataitem is configured with a device address.

Overview: Address Adjustment

Address adjustment options enable you to do any of the following:

« Enter anumeric value that specifies the address adjustment at the class dataitem level.

« Create numeric attributes that will enable the address adjustment to be entered at the object
level.

« Create a string attribute that provides afield in the Object dialog box to enter an additional base
address.

Example

A section of awater heating system that is connected to a PLC requires different address
assignments. These assignments can be made using address adjustment.

Three assignments demonstrate the flexibility that address adjustment options provide.

1 | Input valve Numeric $ADDRESS_ADJ entry | BLOCK 1
2 | Level Attribute $ADDRESS_ADJ Entry | BLOCK 1
3 | Temperature Additional Base Address BLOCK 2

Note: An address can be entered for an individual dataitem in its Data Item dialog box. That
addressis assigned to its instantiated point. This assignment overrides $ADDRESS or $ADDRESS_ADJ
assignments.

T

Configuration: Numeric SADDRESS ADJEntry
A simple numeric value at the class level can be used for address adjustment.

Conditions that can use a simple entry include the following.
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» Class objects will require one base address only.
* The base address will be different for different objects.
* The offset from the base address for an instantiated point can be the same for al objects.

|5/ Note: When $ADDRESS_ADJ is selected an Octal checkbox appears in the Expression dialog box.

Check Octal to define the adjustment as an Octal number.

A Class: $ADDRESS_ADJ configuration.
(page
48)

B Object: Address defined.

(page
48)

C Instantiation: Point properties address result.
(page
49)

1. Class: $SADDRESS _ADJ Configuration

1. Select the Expressions tab in a device Data Item dialog box,
Example

A dataitem, VALVE_IN, will include a basic address adjustment from the base address.

2. Click New.
3. Select $ADDRESS _ADJin the dropdown Field 1D list.

An Expression dialog box opens.

4. Enter anumber in the Number field.
Example

3isentered in the Number field.

a. Object: Address Defined
An addressis entered in the Address field in the Object dialog box.
|5/ Note: The Addressfield is created from the CIMPLICITY class attribute, $SADDRESS.

Example

An object named STATIONO2 is created.
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%R5 is entered in the STATIONO2 Object dialog box Addressfield.
a. Instantiation: Point Properties Address Result

When the point is instantiated, the device addressisthe Base address + $ADDRESS_ADJ
value.

Example

The read-only device address for the instantiated STATIONO2.VALVE_IN point is %R8.

Configuration: Attribute SADDRESS ADJ Entry
A custom attribute can be used for address adjustment.

Conditions that can use a custom attribute include the following.

« Class objects will require one base address only.

* The base address will be different for different objects.

* The offset from the base address for an instantiated point may also be different for different
objects.

Class: $ADDRESS_ADJ configuration.

Object: Address defined.

Instantiation: Point properties address result.

@EO @E\Uﬂ @E\ZD

a. Class: $ADDRESS_ADJ Configuration
Attribute Configuration
An analog attribute can be created to display as a numeric field in the Object dialog box.
Example

The address adjustment will be required for instantiated points that are associated with the
LEVEL value; the adjustment will be different for different objects.

A class attribute is created as follows.

Field Example Entry

1 | Attribute Name | ADJ_LEVEL

2 | Data type Analog
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3 | Prompt LEVEL Offset

4 | Property Page | BLOCK

$ADDRESS ADJ Configuration.

5. Select the Expressions tab in a device Data Item dialog box,
Example

A dataitem, LEVEL, will include an attribute address adjustment against the base address.

6. Click New.
7. Select $ADDRESS_ADJin the dropdown Field 1D list.

An Expression dialog box opens.

8. Select the attribute that should be applied to the SADDRESS ADJ field.
Example

The attribute, ADJ _LEVEL, is selected.
a. Object: Address Defined

Both of the following are entered in the Object dialog box.
Base Address

An addressis entered in the Addressfield.

|5/ Note: The Addressfield is created from the CIMPLICITY class attribute, $ADDRESS.
Example

An object named STATIONO2Z is created.

%R5 is entered in the STATIONO2 Object dialog box Addressfield.

Adjustment

An offset value is entered in the field created by the custom anal og class attribute.
Example

5isentered inthe LEVEL Offset field that was created by the ADJ_LEVEL attribute.
a. Instantiation: Point Properties Address Result
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When the point is instantiated, the device addressisthe Base address + $ADDRESS_ADJ
value entered in the Object dialog box.

Example

The read-only device address for the instantiated STATIONO2.LEVEL point is %R10.

Additional Base Addresses
Address adjustment can enable applying more than one base address to an object.

Conditions that can use more than one base address include the following.

* Objects will be connected to two PLC blocks, each of which requires a unique base
address.

* The base addresses will be different for different objects.

* The offset from the base address for an instantiated point may always be the same or may
be different for different objects.

(page
51)

A Class: $ADDRESS_ADJ configuration.

B Object: Address defined.

(page
52)

C Instantiation: Point properties address result.

(page
52)

a. Class: $SADDRESS_ADJ Configuration

Attribute Configuration
A string attribute can be created to display as a string field in the Object dialog box.
Example

The second address will be required that will be used as the base address for some device
instantiated points.

A class attribute is created as follows.

Field Example Entry

1 | Attribute Name | ADDR_BLOCK2

2 | Data type String

3 | Prompt ADDRESS 2

4 | Property Page | BLOCK
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10.

11.

12.

Data Item Device Address Configuration

Both of the following are entered in the Data Item dialog box.

. An $ADDRESS_ADJ entry is entered in the Expression dialog box.

Example

A dataitem TEMPERATURE is assigned a custom ADJ_ TEMP attribute for the
$ADDRESS ADJ field.

The string attribute created for the additional base address is entered as a string substitution in
the Device tab>Addressfield.

Example

The string substitution { ADDR_BLOCK2} is entered in the Data Item dialog box for the
FLOW_IN dataitem.

a. Object: Address Defined

Both of the following are entered in the Object dialog box.

An addressis entered in the field that was created for the second base address by the custom
string attribute.

(Optional) An offset valueis entered if fields are available.
Example
An object named STATIONO2 is created.

The following entries affect the instantiated FLOW _IN point.

Field Example Entry

ADDRESS 2 %Q2

TEMPERATURE Offset | 6
a. Instantiation: Point Properties Address Result

When the point is instantiated, the device addressisthe Cust omBase address +
$ADDRESS_ADJ value.

|=/ Note: The $ADDRESS_ADJ value may be based on a number entered in the class Expression
dialog box or the Object dialog box.

Example
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The read-only device address for the instantiated STATIONO2. TEMPERATURE point is %Q8.

3. Sripts, Actions, Events

3. Scripts, Actions, Events

CIMPLICITY classes can include scripts, actions and events that can interact with each other the
same way they do inany CIMPLICITY project.

Item Applied to:
3.1 Script | Class as soon as they are created
age
53)
3.2 Action | Each instantiated object where it was applied in the class template.
(page
60)
3.3 Event | Each instantiated object where it was applied in the class template.
age
65)
3.1. Class Scripts

3.1. Class Scripts

» Overview: Scriptsin class configuration.
 Overview: Script included in aclass.
+ Configuration: Class scripts.

Overview: Scriptsin Class Configuration

Class scripts:

+ Can be created and modified in the CIMPLICITY Program Editor by opening it through the
Class dialog box.

+ Can be available anywhere that standard CIMPLICITY project scripts are.

« Are stored in the Workbench Scripts folder, with a class$ prefix, as soon as they are created.\
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Open the CIMPLICITY Program Editor.
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Class scripts definition.
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w
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Pre create script.
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g
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1.4 Post create script.

(page
58)

The class$ script can be modified in the CIMPLICITY Program Editor by opening it through the
Workbench Scripts folder.

Overview: Script Included in a Class

A class retains one copy only of each script.

A Class: Script configuration.
(page
54)

B Instantiation: Class script availability.

(page
54)

1. Class: Script Configuration

Class scripts are created and edited in the Program Editor. CIMPLICITY inserts <Class Name>$ in
front of the script name as soon asit is created.

The syntax for each class script nameis:

Cl ass$Scri pt nane. be

Where

a ass$ isthe name of the class to which the script belongs.

Scriptname.bcl is the name entered in the New Script Name dialog box.

Y ou can modify the script either through the Scripts folder or through the Class dialog box.
Example

A script, feedback.bcl, has been created for a TANKR class.

When feedback.bcl is opened in the Program Editor, the name on the title bar is TANKR
$f eedback. bcl .

1. Instantiation: Class Script Availability
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As soon asaclass script is created (page 55) or duplicated (page 56) it is added to the Basic
Control Engine>Scripts list and is available for objects.

Example

The TANKRS$feedback.bcl islisted in the Workbench right pane. As soon as the Classis applied
(clicking Apply or OK in the Class dialog box) the script will be applied to every object associated
with TANKR.

Configuration: Class Scripts

311 Open the CIMPLICITY Program Editor.

3.1.2 Class scripts definition.

3.1.3 Post create script.

3.1.1. Open the CIMPLICITY Program Editor

Buttons on the Scripts tab enable you to open the CIMPLICITY Program Editor to create a new or
modify an existing script.

rect 15, 215, 90, 238 (page 55)
rect 100, 216, 175, 239 (page 56)
rect 184, 216, 259, 239 (page 56)

* New script.
* Existing script.
* Duplicate script.

|5/ Note: All scriptsthat are listed for a class on the Scripts tab and in the Workbench Basic
Control Engine>Scriptsright pane will be included in the classif the class is exported/imported
(page 81) to another project. They are listed even if you cancelled creating them and/or did not
compile them. Y ou can delete any action by selecting an ID and clicking Delete.

New Script

1. Click New on the Scripts tab in the Class dialog box.

The New Script Name dialog box displays.

2. Enter aunique name in the Script field.
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8.

9.

A Script nameis

* Isup to 15 characters.

+ Can have alphanumeric characters.
+ Can have underscores.

+ Cannot have spaces.

. Click OK.

Result: A blank CIMPLICITY Program Editor window opens.

Existing Script Properties

. Select an existing script.

. Click Properties.

Result: The CIMPLICITY Program Editor window with the existing script opens.

Duplicate Script

. Select an existing script.

. Click Duplicate.

A New Script Name dialog box opens.

Enter a unigque name for the script that adheres to the script 1D requirements (page 55).

Click OK.

The duplicate script is added to the list on the Scripts tab.

3.1.2. Class &cripts Definition

Because class scripts will be used for more than one object, the script will require the flexibility to
call fully instantiated points that have different names.

An extension inthe CIMPLICITY Basic script, G nEMEvent ( object) , enables the script to access
the object that represents the selected event.

One of the attributes is the object that triggered this event.

That way you can make the fully qualified point 1D’ s with the object ID as the prefix to the point ID.
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Sample Script
The script below demonstrates how to identify the name of the object that is being used for an event.

As aresult, that object ID can be used to construct the object's point ID’ s for which script is running.

Sub Mai n()

Di m event As Ci nEMEvent

Set event = C nGet EMEvent ()

Di m poi nt Event As Ci nEMPoi nt Event
Set poi nt Event = event. Poi nt Event ()
Dim CbjectI D As String

Obj ect| D = event. oj ect| D

Di m pt Val ue As | nteger

Di m pt Val ueExpect ed As | nteger

Di m pt Gt rl Pendi ng As Bool ean

pt Val ue = poi nt Event. Val ue

pt Ctrl Pendi ng = Point Get (ObjectID & ". AT")

If ptCtrl Pending Then

pt Val ueExpect ed = Poi nt Get (Obj ect| D & ". DO $RAW VALUE")
If ptValue = ptVal ueExpected Then

"Indicate that a control is conplete

Poi nt Set CbjectID & ".AT", 0

End | f

El se

'Enabl e the alarmon the digital indicator

Poi nt Set Cbject!ID & ". DI . QUALI TY. ALARVS_ENABLED', 1
End | f

End Sub

3.1.3. Pre Create Script

» Overview: Pre create script.
« Configuration: Pre create script.

Overview: pre Create Script

If class objects require additional functionality that is not configured in the class, the additional
functionality can be included in a script. that will call the PreObjectCreateentry point before the
object is created.

© Tip: TheCIMPLICITY Object Model includes many scripting objects that are devel oped
specifically for classes, including the following.

CimClassActionList (object)

CimClassAttribute (object)

CimClassAttributeList (object)

CimClassDataltemExpression (object)

CimClassDataltemExpressionList (object)

CimClassDataltemList (object)
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CimClassEventActionList (object)

CimClassEventList (object)

CimClasslinstance (object)

CimClassList (object)

CimClassScript (object)

CimClassScriptList (object)

Configuration: pre Create Script

The content of the pre create script depends entirely on your class/object requirements. The one
unigue feature when configuring the classis that you enter itsID in the pre create script field on
the Generatab in the Class dialog box.

1. Class: Pre Create Script Configuration
New Pre Create Script

1. Click the Popup menu button to the right os the Pre create script field; select New on the Popup
menul.

A New Script Name dialog box opens.

2. Enter anamein the Script field.
3. Click OK.

4. Click the Browse button to the right of the Pre create script field.
A Select a Script browse window opens.

5. Select a script.

6. Click the Popup menu button to the right of the Pre create script field; select Browse.
A Select a Script browse window opens.

7. Select ascript.

3.1.4. Post Create Script

» Overview: Post create script.
« Configuration: Post create script.

Overview: Post Create Script
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If class objects require additional functionality that is not configured in the class, the additional
functionality can be included in a script that will call the PostObjectCreateentry point after the object

is created.

© Tip: TheCIMPLICITY Object Model includes many scripting objects that are devel oped

specifically for classes, including the following.

CimClassActionList (object)

CimClassAttribute (object)

CimClassAttributeList (object)

CimClassDataltemExpression (object)

CimClassDataltemExpressionList (object)

CimClassDataltemList (object)

CimClassEventActionList (object)

CimClassEventList (object)

CimClasslInstance (object)

CimClassList (object)

CimClassScript (object)

CimClassScriptList (object)

Configuration: Post Create Script

The content of the post create script depends entirely on your class/object requirements. The one
unique feature when configuring the classis that you enter its ID in the Post create script field on

the Generatab in the Class dialog box.

Class: Post create script configuration.

Instantiation: Post create script.

1. Class: Post Create Script Configuration

New Post Create Script

1. Click the Popup menu button to the right os the Post create script field; select New on the Popup

menu.

A New Script Name dialog box opens.

2. Enter anamein the Script field.
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3. Click OK.

4. Click the Browse button to the right of the Post create script field.
A Select a Script browse window opens.

5. Select a script.

6. Click the Popup menu button to the right of the Post create script field; select Browse.
A Select a Script browse window opens.

7. Select ascript.
3.2. Class Actions

3.2. Class Actions

» Overview: Actionsin class configuration.
* Overview: Class actions instantiated into an object action.
* Configuration: Class action.

Overview: Actionsin Class Configuration

Class actions

« Are created through the Class dialog box.

* Appear in the Event Editor window when an object is created.

* In the Event Editor, actions:

» Are associated with an object. An object designer cannot change the association.

+ Cannot be modified. All fields are read-only.

+ Cannot be deleted.

+ Can be associated with a non-object event. This enables an object to instantiate actions that can
be called from other events.

3.2.1 Open an Action dialog box.

3.2.2 Class action definition.

Overview: Class Actions Instantiated into an Object Action:

Class actions are instantiated into object actions, as follows.
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Class: Action configuration.

Object: Object created.

(@} lgg\w @EZD

Instantiation: Action result.
(page
61)

1. Class: Action Configuration

Actions are created in Action dialog boxes that are opened through the Class dialog box.
Example

A class action HEATI N_OPENis created asaSet Poi nt action.

Note: Classaction ID's (page 62) are listed on the Actions tab in the Class dialog box.

1. Object: Object Created

Class objects are created from the class.

Example

A class abject created from the class TANKS is named: STATIONOL.
1. Instantiation: Action Result

Class actions are instantiated into object actions.

Event Editor

The instantiated actions are listed in the Event Editor.

Example

The class action instantiated into a class object is named: STATIONOL.HEATIN_OPEN.

Modify Action Dialog Box
Instantiated object actions cannot be modified.

Example
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The Modify Action dialog box for STATI ONO1. HEATI N_OPEN is read-only.

Configuration: Class Actions

w
N
[E

Open an Action dialog box.

()]
ISR
[©]
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Class action definition.

3.2.1. Open an Action Dialog Box

Buttons on the Actions tab enable you to open an Action dialog box to create a new or modify an
existing action.

rect 15, 216, 93, 238 (page 62)
rect 99, 216, 177, 238 (page 63)
rect 183, 216, 261, 238 (page 63)

* New action.
« Existing action.
* Duplicate action.

Note: You can delete any action by selecting an ID and clicking Delete.

>

New Action

1. Click New on the Actions tab in the Class dialog box.

The New Action dialog box displays.

2. Enter aunique name in the Action ID field.

The Action ID:

* Islimited to 16 characters.

+ Can be composed of

« Uppercase alphabetic characters,

» Numeric characters and

* Underscores.

» Must begin with an alphabetic character.

A blank New Action dialog box opens.

3. Click OK.



Advanced Features | 1 - Classes and Objects | 63

Result: A New Action dialog box for the new action opens.

Existing Action Properties

4. Select an existing action.
5. Click Properties.
Result: The Action dialog box with specifications for the existing action opens.

Duplicate Action

6. Select an existing action.
7. Click Duplicate.
A Duplicate Action dialog box opens.

The selected source action displays.

8. Enter a unique name for the Destination action that adheres to the action ID reguirements (page

62).
9. Click OK.

A New Action dialog box with specifications for the source action opens.

3.2.2. Class Action Definition

|5/ Note: The user can associate a non-object event with an object action. This allows an object to
instantiate actions that can be called from other events.

Thefieldsin the Action dialog box depend on the selected action type.

« Action type.
« Action fields.
« Supported string substitution for action fields.

Action Type

All CIMPLICITY action types (found in the Event Editor) are available except for:

* Alarm L ookup and
* Recipe Upload/Download.
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The difference between configuring a class action and a standard action is that you:

* Select adataitem instead of apoint ID when you configure an action that requires apoint ID.
* The CIMPLICITY $OBJECT variableisautomatically entered when you select the data item.

Actions available in the drop down list for classes include:

Log Only

Point Alarm Acknowledge

Point Alarm Disable

Point Alarm Enable

Run Script

Set Point

Source Transition Set

Transition Set

Action Fields
Fields vary based on your selected action. One or more field may display.
Note: Thefield's value can be selected from an associated browser.

Possible fields and buttons to open associated browsers are as follows.

Field Button | Opens

Point ID Note: The CIMPLICITY s$oBJECT variable appears in the Point ID field before the data item as
follows: { $OBJECT) . Dat al t em

Source

Alarm ID

Script

Resource CIMPLICITY Select a Resource browser

Result: When the Action dialog box is closed, the action, which is modified or created, displays on
the Actionstab in the Class dialog box.
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Supported String Substitution for Action Fields

String substitution is supported for the following action fields, which you enter in the associated
Action dialog box field.

« Point ID.
* Resource ID.
 Point value.

3.3. Class Events

3.3. Class Events

» Class events configuration overview.
» Class events configuration steps.
« Configuration: Class events.

Overview: Eventsin Class Configuration
Class events provide awide degree of flexibility for changing the business rules of a system.

Class events:
* Are created through the Class dialog box.
* Appear in the Event Editor window when an object is created. In the Event Editor, events:
+ Are associated with an object.

An object designer cannot change the association.

« Cannot be modified. All fields are read-only.
+ Cannot be deleted.

Creating class eventsis similar to creating events in the Event Editor. All existing event types that
are supported in the event editor are available for class event configuration.

3.3.1 Open an Event dialog box.
(page
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Class event definition.
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Overview: Class Events|nstantiated into an Object Event

Class events are instantiated into object events, as follows.

A Class: Event configuration.

gpage
66)

B Object: Object created.

jpage
66)

C Instantiation: Event result.

jpage
66)

1. Class: Event Configuration

Actions are created in Event dialog boxes that are opened through the Class dialog box.
Example

A class event FLOW STOPPED is created asaPoi nt  Equal s event.

Note: Classevent ID's (page 67) are listed on the Event tab in the Class dialog box.

Example

The event named FLOW STOPPED is listed with other events on the Events tab in a class named
TANKS.

1. Object: Object Created

Class objects are created from the class.
Example

A class abject created from the class TANKS is named: STATIONOL.
1. Instantiation: Class Event Result

Class events are instantiated into object events.

Event Editor
The instantiated events are listed in the Event Editor.

Example
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The class event instantiated into a class object is named: STATIONO1.FLOW_STOPPED.

Modify Event Dialog Box
instantiated object events cannot be modified.
Example

The Modify Event dialog box for STATI ONO1. FLOW STOPPED is read-only.

Configuration: Class Events

(98]

3.1 Open an Event dialog box.
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3.2 Class event definition.
(page
68)

3.3.1. Open an Event Dialog Box

Buttons on the events tab enable you to open an Event dialog box for a new or existing event.

rect 13, 217, 91, 240 (page 67)
rect 97, 216, 175, 239 (page 68)
rect 182, 215, 260, 238 (page 68)

* New event.
« Existing event.
* Duplicate event.

Note: You can delete any event by selecting an ID and clicking Delete.

New Event
1. Click New on the events tab in the Class dialog box.

The New Event dialog box displays.

2. Enter aunique name in the Event 1D field.

The Event ID:

* Islimited to 16 characters.
+ Can be composed of
« Uppercase alphabetic characters,
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» Numeric characters and
» Underscores.
» Must begin with an alphabetic character.

A blank New Event dialog box opens.

3. Click OK.
Result: A New Event dialog box for the new event opens.

Existing Event Properties

4. Select an existing event.
5. Click Properties.
Result: The Event dialog box with specifications for the existing event opens.

Duplicate Event

6. Select an existing event.
7. Click Duplicate.
A Duplicate Event dialog box opens.

The selected source event displays.

8. Enter a unique name for the Destination event that adheres to the event 1D requirements (page

67).
9. Click OK.

A New Event dialog box with specifications for the source event opens.

3.3.2. Class Event Definition

Class event configuration

Supported string substitution for event fields

Class event configuration

rect 2, 18, 47, 39 (page 69)
rect 92, 18, 151, 39 (page 72)
rect 45, 17, 90, 38 (page 70)



» Event tab
» Actionstab

» Advanced tab

Event Tab
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The fields on the Event tab in the New Event dialog box depend on the selected event type.

» Event type
* Event fields

Event Type

All of the event types available in the Events Editor are available for a class event.

The difference between configuring a class event and a standard event is that you:

» Select adataitem instead of a point ID when you configure an event that requires apoint ID.
* The CIMPLICITY $OBJECT variableisautomatically entered when you select the data item.

Events available in the drop down list for classes include:

Alarm Acknowledged

Alarm Deleted

Alarm Generated

Alarm Reset

Point Change

Point Equals

Point Transition High

Point Transition Low

Point Unavailable

Point Update

Run Once

Timed

Event Fields

Fields vary based on your selected event. One or more field may display.

Note: Thefield's value can be selected from an associated browser.
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Possible fields and buttons to open associated browsers are as follows.

Field Button | Opens
Point ID Note: The CIMPLICITY $oBJECT variable appears in the Point ID field before the data item as
follows: { $OBJECT) . Dat al t em
Source
Alarm ID
Class ID CIMPLICITY Select an Alarm Class browser
Resource CIMPLICITY Select a Resource browser
ID
Event Timed event provides fields to enter The start time and interval for an event.
Time
Event int
Actions Tab

Actions listed on the Actions tab are associated with the selected event. .
Buttons on the Actions tab enable you to open a New Actions dialog box to add an additional action.

|5/ Note: You can remove any action's association with the event by selecting an ID and clicking
Delete.

» New action association.
* Log Flag checkbox.

New Action Association
Click New on the Actions tab in the New Event dialog box.
A New Event-Action dialog box opens.

Selections are as follows.

Action ID
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Methods to select an action ID are as follows.

* Browse existing actions.
* Create anew action.

* Browse existing actions.
1. Do one of the following.

« Click the Browse Actions button to the right of the Action 1D field.
* Click the Popup Menu button to the right of the Action ID field; select Browse on the Popup
menu.

A Select an Action browser opens.

1. Select an action; click OK.

+ Create anew action.
1. Click the Popup Menu button to the right of the Action ID field; select New on the Popup menu.
A New Action dialog box opens.

1. Enter aunique action namein the Action 1D field.

1. Click OK.
A New Action dialog box opens for the entered action

1. Define the action.

1. Click OK.

Result: The New Event-Action dialog box displays when you use either method.
Log Flag Checkbox

Check Log Flag if the action should be logged to a database table.
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Result: When the New-Event Action dialog box is closed a new class action islisted both on the
Actionstab in the Class dialog box and at the end of the list of actions associated with the event.

|=/ Note: Select the action and click the Move Up button if it should be located higher up in the list.
Existing Event-Action Properties
1. Select an existing event-action.

2. Click Properties.

The New Event-Action dialog box opens for the selected event-action.

3. Do one or both of the following.
« Edit the selected action.
a. Click the Popup button to the right of the Action ID field; select Edit.

The New Action dialog box opens for the selected action.

a. Make any required changes to the action configuration.
b. Click OK.

The action is modified.

* Check of clear the Log Flag check box.

When the New-Event Action dialog box is closed the class action that is associated with the event is
modified.

Advanced Tab

Advanced tab options are as follows.

Configure advanced specificationsthe same as you configure them for an event in the Events folder.

When an object is created from the class, the event displaysin the CIMPLICITY Event Editor
window as:

ObjectName.Event| D

Where

ObjectName is the name of the object that has been created.
Eventl D isthe name entered in the New Event dialog box.

Supported String Substitution for Event Fields
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String substitution is supported for the following event fields, which you enter in the associated
Event dialog box field.

* Point ID.

* Alarm ID.

* Resource ID.
» Alarm Class.
* Point Value.

4. CimEdit Class Screens

4. CimEdit Class Screens

* Overview: CimEdit class screens configuration.
 Overview: CimEdit object instantiated into a class object screen.
« Configuration: CimEdit class screens.

Overview: CimEdit Class Screens Configuration

CimEdit screens can be created with graphic objects that include data items. When screens are
applied to class objects, the configuration will be instantiated into a dynamic CimEdit/CimView
screen that reports the selected class object values.

4.1 Top level CimEdit group object in a class.

4.2 Class properties assigned to a CimEdit object.

Class screen assignment.

Overview: CimEdit Object Instantiated into a Class Object Screen

Class: CimEdit Group Object Configuration

Object: Object created.

Instantiation: Object Screen
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1. Class: CimEdit Group Object Configuration

One or more objects are configured on a CimEdit screen.
Example

A CimEdit screen, WaterHeating.cim includes three group objects; the largest object is named
Object,

The CimEdit screen and default object are indicated on the General tab in the Class dialog box.
Example

A class TANKYV selects WaterHeating.cim as its graphics file and Object as its default graphic.

1. Object: Object Created

A classis selected to create an object.
Example

A class abject created from the class TANKYV is named: STATIONOA4.
1. Instantiation: Object Screen

An Object screen can display one or more of the objects created on the CimEdit screen.

A class abject the first object to display be the default graphic entered in the Class dialog box. That
graphic can be changed after the screen is created.

An object is dragged from the Workbench onto a CimEdit Screen; the default graphic displays on the
screen.

The source object from the class CimEdit screen appears on the new screen. Object values are
substituted for variables, e.g. $OBJECT , that were configured on the source screen.

Note: Even though the class object is created from a group object, it cannot be opened; configuration
inisdisabled.

Example
1. STATIONO4 is dragged to a CimEdit screen.

2. The following occurs.

A | Configuration features (e.g. Ungroup, Open Group) are disabled.
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vs}

Display features (e.g. Bring to front) are enabled.

@)

Another graphic, TemperatureHeater, is selected from the list of graphics that are on the WaterHeating.cim
screen.

Configuration: CimEdit Class Screens
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Top level CimEdit group object in a class.
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Class properties assigned to a CimEdit object.
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Class screen assignment.
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4.1. Top Level CimEdit Group Object in aClass

The CimEdit group object can be created to be the source for graphics that are created for a
CIMPLICITY class object.

Define atop level group object as follows.

A Place objects on a CimEdit screen.

(page

75)

B Group the objects into a Class Group Object.
(page

76)

C Identify the group object.

(page

76)

D Assign an $OBJECT variable to the group object.
(page

76)

E Create additional objects.

(page

77)

1. Place Objects on a CimEdit Screen

Y ou can use any of the thousands of CimEdit objects on a class CimEdit screen. The type and
number of objects you place on the screen depends on the class requirements.

The following are examples of objects that can be replaced with values for a class object.

1 | Text string.
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2 | Trend ActiveX object.

3 | Fill'in a tank group object from Object Explorer.

4 | Numeric text to track tank data.

1. Group the Objects into a Class Group Object

The class group object becomes the source for graphics that are created for CIMPLICITY class
objects.

1. Select the objects that should be included in the group object.

Note: Y ou can create more than one group object, then select one to be the default (page 78)

2. Groupthe selected objects the same way you group any objects on a CimEdit screen.
3. Identify the Group Object

A CimEdit class group object requires a name.

4. Select the class group object.

5. Open its Object - Group Properties dialog box, using any of the methods provided by CimEdit,
for example:
a. Right-click the group object.
b. Select Properties on the Popup menu.

The Properties - Group dialog box opens.

6. Name the top-level group object as follows.

1 | Select General.

2 | Enter a name in the Object name field.

3 | Click Apply.

4 | The Object name (e.g. Object) displays in the Properties - Group dialog box title bar.
a. Assign an $OBJECT Variable to the Group Object

A variable must be assigned to the class (group) object that CIMPLICITY will substitute with
the appropriate (class) object name.

Assign the CIMPLICITY $OBJECT variableto the top level group object as follows:
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When an object that is created from the class is dragged into CimEdit, a class object graphicis
created. The name of the object is substituted for { SOBJECT} in expressions during runtime.

1 | Select Variables.

2 | Enter $0BJECT in the Variable field.

3 | Check Public.

IN

Click OK.

Note: The $OBJECT variable on the Variablestab is read-only when a CimEdit screen designer
ens the Properties - Class Object (page 87) dialog box.

S

1. Create Additional Objects

Follow the same procedure to create as many additional group objects as necessary.
Any of the group objects can be selected as the default object for a class object.
Example

A CimEdit screen named WaterHeating.cim includes three objects.

Each group object is assigned a unique name.

1 | object

2 | TemperatureHeater

3 | TANKEXP

4.2. Class Properties Assigned to a CimEdit Object

Y ou can assign expressions and variables to a group of objects and objects that are included in the
top-level group the same way you assign them on any CimEdit screen.

The values you enter are values from the Class configuration, e.g. data items that become point IDs
when an object is created from the class.

Two CimEdit Properties dialog box field types that can take advantage of class configuration are as
follows.

rect 147, 120, 169, 138 (page 78)
rect 146, 94, 168, 112 (page 78)

A Expression field.
(page
78)
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Expr. min/max field.

B
jpage
78)

A | Expression Field

The Expression field that is configured for a class requires the following.
* The dataitem( (or dataitems) that is entered in the Expression field must be manually entered.
Note: Only points are listed in the Select a Point browser.

* The predefined variable, { SOBJECT (page 29) },isrequired to hold the place for the object
name.

The syntax is:

{$OBJECT}. data item

Where

{ $OBJECT} references the object that is created from the class.
Data item indicates the class data item.

Example

{ $OBJECT} . LEVEL

B | Expr. min/max Fields

When an instantiated object uses the configured graphic, CimEdit looks for the selected instantiated
point's display values:

1. First in the CimEdit Properties dialog box.
2. Second in the point's Display low and Display high fields.

4.3. Class Screen Assignment
1. Open the Class dialog box for the class with which the screen will be associated.

2. Select the Generd tab.

3. Enter the following.

Field Enter
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A | Graphics | CimEdit screen name that will be associated with the class. The selected CimEdit screen contains
file the source objects that are available to object designers.

B | Default Name of the CimEdit group object that displays as the default when a class object is dragged to a
Graphic | new CimEdit screen.

When an object that is created from the class is dragged from the Workbench into a new CimEdit
screen, aclass object graphic, which islinked to the class source graphic displays.

Note: An object designer can select another object in the default object's Properties dialog box.

=

5. ClassHelp File

Y ou can associate a custom help (.hlp) filethat is created using athird party tool with aclass. The
help file will assist object designers when they are configuring point objects based on the point class.

In order to make the help file specific to the class you are creating, it is recommended that you write
the help file after you configure the other class components.

|5/ Note: Refer to the documentation from your help-based software for details about creating
custom help files.

Associate a custom help file with aclass

1. Select the General tab in the Class dialog box.
2. Enter the name of the help filein the Help filefield.

When an object designer presses F1 or clicks Help in the Object dialog box, the table of contents for
the specified help file displays.

6. Composite Classes and Objects

About Composite Classes and Objects

Beginning in CIMPLICITY 9.5, there are Composite Classes and Objects. Classes can reference
other classes. Y ou can modify a class dynamically and you can also delete a class dynamically if
there are no references to the class or no object instances of that class with composite references to
the class.
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Advantages of Composite Classes and Objects

WEell-planned composite classes and objects reduce the amount of work required to configure a
CIMPLICITY project. Read more about Composite Classes here (page 80).

About Composite Classes

Composite Classes are classes that contain another class or classes. The Composite Class has al of
the attributes of any class or classesit contains to reduce the work involved in creating CIMPLICITY
objects.

Example of Composite Classes

In thisexample, aCIMPLICITY project named RESETPT.gef, there are three classes,
BufferTankArray, tank and VALVE.

The class named Valveisalow-level class. It has no composite members.

However, BufferTankArray, contains two composite classes. InletVale and OutletVale are both
defined with the Class ID of "tank." Therefore, they contain any attributes contained in the class
"Tank." Using composite classes, you only need to define the class "Tank™ once and then reuse it
over and over again when designing your project.

Note: Composite Classinherit just the attributes of the classes they refer to. They do not inherit
scripts, events or other features of they classes they refer to.

Character Limit and Composite Classes

The composite member name is used in the name of the points for dataitem in the class that get
created for each object instance, and thereisalimit of 256 characters for the fully realized pointl Ds.
To stay under the character limit, carefully consider the naming you use when creating composite
member names. For example, aclass that contains a composite member named FillValve, of class
valve, would create points with the following names (if the Valve class had data items FlowRate,
and VavePosition.)

<$ObjectID>.FillVave.FlowRate

<$0bjectID>.FillValve.ValvePosition
Composite Members Can Refer in Both Directions
Not only do container classes automatically have the values of classesthat it contains, you can have

composite member attributes use the values of the attributes of its container classes. When supplying
the value of a composite members attributes within the class definition, you can refer to the container
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attributes by using a syntax {..\<AttributeName>} . This syntax would refer to an attribute in the
immediate container class and {..\..\<AttributeName>} refersto an attribute two levels up in the
container hierarchy.

Export or Import a Class

Export or Import a Class

The power of the class becomes particularly apparent when you export a class from one project and
import it into another.

Optionsinclude:

Option
1 (page

81)

Export a class.

Option
2 (page
82)

Import a class.

Option 1. Export a Class
Y ou can export a point class.
Exported point class files:

* Havea .soc extension
+ Can be imported into other CIMPLICITY projects.

(1) Important: Any changes you make to a class within a project will not be reflected in an

exported class until it is re-exported.

1. Right-click a classin the Workbench right pane.
2. Select Export on the popup menu.

The Save As dialog box opens.

3. Select the folder in which the file should be saved.
4. Save thefile using the syntax:

<ClassName>. soc
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Example
The class TANKYV will be exported.
The export file nameis:

TANKYV.soc

5. Click Save.

CIMPLICITY gathers all the class components and includes them in the .soc file as follows:

Component Folder Retrieved from:

Class configuration | Classes

Scripts (.bcl) files Scripts

CimEdit (.cim) files | Screens

A class developer can import the classinto a different project and work with the class configuration.

Option 2. Import a Class

Y ou can import a class that has been exported to a .soc fileinto another CIMPLICITY project using
the class popup menu options.

1. Right-click the Classes icon in the Workbench left pane.
2. Select Import on the popup menu.

The Open dialog box opens.

3. Open an import (.soc) file asfollows.
4. Click Open.

The Workbench displays.

5. Press F5 to refresh the screen.

CIMPLICITY distributes the .soc file components as follows:

Component Folder Distributed to:

Class configuration | Classes

Scripts (.bcl) files Scripts
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CimEdit (.cim) files | Screens

A class developer can now modify the class to meet any different requirements for the project.

An object designer can immediately implement objects with associated CimEdit/CimView screens.

Class Object Configuration

About Class Objects

Class objects provide an easy way to do complex configuration for one or more objects that are
similar. Class objects, which are based on a Class template, can include pre-configured attributes,
points, events, actions and scripts.

When creating a class object, an object designer ssmply needs to specify the values that pertain to
that class object. Once specified, the class object’s features achieve full status withina CIMPLICITY
project.

For example, class object points behave as any other points with the same type of configuration; class
object events function the same as any other similar events.

1 | A class file (.soc file) can have several components, including CimEdit screens and developer created help.

2 | One or more objects can be created from the class.

3 | Objects include instantiated parts that are included in the class.

4 | One or more CimEdit screens can be created for each object.

Although class object features behave the same as their non-class counterparts, CIMPLICITY
makes it easy for the object designer (or any project designer) to locate features for any class object.
CIMPLICITY attaches the object name to the front of the feature name.

(1) Important: Before you can configure a class object, a class must be created (page 11). If
the class exists, but is not in the current project, you simply need to import (page 82) it into the
project.

Class Object Configuration
Class Object Configuration

Creating a class object is straight-forward. Because the object is based on a class template, most of
the configuration is aready done.
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Following are steps to configure one or more class objects.

Step 1 | Open an Object dialog box.

Step 2 | Assign values to the class object.

Display class object graphics in CimEdit/CimView

Step 4 | Add a class object to a project.

Step 1. Open an Object Dialog Box

Sep 1. Open an Object Dialog Box

|5/ Note: Classes can be created in the same project in which objects are made or imported (page
82) from other projects.

Option Create a new class object.

1.1 (page

Option Open an existing Object dialog box.

Option 1.1. Create a new Class Object

1. Select Project>0bjectsin the Workbench left pane.

2. Do one of the following.

A | Click File>New>Object on
the Workbench menu bar.

B | Click the New Object button
on the Workbench toolbar.

C | In the Workbench left pane:

Either

Double click Object.
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D a. In the Workbench right
pane.

a. Right-click anywhere.

b. Select New on the Popup
menu.

E | Press Ctrl+N on the keyboard.

A New Object dialog box opens when you use any method.

3. Right-click anywhere.
4. Select New on the Popup menu.

5. Fill inthefields as follows.

Field Description

Object A unique name for the new object. The Object ID:
ID « Can contain alphanumeric characters and underscores.
» Must begin with an alphabetic character
» Has a maximum length of 255 characters, which includes the following three components.
a. Object name.
b. . (separator).
c. Data item name.
The three components can total 255 characters, and the Object ID becomes the point name when the
object is instantiated. Example
a. An object ID is TANKO02
b. A data item name is FLOWLEFT
c. The separator is always .
d. The point name is TANKO2.FLOWLEFT.
TANKO2.FLOWLEFT is only 15 characters; therefore, it is a valid name.

Class ID | Class that are used as the template for the class object. (Optional) Click the buttons to do the
following.

Opens the Select a Class browser.

Displays a New/Edit/Browse pop-up menu.

6. Object name.
7. . (separator).

8. Dataitem name.
The three components can total 255 characters, and the Object ID becomes the point name when
the object is instantiated.Example

9. An object ID isTANKO02
10. A dataitem nameis FLOWLEFT
11. The separator is always .

12. The point name is TANKO2.FLOWLEFT.
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TANKO2.FLOWLEFT isonly 15 characters; therefore, it isavalid name.
13. Click OK.
The Object - <object name> dialog box opens for the new object.

Option 1.2. Open an Existing Object Dialog Box

1. Select Project>Objects in the Workbench |eft pane.
2. Select an object in the Workbench right pane.

3. Do one of the following.

A | Click Edit>Properties on the Workbench menu bar.

B | Click the Properties button on the Workbench toolbar.

C | In the Workbench left pane:
a. Right-click Object.
b. Select Properties on the Popup menu.

D | In the Workbench, double-click an object.

E | Press Alt+Enter on the keyboard.

4. Right-click Object.

5. Select Properties on the Popup menu.
Step 2. Assign Vauesto the Class Object

The type of information available to you depends on the attribute properties created for the class.

When you create a class object, an Object dialog box that reflects the class configuration opens. (The
object ID displaysin the dialog box'stitle bar.)

The class object adheres to specified requirements based on the class definitions. Y ou assign the
values of these requirements in the Object dialog box.

Customized class features that display in the dialog box can include:

Customized Feature | Description

Fields The fields that display and
whether or not they are write-
able come from the class
configuration.

Default Entries Any default entries in
fields come from the class
configuration.
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Tabs The Object dialog box displays.

Enter values in the Object dialog box fields that define the specific criteriafor the class object that is
being configured.

When appropriate, the Browse buttons that display throughout CIMPLICITY, display to aid you
search for the correct entries.

Option Browse Button that will display

Alarm Class

Resource

Device

Role

Point

User

Port

Step 3. Display Class Object Graphicsin CimEdit/CimView

1. Make sure the project is running.
2. Open a CimEdit screen.

The CimEdit screen can either be anew or existing screen.

3. Drag a class object onto the CimEdit screen.

The following happens.

A | The default graphic for the class displays.

B | CimEdit functionality (e.g. Ungroup, Open Group) is disabled.

Enter Class object Specifications

Limited changes can be assigned to the graphic object.
Right-click the CimEdit class object.

Popup Menu Options

The Graphic objects are listed on the Popup menu that included in the CimEdit screen that is
assigned (page 73) to the class.
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Select any listed object to replace the object that is currently selected.

Properties Dialog Box Options

4. Right-click the class object graphic.

5. Select Properties from the Popup menu.

The Properties - Class Object dialog box opens.

6. Select Class Object.

Class object options are as follows.

Option | Description

Project | Project with which the class object is associated.

Class Class that contains the CimEdit graphic (read-only).

ID

Object | Selected class object (read/write). The ID for any object in the class can be selected if you want to

ID associate the graphic with a different object from the one dragged onto the CimEdit screen.

=J Note: Click the Browse button to the right of the Object ID field to display a list of all of the objects

in the class.

Graphic | Selected class object graphic (read/write). Any graphic from the source CimEdit screen can be

Name selected if you want to use a class graphic that is different from the default.

Apply Important: Clicking Apply updates the $oBJECT variable to the new value. The $0oBJECT variable, which
was created during class object configuration (page 29), is read-only on the Variables tab in the
Class Object dialog box.

Result: The graphic will adhere to your specifications as follows:

7. During runtime the graphic will represent the values of the selected class object.

8. The graphic wills change to the graphic you selected, if it is different from the default, as soon
as you close the Properties - Class Object dialog box.

Step 4. Add a Class Object to a Project

When all of the required values have been assigned and any optional values to support your class
object, add the class object to your project.

* Click OK in the Object Properties dialog box.
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Result: CIMPLICITY takes the values you enter in the Object dialog box and applies them to the
appropriate featurein CIMPLICITY, e.g. points, alarms. Y ou can also do more specific configuration
throughout the Workbench.

(1) Important: You will not be able to complete atab's configuration until you fill in al of the
required fields. If you try, an error message openstelling you that a value for an attribute is required.
This message continues to display when you attempt to exit the dialog box until all required fields are
filled in.



Chapter 2. Logging and Archiving

Historian OPC Interface

About CIMPLICITY Integration with Historian

Historian enables you to archive data for historical retrieval.

CIMPLICITY provides a straightforward OPC interface that enables you to easily connect to
Historian to archive CIMPLICITY point data.

|= Note:

« Historian provides detailed documentation to configure and use Historian. This documentation
describes CIMPLICITY integration with Historian.
* Historian 3.1x and lower are not supported on Vista or Windows Server 2008.

Step Number Description

Step 1 (page Select Alarm and Event Archiver during Historian installation.
90)

Step 2 (page Enable the Historian OPC Interface.

91)

Step 3 (page Select points to be logged to Historian.

95)

Step 4 (page Open the Historian Administrator System Statistics window.
96)

Step 5 (page Review CIMPLICITY point (tag) details in Historian.

96)

Step 6 (page Display CIMPLICITY alarm data in Historian.

98)

Step 7 (page Set up Historian connections to collect data.

99)

Sep 1. Select Archive Features during Historian Installation

Make sure the following are selected during Historian installation.
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Note: If Historian is aready installed and these features were not included you can rerun Historian
installation to add them.

1. Run (or rerun) Historian installation.

2. Check Alarm and Event Archiver in the Install Shield Wizard Select Components window.

3. Continue Historian install ation.

4. Check CIMPLICITY.HMI.AE.Svr.1.

5. Continue with Historian installation.

The selected Historian archive features will enable Historian to store CIMPLICITY aarm and event

data.

Sep 2. Enable the Historian OPC Interface(s)

Step 2. Enable the Historian OPC Interface(s)

(1) Important: Make sure Historian isinstalled and accessible to the CIMPLICITY project.

Step 2.1
(page
91)

Select the Historian logging option(s).

Step 2.2
(page
92)

Define the Historian connection.

Step 2.1. Select the Historian Logging Option(s)

1. Open the CIMPLICITY project with data that will be sent to Historian.

2. Open the Project Propertiesdialog box.

3. Select the General tab.

4. Select either or both of the following.

A

Historian OPC A&E Interface CIMPLICITY:
* Logs alarm and event data to Historian through the OPC Alarm & Event server.
» Maps (page 200) fields in the ALARM_LOG and EVENT_LOG to be consistent with fields provided by
the OPC Alarm & Event server.
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B [ Historian OPC Interface CIMPLICITY
« Logs data to Historian through the CIMPLICITY OPC server.
» Maps (page 200) fields in the DATA_LOG to resolve differences in how data is identified between the
CIMPLICITY DATA_LOG and the real-time Collector.

Note: This enables the Historian OPC Interface for this project.

=l

A Historian tab displays in the Project Properties dialog box when you select either or both Historian
OPC options.

Step 2.2. Define the Historian Connection

1. Open the CIMPLICITY Workbench and select Pr oject from the menu bar.
2. Click Propertiesto open the Project Properties dialog per the example below.

NOTE: If you added Historian as part of your project setup, the Historian tab isvisible. If not,
you can select one or both of the Historian check boxes that appear in the list on the Gener al
tab.

If you select the Historian OPC | nter face check box, you enable the Historian Data
Server.

If you select the Historian OPC A & E Interface check box, you enable the Historian
Alarm Server.

3. Select the Historian tab and complete the fields as described below.

For the Historian data and alarm connections;

4. In the top section, enter the name of your Historian Data Server and in the bottom section,
enter the name of your Historian Alarm Server.

5. In each section, enter the Historian username and Historian password used to access your
Historian Data Server and Historian Alarm Server, respectively. If these are not entered
correctly, the logging will fail.

These entries are not always required; instances where an entry should be made include the
following:

» The Historian Server and users who log into that server are different from the
CIMPLICITY Server and user.

* A user who islogged into the Historian Server may not have al of the privileges required
to manage logging CIMPLICITY data. An entry in this field can specify a user with
administrator privileges.
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6. The CIMPLICITY username automatically populates from your project.

7. Enter the corresponding CIMPLICITY password. Note that privileges may differ between the
Historian user and the CIMPLICITY user.

8. Keep the default Tag name convention or identify a new one. For information, see the Tag
naming convention section.

9. Click Test to test your connection to the Historian server. One of the following messages
appears:

Test Result Message

The Historian server is incorrect or not available. Failed to connect to the Historian server.

Historian does not recognize the user name or The configured user does not have permission to write to
password. Historian.

Connection succeeds. Connected to the Historian server.

NOTE: when the Test button is clicked, global parameters (page 298) related to Historian
Server information (e.g. HISTDATASERVER (page 342), HISTDATAUSER (page 342),
HISTALMSERVER (page 341)) are created with appropriate values.

g. (Optional) Click Migrate Data to open the Historian Migration Utility (page 199)
and migrate datain SQL databases to Historian. The Historian Migration Utility is also
available through the CIMPLICITY Database Logger.

For the Historian Data Server only, select or clear the Overwrite check box to do the following.

» Select the check box to overwrite tag descriptions that already exist in Historian.
* Clear the check box to keep the tag descriptions that already exist in Historian.

IMPORTANT: You can revise (page 97) tag definitions, e.g. data type, in Historian.
However, if Overwrite is checked, the changes will be overwritten when the Historian log is
updated. However, collection (page 98) criteria are not overwritten.

Tag Naming Convention

An example of the current Historian tag name displays the Tag Name field. This naming
convention can be changed.

|=/ Note: If tags have previously been imported into Historian, changing the tag naming
convention will result in duplicate tags, tags with the old naming convention and tags with the
new naming convention.

Example
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The Historian tag name convention was changed for CIMPLICITY points that had been
previously imported into Historian. The same CIMPLICITY points are listed as two separate
tags in Historian.

Click the Open button to the right of the Tag Name field to change the displayed naming
convention.

The Historian Tag Naming Configuration dialog box opens and displays the following options:

Default The default Native Collector format is available to help Historian users who used the Native

Native Collector, which is not supported by CIMPLICITY v7.5 and higher. When Default Native Collector

Collector | Format is checked, Historian will use the Native Collector naming convention, which was

Format | <PROJECTNAME>. <POINTNAMES>. VALUE Where <PROJECTNAME> is the name of the CIMPLICITY
project that the point is in. <POINTNAME> is the CIMPLICITY point name. A read-only naming
convention preview displays for a sample point in the Tag Name field.

Default When Default OPC Collector Format is checked, Historian will use the OPC Collector format

OPC as the naming convention for migrating CIMPLICITY points. The OPC Collector format is:

Collector | <MACHINENAME>. \\ <PROJECT NAME>\ <POINTNAME>. VALUE Where <MACHINENAME> is

Format [ the Historian server. <PROJECTNAME> is the name of the CIMPLICITY project that the point is in.
<POINTNAME> is the CIMPLICITY point name. A read-only naming convention preview displays for a
sample point in the Tag Name field.

Custom | (Default) When Custom Format is checked the entire naming convention can be customized and

Format applied as the official Historian tag naming convention. The convention is divided into a prefix and
suffix, as follows.

Prgfixhe default Prefix text for a Historian tag name is <MACHINENAME>. \\ <PROJECTNAME> Where

<MACHINENAME> is the Historian server. <PROJECTNAME> is the name of the CIMPLICITY project
that the point is in.
|5 guide: Guidelines
» Text can be entered instead of or in addition to the <MACHINENAME> and <PROJECTNAME>
parameters.
Note: Click the Popup Menu button to the right of the Prefix field to select and automatically enter
either parameter.
* The following should not be included in the prefix.
* ? Spaces
« If the text in the Prefix field is empty then the prefix for the tag name will be the CIMPLICITY point
name only.
Example The following example describes how a Historian tag name is constructed when the Prefix
field is blank.
A Prefix Blank.

B Suffix .<PROJECTNAME>.<MACHINENAME>.VALUE Important: Include the . character where it
should be included in the Historian tag name.

C Point SAMPLEPOINT

D Tag Name SAMPLEPOINT.PROFCIMP.HISTSERV.VALUE Where the sample tag name parts are
as follows. SAMPLEPOINT PROFCIMP HISTSERV VALUE
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Syffithe default Suffix text for a Historian tag name is . VALUE.

|5 guide: Guidelines
» The parameters <MACHINENAME> and <PROJECTNAME> can be used in the suffix instead of
or in addition to being used in the prefix.

Note: Click the Popup Menu button to the right of the Prefix field to select and automatically enter
either parameter.

« The following should not be included in the suffix.
*? Spaces

« If the text in the Suffix field is empty then the suffix for the tag name will be the CIMPLICITY point

name only.

Example The following example describes how a Historian tag name is constructed when the Suffix
field is blank.
A Prefix VALUE. Important: Include the . character where it should be included in the Historian tag
name.

B Suffix Blank.
C Point SAMPLEPOINT

D Tag Name VALUE.SAMPLEPOINT Where the sample tag name parts are as follows: VALUE
SAMPLEPOINT

Sep 3. Select Points to be Logged to Historian

1. (If the project is running) make sure dynamic configuration is enabled.
2. Select Points in the Workbench left pane.

3. Select apoint that will be logged in the Workbench right pane.

4. Openthe point's Point Properties dialog box.

5. Select the General tab.

6. Check Log data.

7. Click OK.

8. (If the project is not running) do the following:
a. Do a Configuration Update.
b. Startthe project.

The selected point and/or point alarm will be logged to Historian, based on the Historian options
(page 91) that were selected.

(1) Important: If Database Logger: Pointsis checked on the General tab in the Project Properties
dialog box, point datawill be logged to both the Historian and the Database L ogger.
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Sep 4. Open the Historian Administrator System Satistics Window

1. Click Start on the Windows task bar.
2. Select (All) Programs>Proficy Historian>Historian Administrator.
Note: The location on your start menu may differ from this path.

The Historian Administrator System Statistics window opens.

» The Collector s box reports if the selected Historian OPC collectors are running.
* The Historian OPC Collectors are as follows.

A | Historian data server | <Historian OPC Collector Server Name>_ OPC_CIMPLICITY_HMI_OPCServer

B [ Historian alarm server | <Historian OPC Collector Server Name>_OPCAE_CIMPLICITY_HMI_AESvr_1

=] Note: The services status can be seen in the Microsoft Windows Services window.

A | Historian OPC Collector-_OPC_CIMPLICITY_HMI_OPCServer

B | Historian OPC Collector OPCAE_CIMPLICITY_HMI_AESvr_1

Sep 5. Review CIMPLICITY Point (Tag) Detailsin Historian
Step 5. Review CIMPLICITY Point (Tag) Detailsin Historian
|5 Note:

* CIMPLICITY points are referred to as tags in Historian.
» Theinitia value for tags (points) that are unsolicited is collected twice.

Step 5.1 | List CIMPLICITY tags in Historian

(page
96)

Step 5.2 | Display CIMPLICITY tag details that can be revised.
(page
97)

Step 5.1. Search the Historian Tag Database for CIMPLICITY Tags

1. Click Tags on the Historian menu bar.
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The Tags Maintenance window opens.

2. Click Search Historian Tag Database.

A Search Historian Tag Database dialog box opens.

3. Select <Server Name> OPC Cl MPLI CI TY_HM _OPCSer ver inthe Collector field.

Note: Consult Historian documentation for details about the fields in the Search Historian Tag
Database dialog box.

The CIMPLICITY tagsthat fulfill the criteria are listed in the Tags box.

Step 5.2. Display CIMPLICITY Tag Details that can be Revised

The following tag configuration was entered for the CIMPLICITY point entered by Historian
migration to accommodate differences in data definitions between CIMPLICITY and Historian.
The details can be changed in Historian. However, if Overwrite is checked on the Historian tab in
the CIMPLICITY Project Properties dialog box, when the OPC Server detects these tags as new
(e.0. CIMPLICITY and Historian are stopped and started) and changes will be overwritten with the
CIMPLICITY data.

rect 229, 102, 251, 124 (page 98)
rect 196, 102, 218, 124 (page 98)
rect 0, 108, 22, 130 (page 97)

A Tag list
(page
97)

B General tab

(page
98)

C Collection tab
(page
98)

A | Tag list

» Tagsthat fulfill search criteriaare listed in the Tag Maintenance window T ags box.
* Tag names for tags that came from CIMPLICITY points display as follows.

<OPC Server name >\\<CIMPLICITY project name>\<Point name>.<POINT VALUE>

* Select atag to display its details on the Tag Maintenance window tabs.
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General tab

The following field on the General tab can be revised in Historian

Field

Default Entry/Action

Description

Entry in the Description field in the CIMPLICITY Point Properties dialog box.

Update

Updates tag details in Historian when clicked.

Collection tab

The following fields on the Collection tab can be revised in Historian.

Field Default Entry/Action
1 | Data Type Historian tag data type that provides a long enough field to accommodate its corresponding (page
103) CIMPLICITY point data type.
2 | Collection Options are:
Type
+ Unsolicited.
* Polled.
3 | Collection Options for an entered number are:
Interval
+ Milliseconds
» Seconds
* Minutes
* Hours.
4 | Update Updates tag details in Historian when clicked.

|5/ Note: The Historian OPC data collector uses the Historian Collector default settings as the
collection defaults. Y ou can change the settings for a selected tag. If you change the Historian
Collector default settings, the new defaults will apply to new tags. They will not overwrite your
customized settings for selected tags.

Sep 6. Display CIMPLICITY Alarm Data in Historian

Click Collectors on the Historian menu bar.

The Collector Maintenance window displays.

rect O, 106, 23, 128 (page 99)
rect 207, 91, 237, 123 (page 99)
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1 Collector list
(page

99)

2 Configuration tab
(page

99)

1 | Collector list

» Collectors that are available for Historian are listed in the Collector M aintenance window
Collector s box.
+ Collector names display asfollows.
<Alarm & Event OPC Server name >\\<Collector name>

* Select the <server name> OPCAE_CIMPLICITY_HMI_AESvr_1.

2 | Configuration tab

Thelast 10 CIMPLICITY alarms and events can be displayed through the Configuration tab.

Feature Description

A | OPC Server PROGID | The CIMPLICITY.HMI.AE.Svr.1 was installed (page 90)
with Historian.

B | Show Last Alarms Opens a Show Alarms/Events window when clicked.

A Show Alarms/Events window lists details about the last 10 CIMPLICITY aarms and events.

=) Note: Review Historian documentation for more detail s about the Historian Collectors

=

Maintenance Configuration tab.

Sep 7. Set up Historian Connections to Collect Data

Valid Historian connections that are listed on the Historian Connections tab can pull selected data
from Historian and display it in CIMPLICITY applications.

A Open Add Historian Connections or Edit Histoian Connections dialog boxes.

gpage
100)

B Add, edit, remove Historian connections.
(page
101)

Connection Guidelines.
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1. Open Add Historian Connections or Edit Histoian Connections dialog boxes

Dialog boxes that enable you to add, edit and/or remove Historian connections (to pull data from
Historian), can be opened, as follows.

« Historian Connections dialog box.
« Historian Connections Tab in the CIMPLICITY Options dialog box

Historian Connections Dialog Box

1. Open a Select a Tag browser anywhere that Historian tags can be selected and used in
CIMPLICITY, e.g. an Expression field in CimEdit.

An Historian Connections dialog box opens, displaying the list of Historian server/connections.

Note: The Historian Connections dialog box offers the same functionality as the the Historian
Connectionstab in the CIMPLICITY Options dialog box.

2. Add, Edit or remove connections, as follows.

rect 312, 251, 334, 273 (page 102)
rect 236, 254, 258, 276 (page 102)
rect 153, 255, 175, 277 (page 101)

A Add button

(page
101)

B Edit button
(page
102)

C Remove button
(page
102)

Historian Connections Tab in the CIMPLICITY Options Dialog Box

3. Open the CIMPLICITY Optionsdialog box.
4. Select the Historian Connections tab.

Note: The Historian Connections tab offers the same functionality as the the Historian
Connections dialog box.

5. Add, Edit or remove connections, as follows.
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rect 247, 258, 269, 280 (page 102)
rect 176, 258, 198, 280 (page 102)
rect 109, 258, 131, 280 (page 101)

A Add button

(page
101)

B Edit button
(page
102)

C Remove button
(page
102)

a. Add, Edit, Remove Historian Connections

Buttons in the Historian Connections dialog box or on the Historian Connections tab in the
CIMPLICITY® Options dialog box open the following dialog boxes to add, edit and/or remove
Historian connections.

A | Add button

The Add button enables you to add a server/connection to the Historian Connections list. During
runtime, CIMPLICITY can pull data from Historian tags in applications and fields that use and
display Historian tag values.

Click Add.
A blank Add Historian Connection dialog box opens.

Entries to define the Historian connections are as follows.

Field Description

Connection Name An alias that will make the connection easy to recognize.

Server Name Name of Historian server.

Description Additional detail to help identify the Historian connection.

Specify Username/ Check to enable the Username and Password fields.

Password

Username Username that has access to the Historian Administrator.

Password Valid password for the entered user. Note: A valid password is required to connect if a
user name is entered.

Buttons OK Closes the dialog box; adds the connection/server to the list.
Cancel Cancels the addition.
Test Tests the connection to the Historian server.
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B | Edit button

Specifications for any connection can be edited.
a. Select the connection in the list to be edited; click Edit.

An Edit Historian Connection dialog box opens.

a. Make any required change.
b. Click OK.

The Edit Historian Connection dialog box closes; the edited connection/server replaces the origina
connection/server in the Historian Connections list.

C | Remove button

Any connection/server can be removed from the Historian Connection list.

1. Select a connection
2. Click Remove.

The connection is removed from the list; this connection will no longer be listed or be available when
auser selects the connection/server that will supply Historian tag data for afeature, e.g. Historian
Trend line.

Connection Guidelines

» The default Historian server is selected as follows.

Machine | Default Server is selected:

Server Historian Administrator.

Viewer | During the Historian Client installation. Note: Historian Client can be installed during installation of the
CIMPLICITY viewer.

* The Historian connection file:

* Isnamed histmgr_connection_config.xml.

* Islocated in the ...\CIMPLICITY \data directory.
* Is stored at the computer level.

» Must beidentical on the server and the viewer.

Q Tip: histmgr_connection_config.xml can be included in CIMPLICITY deployment (page
249) to insure that it isidentical on the server and viewer.
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Technical Reference: Historian Integration

Technical Reference: Historian Integration

* CIMPLICITY datafiles location in Historian.
* CIMPLICITY datatypes vs. Historian data types.
* CIMPLICITY tags selected for collection.

CIMPLICITY DataFiles Location in Historian

« Historian data location.
« Historian activity logs.
« Historian archives.

Historian Data Location
Historian datais located in the c:\Proficy Historian Datafolder.
Historian activity logs

The Historian logs activity for the Conput er Name_OPC_ connection in the Historian>L ogFiles.

A | OpcAECollector_<server name>_OPCAE_CIMPLICITY_HMI_AESvr_<n>.shw

B | OPCCollector_<server name>_ OPC_CIMPLICITY_HMI_OPCServer-<n>.shw

Historian archives

1. Open Microsoft Explorer.
2. Select C:\Program Files\Proficy\Historian\Archives.

Note: Thisisthe default path for Historian archives. The path to Historian in your system may
be different.

When CIMPLICITY points are selected for data collection, Historian stores the datain
Historian>Archives.

|=/ Note: Consult your Historian documentation for details about reviewing the data

CIMPLICITY Data Typesvs. Historian Data Types
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CIMPLICITY ensures that the data type in Historian is long enough to accommodate the

CIMPLICITY datatype length.

Datatype mapping is as follows.

Data Type | CIMPLICITY | Historian
Integer DINT Double integer
INT Double integer
REAL Double float
SINT Double integer
UDINT Double float
UINT Double integer
USINT Double integer
Boolean BOOL Integer
BYTE Double integer
DWORD Double integer
WORD Double integer
Text STRING Variable string
STRING_20 | Variable string
STRING_8 [ Variable string
STRING_80 [ Variable string

1> CAUTION: You can change the data type in Historian. However, if you checked Overwrite on
the Historian tab in the CIMPLICITY Project Properties dialog box,

CIMPLICITY Tags Selected for Collection

CIMPLICITY Tags Sdected for Collection

Historian provides options for selecting CIMPLICITY tags for collection.

Optionsinclude:

Single CIMPLICITY tag for collection.

Several CIMPLICITY tags for collection.

Sngle CIMPLICITY Tag for Collection
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Tags that have not already been added to the Historian Collector can be added manually.

(1) Important: One project has to be running for the Collector to be available; then all the projects
connected to the OPC_Collector will be listed even if they are not running.

1 Open the Add Tag Manually dialog box.
(page

105)

2 Add a tag manually.

(page

105)

Open the Add Tag Manually dialog box

Click Add Tag Manually in the Historian Tag Maintenance window.

Result: The Add Tag Manually dialog box opens.

Add a tag manually.
Enter the following specifications.

rect 88, 193, 118, 216 (page 107)
rect 4, 159, 27, 182 (page 107)
rect 4, 131, 27, 154 (page 107)
rect 4, 105, 27, 128 (page 106)
rect 4, 82, 27, 105 (page 106)
rect 4, 56, 27, 79 (page 106)

rect 4, 30, 27, 53 (page 106)

A Collector Name.

B Source Address.

Tag Name.

D Data type.

Data Length.
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F Time Resolution.
(page

107)

G OK.

(page

107

A | Collector Name

Select <Server Name>_OPC_CIMPLICITY_HMI_OPCServer.

Example

A project named PROFCIMPj has the Historian OPC Interface enabled.

The project's collector displaysin Historian as PROFSERVER_OPC_Cl MPLI Cl TY_HM _OPCSer ver .

B

Source Address

The Browse button to the right of Source Address opens the Browse for Source Tag window.

Do the following.

1| Show Select Source Tags Not Collected.
Only
2 | Show All (Optional) Check to show all tags listed under a selected folder, including points in subfolders.
Children
3 | Auto Check to display tagnames in the right-pane that are associated with the selected folder in the left-
Browse pane.
4 | Browse Displays the number of tags associated with a selected folder.
Results
|5 Note: If Source Tags not Collected are the only tags that should display, the browse result will be
0 if all tags for a selected folder are already being collected.
5| Tag Selected folder displays its tags in the Browse for Source Tag dialog box right-pane.
Folder
6 | Tagname | Select the tag that should be added to Historian collection. Note: Listed tagname(s) are associated
with the listed folder.
7| OK Click OK to close the Browse for Source Tag dialog box.

Result: The selected tag displaysin the Add Tag Manually dialog box.

C

Tag Name

Tag selected in Browse for Source Tag dialog boxdisplays.

D

Data Type
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Automaticaly filled in.

E | Data Length

Automatically filled in.

F | Time Resolution

Automatically filled in.

G | OK

Click OK to close the Add Tag Manually dialog box.

Result: The selected unique tag is added to the Porficy Historian Administrator Tags box.
Historian will now collect the tag's values from CIMPLICITY .

|5/ Note: Consult the Historian documentation for more information about configuring the
Historian.

Several CIMPLICITY Tags for Collection

Tags that have not already been added to the Historian Collector can be added from the Collector.

(1) Important: One project has to be running for the Collector to be available; then all the projects
connected to the OPC_Collector will be listed even if they are not running.

1. Open the Add Multiple Tags from Collector dialog box.
Do one of the following.

* Click Add Tag From Collector in the Historian Tag Maintenance window.

» Click Collectorsin the Historian Administrator; do the following.

A | Select the collector that is collecting the required tag values.

B | Click Add Tags.

Result: The Add Multiple Tags from Collector window opens.

1. Select tags from the collector.
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Select the following.

1 | Collector (Based on how the Add Multiple Tags from Collector dialog box was opened) select a collector if the
correct collector is not already selected.

2 | Show Select Source Tags Not Collected.
Only

3 | Show All (Optional) Check to show all tags listed under a selected folder, including points in subfolders.
Children

4 | Auto Check to display tagnames in the right-pane that are associated with the selected folder in the left-
Browse pane.

5 | Browse Displays the number of tags associated with a selected folder.
Results

|5 Note: If Source Tags not Collected are the only tags that should display, the browse result will be
0 if all tags for a selected folder are already being collected.

6 | Tag Selected folder displays its tags in the Browse for Source Tag dialog box right-pane.
Folder

7 | Tagname | Select the tag that should be added to Historian collection. Note: Listed tagname(s) are associated
with the listed folder.

8 | OK Click OK to close the Add Multiple Tags From Collector dialog box.

Result: The Historian Tag Maintenance window displays the selected tags; Historian will now collect
the selected tags values from CIMPLICITY.

Result: The CIMPLICITY Historian OPC Interface enables collection of datafor the selected points.

|5/ Note: Consult the Historian documentation for more information about configuring the
Historian.

Database Logger Configuration

About the Database Logger

The CIMPLICITY Database Logger provides you with a seamless way to analyze your system
processes and equipment performance by logging data to and reporting data from a wide variety of
ODBC (Open Database Connectivity)-compliant databases.

The configuration is straightforward. Y ou do not need to know about SQL or other ODBC database
internals to configure Database L ogger logging tables.
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Overview of the Database L ogger Functionality

In the Database L ogger you easily:

» Use existing tables or create new tables that will log selected items for any one of the processes.
« Enter specifications for how, when and to what ODBC data source you want to log data.

When you start the project in which you configured the Database L ogger, the Database L ogger
creates tables you configured based on the attributes you specified.

» When a project starts, the Database L ogger:

* Creates or repair any missing or damaged databases.
» Creates any missing tables.

« Creates any missing columnsin the tables.

Creating areport is also straightforward. CIMPLICITY provides sample reports that you usein
Excel. You can use these sample reports to quickly generate areport or as a basisto create new
reports.

The Database Logger option uses the standard ODBC interface to log your production data.

Refer to the Readme file that accompanies thisrelease for alist of supported database interfaces.
Database Logger Configuration Overview

Database Logger Configuration Overview

Database Logger configuration is straightforward. The following list provides alogical order for
reviewing the details when you are learning how to configure one or more log tables.

Database Logger configuration includes:

Hardware and database logger performance.
age
10

Start Database Logger configuration.

HER

a
111)

Database Logger configuration hierarchy review.

Review available Database Logger file management functions.

| s
) S
D [¢]

[N
[N
©
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5 Configure Database Logger defaults.
(page
130
6 Configure any or all of the following database logs:
A (page 140) Points.
B (page 162) Group of points.
C (page 170) Alarms.
D (page 182) Event alarms.
E (page 189) Event Management.
F (page 198) External applications.
7 Historian migration.
(page
199)

Hardware and Database Logger Performance

On a400 MHz Pentium Il with 200 MB memory

SQL For Database Logging Peaks at Around
Server
On- 265 writes per second (2 field writes)
node
Off- 100 writes per second (2 field writes). However, off-node is dependent on your network configuration as well.
node
Table Write Definition
Type
DATA One point being logged. If you have 20 points, you are doing 20 independent writes (when is configurable
individually for each point). The size of each write (humber of fields) depends on how many attributes you are
logging. Fields include:
« 1 for timestamp
« 1 for the point ID
» Anything else you are logging (e.g., value, engineering units).
The more attributes you have, the slower the writes will be.
GROUP | Is based on your table's logging conditions. The number of points and the attributes being logged

(configurable independently for each point) determine how big the writes will be (how many fields there will
be). Fields include:

« 1 for the timestamp
» Anything else you are logging.

Example If you are logging the value of two points, your group log table will have 3 fields, timestamp and two
fields for the points' values.
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Bulk Insertion Peak Performance

CIMPLICITY Database Logger using bulk Avg. bytes/ Approx. Writes/ Approx. Total throughput/
insertion. write sec sec

On-node 28 900-1000 25-30Kb

Off-Node 28 700-800 20-25Kb

1) Important: (For SQL Server) insert triggersfire only if bulk insertion is disabled.

Start Database L ogger Configuration

Sart Database Logger Configuration

Step 1 | Enable Database Logger options.
(page
111)

Step 2 | Open the Database Logger window.
(page
111)

Sep 1. Enable Database Logger Options

1. Do one of the following.
* Click Project>Properties on the Workbench menu bar.
* Click the Project Properties button on the Workbench toolbar.

The Project Properties dialog box opens.

2. Select the Generd tab.

3. Check the Database L ogger options that your system will use.

Option Enables

A | Database Logger: A&E & App | ALARM_LOG EVENT_LOG EM_LOG Selected application tables

B | Database Logger: Points POINT_LOG Existing GROUP_LOG tables

4. Click OK.

The logging tables for the selected options will be available for logging selected data.

Sep 2. Open the Database Logger Window

1. Select Project>Database L ogger in the Workbench left pane.
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2. Select Database L ogger in the right pane.

3. Do one of the following.

A | Click Edit>Properties on the Workbench menu bar.

B | Click the Properties button on the Workbench toolbar.

C | In the Workbench left pane:

Either Or

Double click Database Logger. a. Right-click Database Logger.
b. Select Properties on the Popup menu.

D | In the Workbench right pane:

Either Or

Double click Database Logger. a. Right-click Database Logger.
b. Select Properties on the Popup menu.

E | Press Alt+Enter on the keyboard.

4. Right-click Database L ogger .
5. Select Properties on the Popup menu.
6. Right-click Database L ogger .

7. Select Properties on the Popup menu.

Database Logger Configuration Hierarchy

Database Logger Configuration Hierarchy

When you open the Database L ogger Configuration window, you see alist of the currently
configured point data and group tables as well asthe Alarm Log and Event L og tables.

rect -2, 64, 105, 91 (page 112)
rect -2, 120, 130, 138 (page 113)
rect -2, 136, 130, 154 (page 113)
rect -2, 152, 130, 170 (page 113)
rect -2, 168, 105, 186 (page 113)
rect -2, 89, 105, 120 (page 113)

Theicon to the left of each table indicates its type as follows:

* | lcon Table Log

A | Alarm Logging (page 170) ALARM_LOG Selected alarms that appear in the Alarm Viewer.
(page 170)




Advanced Features | 2 - Logging and Archiving | 113

P | Point Data Logging (page Data (page 140) Selected point values individually.
140)
A | Event Management EM_LOG (page Event Manager activities.
Logging (page 189) 189)
A | Event Alarm Logging (page | EVENT_LOG Selected system alarms that do not appear in the Alarm
182) (page 182) Viewer.
A | Application Logging (page External Actions in certain CIMPLICITY applications, e.g., Tracker.
198) application (page
198)
P | Group Point Logging (page | Group (page Selected point values in parallel.
162) 162)

* |ndicates the option checked in the Project Properties dialog box, as follows.

A

Database Logger: A&E & App

P

Database Logger: Points

In order to configure how, when and where logs will collect and report data you can start at the
Database Logger level to specify certain properties and become more specific in your configuration
asfollows:

Level

BE

13

Configure Database Logger defaults that apply to all tables in the Database Logger.

2

Level

(page
114)

Configure Table defaults that apply to a selected table in the Database Logger. Override selected Database
Logger defaults, if necessary.

3

Level

(page
114)

Configure Item logging conditions for selected items. These conditions override a table default, if necessary.

When you complete your configuration to can easily create areport for reviewing logged data.

Level 1 Configuration—Database Logger Defaults

Configuration

Create Database Logger defaults for all the tables, including:

Several basic parameters.

Data logging sources for alarm and point logs. Note: The tabs in the dialog box display based on
4 what options were check in the Project Properties dialog box.

Tab

Option Checked
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Default Alarm Connection Database Logger: A&E & App

Default Point Connection Database Logger: Points

Configuration
Tool

Logging Properties dialog box.

Level 2 Configuration—Database Logger Table

Configuration

Configure and create defaults for individual tables including:

« Default logging conditions,
« Logging attributes,

« Connection,

» Maintenance events,

« Maintenance actions and
» Advanced specifications.

Note: The specific configuration depends on the process being configured. Table defaults can override
Database Logger defaults.

Configuration
Tool

Table Properties dialog box.

Level 3 Configuration—=ltemin a Database Logger Table

Configuration

Enter logging conditions that are different from the table defaults for individual items in the table.

Configuration Tool | Item's Properties dialog box.

Result: When configuration for any table is completed you can open Excel and generate reports from
the samplesthat are included in CIMPLICITY or create your own reports.

Note: The Event Manager Log (EM_LOG) and logs for external applications require new reports.

Log Reports included with CIMPLICITY

Configuration

Create reports to display the data logged as a result of configuration in the Database Logger.

Configuration Tool | Reports created on site or Excel reports supplied with CIMPLICITY that report:

Alarms Alarms reported in the Alarm Viewer or other alarms.
Data Points logged individually.
Trends Points logged in parallel.

Logging Table Columns Guidelines

L=

guide: Guidelinesfor logging table columnsinclude:

* A table can have, at most, 250 columns. The number of columns you can actually havein a
group table depends on the type of datayou are storing.
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* A record being added to the database can have at most 2 KB of data.

With overhead, 2 KB amounts to approximately 222 8-byte floating-point numbers. (Points with
Engineering Units conversion are stored in floating point format.)

If you are storing a number of floating-point numbers or long text strings in agroup record, it is
recommended that you verify that the 2-KB limit is not being exceeded.

Review Log Table Configuration

Review configuration for CIMPLICITY :

« Alarm Logging (page 170) (ALARM_LOG)

« Status Log Logging (page 194) (COR_LOG)

+ Point Data L ogging (page 140) (Data L og)

 Event Management L ogging (page 189) (EM_LOG)

+ Event Alarm Logging (page 182) (EVENT_LOG)

« Group Poaint L ogging (page 162) (Group log)

« Application Logging (page 198) (An external application log)

Review Advanced Configuration

Review configuration for CIMPLICITY :

* ALARM-LOG. See Step 3.7. Do Advanced Alarm Logging Configuration (page 180).
* COR_LOG. See Step 2.5. Perform advanced COR_L OG Configuration (page 197).

» DatalLog. See Step 2.7. Do advanced L ogging Configuration (page 160).

* EM_LOG. See Step 2.6. Do advanced EM_L OG Configuration (page 194).

* EVENT_LOG. See Step 3.6. Advanced Event Logging Configuration (page 188).

» Group Log. See Step 2.7. Do Advanced Group L og Configuration (page 169).

» An externa application log. See Application Logging (page 198).

Automatic Report Configuration

Automatic Report Printing Configuration

(1) Important: You can only use the automatic report printing capability with Microsoft Access
(As-Is product) and SQL Server databases.

Y ou can use OLE automation from CIMPLICITY scriptsto trigger the running and printing of
reports from Microsoft Excel spreadsheets that you have configured to produce reports

The CIMPLICITY script may be:

* Triggered by Database Logger Maintenance Events, or
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* Triggered by any event in the Event Manager, or
« Attached to an object a user can trigger on a CimView screen.

The steps to implement automatic report printing include:

Step 1 | Configure the CIMPLICITY Service to access a printer.

Step 2 | Create a script to generate the report and print it.

Step 3 | Create an event to trigger the script.

Sep 1. Configure the CIMPLICITY Service to Access a Printer

1. Open the Windows Services window.
2. Double-click the CIMPLICITY HMI Service.

The CIMPLICITY Service Properties dialog box opens.

3. Choose one of the following options to continue:

For systems with single users:

a. Click This Account in the Service dialog box, under Log On As.
b. Select aCIMPLICITY user account.
c. Enter the correct password and confirm it, if the account requires a password.

Note: If no oneislogged in to the account you select here, when the script executes, no printers
will be available. The report will be generated, but it will not be printed.

For systems with multiple users:

a. Click System Account in the Service dialog box, under Log On As.
b. Check the Allow Serviceto I nteract with Desktop check box.

4. Click OK to accept your changes and close the Service dialog box.
5. Click OK to close the Services dialog box.

6. Close the Control Pandl.

Service access is configured according to your specifications.

Sep 2. Create a Script to Generate the Report and Print it
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1. Expand the Basic Control Engine folder in the CIMPLICITY Workbench left pane.
2. Double-click Scripts.

The CIMPLICITY Program Editor opens.

3. Create the script to run the report and print it.

Y ou can use the sampl e script below as atemplate.

4. Compile the script and create an executable.

|=/ Note: The following script opens the SQL AL ARM .xls spreadsheet, generates areport, and
printsit. You can useit as atemplate for creating your own scripts:

Sub Main ()
This section sets REPORT _TRI GGER back to 0 so that the script
doesn't continue to run
This is not needed if the report is triggered directly froma
Ci nVi ew screen or by a
TI MED event in the Database Logger or Event Manager

Dim PT As New poi nt

PT.id = "\\ PROUECT\ REPORT_TRI GCER"

PT.value = 0

PT. set

The code fromthis point on is for printing.

Thi s exanpl e uses one of the existing Excel spreadsheets for
extracting and printing

the data fromthe cinpl og. ndb al arm dat abase

You will need to custom ze this code so that it prints what you
need. It is also

possible in sone applications to run a specific macro fromthe
command | i ne.

You can then use the SHELL command.

Di m Excel As Obj ect
Set Excel = Create(bject ("Excel.Application")

Open the wor kbook for alarmreporting
Excel . appli cati on. wor kbooks. open "C:.\ Cl MPI Cl TY\ REPORT\ SQLALARM XLS"
Excel . appli cati on. wor kbooks(" SQLALARM XLS"). acti vate

Run the macro to get the data
Excel . applicati on. Run "SQ.ALARM XLS! Gener at eReport"

Print the data
Excel . appl i cati on. wor kbooks(" SQLALARM XLS") . wor ksheet s("Data"). acti vate



Advanced Features | 2 - Logging and Archiving | 118

Excel . appli cati on. wor kbooks(" SQLALARM XLS") . acti vesheet. pri nt out

Quit wthout saving the data
Excel . appli cati on. wor kbooks (" SQLALARM XLS") . saved = TRUE
Excel . application. quit
End Sub

Sep 3. Create an Event to Trigger an Automatic Report

Sep 3. Create an Event to Trigger an Automatic Report

There are many ways to trigger a script to run and print a report from Database L ogger tables.

Following are two options.

Option Use the Database Logger Maintenance Actions.

3.1 (page
118)

Option Use the Event Manger.

3.2 (page
118)

Option 3.1. Use the Database Logger Maintenance Actions

1. Open (page 111) the Database Logger in the project's Workbench.

2. Open the Table Properties dialog box for the table whose report will be printed.
3. Select the Maintenance Events tab for the table.

4. Specify the event(s) you want to trigger the script.

5. Select the Maintenance Actions tab for the table.

6. Check Run program.

7. Enter the fill path and name of the executable you created from the script.

8. Click OK.

The Database Logger saves your changes and closes the Table Properties dialog box.

The report automatically generates and prints whenever any of the maintenance events you specified
occur.

Option 3.2. Use the Event Manager
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« Trigger areport automatically from an event
« Allow usersto trigger areport from a CimView screen

Trigger areport automatically from an event

1. Openthe Event Editor in the project's Workbench.
2. Create any event you wish to trigger the report.
3. Create an action for this event to run the script.
Result: The report automatically generates and prints whenever the event occurs.

Allow usersto trigger areport from a CimView screen

4. Open a screen in CimEdit.

5. Select or create the object you want to trigger the report.
6. Display the object's property sheets.

7. On the Script tab, click Edit.

8. In the Edit Script window, enter a script that will trigger the report. Y ou can generate the report
directly, or trigger an event that invokes an action that generates the report.

9. Close the Edit Script window.
10. Display the Events tab.
11. Create anew event and assign it a new procedure.

12. In the Procedure Information dialog box, create an Invoke Script action and specify the script
you created.

13. Click OK to save the new procedure information.

14. Click OK to save the object's properties.

When a user executes the event you configured, the report automatically generates and prints.

Database Logger File Management Functions

Database Logger File Management Functions
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The Database Logger window provides you with the ability to carry out several file management
functions to manage CIMPLICITY tables, including:

Create a new logging table.
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Open an existing logging table.

Copy an existing logging table to a new logging table.
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Rename a logging table.

Delete a logging table.

Filter table lists.

Activate dynamic configuration.
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Reconcile a CIMPLICITY table with a logging database.
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Close a logging table.
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Exit the Database Logger Configuration window.

oo

=

=
o)

1. Create anew Logging Table

|5/ Note: Thelogging tables that are available and that can be created depend on the options you
selected in the Project Properties (page 111) dialog box.

Y ou can create as many new CIMPLICITY data, group or applications tables as you need.

1. Do one of the following:

A | Click File>New Table on the Database Logger Configuration window menu bar.

B | Click the New Table button on the Database Logger Configuration window toolbar.
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C | Press Ctrl+N on the keyboard.

D a. Right-click any icon in the Database Logger Configuration window's list.
b. Select New... on the Popup menu.

The New Table dialog box opens when you use any method.

2. Right-click any icon in the Database L ogger Configuration window's list.
3. Select New... on the Popup menu.
4. Enter and select the following.

|5/ Note: Tabletypes are enabled based on the Database L ogger options selected in the Project
Properties (page 111) dialog box.

Option Description

Table identifier [ Name for the table The name:
field + Can contain

« Alphanumeric characters (A through Z, 0 through 9) and

» Underscores (_).

+ Should be no longer than 16 characters.
If you enter more than 16 characters, the name will automatically be truncated to the first 16
characters when you click OK.

» Cannot be the name of a currently existing table.

« Should not use any words that are reserved for the database management system being

used.

Example If you are using a SQL Server, do not use BULK, which is a reserved word for that
DBMS.

Radio buttons | Check the type of table to create in the Table type box.

5. Click OK.

A Table Properties dialog box opens for you to configure the new table.

(1) Important: You can only create new group, data and application log tables, when the
appropriate Database L ogger options are enabled in the Project Properties (page 111) dialog box.

When the Database Logger: A& E & App option is enabled, only one alarm table (ALARM_LOG),
event table (EVENT_LOG) and Event Manager (EM_L OG) table exist in the Data Logger. Y ou
cannot delete these tables, and you cannot create additional Alarm, Event or Event Manager tables.
When the option is not enabled, these tables are not available.

2. Open an Existing Logging Table

1. Select the logging table in the Database Logger Configuration window.

2. Do one of the following.
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A | Click File>Open on the Database Logger Configuration window menu bar.

B | Click the Open Table button on the Database Logger Configuration window toolbar.

C a. Right-click the selected table.
b. Select Open on the Popup menu.

D | Press Ctrl+O on the keyboard.

3. Right-click the selected table.

4. Select Open on the Popup menu.
3. Copy an Existing Logging Table to a New Logging Table

The following log tables can/cannot be copied.

Can be copied
* CIMPLICITY data logs
* CIMPLICITY group logs

Cannot be copied
* ALARM_LOG

« EM_LOG

« EVENT_LOG

» External application log

1. Select the logging table you want to copy.

2. o one of the following.

A | Click File>Copy Table on the Database Logger Configuration window menu bar.

B | Click the Copy Table button on the Database Logger Configuration window toolbar.

C a. Right-click the selected table.
b. Select Copy on the Popup menu.

D | Press Ctrl+C on the keyboard.

A Copy table dialog box opens.

3. Right-click the selected table.
4. Select Copy on the Popup menu.
5. Enter the name of the new table in the New table I D field.

6. Click OK.
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4. Rename aLogging Table

The following log tables can/cannot be renamed.

Can be renamed

* CIMPLICITY data logs
» CIMPLICITY group logs

Cannot be renamed
+ ALARM_LOG

« EM_LOG

- EVENT_LOG

» External application log

1. Select the logging table you want to rename.

2. Do one of the following.

A | Click File>Rename Table on the Database Logger Configuration window menu bar.

B a. Right-click the selected table.
b. Select Rename on the Popup menu.

C | Press Ctrl+R on the keyboard.

A Rename table dialog box appears.

3. Right-click the selected table.
4. Select Rename on the Popup menu.
5. Enter the new name for the table in the New table ID field.

6. Click OK.

5. Delete aLogging Table

The following log tables can/cannot be del eted.

Can be deleted
* CIMPLICITY data logs

* CIMPLICITY group logs
« External application log
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Cannot be deleted
« ALARM_LOG
- EM_LOG
« EVENT_LOG

1. Select the logging table you want to delete.

2. Do one of the following.

A | Click File>Delete Table on the Database Logger Configuration window menu bar.

B | Click the Delete Table button on the Database Logger Configuration.

C a. Right-click the selected table.
b. Select Delete on the Popup menu.

D | Press Delete on the keyboard.

A message opens to inform you of the number of itemsin the table and confirm deletion.

3. Right-click the selected table.
4. Select Delete on the Popup menu.

5. Click OK.

6. Filter Log Table Lists

* Definefilter.
» Wildcard guidelines.

Definefilter

1. Do one of the following in the Database Logger Configuration window or any open table.

A | Click View>Filter... on the Database Logger Configuration window menu bar.

B | Click the Filter button on the Database Logger Configuration window or a table's toolbar.

A Filter <Type> dialog box opens.
Where

<Type> depends on the table or window in which the filter operation is being used.

2. Enter filter specifications based in the associated dialog box as follows.
« Database L ogger Configuration window.
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A Filter Tables dialog box opens.

Enter the following.

Field Description

Table Identifier | Full or partial table ID. Use the ? and * wildcards to perform partial string searches.

Table Type Options are:

* ALARM

* ALL

« DATA

* EXTERNAL

* GROUP

« Data log or group log table

« Datalog or group log table.

A Filter Points dialog box opens.

Enter the following.

Field Description

Point Identifier | Full or partial point ID. Use the ? and * wildcards to perform partial string searches.

Point Type Options are:

* 4ASTATE
* ALL

+ ANALOG
« APPL
 DIGITAL
* TEXT

- ALARM _LOG table and EVENT_LOG tables.

A Filter Alarms dialog box opens.

Enter the following.

Field Description

Alarm Identifier | Full or partial alarm ID. Use the ? and * wildcards to perform partial string searches.

Alarm Type Not available.

3. Do one of the following.
a. Click OK to filter the list according to the information you've entered.
b. Click Cancel to cancel the filter function.

ﬂ Tip: Todisplay all theitemsin the table, enter an asterisk (*) in the <Type> | dentifier
field.

Wildcard guidelines
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Y ou can use the following wild cards in the Database Logger user interface:

wildcard | Description

* Search for any number of characters at this point in the string.

? Search for any single character in this place in the string.

If you are calling ODBC functions directly, you cannot use the * and ? wild cards. The underscore
character, _,is the only available wild card. Use it to search for any character in this place in a string.

|5/ Note:

* There are no implied wild cards.

If you do not include or terminate your search string with an asterisk, only those items that
match your request exactly will be returned.

« If you are calling SQL functions directly, you can use the* and ? wild cards.
7. Activate Dynamic Configuration

Y ou can dynamically configure several logging properties through the Database Logger. Y ou can:

 Add, remove or modify all point table configuration.

» Add and remove alarms from ALARM_LOG and EVENT _LOG tables.

» Modify logging conditionsin ALARM_LOG and EVENT_LOG tables. That includes the
default logging conditions in the table and the logging conditions of individual alarms.

To activate dynamic configuration in the Database L ogger :
Click the Dynamic button on any table's toolbar.

When you activate Dynamic Configuration, CIMPLICITY updates your project's configuration
automatically. Y ou don't have to return to the Workbench and do a project update in order for your
changes to take affect.

8. Reconcilea CIMPLICITY table with a Logging Database

1. Openthe CIMPLICITY table in the Database L ogger that you want to reconcile.
2. Click Edit>Reconcile Table on the table's menu bar.

The Reconcile table dialog box opens.
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A Table reconcile status color code

(page
127)

B Reconcile buttons

(page
127)

A | Table Reconcile Status Color Code

Theicon colors display the differences between the CIMPLICITY table (Database L ogger
configuration) and the logging database as follows.

Field in the CIMPLICITY | Field in the

Icon | Database Logger Logging Database | Comment
Yes Yes
Yes Yes Types don't match.
No Yes Unused
Yes No Uncreated
Removed Removed

B | Reconcile Buttons

Reconcile buttons are available to perform the following actions.
* Refresh the view.

Refresh

Click Refresh.
* Create uncreated fields that are in the CIMPLICITY table but not in the logging database.

Select uncreated

Create

a. Select the fields that display the icon.
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Tip: Do one of the following.

* Press the Shift or Ctrl key to select multiple fields
* Click Select Uncreated to select all the uncreated fields in the table.
a Click Create.

The fields are created in the logging database. The fields icons change to:

* Remove unused fields that are in not in the Database L ogger, but are in the logging
database.

Select unused

Remove

For Microsoft Access (As-Is product)

a. Select the fields that display the icon.
Tip: Pressthe Shift or Ctrl key to select multiple fields, or click Select Unused to select all the
unused fieldsin the table.

a. Click Remove.
SQL Server and Oracle

SQL Server and Oracle do not directly support dropping columns in a database table.

a. Copy the table to atemporary table.

b. Drop the table from the database.

C. Recreate the table with the fields you wish to use.

d. Copy the data from the temporary table to the new table.

e. Delete the temporary table.

f. Consult your SQL Server or Oracle documentation for details on how to do this.

The unused fields are removed from the database. The fields icons changeto .

* Drop table

Drop Table

1. Click Drop Tableto drop the table from the database.

A message displays asking you to confirm dropping the table.

1. Click Yesto drop the table from the database.

Note: Thetableis not dropped from the CIMPLICITY Database Logger.
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* Upgrade Indexes

Upgrade Indexes

Note: Upgrade Indexes is enabled if you are looking at indexes that have not updated from a 5.0 or
older log.

Important: Updating indexesto CIMPLICITY v5.5 may take along time to complete. The amount
of time required depends on the size of the table. This operation is very CPU intensive and will
degrade the database server performance while it is executing.

1. Make sure your project is shut down.
2. Disconnect any other clients accessing the table whose indexes you will be upgrading.
3. Click Upgrade I ndexes.

A message appears warning you about making sure that no one is logging to the table.

CIMPLICITY:
1. Dropsall old indexesthat it had created,

2. Creates new Version 5.5 indexes and
3. Disables the Upgrade | ndexes button.

9. CloseaCIMPLICITY Logging Table

9. Close a CIMPLICITY Logging Table

When aCIMPLICITY logging table is open, you can close the table.

Option Return to the Database Logger Configuration window.

9.1 (page
129)

Option Exit the Database Logger from an open table.

9.2 (page
129)

Option 9.1. Return to the Database Logger Configuration Window

1. Right-click on any item in the table.
2. Select Close on the Popup menu.

Option 9.2. Exit the Database Logger from an Open Table

Click the Exit Window button on the top right corner of the table.
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Result: The Database Logger closes.
10. Exit the Database L ogger Configuration Window

Do one of the following in the Database Logger Configuration window.

A | Click File>Exit on the Database Logger Configurationwindow menu bar.

B | Click the Exit Window button on the top right corner of the table.

C | Press Alt+F+C on the keyboard.

Result: The Database Logger Configuration window closes.

|=/ Note: You can also exit the Database L ogger Configuration window by clicking the Close
Window button on the top right corner of any open table.

Table Renamed or Copied

Choose either:

Copy a table.

Rename a table.

Database Logger Default Logging Properties
Database Logger Default Logging Properties

The Database L ogger Configuration window provides you with the capability to set global defaults
that specify:

 Open the Logging Properties dialog box. See Open the L ogging Properties Dialog Box (page

131).
« Database Logger Default general parameters. See Database L ogger Default General Parameters

(page 131).

« Database Logger Defaults for alarm, event, status log, and application logs. See Database
Logger Defaults for Alarm, Event, Status Log, and Application Logs (page 134).

« Database Logger Defaults for point and group point logs. See Database L ogger Defaults for
Point and Group Point Logs (page 138).

Y ou can change these defaults for any individua table when you are configuring that table's
properties.
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Open the Logging Properties Dialog Box

1. Right-click the Database L ogger window.
2. Select Logging Properties on the Popup menu.

Database Logger Default General Parameters

Because there are severa parameters that may be the same for all your logging tables, the Database
Logger provides you with the ability to specify defaults. The default you set will be the initial value a
table uses. However, you can change the values for individual tabls.

rect -2, 263, 281, 290 (page 134)
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rect -1, 205, 238, 232 (page 134)
rect -3, 230, 236, 257 (page 134)
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Select the Parameters tab in the Logging Properties dialog box.

Default table write queue size
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1 | Default table write queue size
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A gueue size that supports the worst-case logging during activity bursts.

For example, if 10 points are being logged to the DATA_LOG table, you should have a queue size of
at least 10 in case the points' logging conditions all occur simultaneously.

Guiddlines

The default queue size isthe size of the queue of logged data for each table in the Database queue
sizefield.

« If the database queue for a table overflows a message islogged to your project's Status Log and
additional write requests are dropped until there is room in the queue for them.

« If there is more logging than can be supported by the benchmarked data rate for the database
increasing the size of the database queue will not resolve the problem of lost data.

* Increasing the size of the Database Logger queue will increase the amount of memory used by
the database logger. Since each table pre-allocates memory for the queue, this growth will take
place at startup time. For each additional entry in the queue, the following additional memory
will be used:

Alarm Log Table 200 bytes per entry.

Event Log Table 200 bytes per entry.

Data Tables Size of logged data plus 36 bytes.
Group Tables Size of logged data plus 36 bytes.
Database Logger Default: | 20

2 | Maintenance action export path

The system path to the directory that holds the files created by table maintenance export and purge
actionsin the, if it is different from the default.

Default | SITE_ROOT:\ARC places the data into the ARC subdirectory of the
project.

Guiddines

Y ou may use the logical directory name SITE_ROOT to specify a different subdirectory of your
project, or use any other full path specification such as D:\EXPORT.

3 | Enable measurement systems

Checked | Database Logger logs data for point values using the active measurement system converted value.

Note: The Database Logger logs values for device points and virtual points are as follows:
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Device | Checked and the Database Logger logs the data in the specified units. Note: You can also log the raw
points | measurement value for device points by checking Raw Value on the Log Attribute tab in a table's
system is active Properties dialog box.
Clear or no Database Logger logs the EU converted value.
measurement
system is active
Virtual | The database logger logs the derived value of the point.
points
Example

If you configure a point to be in inches, if you are using a metric system and that point is showing
as centimeters, the Database Logger is still going to log it as inches unless you check Enable
Measurement Systems.

4 | Enable timestamp filtering

Checked

the timestamp.

Limits the number of characters in a table's timestamp column. You can choose to either round or truncate

Default

Clear

Option 1-Rounding up or down

1. Check Round to round the actual time is rounded in the timestamp to the nearest specified
number of units.
2. Enter the nearest number and unit to which the timestamp will be rounded in the timestamps to

the

nearest fields.

Example

Y ou specify that timestamps be rounded to the nearest 5 seconds.

Thetimeis 10:50:22:05. It will be rounded to 10:50:20.

Thetimeis 10:50:24:05. It will be rounded to 10:50:25.

Option 2—Truncating

1. Check Truncate to truncate the actual time in the timestamp to the nearest specified unit.
2. Enter the unit to which the timestamp will be truncated.

Example

Y ou specify that timestamps be truncated to seconds.

Thetimeis 10:50:22:05. It will be truncated to 10:50:22.
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Thetimeis 10:50:24:55. It will be truncated to 10:50:24.

5 | Clock adjustment monitor rate

Rate (in seconds) at which system clock adjustments are checked. All synchronized timed events are
adjusted when a system clock adjustment occurs.

Default | 60

Valid values from 1 through 3600.

6 | Disk full scan rate

Aninterval (in minutes) the Database Logger should wait between disk scans.

Default | 30

Guiddines

The Database Logger scans the disk at intervalsto determineif it isfull. The Disk full scan rate
(min) determines how long the Database L ogger waits after completing one scan before it scans the
disk again.

The default for the Disk full scan rate affects tables for which you have enabled Disk Space Low
maintenance event.

Note: The Disk Full condition isonly useful for Microsoft Access (As-Is product) databases. The
SQL Server forces pre-allocation of disk space for data tables.

7 | Point data logging scan rate

A valuein ticks (100 ticks=1 second) in the Point data logging scan rate field that is:

« Faster than the fastest table scan rate in ticks at which the Point Data Logger will submit data
for logging.
+ Large enough so that all the data for a PLC scan comes into the database together.

Default | 100

Guidelines
The Point Data Logging scan rate is the rate at which the Point Data L ogger submits data for logging.

Result: The pathname you enter is validated when the Parameters tab is closed.

Database Logger Defaults for Alarm, Event, Status Log, and Application Logs
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Y ou can specify asingle global ODBC data source that will be used when logging to Alarm, Event,
Status Log, and Application database files.

The Default Alarm Connection section is displayed when you select the Database Logger: A&E &
App option in the Project Properties dialog box.

When you configure each table, you can choose to use these defaults or you can specify an ODBC
data source that is unique for that table.

In the Logging Properties dialog box, select the Default Alarm Connection tab.
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1. ODBC data source.

2. Database user.

3. Password.

4. Reconnect wait period.

5. Enable store and forward.

6. Additional information that may be needed.
ODBC Data Sour ces

Issues that apply to the ODBC data source for alarm, event, application, point and group point logs
include the following.

+ ODBC Data Source on 64-bit System
» ODBC Connection to SQL Server 2012 using Windows Authentication
+ Database to Database Information

ODBC Data Sour ce on 64-bit System

(1) Important: System Data Sources may not be listed on the System DSN tab when you open The
ODBC Data Source Administrator on a 64-bit system.

1. Fromthe CIMPLICITY Start menu, expand All Programs>HMI SCADA - CIMPLICITY on the
Windows start menu.
2. Click ODBCAD32 - View 32bit DSNS.
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Advanced Features | 2 - Logging and Archiving | 136

w

. From the ODBC Data Source Administrator opens, select the DSN tab. The System Data
Sources will be listed.
. Click the Start button on the Windows task bar.
. Enter the following in the Command Linefield: c:\windows\syswow64\odbcad32.exe
. Press Enter. The ODBC Data Source Administrator opens.
. Select the DSN tab. The System Data Sources will be listed.
. Select from available options or configure an existing or anew ODBC data source.
. Select from the one or more Microsoft Access (As-Is product) or SQL Server optionsin the
drop down menu. Basic options include:
* CIMPLICITY Logging - Alarms L ogs data to the cimplog.mdb file in the ARC directory of
your CIMPLICITY project.
« CIMPLICITY Logging - Points Logs data to the pointlog.mdb file in the ARC directory of
your CIMPLICITY project.
10. Configure an existing or add a new ODBC data source.
11. Click the ODBC Data Sour ce button to the right of the ODBC data sour ce field. The ODBC
Data Source Administrator opens.
12. Select the System DSN tab.
13. Configure the new ODBC data source based on the data source procedures. Consult Microsoft
documentation.
14. Close the ODBC Data Source Administrator.
15. Select the new ODBC data source from the drop down menu.

©O© o0o~NO Ol b

ODBC Connection to SQL Server 2012 using Windows Authentication

The NT AUTHORITY/SY STEM role must have administrative privileges for the Database L ogger
to connect to ODBC. Beginning with SQL Server 2012 NT AUTHORITY/SY STEM does not have
administrative privileges by default. The privilege needs to be granted in the Microsoft SQL Server
Management Studio.

1. Open the Microsoft SQL Server Management Studio.

2. Expand Security>L oginsin the Object Explorer |eft-pane.

3. Right-click NT AUTHORITY\SYSTEM.

4. Select Properties on the Popup menu. The Login Properties- NT AUTHORITY\SY STEM
dialog box opens.

5. Select Server Rolesin the Login Properties - NT AUTHORITY\SY STEM dialog box left
pane.

6. Check sysadmin in the right-pane.

7. Save your changes; close the Microsoft SQL Server Management Studio.

The Database L ogger should be able to connect to ODBC using Windows Authentication. Consult
Microsoft documentation for additional details.

Database to Database | nfor mation

Information needed varies from database to database. In general if you are connecting to:
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A Microsoft Access database, you may be prompted for afile name. Microsoft Access (As-Is
product) does not fully support the long point IDs or alarm messages that were introduced in
CIMPLICITY V9.0. Consult Microsoft documentation for details about maximum character
support.

* A SQL Server, you may be prompted for a database name.
» An Oracle database, you may be prompted for a Server ID. Enter the Alias Name for the Oracle
database in this field.

If the Data Logger is unable to connect to the selected database, validation fails.
Database user

User who will connect to the selected database driver. A database user name isrequired if you are
connecting to a SQL Server. Make sure that the name is a valid database user name.

Password

Password needed to connect to the selected database driver. A password is required if you are
connecting to a SQL Server. Make sure that the password is avalid database password.

Reconnect wait period

The amount of time that the Database L ogger waits between reconnect attempts when the connection
to the database is|ost.

Enter avalue from O (continuous retries) through 24 hours. Default: 30 seconds.
Enable store and forward

Check Enable store and forward to enable the ALARM_LOG table perform store and forward
options:

Option Check if you want:

No Limit The Database Logger to store an unlimited number of records when its connection to the database is
down. The number of records actually stored is determined by the amount of time the connection is lost
and by the amount of free disk space you have.

Max To select the number of records the Database Logger will store when its connection to the database is
number down. Enter a number between 1 and 4294967285.

of stored

records

Additional information that may be needed

Information needed varies from database to database. In general if you are connecting to:

A Microsoft Access database, you may be prompted for afile name.
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» A SQL Server, you may be prompted for a database name.

» An Oracle database, you may be prompted for a Server ID. Enter the Alias Name for the Oracle
database in thisfield. If the Data Logger is unable to connect to the selected database, validation
fails.

The Database Logger validates your entries. Y ou will be prompted if additional information is
required to connect to the database.

Database Logger Defaults for Point and Group Point Logs

Y ou can specify asingle global ODBC data source that will be used when logging data to
CIMPLICITY dataand group tables.

1. The Default Point Connection tab displays when the Database L ogger: Points option is checked
in the Project Properties dialog box.

2. When you configure each table, you can choose to use these defaults or you can specify an
ODBC data source that is unique for that table.

Select the Default Point Connection tab in the Logging Properties dialog box.
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Configure the default parameters for the CIMPLICITY point and group log tables the same way
you configure the parameters (page 134) for the CIMPLICITY alarm, event and application

log tables
1 ODBC data source
(page
)
2 Database user.
(page
)
3 Password.
(page
)
4 Reconnect wait period.
(page
)
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5 Enable store and forward.
(page
)
6 Additional information that may be needed.
(page
)

Review Database L ogger Default Logging Connections

Review Database Logger Defaults for CIMPLICITY :

» Database Logger Defaults for Alarm, Event, Status Log, and Application Logs (page 134)
» Database L ogger Defaults for Point and Group Point Logs (page 138)

Review Logging Connections

Review Logging Connections for CIMPLICITY::

* ALARM_LOG. See Step 3.6. Configure the Alarm Log Connection (page 180).

* COR_LOG. See Step 2.4. Configure the COR_L OG Connection (page 197).

« Datalog table. See Step 2.6. Configure the L ogging Connection (page 157).

* EM_LOG. See Step 2.5. Configure an EM_LOG Connection (page 193).

* EVENT_LOG. See Step 3.5. Configurethe EVENT_LOG Connection (page 187).

* Group log table. See Step 2.6. Configure the Group Connection (page 169).

» An externa application log. See Application Logging (page 198).

Review Default Logging Conditions for Points

Review configuration for aCIMPLICITY::

Data table.

Group table.
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Point Data Logging

Point Data L ogging

Data Logging

Enables you to log point data individually.

Default point data log table | DATA_LOG

Point data logging provides you with a straightforward process to create and maintain records for

analyzing the performance of selected points.

The point performance represents the actual performance of equipment and processes in your system.
As aresult, point logging provides you with an in depth record that can help you determine if action
isrequired to improve the performance of any equipment or processin your system.

Configuration steps in an open (page 121) data log table are as follows.

Step 1

Add points to a data table.

= 92}
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Configure CIMPLICITY point DATA logging properties.
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Configure logging conditions for a single point.

(1) Important: When using fully quaified points, you must provide remote project log

inconfiguration with the project.

Indexes, Columns, Rowsin CIMPLICITY DataLog Tables

* Indexes in data logging tables.
+ Columns and rows in data logging tables.

Indexesin data logging tables

Indexesin datalogging tables include a

Index

Description

Primary key

Is on the Joined Point ID and Timestamp columns. Includes the following if:

The project name table attribute is selected.

Project name column

milliseconds is enabled.

An MSEC column




Secondary key

Joined Point ID and timestamp_utc columns.
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Secondary key

Is on the timestamp only.

Secondary key

Is on the timestamp_utc only.

Columns and rowsin data logging tables

Columns and rows in data logging tables are as follows.

Column Name | Data Type Description

Constant fields

timestamp date/time Timestamp of the logging event

timestamp_utc | date/time UTC timestamp of the logging event.

point_id string CIMPLICITY identifier for the point

Attribute fields

_ALRM string Alarm state of the point .

_ENG string Engineering units label of the point.

_PREV As configured. Default is string | Previous logged value of the point for the same logging event.
_VAL As configured. Default is string | Point value.

_TIME date/time Previous time the point was logged for the same logging event.
_TIME_UTC UTC date/time Previous UTC time the point was logged for the same logging event.
_RAW As configured. Default is string | Raw value of the point.

_RES string CIMPLICITY Resource associated with the point.

_QUALITY number Point quality flags.

_USER number Value of the user defined flags.

Optional fields

project string Name of the CIMPLICITY project

msec number Actual number of milliseconds in the timestamp

Review Logging Attributes

Review Logging Attributes for CIMPLICITY':

ALARM_LOG

EM_LOG

EVENT_LOG

An external application log.
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Review Logging Attributes for Points

Review Logging Attributes for CIMPLICITY':

Data log table

Group log table

Step 1. Add Pointsto aDataLog Table

Sep 1. Add Pointsto a Data Log Table

Y ou can add pointsto a data or group log through either the:

Step 1.1 | Point Properties dialog box

Step 1.2 | Database Logger

Sep 1.1. Add Pointsto Log Tables via a Point Properties Dialog Box

1. Openthe Point Properties dialog box for a selected device or virtual point.
2. Select the General tab.
3. Check Log data.

Note: The Log data checkbox displays when the option Database Logger: Pointsis checked in
the Project Properties dialog box.

4. Click OK or Apply.

CIMPLICITY adds the point to its default DATA_LOG. Y ou can apply more specifications in the
Database L ogger.

Sep 1.2. Add Points to Data Log Tables through Database Logger

Add points to adata log table through the:

« Database Logger Configuration window.
« Datalog table
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Database L ogger Configuration window

1. Open the CIMPLICITY Database Logger Configuration window.
2. Select aDATA_LOG table.

3. Do one of the following.

A | Click Edit>Add Points on the CIMPLICITY Database Logger Configuration window menu bar.

B | Click the Add Item button on the Database Logger Configuration window toolbar.

C a. Right-click in the CIMPLICITY Database Logger Configuration window.

a. Select Add Points... on the Popup menu.

Datalog table

4. Right-click in the CIMPLICITY Database Logger Configuration window.
5. Select Add Points... on the Popup menu.
6. Select adatalog table.

7. Do one of the following.

A | Click File>Add Points on the table menu bar.

B | Click the Add Item button on the log table toolbar.

C a. Right-click in the log table window.
b. Select Add Points... on the Popup menu.

The Select a Point browser opens when you use any method.

8. Right-click in the log table window.
9. Select Add Points... on the Popup menu.
10. Select the Point IDs you want to add.

11. Click OK.
The Point IDs display in the data table window and will be logged according to your specifications.

Step 2. Configure CIMPLICITY Point Data Logging Properties

Sep 2. Configure CIMPLICITY Point Data Logging Properties
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Y ou configure the point logging properties for all pointsin adatalog table in a Table Properties
dialog box. Y ou can adjust the logging conditions for a single point in the (Database L ogger's) Point
Properties dialog box..

The tasks to configure the point logging properties include:

Step 2.1 | Open a CIMPLICITY data log table Properties dialog box.

Step 2.2 | Configure data logging conditions.

Step 2.3 | Configure data logging attributes.

Step 2.4 | Configure data log maintenance events.
a

Step 2.5 | Configure maintenance actions.

Step 2.6 | Configure the CIMPLICITY point data log connection.

Step 2.7 | Do advanced configuration for a data log table.

Sep 2.1 Open a Table Properties Dialog Box

« Database Logger Configuration window.
« Datalog table.

Database Logger Configuration window

1. Select adatatable (e.g. DATA_LOG) in the Database L ogger Configuration window.

2. Do one of the following.

A | Click Edit>Table Properties... on the Database Logger Configuration window's menu bar.

B | Click the Table Properties button on either window's toolbar.

C a. Right-click the data table.
b. Select Properties... on the Popup menu.
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Result. The datatable, e.g. DATA_LOG Table Properties dialog box opens when you use any
method.

Datalog table

Do one of the following.

A | Click Edit>Table Properties... on the data table window's menu bar.

B | Click the Table Properties button on either window's toolbar.

C a. Right-click the data table.
b. Select Table Properties... on the Popup menu.

Result. The datatable, e.g. DATA_LOG Table Properties dialog box opens when you use any
method.

3. Right-click the data table.
4. Select Properties... on the Popup menu.
5. Right-click the data table.

6. Select Table Properties... on the Popup menu.

Sep 2.2. Configure Default Logging Conditions

Sep 2.2. Configure Default Logging Conditions

Logging Conditions determine when data will be logged into the table.

|5/ Note: For aCIMPLICITY datalog table, you can change the table's default logging conditions
for anindividual point in the (Database Logger's) Point Properties dialog box.

Select the Default Logging Conditions tab.

Configuration includes the following.

Option Time/gated logging
2.2.1 (page
146)

Option Data triggered logging.
2.2.2 (page
148)

© Tip: Click Use Defaultsto reset the Logging Conditions to their default values. The default isto
log data periodically every 5 minutes.
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Option 2.2.1. Timed/Gated Logging and Timed/Gated Maintenance

Option 2.2.1. Timed/Gated Logging and Timed/Gated Maintenance

* Options.
* Option combinations.

Options
Options to configure timed/gated logging are as follows.
Note: One or more options can be selected.

rect 19, 78, 198, 102 (page 146)
rect 20, 107, 289, 131 (page 146)
rect 21, 135, 415, 159 (page 146)

Option Description

Periodic Logs data into the table at regular intervals. Configuration for the Periodic configuration group includes:

Checkbox | Checked enables periodic logging.

Value Enter the time value.
field
Interval Select the time interval. Valid intervals are
field
* DAYS
« HOURS
* MINUTES
« SECONDS

* TICKS (100 ticks = 1 second).

Synchronized | Synchronizes log data to a selected daytime. Configuration for the Synchronized group includes:

Checkbox | Checked enables synchronizing.

Time Select hour, minutes and seconds (12 hours).
boxes

AM/PM Select AM or PM from the drop-down list.

On digital Logs data while a digital point is in a selected state. Configuration for the On digital point state group
point state includes:

Checkbox | Checked enables On digital point state.
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State Valid states in the drop-down list are:
* high
* low
« transition (high or low state)
If a periodic time interval is not specified, logging will be triggered when the selected digital
point transitions to the selected state, or any time the digital point transitions (if transition is
selected). If you select a TRANSITION point state, together with a periodic or synchronized
time, the gate will be ignored.
Point Point whose state is monitored for logging. Note: If a device point is configured as On
Scan, the point value is updated on every scan even though its value remains unchanged.

=l

Note: Fields aso appear for timed/gated logging on a

« Datalog table's default logging conditions tab.

* Group log table's Logging Conditions tab.

Option combinations

Option 2.2.1.1
(page 147)

Periodic and synchronized.

Option 2.2.1.2
(page 147)

Periodic and On Digital Point State.

Option 2.2.1.3
(page 148)

Synchronized and On Digital Point State.

Option 2.2.1.4
(page 148)

Periodic, Synchronized and On Digital Point State.

Option 2.2.1.1. Periodic and Synchronized

The combination of periodic and synchronized actions are executed as follows.

A | Periodic

Periodically at the specified time interval

B | Synchronized

Beginning at the specified time of the day

Option 2.2.1.2. Periodic and on Digital Point Sate

The combination of periodic and On digital point state actions are executed as follows.

1 | If the Digital Point state is:

HIGH

LOW

TRANSITION

Logging and maintenance actions are executed when:

2 | The Digital Point transitions to:

HIGH

LOW

HIGH or LOW
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3 | And:

« At the specified time interval

HIGH | LOW | HIGH or LOW
» While the digital point state is:

Option 2.2.1.3. Synchronized and On Digital Point Sate

For Synchronized and On digital point state:

1 | If the Digital Point state is: HIGH | LOW | TRANSITION

Logging and maintenance actions are executed:

« At the specified day time.

HIGH | LOW | HIGH or LOW
» While the digital point state is:

Option 2.2.1.4. Periodic, Synchronized and On Digital Point Sate

For Periodic, Synchronized and On digital point state as follows.

1 | If the Digital Point state is: HIGH | LOW | TRANSITION

Logging and maintenance actions are executed:

2
« At the specified day time
HIGH | LOW | HIGH or LOW
« If the Digital Point state is:
And
3

« At the Specified Time Interval

HIGH | LOW | HIGH or LOW
« While the Digital Point state is:

Option 2.2.2. Data Triggered Logging
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Options to configure data triggered logging are as follows.

1 On point value update

(page

149)

2 On point alarm state

(page

150)

3 Data triggered logging guidelines
(page

151

1 | On point value update

On point value update logs values when a selected point is updates.

Configuration for the On point value update group includes:

Option Description
Checkbox | Enables On point value update option.
Radio Check one option to determine the conditions for when the values of all the points in the table will be
buttons logged.
Point being Each point that was added to the table after Point being logged was checked (and
logged does not have a customized logging condition) is logged when its value is updated.
Specific point Selected point is updated. Enter a Point ID for this option.
« Click the Browser button to open the Select a Point browser or
« Click the Popup Menu button to display options for selecting a point.
Deadband | filter out changes in the value of the selected point type before triggering a logging event—for either the

point being logged or the specific point. Configuration in the Deadband group includes:

Checkbox

Checked enables deadband.

Value

Floating point number. Deadband value

Radio buttons

Check one to specify how to evaluate the entered value to trigger another logging
event.

Absolute Absolute value

Percent Percent of the last value.

The point's value must change more than the Deadband value before another logging event will be

triggered.

Deadband Example 1. Absolute Value

An Absolute Deadband value is 5.0.
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Point Value | Result

200.0 First logging event
201.3 No Logging event

204.2 No Logging event

205.1 Logging event triggered.

Deadband Example 2. Percent Value

A Percentage Deadband value is 5.0

Point Value | Result

200.0 First logging event
201.3 No Logging event

204.2 No Logging event

205.1 No Logging event

210.2 Logging event triggered.

|5/ Note: An explicit deadband of O specifies that the point must have actually changed as opposed
to having been updated by the point manager.

2 | On point alarm state

On point alarm state logs point values when a selected point goes into one or more selected alarm
states.

Configuration for the On point alarm state group includes

Option Description

Checkbox | Enables the on point alarm state option.

Field Entered the point to be evaluated. Aids to find the point include:

Opens the Select a Point browser

Displays a Popup menu with options for selecting a point.

Important: For On point alarm state to work successfully, you must define alarm limits for the trigger point.
For example, if you select a Point ID and choose its Alarm High state, logging in the table will occur each
time the point enters the Alarm High state.

Alarm One or more alarm states must be checked. The values for these alarm states is specified on the Alarm
limits tabin the selected point's Properties dialog box.

Alarm high

Warning high

Warning low
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Alarm low

© Tip: Click Use Defaults to reset the Logging Conditions to their default values. The default isto
log data periodically every 5 minutes.

3 | Data triggered logging guidelines

« Y ou can combine On point value update logging with On point alarm state logging.

« If you do not define any logging conditions under Timed/Gated L ogging, then data will only be
logged into the table when the trigger occurs.

* You can combine triggers. When you combine triggers, logging occurs when either of the
triggers occurs.

Example

Y ou want to log a set of points when POINT_A is updated or when POINT_B isin Alarm High state.
Do the following.

1. Check the On point value update check box.
2. Enter POINT_A inthe Point field.

3. Check the On point alarm state check box.
4. Check the Alarm High check box.

5. Enter POINT_B in the Point field.

Sep 2.3. Configure Data Logging Attributes

Logging Attributes for adatalog table (e.g. DATA_LOG) enables you to:

« Select the current point attributes that will be logged to the table.
* Log the name of the CIMPLICITY project.

1. Select the Logging Attributes tab.

2. Check any of the following point attributes to log.
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Point Log the
attributes

Point Value | Point's current value. Select a Data Type. The Database Logger will attempt to "force" the logged
data into the type you select. Data type options are:

« BOOL

* SINT

* USINT

* INT

*« UINT

* DINT

* UDINT

* REAL

« STRING (255)

Previous Previous value recorded in this table for this point. Data type options are the same as for Point

Value Value (page 152).

Raw Value | Point's raw value. Data type options are the same as for Point Value (page 152).

Alarm State | Point's alarm state when the value is being logged.

Resource Point's Resource ID.

Time Last Time the point was last logged in this table.

Logged

Engineering | Point's engineering units.

Units

Quality Is the value of the QUALITY attribute. .

User Flags | Value of the USER_FLAGS attribute.

Table
attributes

Project Project name.
name

a Tip: Click Use Defaultsto reset the Logging Attributes to their default values. The defaults
areto:

 Log Point Value (STRING(255) in the DATA_LOG) and
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* Not log the Project Name.

Sep 2.4. Configure Logging Maintenance Events

Maintenance Events define when export, purge, and command actions will be performed on the table.

Y ou can specify that maintenance be triggered when:

« A condition, such as low disk space, occurs or
* On aperiodic or gated interval

Any specified event will trigger maintenance actions.

Select the Maintenance Events tab in a data Table Properties dialog box.

Configuration options are as follows.
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1 Timed/gated maintenance
(page

153)

2 Triggered maintenance
(page

154

1 | Timed/gated maintenance

Specifies when maintenance will be triggered.

Use any combination of the options.

Option

Description

Periodic

Triggers maintenance at regular intervals. Configuration for the Periodic configuration group includes:

Checkbox

Checked enables periodic maintenance.

Value Enter the time value.

field

Interval Select the time interval. Valid intervals are
field

* minutes
* hours
* days

Synchronized

Triggers maintenance at a selected time of day. Configuration for the Synchronized group includes:

Checkbox

Checked enables synchronizing.
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Time Select hour (12 hours) and minutes.
boxes
AM/PM Select AM or PM from the drop-down list.
On digital Logs data while a digital point is in a selected state. Configuration for the On digital point state group
point state includes:
Checkbox | Checked enables On digital point state.
State Valid states in the drop-down list are:
* high
* low
« transition (high or low state)
If a periodic time interval is specified Maintenance actions will be executed when the
selected digital point is in the selected state. If a periodic time interval is not specified
Maintenance actions are triggered when the specified digital point transitions to the
selected state, or any time the digital point transitions (if transition is selected).
Point Valid states are HIGH, LOW, and TRANSITION. If a periodic time interval is specified,

maintenance actions will be executed when the digital point you choose is in the selected
state. If a periodic time interval is not specified, the maintenance actions are triggered
when the specified digital point transitions to the selected state, or any time the digital point
transitions (if transition is selected).

Up (page 153)

2 | Triggered maintenance

Specify if and when maintenance events should be triggered.

Use either or both of the following conditions.

Condition | Description
Disk A drive's space falls below a specified size. Configuration for the Disk space low group includes:
space
low
Check Checked enables Disk space low.
box
Drive Select the drive.
Space Megabytes Maintenance events occur when space falls below the threshold specified in this
remaining | field.
Note: The disk is checked at an interval that you specify on the Parameters tab the Logging Properties
dialog box.
Logging | The logging count exceeds a specified number.
count
Check Checked enables Logging count.
box
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Field Number of records. Maintenance actions will be executed when the number of records logged
to the table reaches a multiple of this number. Example You specify 500. Maintenance actions
are executed when the count reaches 500, 1000, 1500, etc. Note: If you check both conditions
maintenance is triggered when either condition occurs.

(1) Important: Record del etion'may not actually free disk space; this can depend your DBMS.
Consult your DBM S documentation.

Up (page 153)

Sep 2.5. Configure the Logging Maintenance Actions

Maintenance Actions define the type of actions that take place when a Maintenance Event occurs.

Y ou can configure a data table to:

* Export records to an export file,
* Purge records from alogging table and/or
* Incorporate command line actions.

Select the Maintenance Actions tab in the DATA_LOG Table Properties dialog box.
Options are as follows.
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1 Delete actions
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2 Export actions
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3 Other actions
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1 | Delete actions

Delete actions specify the criteriafor how many records will be retained when data is deleted from a
logging table when a maintenance event occurs.

Options in the Delete actions group include:

Option Description

Delete records Determines the method of counting the number of records to retain in the table.
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Checkbox | Check to enable Delete records.

Check either radio button.

By count | Delete all but the last (most recent)<n> records in the table.

By time Delete all but the records entered in the table for the last <n> days, hours or minutes.

Save deleted in file | Saves the purged data to a .csv format file before removing it from the table.

Checkbox | Check to enable Save deleted in file.

Field Name of the .csv file.

2 | Export actions

Export actions specify how many records will be exported when a maintenance event occurs.

Export actions specify

Option Description

Export records Exports specified data. Configuration includes:

Checkbox | Checked to enable Export records.

Check either radio button.

By count | Export last (most recent)<n> records in the table.

By time Export all the table for the last <n> days, hours or minutes.

Save exported in file | Saves the exported data in a .csv file.

Field Name of the .csv file.

3 | Other actions

(Optional) Select one of the other actions.

Option Description
Execute Enables you to incorporate a SQL command line action. Configuration includes:
SQL
command
Check | Checked enables Execute SQL command
box
Field Enter a SQL command Example Records should be counted in the data table from the current
time minus one day (point values logged in the last 24 hours.) The field entry is: INSERT NTO
MYTABLE VALUES NOW(), SELECT COUNT(*) FROM DATA_LOG Where DATA_LOG is the
data log table.
Run Runs a selected program. Configuration includes:
program
Check | Checked enables Run program.
box
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Enter a program path name in the accompanying field. The entry can include command-

line arguments for the program. Example Purge actions have been configured to save the
records to a .csv file. A program has been written that transfers the files to a zip drive. The
field entry is: D:\Deleted\ Backupdeletedcsv.bat Where D:\Deleted\ is the path to the program.
Backupdeletedcsv.bat is the program that will be run when a maintenance event occurs.

Compact | Compacts the Microsoft Access (As-Is product) database where the table resides during a maintenance
database | event.

Check | Checked enables Compact database.

box

Sep 2.6. Configure the Logging Connection

Sep 2.6. Configure the Logging Connection

Connection defines the database connection and the Store and Forward properties for atable.

Option

157)

2.6.1 (page

Default logging connection.

Option

157)

2.6.2 (page

Customized logging connection.

Option 2.6.1. Default Logging Connection

1. Select the Connection tab.

2. Check Use default point connection.

The Connection (page 138) tab is dimmed and unavailable for configuration. The data log table

uses the connections specified on the Default Point Connection tab in the Logging Properties dialog

box.

Option 2.6.2. Logging Connection Selected for a Sngle Table

Select the Connection tab.

Configuration is as follows.
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Use default point logging.
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2 Connection information
(page

158)

3 Store and forward
(page

159

1 | Use default point connection

Clear Use default point connection.

The Connection tab is enabled to enter specifications for the selected table.

2 | Connection information

The connection information enables you to select an ODBC data source that is different from the

default.

Connection options

ODBC data source selection procedures.

Connection Options
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Field Description
ODBC An ODBC data source can be:
data
source
A Selected from the field's drop-down list
B A re-configured existing source or a new ODBC data source.
Database | User who will connect to the selected database driver. Important: This field is required if you are
user connecting to a SQL Server.
Password | Needed to connect to the selected database driver. Important: This field is required if you are connecting
to a SQL Server
Reconnect | A value between 0 (continuous retries) and 24 hours. This value specifies the amount of time that the
wait Database Logger waits between reconnect attempts when the connection to the database is lost. Time
period unites include:

« Seconds
* Minutes
« Hours

Default 30 seconds.
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Up (page 158)
ODBC data source selection procedures

1. Select an ODBC data source from the drop down list in the ODBC data sour ce, field. Y ou can
select from available options or configure an existing or anew ODBC data source:

Basic options include, but are not limited to:

Selection SQL Server is: | Logs to:

CIMPLICITY Logging - Alarms | Installed SQL Server database

Not installed cimplog.mdb in the ...\Proficy CIMPLICITY\ARC directory

CIMPLICITY Logging - Points | Installed SQL Server database

Not installed pointlog.mdb in the ...\Proficy CIMPLICITY\ARC directory

Note: If you have an Oracle database, you may see the ODBC data source that you created for
Oracle.

2. Configure an existing or add a new ODBC data source.
a. Click the ODBC Data Source button to the right of the ODBC data sour ce field.
The ODBC Data Source Administrator opens.

a. Select the System DSN tab.

a. Configure the new ODBC data source based on the data source procedures.
b. Close the ODBC Data Source Administrator.

c. Select the new ODBC data source from the drop down menu.

Up (page 158)

3 | Store and forward

When Enable store and forward is checked the DATA_LOG will perform store and forward
functions.

Options are:

rect 32, 97, 185, 117 (page 159)
rect 33, 115, 269, 135 (page 160)

Option Description

No Limit | Checked enables No Limit. The Database Logger will store an unlimited number of records when
its connection to the database is down. The number of records actually stored is determined by the
amount of time the connection is lost and by the amount of free disk space you have.
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Max

number
of stored
records

The Database Logger will store a specified number of records when its connection to the database is
down. Enter a number between 1 and 4294967285.

Checked

Enables Max number of stored records.

Field

Number that will be the maximum stored. Valid numbers are from 1 to 4294967285.

Sep 2.7. Do advanced Logging Configuration

The Advanced tab in the datalog's Table Properties dialog box enables you to:

+ Disable logging actions for the table that you are configuring.
« Override the queue size that is specified in the Database Logger's Logging Properties dialog

box.

* Select and control bulk insertion for Microsoft SQL Server or MSDE.

Select the Advanced tab in the data log's Table Properties dialog box.

Configuration options are as follows.
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1 Disable logging actions
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160)

2 Write a queue size/Use default

(page

160

3 Use bulk insertion (Microsoft SQL Server and MSDE only)
(page

161

1 | Disable logging actions

Select whether or not to log data to the table.

Do one of the following in the Disable logging actions checkbox.

Option Description
Check Do not log data to the selected table.
Clear Log to the selected table when the CIMPLICITY project is running.

2 | Write a queue size/Use default
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Choose one of the following.

Option Description
Use default Check to use the universal size specified on the Parameters tab in the Database Logger's Logging
Properties dialog box.
Write queue
size field 1. Clear Use default.

2. Enter a number in the that supports the worst-case logging during activity bursts.

Example: If 10 points are being logged to the table, you should have a queue size of at least 10 in case
the points' logging conditions all occur simultaneously.

3 | Use bulk insertion (Microsoft SQL Server and MSDE only)

Use bulk insertion enables you to take advantage of the Database L ogger's bulk insertion capability
(Microsoft SQL Server or MSDE only).

1. Check Use bulk insertion.
2. Select the Maximum number of insertions that your system can handle.
3. Select the interval between insertions in the Bulk insertion rate field.

The Database Logger will be triggered to insert records, based on whichever specification occurs

first.
Example
Y ou specify the:
Maximum number of insertions | = [ 1000
Bulk insertion rate = | 60 seconds
Asaresult:
If the Database L ogger : Then the Database L ogger :
Collects 1000 records within 60 seconds. Inserts the records into the log.
Does not collect 1000 records within 60 seconds. | Inserts whatever records have been collected.

1) Important: For SQL Server, insert triggersfire only if bulk insertion is disabled.

Step 3. Configure Logging Conditions for a Single Point

1. Open aCIMPLICITY datatable's window.
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2. Select the point you want to log under different conditions from the default.

3. Do one of the following.
* Double-click the selected Point ID.
» Click the Item Properties button on the window's toolbar.
» Click Edit>Point Properties... on the Table window's menu bar.
* Use the Popup menu.
a. Click the right mouse button.
b. Select Properties... on the Popup menu.

Result: The (Database Logger's) Point Properties dialog box opens when you use any method.

The Point Properties dialog box displays either the default logging conditions or conditions that
were previously checked for the selected point.

4. Select the logging conditions that apply to the selected point.

Options are included for:

Timed/gated logging

Data triggered logging.

5. Click OK.

The selected point will be logged when its logging conditions occur.

|5/ Note: If point datais being logged to Historian and the point's logging conditions configuration
ischanged in the CIMPLICITY Database L ogger, the Historian Collection Options (page 97)
will be changed for the tag.

Group Point Logging

Group Point Logging

Group Point Logging Enables you to log data for a selected group of points in parallel.

Benefit Gives better performance and uses disk space more efficiently than data logging

Default group point data log table | GROUP_LOG

Group Point logging provides you with a straightforward process for creating and maintaining
records to analyze the performance of selected points, whose values and selected attributes are
logged at the same time.
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The point performance represents the actual performance of equipment and processes in your system.
As aresult, point logging provides you with an in depth record that can help you determine if action
isrequired to improve the performance of any equipment or processin your system.

Steps to configure group logging include:

Step 1 | Add points to a group log table.

Configure group logging properties.

Step 3 | Configure logging attributes for a single point.

(1) Important: When using fully qualified points, you must provide remote project login
configuration with the project.

Indexes, Columns, Rows in Group Tables

* Indexes in group data logging tables.
+ Columns and rows in group data logging tables.

Indexesin group data logging tables

Indexesin Group logging tablesinclude &

* Unique primary key index on the timestamp column.
* Unique primary key index on the timestamp_utc column.

If you have selected the project name table attribute, the primary key index also includes the project
name column.

The primary key includes an MSEC column, if milliseconds is enabled.

Columnsand rowsin group datalogging tables
Columns and rowsin Group logging tables are as follows.
Note: The prefix of each attribute column is based on the SQL Field Prefix specified for the point.

The index of each column is based on the point array element. Non array points always have index
value of '0' (e.g. <prefix>_VALO)

Column Name Data Type Description
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Constant fields

timestamp date/time Timestamp of the logging event

timestamp_utc date/time UTC timestamp of the logging event

Attribute fields

<prefix>_ALRM<index> string Alarm state of the point .

<prefix>_ENG<index> string Engineering units label of the point.

<prefix>_PREV<index> Depends on point Previous logged value of the point for the same logging event.
type

<prefix>_VAL<index> <prefix>_VAL<index> | Value of the point.

<prefix>_TIME<index> date/time Previous time the point was logged for the same logging event.

<prefix>_TIME_UTC<index> | UTC date/time Previous UTC time the point was logged for the same logging

event.

<prefix>_RAW<index> Depends on point Raw value of the point.
type

<prefix>_RES<index> string CIMPLICITY Resource associated with the point.

<prefix>_QUALITY<index> | number Point quality flags.

<prefix>_USER<index> number Value of the user defined flags.

Optional fields

project string Name of the CIMPLICITY project

msec number Actual number of milliseconds in the timestamp

|5/ Note: The maximum number of columns atable can have is SBM S specific. Consult your
DBM S documentation to ensure that your Group table does not exceed these limits. Default MSDE
DBMSis 1024 columns, 8060 Bytes per row.

) Important: Since the Microsoft Access (As-Is product) and Oracle format does not support sub-
second timestamp data, you cannot log points to a Group table at sub-second rates. Attempting to do
so will cause the duplicate-keyed records to be dropped from the database, unless you have enabled
millisecond logging.

Step 1. Add Pointsto a CIMPLICITY Group Table

Y ou can add points to a group log through the Database L ogger Configuration window and in a
Group Log window.

Add points to adata log table through the:

« Database Logger Configuration window.
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* Group log table.
Database L ogger Configuration window

1. Open the CIMPLICITY Database Logger Configuration window.
2. Select aGROUP_LOG table.

3. Do one of the following.

A | Click Edit>Add Points on the CIMPLICITY Database Logger Configuration window menu bar.

B | Click the Add Item button on the Database Logger Configuration window toolbar.

C a. Right-click in the CIMPLICITY Database Logger Configuration window.
b. Select Add Points... on the Popup menu.

Group log table

4. Right-click in the CIMPLICITY Database Logger Configuration window.
5. Select Add Points... on the Popup menu.
6. Select adatalog table.

7. Do one of the following.

A | Click File>Add Points on the table menu bar.

B | Click the Add Item button on the log table toolbar.

C a. Right-click in the log table window.
b. Select Add Points... on the Popup menu.

The Select a Point browser opens when you use any method.

8. Right-click in the log table window.
9. Select Add Poaints... on the Popup menu.
10. Select the Point I1Ds you want to add.

11. Click OK.

The Point IDs display in the group data table window and will be logged according to your
specifications.
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Step 2. Configure Group Logging Properties

Sep 2. Configure Group Logging Properties

Y ou configure the point logging properties for al pointsinain a CIMPLICITY group table's Table
Properties dialog box. (Y ou can adjust the logging conditions for a single point in the (Database
Logger's) Point Properties dialog box.).

Step 2.1 | Open the CIMPLICITY group Table Properties dialog box.

cH

66

Step 2.2 | Configure logging conditions.
(page

Step 2.3 | Configure logging attributes.

Step 2.4 | Configure maintenance events.
(page

Step 2.5 | Configure maintenance actions.

Step 2.6 | Configure the CIMPLICITY group point log connection.

Step 2.7 | Configure advanced properties for a group log table.

Step 2.1. Open a Group Table Properties Dialog Box

1. Either:
* Select agroup table (e.g., GROUP_LOG) in the Database Logger Configuration window,
or
* Open the group (page 121) table (e.g., GROUP_L OG) window..

2. Do one of the following.
Method 1
Click the Table Properties button on either window's tool bar.

Method 2

a. Click Edit on either window's menu bar.
b. Select Table Properties...
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Method 3

a. Right-click a group table in the Database L ogger Configuration window or any Point ID in
the group table's window.
b. Select Table Properties... from the popup menu.

Result. The group table's (e.g., GROUP_LOG) Table Properties dialog box opens when you use
any method.

Sep 2.2. Configure Group Logging Conditions

Logging Conditions determine when datawill be logged into the table

|=! Note: Because, the pointsin agroup table are logged in parallel, the logging conditions are the
same for all. However, you can select attributes that will be logged for individual points.

1. Select the Logging Conditions tab.

The conditions you check define the conditions for when the values of all the pointsin the table
will be logged.

2. Specify logging conditions the same way you specify them for a data log (page 145) table.

3. Check On point alarm state to log point values when a specified point goes into one or more
selected alarm states.

Sep 2.3. Configure Group Logging Attributes

Logging Attributes for a group table (e.g. GROUP_LOG) enables you to:

« Select the current point attributes that will be logged to the table.
* Log the name of the CIMPLICITY project.:

The checked logging attributes will be the default logging attributes for additional points you add to
the group table.

|=/ Note: You can also specify that selected attributes be logged for individual pointsin the group
table.

1. Select the Logging Attributes tab.

2. Check any of the following point attributes to log:

Point Attribute Log the:

Point Value Point's current value.
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Previous Value Previous value recorded in this table for this point.
Raw Value Point's raw value.

Alarm State Point's alarm state when the value is being logged.
Resource Point's Resource ID.

Time Last Logged | Time the point was last logged in this table.

Engineering Units | Point's engineering units.

Quality Is the value of the QUALITY attribute.

User Flags Value of the USER_FLAGS attribute.

Table attributes

Project name Project name.

© Tip: Click Use Defaultsto reset the Logging Attributes to their default values. The defaults
areto:

* Log Point and
* Not log the Project Name.

Note: Thisalso appliesto BATCH_DATA attributes.

Sep 2.4. Configure Group Maintenance Events

Maintenance Events define when export, purge, and command actions will be performed on the
group table.

Y ou can specify that maintenance be triggered when:

+ A condition, such as low disk space, occurs or
* On aperiodic or gated interval

Any specified event will trigger maintenance actions.

1. Select the Maintenance Eventstab in a data Table Properties dial og box.

2. Specify actions the same way you specify them for a datalog (page 153) table.

Sep 2.5. Configure Group Maintenance Actions

Maintenance Actions define the type of actions that take place when a Maintenance Event occurs.

Y ou can configure a group table to:
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« Export records to an export file,
« Purge records from alogging table and/or
* Incorporate command line actions.

1. Select the Maintenance Actions tab in the group log Table Properties dialog box.

2. Specify actions the same way you specify them for a datalog (page 155) table.

Sep 2.6. Configure the Group Connection

Connection defines the database connection and the Store and Forward properties for the table.

Do one of the following.

* Use the default connection.
* Specify logging connection specific to the GROUP_LOG table.

Use the default connection

1. Select the Connection tab in the GROUP_L OG Table Properties dialog box.

2. Check Use default point connection.

3. Do default connection configuration the same way you do for adatalog (page 157) table.

Specify logging connections specific to the GROUP_LOG table

4. Select the Connection tab in the GROUP_L OG Table Properties dialog box.
5. Clear Use default point connection.

6. Do custom connection configuration the same way you do for adatalog (page 157) table.

Sep 2.7. Do Advanced Group Log Configuration

The Advanced tab in the group log's Table Properties dialog box enables you to:

+ Disable logging actions for the table that you are configuring.

« Override the queue size that is specified in the Database Logger's Logging Properties dialog
box.

* Select and control bulk insertion for Microsoft SQL Server or MSDE.

1. Select the Advanced tab in the group log's Table Properties dialog box.

2. Do advanced configuration the same way you do for adatalog (page 155) table.
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(1) Important: For SQL Server, insert triggers fire only if bulk insertion is disabled.

Step 3. Configure Logging Attributes for a Single Point in a Group Table

1. Open agroup table (e.g. GROUP_L OG) window.
2. Select the point for which you want to log different attributes from the default.
3. Do one of the following.

Method 1

Double-click the selected Point ID.

Method 21

Click the Item Properties button on the group log table toolbar.

Method 3

a. Click Edit on the window's menu bar for the group log table.
b. Select Point Properties...

Method 4

a. Click the right mouse button.
b. Select Properties... from the popup menu.

The (Database L ogger's) Point Properties dialog box opens when you use any method
displaying either the default logging conditions or conditions that were previously checked for
the selected alarm.

4. Check the attributes that you want logged for the selected point.

5. Click OK.

The attributes you select will be logged for the selected point. The selection does not change if you
change the table defaults.

Alarm Logging

Alarm Logging
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Alarm logging provides you with a straightforward process for creating and maintaining recordsto
analyze the alarm state of equipment and processes in your system. As aresult, dlarm logging helps
you determineif action is required to repair or maintain your system.

The Database Logger enables you to:

* Log data about selected alarms or all alarmsto an alarm log table.
« Save the log files, until specified criteria occur.

 Have the logged data discarded, based on specified criteria.

« Save the logged data to another file for future analysis.

Y ou can display, print and analyze that information in areport that you create or in an Excel
CIMPLICITY Alarm Report that isincluded in CIMPLICITY ..

|=/ Note: Datalogged for alarmsincludes:

* Alarm ID,

» Time the Alarm was Generated,

» Alarm Class, Resource,

» Alarm Message,

« Alarm comments that are entered in the Alarm Viewer.
* Logged By

* Other optional attributes that you select.

Steps to configure alarm logging include:

Step 1 | Review system alarms included in the alarm log table.

Step 2 | Add additional alarms to the alarm log table.

Configure alarm logging properties.

Step 4 | Configure logging conditions for a single alarm.

Note: Y ou cannot copy or create a second ALARM_LOG.

=l

Review Logging Conditions for a Single Alarm

Review configuration for asingle CIMPLICITY::

Alarm.
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Event alarm.

Step 1. Review System Alarmsinthe ALARM_LOG

Sep 1. Review System Alarms in the ALARM LOG

The following system alarms are recorded in the Alarm Log table:

Alarm ID Description
$DEVICE Specified device has a problem.
$DEVICE_DOWN Specified device has failed.

$DEVICE_FAILOVER Device failure for Server Redundancy.

$REDUND_DEV_DOWN [ Redundant device down for Server Redundancy.

AMSI_ALARM Reserved for future use.

DB_CONN_DOWN Connection lost to specified database for Database Logger.

DB_START_FORWARD | Forwarding files found for Database Logger Store and Forward.

MCP_PROC_DOWN Specified CIMPLICITY process has terminated unexpectedly.

Indexes, Columns, Rows in the ALARM_LOG Table

Indexesin Alarm logging tablesinclude a

* Primary key index on the joined timestamp and sequence number columns.

« Secondary key index on the joined timestamp_utc and sequence humber columns.
+ Secondary index on the timestamp alone.

+ Secondary index on the timestamp_utc alone.

If you have selected the project name table attribute, the primary key index also includes the project
name column.

The primary key includes an MSEC column, if milliseconds is enabled.

Columnsand rowsin Alarm logging tables are as follows:

Column Name Data Type Description

Constant fields

timestamp date/time Timestamp of the logging event.
timestamp_utc date/time UTC timestamp of the logging event.
sequence_number number Identity column to ensure uniqueness.

alarm_id string CIMPLICITY alarm identifier.
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alarm_class string CIMPLICITY alarm class associated with the alarm.
resource string CIMPLICITY resource associated with the alarm.
logged_by string CIMPLICITY process that logged the alarm.
reference string Reference information for the alarm logged.
prev_state string Previous state of the alarm. Possible values.

N | Normal

G | Generate

R | Reset

A | Acknowledge

D | Delete
log_action string State of the alarm that caused log event. Possible values.

N | Normal

G | Generate

R | Reset

A | Acknowledge

D | Delete
final_state string Final state of the alarm. Possible values N=G=R=A= D=

N | Normal

G | Generate

R | Reset

A | Acknowledge

D | Delete
alarm_message string Message associated with the alarm.
generation_time date/time Timestamp the alarm was generated.
generation_time_utc | UTC date/time | UTC timestamp the alarm was generated.
Optional fields
project string Name of the CIMPLICITY project.
msec number Actual number of milliseconds in the timestamp.

Step 2. Add Point Alarms and Alarmsto the ALARM_LOG Table

Sep 2. Add Point Alarms and Alarms to the ALARM LOG Table
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Y ou can add the following to the CIMPLICITY aarm log table:

Option Add Point Alarms to the ALARM_LOG Table via a Point Properties dialog box.
2.1 (page
174)

Option Add Alarms to ALARM_LOG through the Database Logger.
2.2 (page
174)

Option 2.1. Add Paint Alarmsto the ALARM_LOG Table via a Point Properties Dialog Box

1. Select Pointsin the Workbench | eft pane.

2. Select the point for which you want to log alarms in the Workbench right pane.
3. Open the point's Properties dialog box.

4. Select the Alarm tab.

5. Check if and when you want an alarm to be logged in the Alarm Logging box on the Alarm tab
of the Point Properties dialog box. Y ou can select any or all of the options:

Condition Alarm data is logged when the alarm:

Generate Occurs.

Acknowledge | Is acknowledged by the operator or the system.

Reset Is reset by the operator or the system.

Delete Is manually deleted from the system.

6. Click OK or Apply.

CIMPLICITY adds the point to its default ALARM_LOG. Y ou can apply more specificationsin the
Database L ogger.

Option 2.2. Add Alarmsto ALARM_LOG through the Database Logger

1. Do one of the following in the Database Logger Configuration window or the ALARM_LOG
window.

In the Database L ogger Configuration window

a. Select ALARM_LOG
b. Do one of the following:

Method 1
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Click the Add Item button on the Database Logger Configuration window toolbar.

Method 2

a. Click Edit on the Database Logger Configuration window menu bar.
b. Select Add Alarms...

Method 3

a. Right-click ALARM_LOG.
b. Select Add Alarms... from the popup menu.

Inthe ALARM_LOG window

Do one of the following.

Method 1

Click the Add Item button on the ALARM_LOG toolbar.

Method 2

a. Click File on the ALARM_L OG window menu bar.
b. Select Add Alarms...

Method 3

a. Right-click inthe ALARM_LOG window.
b. Select Add Alarms... from the popup menu.

The Select an Alarm Definition browser opens when you use any method.

2. Select the Alarm IDs you want to add.

3. Click OK.

The alarms display inthe ALARM_LOG window and will be logged according to your
specifications.

Step 3. Configure Alarm Logging Properties

Sep 3. Configure Alarm Logging Properties

Y ou configure the alarm logging properties for al included alarmsin the ALARM_LOG Table
Properties dialog box. (Y ou can adjust the logging conditions for asingle alarm in the Alarm
Properties dialog box.).

Step 3.1 | Open the ALARM_LOG Table Properties dialog box.

(page
176
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Step 3.2 | Configure default logging conditions.

Step 3.3 | Configure logging attributes.

Step 3.4 | Configure maintenance events.

Step 3.5 | Configure maintenance actions.
(page

Step 3.6 | Configure the ALARM_LOG connection.

Step 3.7 | Configure advanced properties for the ALARM_LOG table.

Step 3.1. Open the ALARM LOG Table Properties Dialog Box

1. Either:
» Select ALARM_LOG in the Database L ogger Configuration window, or
* Open (page 121) the ALARM_LOG window.

2. Do one of the following.
Method 1
Click the Table Properties button on either window's toolbar.

Method 2

a. Click Edit on either window's menu bar.
b. Select Table Properties...

Method 3

a. Right-click ALARM_LOG in the Database Logger Configuration window or any alarmin
the ALARM_LOG window.
b. Select Table Properties... from the popup menu.

Result. The ALARM_LOG Table Properties dialog box opens when you use any method.

Sep 3.2. Configure Default Alarm Logging Conditions

Logging Conditions determine when data will be put into the log table. .
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|5/ Note: You can change the conditions you specify in the ALARM_LOG Table Propertiesfor a
single alarm.

1. Select the Default Logging Conditions tab.

The conditions you check define the default conditions for when the alarmsin the table will be
logged.

2. Modify the existing default conditions, if required.

The conditions are:

Condition Alarm data is logged when the alarm:

Generate Occurs.

Acknowledge | Is acknowledged by the operator or the system.

Reset Is reset by the operator or the system.

Delete Is manually deleted from the system.

Sep 3.3. Configure Alarm Logging Attributes

Logging Attributes for an ALARM_L OG table enables you to log additional information about the
logged alarms.

Select the Logging Attributes tab in the Table Properties dialog box.
Options are as follows.
rect -1, 57, 23, 84 (page 177)

rect 108, 73, 132, 100 (page 178)
rect 319, 279, 343, 306 (page 179)

1 Table attributes.
(page

177)

2 Log addition points.
(page

178)

3 Use defaults.

(page

179

1 | Table attributes

Check the table attributes that should be included in the ALARM_LOG table.
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Note: These attributes can also be included in the DATA_LOG

Attribute | SQL Description
Field
Project | project Project the point is in.
name
Point point_val | Point value of the alarm being logged.
value
Point user_bits | The value of the point's 64 bit user set usage. Even though CIMPLICITY is a 32 bit application a
user point can access the lowest 32-bits and the highest 32 bits in a 64 bit set. The logged value:
bits

« Displays the combined 64 bit value.
* Is logged as a decimal.

Example A point writes the following values to EXTENDED_USER_FLAGS_HIGHand
EXTENDED_USER_FLAGS_LOW.

Bit Set Decimal = Hex
HIGH 35 = 0x23
LOW 15 = Oxf

CIMPLICITY combines the EXTENDED_USER_FLAGS_HIGH and
EXTENDED_USER_FLAGS_LOW.

The HEX value is: 0x0000002300d

Converted to Decimal: 150323855375

Result: CIMPLICITY logs 150323855375 to the ALARM_LOG in SQL.

|5/ Note: If you select or de-select the project name table attribute you must drop the table so that it
is properly re-created with or without the new project field as part of the primary key. Failing to do
So can cause the database logger to fail to log data into the table.

2 | Log additional points

The status of any component in a system may be affected by the operation of other componentsin
that system.

Therefore, if apoint isin alarm state, even if related points are not in alarm state, another value or
combination of values may be causing or influencing the alarm state value.

To help analyze an alarm status, CIMPLICITY enables you to log additional point valuesin the SQL
table row that contains the selected point's alarm state information.

Each point message checkbox that is checked adds two columnsto the ALARM_LOG table, as

follows.

0000f
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Checkbox Column 1 Column 2

Point message <n> | point_id_<n> | point_val_<n>

» When a point's alarm messageincludes related point values, CIMPLICITY enters the point ID
and valuein the fields that are assigned in the alarm message.

« If aPoint message <n> is checked, but is not included in a point's alarm message, there is no
entry (e.g. NULL) for that point inthe ALARM_LOG.

3 | Use Defaults

Click Use Defaults to return the ALARM _LOG to its default logging attribute settings.

The default logging attribute settings are as follows.
* Thefirst time you open the ALARM_LOG al check boxes are clear.
When you click Use Default, all check boxes are once again cleared.

* The next time you open the ALARM_LOG the settings that were selected the last time iswas
closed become the default settings

When you click Use Default, check boxes that were:

* Checked when the previous session closed, are checked.
« Clear when the previous session closed, are clear.

Sep 3.4. Configure Alarm Log Maintenance Events

Maintenance Events define when export, purge, and command actions will be performed on the
Alarmtable.

Y ou can specify that maintenance be triggered when:

* A condition, such aslow disk space, occurs or
» On aperiodic or gated interval

Any specified event will trigger maintenance actions.

1. Select the Maintenance Eventstab in aalarm Table Properties dialog box.

2. Specify actions the same way you specify them for adatalog (page 153) table.
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(1) Important: (For SQL Server) insert triggersfire only if bulk insertion is disabled.

Sep 3.5. Configure Alarm Log Maintenance Actions

Maintenance Actions define the type of actions that take place when a Maintenance Event occurs.

Y ou can configure the ALARM_L OG table to:

* Export records to an export file,
* Purge records from alogging table and/or
* Incorporate command line actions.

1. Select the Maintenance Actionstab in the ALARM_LOG Table Properties dialog box.

2. Configure the maintenance actions the same way you configure maintenance actions for a
CIMPLICITY data (page 155) table.

Sep 3.6. Configure the Alarm Log Connection

Connection defines the database connection and the Store and Forward properties for atable.

Do one of the following.

* Use the default connection.
* Specify logging connection specific to the ALARM_LOG table.

Use the default connection

1. Select the Connection tab in the ALARM_LOG Table Properties dial og box.
2. Check Use default point connection.

3. Do default connection configuration the same way you do for adatalog (page 157) table.

Specify logging connections specific to the ALARM_LOG table

4. Select the Connection tab in the ALARM_LOG Table Properties dial og box.
5. Clear Use default point connection.

6. Do custom connection configuration the same way you do for a datalog (page 157) table.

Sep 3.7. Do Advanced Alarm Logging Configuration
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The Advanced tab in the ALARM_LOG Table Properties dialog box enables you to:

* Disable all logging actions for the table that you are configuring

+ Override the queue size that is specified in the Database Logger's Logging Properties dialog
box.

* Select and control bulk insertion for Microsoft SQL Server or MSDE.

1. Select the Advanced tab inthe ALARM_LOG Table Properties dialog box.

2. Do advanced configuration the same way you do for aDATA_LOG (page 157) table.

(1) Important: For SQL Server, insert triggers fire only if bulk insertion is disabled.

Step 4. Configure Logging Conditions for a Single Alarm

1. Select the alarm you want to log under different conditions from the default.
2. Do one of the following.

Method 1

Double-click the selected Alarm ID.

Method 2

Click the Item Properties button on the ALARM_L OG toolbar.

Method 3

a. Click Edit onthe ALARM_LOG menu bar.
b. Select Alarm Properties...

Method 4

a. Click the right mouse button.
b. Select Properties... from the popup menu.

The Alarm Properties dialog box opens when you use any method displaying either the default
logging conditions or conditions that were previously checked for the selected alarm.

3. Check the logging conditions that apply to the selected alarm.

4. Click OK.

The selected alarm will be logged in the ALARM_LOG when its logging conditions occur.
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Event Alarm Logging
Event Alarm Logging

Event Alarm Logging enables you to log alarms for events that do not need to be acknowledged or
reset. These events are normally system-based events, such aslogging in and logging out. They do
not appear in the Alarm Viewer. Asaresult, Event Logging is a convenient way for you to track a
system issue that you are concerned about, but for which you do not want to have alarms appear in
the Alarm Viewer where acknowledgement and resetting issues arise. :

The Database L ogger enables you to:

* Log data about the specialy selected alarmsto an ALARM_LOG table.
« Save the log files, until specified criteria occur.

» Have the logged data discarded, based on specified criteria.

« Save the logged data to another file for future analysis.

Y ou can display, print and analyze that information in areport that you create or in an Excel
CIMPLICITY Alarm Report that isincluded in CIMPLICITY.

Steps to configure event alarm logging include:
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Review system alarms included in the EVENT_LOG table.
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Add event alarms through the Database Logger.
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Configure event alarm logging properties.

[}
=
D
i=]
D

Configure logging conditions for a single event alarm.
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Note: You cannot copy or create asecond EVENT_LOG.

I

Step 1. Review System Alarmsin the EVENT_LOG

Sep 1. Review System Alarmsiin the EVENT_LOG

The following system events are recorded in the Event Log table:

Event ID Description




$ALARM_DISABLED

Alarming for specified point is disabled.
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$ALARM_ENABLED

Alarming for specified point is enabled.

$ALARM_MODIFIED

Alarm limits for specified point modified by user.

$ALARM_RESTORED

Alarm limits for specified point restored to original values.

$AM_STATUS

Alarm Management throughput statistics. Issued every half-hour.

$DL_FILE_FULL

Reserved for future use.

$DOWNLOAD

Setpoint was downloaded to a specified point.

$DYN_CFG

Dynamic configuration enable/disable has been performed by a specified user.

$LOGIN_DISABLED

Specified use failed to log in to the specified CIMPLICITY project.

$LOGON

Specified user has logged in to a specified CIMPLICITY project.

$LOGOUT

Specified user has logged out of a specified CIMPLICITY project.

$RTR_LINK_DOWN

Router link has been lost to specified node.

DEMO_SPEED

Carwash Demo speed alarm is generated.

Indexes, Columns, Rowsin the EVENT_LOG Table

Indexesinthe EVENT_LOG include a:

* Primary key index on the joined timestamp and sequence number columns.

* Secondary key index on the joined timestamp_utc and sequence number columns.
+ Secondary index on the timestamp alone.

+ Secondary index on the timestamp_utc aone.

If you have selected the project name table attribute, the primary key index also includes the project

name column.

The primary key includes an MSEC column, if milliseconds is enabled.

Columns and rows in Event logging tables are as follows:

Column Name Data Type Description

Constant fields

timestamp date/time Timestamp of the logging event.

timestamp_utc date/time UTC timestamp of the logging event.
sequence_number number Identity column to ensure uniqueness.

alarm_id string CIMPLICITY alarm identifier.

alarm_class string CIMPLICITY alarm class associated with the alarm.
resource string CIMPLICITY resource associated with the alarm.
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logged_by string CIMPLICITY process that logged the alarm.
reference string Reference information for the alarm logged.
alarm_message string Message associated with the alarm.
generation_time date/time Timestamp the alarm was generated.

generation_time_utc | UTC date/time | UTC timestamp the alarm was generated.

Optional fields

project string Name of the CIMPLICITY project

msec number Actual number of milliseconds in the timestamp

Step 2. Add Event Alarms through the Database L ogger
1. Do one of the following in the Database Logger Configuration window or the EVENT_LOG
window.

In the Database L ogger Configuration window

a Select EVENT_LOG
b. Do one of the following:

Method 1
Click the Add Item button on the Database Logger Configuration window toolbar.

Method 2

a. Click Edit on the Database Logger Configuration window menu bar.
b. Select Add Alarms...

Method 3

a. Right-click EVENT_LOG.
b. Select Add Alarms... from the popup menu.

Inthe EVENT_LOG window

Do one of the following.

Method 1

Click the Add Item button on the EVENT_LOG toolbar.

Method 2

a. Click Fileonthe EVENT_LOG menu bar.
b. Select Add Alarms...
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Method 3

a Right-click in the EVENT_LOG window.
b. Select Add Alarms... from the popup menu.

The Select an Alarm Definition browser opens when you use any method.

2. Select the Alarm IDs you want to add.

3. Click OK.
The aarms display in the EVENT_L OG window and will be logged according to your specifications.

Step 3. Configure Event Alarm Logging Properties

Sep 3. Configure Event Alarm Logging Properties

Y ou configure the event logging properties for all dlarmsin the EVENT_LOG Table Properties
dialog box. (Y ou can adjust the logging conditions for asingle alarm in the Alarm Properties dialog
box.). .).

Step 3.1 | Open the EVENT_LOG Table Properties dialog box.

Step 3.2 | Configure event logging attributes.

Step 3.3 | Configure EVENT_LOG maintenance events.
(page

Step 3.4 | Configure EVENT_LOG maintenance actions.

Step 3.5 | Configure the EVENT_LOG connection.

Step 3.6 | Advanced event logging configuration.

Sep 3.1. Open the EVENT_LOG Table Properties Dialog Box

1. Either:
» Select EVENT_LOG in the Database L ogger Configuration window, or
* Open (page 121) the EVENT_L OG window.
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2. Do one of the following.
Method 1
Click the Table Properties button on either window's toolbar.

Method 2

a. Click Edit on either window's menu bar.
b. Select Table Properties...

Method 3

a. Right-click EVENT_LOG in the Database Logger Configuration window or any alarm in
the EVENT_LOG window.
b. Select Table Properties... from the popup menu.

Result. The EVENT_LOG Table Properties dialog box opens when you use any method.

Sep 3.2. Configure Event Logging Attributes

Logging Attributesfor aCIMPLICITY EVENT_LOG table enables you to log the name of the
CIMPLICITY project.

1. Select the Logging Attributes tab in the EVENT_LOG Table Properties dialog box.
2. Check Project nameto log the project name.

0 Tip: Click Use Defaultsto set the logging attributes to their default value. The
EVENT_LOG will be set to not log the Project Name.

0 Warning: If you select or de-select the project name table attribute you must drop the table
so that it is properly recreated with or without the new project field as part of the primary key.
Failing to do so can cause the database logger to fail to log datainto the table.

Sep 3.3. Configure EVENT_LOG Maintenance Events

Maintenance Events define when export, purge, and command actions will be performed on the
table. .

Y ou can specify that maintenance be triggered when:

* A condition, such aslow disk space, occurs or
» On aperiodic or gated interval
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1. Select the Maintenance Eventstab in the EVENT_LOG Table Properties dialog box.

2. Specify events the same way you specify them for an DATA_LOG (page 153).

Sep 3.4. Configure the EVENT_LOG Maintenance Actions

Maintenance Actions define the type of actions that take place when a Maintenance Event occurs.

Y ou can configure an event table to:

* Export records to an export file,
« Purge records from alogging table and/or
* Incorporate command line actions.

1. Select the Maintenance Actions tab in the event log Table Properties dialog box.

2. Specify actions the same way you specify them for adatalog (page 155) table.

Sep 3.5. Configure the EVENT _LOG Connection

Connection defines the database connection and the Store and Forward properties for the table.

Do one of the following.

+ Use the default connection.
« Specify logging connection specific to the EVENT_LOG table.

Use the default connection
1. Select the Connection tab in the EVENT_LOG Table Properties dialog box.

2. Check Use default alarm connection.

Result: The Connection tab is dimmed and unavailable for configuration. The event log uses the
properties specified on the Default Alarm Connection tab in the Logging Properties dialog box.

Specify logging connections specific to the EVENT_LOG table

3. Select the Connection tab in the EVENT_LOG Table Properties dialog box.

4. Clear Use default point connection.

5. Do custom connection configuration the same way you do for adatalog (page 157) table.
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Sep 3.6. Advanced Event Logging Configuration

The Advanced tab in the EVENT_LOG Table Properties dialog box enables you to:

+ Disable logging actions for the table that you are configuring.

« Override the queue size that is specified in the Database Logger's Logging Properties dialog
box.

* Select and control bulk insertion for Microsoft SQL Server or MSDE.

1. Select the Advanced tab in the EVENT_LOG Table Properties dialog box.

2. Do advanced configuration the same way you do for aDATA_LOG (page 157) table.

(1) Important: For SQL Server, insert triggers fire only if bulk insertion is disabled.

Step 4. Configure Logging Conditions for a Single Event Alarm

1. Select the alarm you want to log under different conditions from the default.
2. Do one of the following.

Method 1

Double-click the selected Alarm ID.

Method 2

Click the Item Properties button on the EVENT_L OG toolbar.

Method 3

a. Click Edit onthe EVENT_LOG menu bar.
b. Select Alarm Properties...

Method 4

a. Click the right mouse button.
b. Select Properties... from the popup menu.

The Alarm Properties dialog box opens when you use any method displaying either the default
logging conditions or conditions that were previously checked for the selected alarm.

3. Check the logging conditions that apply to the selected alarm.

4. Click OK.
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The selected alarm will be logged in the EVENT_LOG when its logging conditions occur.

Event Management Logging
Event Management Logging

The CIMPLICITY Database L ogger enables you to keep arecord of event management event actions
using the EM_L OG table. When the event triggers actions that have been selected to be logged, the
Event Manager sends a message to the logger to log..

The steps to configure the event actions logging properties include

Step 1 | Add event actions to the EM_LOG.
(page
190)

Step 2 | Configure EM_LOG properties.

(page
191)

Indexes, Columns and Rowsin EM_LOG Tables

Indexesin EM logging tablesinclude a

* Primary key index on the joined timestamp and sequence number columns.

+ Secondary key index on the joined timestamp_utc and sequence number columns.
« Secondary index on the timestamp alone.

« Secondary index on the timestamp_utc alone.

If you have selected the project name table attribute, the primary key index also includes the project
name column.

The primary key includes an MSEC column, if milliseconds is enabled.

Columns and rows in EM logging tables are as follows.

Column Name | Data Type Description

Constant fields

timestamp date/time Timestamp of the logging event.

timestamp_utc date/time UTC timestamp of the logging event.

sequence_number | number Identity column to ensure uniqueness.

time string Local timestamp of the previous time the point was logged.

time_utc string UTC timestamp of the previous time the point was logged.
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Column Name | Data Type Description

event_type string The type of Event Manager event associated with the event source.
event_source string Identifier that triggered the event.

action_type string The type of Event Manager action associated with the action source.
action_target string Identifier of the action's target.

Optional fields

project string Name of the CIMPLICITY project.

msec number Actual number of milliseconds in the timestamp.

Review Maintenance Events

Review Maintenance Events for CIMPLICITY::

* ALARM_LOG. See Step 3.4. Configure Alarm Log Maintenance Events (page 179).

* COR_LOG. See Step 2.2. Configure Status Log L ogging Maintenance Events (page 196).

« Datalog table. See Step 2.4. Configure Logging Maintenance Events (page 153).

* EM_LOG. See Step 2.3. Configure Event Management L ogging M aintenance Events (page
193).

* EVENT_LOG. See Step 3.3. Configure EVENT_L OG Maintenance Events (page 186).

* Group log table. See Step 2.4. Configure Group Maintenance Events (page 168).

« An external application log. See Application Logging (page 198).

Review Maintenance Actions

Review Maintenance Actionsfor CIMPLICITY :

* ALARM_LOG. See Step 3.5. Configure Alarm L og Maintenance Actions (page 180).

* COR_LOG. See Step 2.3. Configure Status Log L ogging Maintenance Actions (page 197).

« Datalog table. See Step 2.5. Configure the L ogging Maintenance Actions (page 155).

* EM_LOG. See Step 2.4. Configure Event Management L ogging Maintenance Actions (page
193).

* EVENT_LOG. See Step 3.4. Configurethe EVENT_LOG Maintenance Actions (page 187).

* Group log table. See Step 2.5. Configure Group Maintenance Actions (page 168).

» An externa application log. See Application Logging (page 198).

Step 1. Add Event Actionsto the EM_LOG

1. Expand the Basic Control Engine folder in the Workbench left pane.

2. Double-click Event Editor.
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The Event Editor window opens.

3. Select the Event ID in the |eft pane to which you want to attach the action.

4. Left-click the Action ID column.

5. Open the New Event-Action dialog box using any of the following methods.
Method 1
Click the New Event_Action button on the CIMPLICITY Event Editor toolbar.

Method 2

a. Click Fileon the CIMPLICITY Event Editor menu bar.
b. Select New Event_Action.

Method 3

a. Click the right-mouse button in the right pane.
b. Select New Event_Action from the popup menu.

Method 4
Press Ctrl+N on the keyboard.

The New Event-Action dialog box opens when you use any of these methods.

6. Enter aname for the Action ID.
7. Check Log Flag.

8. Click OK.

When the selected event triggers the action, the Event Manager sends the data to the Database
Logger.

Step 2. Configure EM_L OG Properties

Sep 2. Configure EM_LOG Properties

Y ou configure the event action logging propertiesin the EM_LOG Properties dialog box.

The tasks to configure the Event Management action logging properties include:

Step 2.1 | Open the EM_LOG Properties dialog box.

(page
192)
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Step 2.2 | Configure logging attributes.

Step 2.3 | Configure maintenance events.

Step 2.4 | Configure maintenance actions.
(page

Step 2.5 | Configure the EM_LOG connection.
(page

Step 2.6 | Configure advanced properties for the EM_LOG.

Sep 2.1. Open the EM_LOG Properties Dialog Box

1. Select EM_LOG in the Database Logger Configuration window.
2. Do one of the following.
Method 1
Click the Table Properties button on the Database L ogger Configuration window toolbar.

Method 2

a. Click the right mouse button.
b. Select Properties... from the popup menu.

Method 3

a. Click Edit on the Database Logger Configuration window menu bar.
b. Select Table Properties...

The EM_LOG Table Properties dialog box opens when you use any method.

Sep 2.2. Configure Event Management Logging Attributes

Logging Attributes for an EM_LOG enables you to log the name of the CIMPLICITY project.

1. Select the Logging Attributes tab in the Table Properties dialog box.

2. Check Project nameto log the project name.
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© Tip: Click Use Defaults to set the logging attributes to their default value. The EM_LOG
will be set to not log the Project Name.

@ Warning: If you select or de-select the project name table attribute you must drop the table

so that it is properly recreated with or without the new project field as part of the primary key.
Failing to do so can cause the database |ogger to fail to log data into the table.

Sep 2.3. Configure Event Management Logging Maintenance Events

Maintenance Events define when export, purge, and command actions will be performed on the table.

Y ou can specify that maintenance be triggered when:

* A condition, such as low disk space, occurs or
* On aperiodic or gated interval

1. Select the Maintenance Eventstab in the EM_L OG Table Properties dialog box.

2. Specify actions the same way you specify them for a datalog (page 153) table.

Sep 2.4. Configure Event Management Logging Maintenance Actions

M aintenance actions define the type of actions that take place when a Maintenance Event occurs.

Y ou can configure the EM_L OG table to:

« Export records to an export file

« Purge records from alogging table and/or
* Incorporate command line actions.

1. Select the Maintenance Actions tab in the Event Manager Log Table Properties dialog box.

2. Specify events the same way you specify them for adatalog (page 155) table.

Sep 2.5. Configurean EM_LOG Connection

Connection defines the database connection and the Store and Forward properties for the table.

Do one of the following.

+ Use the default connection.
« Specify logging connection specific to the EM_LOG table.
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Use the default connection

1. Select the Connection tab in the EM_LOG Table Properties dialog box.
2. Check Use default point logging.

Result: The Connection tab is dimmed and unavailable for configuration. The EM_LOG uses
the properties specified on the Default Alarm Logging tab in the Logging Properties dialog box.

Specify logging connections specific to the EM_LOG table

3. Select the Connection tab in the EM_LOG Table Properties dialog box.
4. Clear Use default point connection.

rect 0, 43, 330, 72 (page 158)
rect 1, 184, 409, 277 (page 159)
rect O, 70, 408, 186 (page 158)

5. Do custom connection configuration the same way you do for adatalog (page 157) table.

Sep 2.6. Do advanced EM LOG Configuration

The Advanced tab in the EM_LOG Table Properties dialog box enables you to:

+ Disable logging actions for the table that you are configuring.

« Override the queue size that is specified in the Database Logger's Logging Properties dialog
box.

* Select and control bulk insertion for Microsoft SQL Server or MSDE.

1. Select the Advanced tab in the EM_LOG Table Properties dialog box.

2. Do advanced configuration the same way you do for adata log (page 157) table.

(1) Important: (For SQL Server) insert triggers fire only if bulk insertion is disabled.

Satus Log Logging
Status Log Logging

The CIMPLICITY Database L ogger enables you to record a project's status log messages to the
COR_LOG database table in addition to the cor_recstat.cl2 filein the project’ s\log directory. The
project is scanned periodically, and any records added to it are also added to the COR_L OG table.
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To configure Status Log logging, you must:

» Step 1. Enable Status Log Logging (page 195)

* Step 2. Configure COR_L OG Properties (page 196)

« Step 3. Configure Scan Time (page 198)

Indexes and Columnsin COR_LOG Tables

Indexesin COR_L OG tables include the following:

* A primary key index in the joined timestamp_utc and sequence number columns.
* A secondary key index in the joined timestamp and sequence number columns.

* A secondary index in the timestamp_utc alone. Thisisthe clustered index for the table.

The columns and rowsin COR_LOG tables are as follows:

Column Name | Data Type Description

timestamp datetime Timestamp of the logging event.

timestamp_utc datetime UTC timestamp of the logging event.
sequence_number | number Identity column to ensure uniqueness.

date_time datetime Date/Time field in Status Log.

project varchar(21) Name of the project from where this Status Log record originated.
severity int Severity field in the Status Log.

pid int Process id of the process logging the Status record.
process varchar(33) Process field in the Status Log.

procedure varchar(33) Procedure field in the Status Log.

status int Status field in the Status Log.

reference int Reference field in the Status Log.

code int Code field in the Status Log.

source varchar(21) Source field in the Status Log.

message varchar(1024) | Message field in the Status Log.

Step 1. Enable Status Log Logging

1. Inthe CIMPLICITY Workbench window, select Project, and then select Properties.

2. Inthe Project Properties window, in the General section, select the Database L ogger : Status
L og option.
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|=/ Note: Thiswill enable the Database Logger : A&E & App option.
Status logging is now enabled.
Step 2. Configure COR_LOG Properties

Sep 2. Configure COR_LOG Properties

The CIMPLICITY Database Logger enables you to keep arecord of event management event actions
using the EM_L OG table. When the event triggers actions that have been selected to be logged, the
Event Manager sends a message to the logger to log..

The steps to configure the event actions logging properties include:

» Step 2.1. Accessthe COR_LOG Properties Dialog Box (page 196)

* Step 2.2. Configure Status L og L ogging Maintenance Events (page 196)
« Step 2.3. Configure Status L og L ogging Maintenance Actions (page 197)
* Step 2.4. Configure the COR_LOG Connection (page 197)

* Step 2.5. Perform advanced COR_L OG Configuration (page 197)

Sep 2.1. Accessthe COR_LOG Properties Dialog Box

1. Inthe CIMPLICITY Workbench window, in the |eft pane, expand Proj ect, and then select
Database L ogger .

2. Double-click the Database L ogger file.
3. Inthe Database L ogger Configuration window, select COR_LOG.

4. Select Edit, and then select Table Properties. Alternatively, you could select , or right-click,
and then select Properties. Y ou can now access the COR_LOG Properties dialog box.

Sep 2.2. Configure Satus Log Logging Maintenance Events

The Maintenance Events section defines when the export, purge, and command actions will be
performed on the table. Y ou can specify that maintenance is triggered when either a condition, such
as low disk space, occurs; or a periodic or gated interval of time passes. Use these steps to configure
mai ntenance events.

1. Inthe COR_L OG Table Properties dialog box, select the M aintenance Eventstab.

2. Specify actions the same way you specify them for a data log table, as described for Point Data
Logging in Step 2.4. Configure Logging Maintenance Events (page 153).
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Sep 2.3. Configure Status Log Logging Maintenance Actions

The Maintenance Actions section defines the type of actions that take place when a maintenance
event occurs. You can configure the COR_L OG table to: Export records to an export file, Purge
records from alogging table, and/or Incorporate command line actions. Use these steps configure
maintenance actions for atable.

1. Inthe COR_LOG Table Properties dialog box, select the Maintenance Actions tab.

2. Specify events the same way you specify them for a datalog table, as described for Point Data
Logging in Step 2.4. Configure L ogging Maintenance Events (page 153).

Sep 2.4. Configure the COR_LOG Connection

The Connection section defines the database connection and the store and forward properties for the
table. Do one of the following: Use the default connection, or Specify logging connection specific to
the COR_LOG table.

Use the default connection

1. Inthe COR_L OG Table Properties dialog box, select the Connection tab.

2. Select the Use default alarm connection check box.
The COR_LOG table now uses the properties specified in the Default Alarm Connection section
in the Logging Properties dialog box.

Specify logging connections specific to the COR_LOG table

1. Inthe COR_L OG Table Properties dialog box, select the Connection tab.
2. Clear the Use default alarm connection check box.

3. Perform the custom connection configuration, and store and forward configuration asit is
done for adata log table, as described for Point Data Logging in Step 2.4. Configure Logging
M aintenance Events (page 153).

Step 2.5. Perform advanced COR_LOG Configuration

The Advanced section in the COR_LOG Table Properties dialog box enables you to: Disable

logging actions for the table that you are configuring, Override the queue size that is specified in the
Database Logger's Logging Properties dialog box, and Select and control bulk insertion for Microsoft
SQL Server. Use these steps to perform advanced configuration.

1. Inthe COR_L OG Table Properties dialog box, select the Advanced tab.
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2. Perform advanced configuration the same way you specify them for a data log table, as
described for Point Data Logging in Step 2.4. Configure L ogging Maintenance Events (page

153).

(1) Important: For SQL Server, insert triggers are fired only if bulk insertion is disabled.

Step 3. Configure Scan Time

The Status Log fileis periodically scanned to check for records that have been added to it since the
last scan. The COR_LOG_RP_SCAN_TIME global parameter represents the period over which the
scan is performed. The default value is 300 seconds, and the minimum value is 15 seconds. Use these
stepsto set the COR_LOG_RP_SCAN_TIME global parameter.

1. Inthe CIMPLICITY Workbench window, in the left pane, expand Pr oj ect, expand
Advanced, and then select Project Parameters.

2. Inthelist of parameters, double-click COR_LOG_RP_SCAN_TIME, enter avalue, and then
select OK.

Note: If you enter avalue lessthan 15 seconds, the value is automatically set to 15 seconds.
the parameter is not found, the default value of 300 secondsis set.

it

Application Logging
Application Logging

Application Logging enables you to log actions of certain CIMPLICITY applications, such asthe
Basic Control Engine. To take advantage this feature, you must configure an Application Table for
the product option.

The application chooses what data to log and when to log it.

0 Tip: You can configure the following properties for an Application logging table.

« Logging attributes.
» Maintenance actions.
« Maintenance events.
« Logging properties.

Follow the same steps that you follow for the EM_LOG (page 189) .

Indexes, Columns, Rows in Application Logging Tables



Advanced Features | 2 - Logging and Archiving | 199

Indexesin Application logging tables include a:

* Primary key index on the joined timestamp and sequence number columns.

+ Secondary key index on the joined timestamp_utc and sequence number columns.
+ Secondary index on the timestamp aone.

+ Secondary index on the timestamp_utc alone.

If you have selected the project name table attribute, the primary key index also includes the project
name column.

Columnsin Application logging tables include:

» Columns that are specific to that table.
» An additional column for each table attribute you have selected.

Rowsin al Application logging tables include:

* A timestamp column.
* A timestamp_utc column
 An auto increment sequence number that ensures that each row is unique.

Proficy Historian Migration

Historian Migration

* Overview
« Historian migration configuration steps

Overview

When you update CIMPLICITY logging to use the Historian logging database, you can preserve
previously logged data by using the Proficy a Migration tool.

The Historian Migration utility migrates all or selected data from the previously used |og database,
e.g. CIMPLICITY SQL, to Historian.

Tablesthat can be migrated are:

- DATA_LOG
- ALARM_LOG
- EVENT_LOG

Y ou can migrate as many records that the Historian license permits.
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Tables that cannot be migrated include:

» SPC tables
*« GROUP_LOG

Historian Migration Configuration Steps
Migration is straightforward.

When you open the Historian Migration tool, you open a migration session. Y ou specify what

data you want migrated. When the datais migrated and you close the Historian Migration tool, the
migration session is ended. If al of the data you want to migrate has been migrated you may not use
the tool again. If there is more data to migrate, you can simply, re-open the tool, select your criteria
and migrate your selection.

|=/ Note: The previously used database will not be removed after migration.
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Historian Migration Mapping

(1) Important: There are some differencesin how dataisidentified between the CIMPLICITY and
the real-time Collector.

The following lists define how datais mapped from CIMPLICITY to Historian to resolve these
differences.

* DATA_L og migration mapping.
* ALARM_LOG and EVENT_LOG migration mapping.
* Mapping guidelines.
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DATA_LOG migration mapping

The Historian Migration utility maps data from the CIMPLICITY DATA_LOG to Historian as

follows.

1 Quality mapping
(page
201)

Data Type mapping

N
Q
D

201)

Point/Tag attributes mapping

Data attribute mapping

[ N w
I Qo
D (0]

202

Quality Mapping

CIMPLICITY Quality Attribute Value

Historian Quality, Subquality

IS_AVAILABLEand IS_IN_RANGE and
STALE=FALSE

Good, ihOPCNonspecific

IS_AVAILABLE and IS_IN_RANGE and
STALE=TRUE

Good, ihOPCLastKnowValue

NOT IS_AVAILABLE

Bad, ihOPCCommpFailure

NOT IS_IN_RANGE

Bad, ihOPCOutOfService

DISABLE_WRITE ALARMED
ALARMS_ENABLED

No effect on Historian quality No effect on Historian quality No effect on
Historian quality

USER Qualityflags

Bad, ihOPCNonspecific

Data Type Mapping

CIMPLICITY Point Types

Historian Data Type

BOOL SINT INT USINT

Integer Double integer Double integer Double integer

REAL UDINT

Double float Double float

DINT UINT

Double Integer Double Integer

STRING STRING_20 STRING_8 STRING_80

Variable String Variable String Variable String Variable String

3D_BCD 4D_BCD BYTE

Not supported Not supported Not supported

Point/Tag Attribute Mapping
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CIMPLICITY Historian
Point_id Tagname
_ENG Engineering Units

FROM SQL Table | DataType

Data Attribute M apping

CIMPLICITY | Historian

Timestamp | Timestamp

_VAL Value

_QUALITY | Quality

|5/ Note: Hi and Lo Engineering Units do not exist in CIMPLICITY SQL table; thesefields are
ignored during the migration.

ALARM LOG and EVENT_LOG migration mapping

During the Historian migration fieldsin the ALARM_LOG and EVENT_LOG are mapped to be
consistent with fields provided by the OPC Alarm & Event server.

CIMPLICITY Historian

alarm_message Description

Project, resource, alarm_id | Source (project/resource/alarm_id)

timestamp TimeStamp

generation_time Endtime Condition Subcondition Event Category

HIGH,MED,LOW,$SYS Severity Quality

Mapping Guidelines

* Al ar niType isasfollows.

AlarmType When read from

ihALARM_CONDITION | ALARM_LOG table

ihALARM_SIMPLE EVENT_LOG table

» Condi ti on and SubCondi t i on are asfollows.

For the: Condition and Subcondition

Alarm log Exist, only for the Alarm log.
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Tag alarm | Are set to Level to match the real time collector.

System tag | Use System.

* Event Cat egor y use the following.

For the: EventCategory

Tag alarm Level"

System alarm | System

* Severi ty isconfigurable by user.

Default mapping is as follows.

CIMPLICITY | Historian

HIGH $SYS | 850

MED 500

LOW 150

* Dat aSour ce iSPEAE_M GRATI ON.
* Sour ce is combination of project/resource/alarm_id.

Step 1. Open the Historian Migration Utility

1. Right-click any icon in the Database Logger Configuration window's list.
2. Select Migration... on the Popup menu.

Step 2. Select Datato Migrate

1. Click File on the Historian migration utility menu bar.
2. Select either of the migration options.

rect 3, 41, 113, 63 (page 203)
rect 3, 61, 113, 81 (page 204)

A | Migrate all tables

Migrate al available tablesin the SQL database to Historian.

Available tablesinclude:
 DATA_LOG
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- ALARM_LOG
-« EVENT_LOG

1) Important: SPC log tables and GROUP_L OG tables are not included in the migration.

B | Choose & migrate

Migrate a subset of tables.

Choicesinclude the following.

rect O, 25, 177, 139 (page 204)
rect 178, 39, 373, 117 (page 204)
rect 180, 117, 375, 195 (page 204)
rect 64, 290, 154, 327 (page 204)
rect 156, 292, 237, 326 (page 204)

1| Tables One or more of the available tables can be selected for migration.

available for
migration

2 | Start Time Date | Month/Day/Year of data that should be selected as the first data in the migration.
Note: Click the Down Arrow button to open a calendar on which you can make the
selection.

Default | 1/ 1/1969
Time Hour:Minute Second (AM or PM) of data that should be selected as the first
data in the migration.
Default | 1:01:01 AM
The default date and time migrates all data up to the selected end time.

3 | End Time Date | Month/Day/Year of data that should be selected as the last data in the migration.
Note: Click the Down Arrow button to open a calendar on which you can make the
selection.

Default | Current date.
Time Hour:Minute Second (AM or PM) of data that should be selected as the last
data in the migration.
Default | Current time.
The default migrates data from the start date to the most current.

4 [ OK Closes the Select tables to migrate dialog box. The migration begins as soon as the dialog

box is closed.

5 | Cancel Cancels the migration.
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(1) Important: The same start time and end time are used for each selected table during the
migration session. The selections apply to the one migration session only. Once compl eted,
settings revert to the default settings.

Migration occurs after you select either option. A status bar displays migration progress.

Step 3. Enter Advanced Migration Specifications
Click Options>Configuration on the Historian migration utility menu bar.

The Migration options dialog box opens.
Configuration options are as follows.

rect -1, 11, 222, 148 (page 205)
rect 221, 70, 410, 149 (page 207)
rect 220, 9, 409, 72 (page 206)
rect 2, 203, 434, 254 (page 206)
rect 0, 146, 223, 197 (page 206)

Historian server options
a

Time options

Logfile Options

BE"|BE"|EBE™

4 Data & tag add options
(page

206)

5 Alarm severity mapping
(page

207)

6 Read/write options
(page

208)

1 | Historian server options
Option Description

Server Historian Server name.

name
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Default

« Blank if the CIMPLICITY Server is different from the Historian Server.

« CIMPLICITY Server if the Historian Server is the same as the CIMPLITY Server.

Username

Valid Historian user name. If the name is not recognized by Historian, the migration will fail.

Password

Password required for the specified Historian user. If the password is incorrect, the migration will fail.

Event rate/

Number of data per second that can be sent to the Historian Server. Note: This can be used to slow data

second flow for Historian Server processing requirements.
No limitation 0
Default 10000

2 | Time options

Treat as DST timestamp directs CIMPLICITY to do the following.

Checked

Converts the time stamp entered when the data was logged from Local to Universal Tmestamp format.

Clear

Leaves the time stamp in the designated Local format.

3 | Lodfile options

Logfile options provide instructions for logfile maintenance.

Option

Description

Filename

Location and name of the file that contains the log data.

Default ...\Project Path\Project Name\Log\<Logfile.log>

Log migrated samples | Checked | Every sample sent to Historian is logged on screen

Clear Samples sent to Historian are not logged on screen.

Default Clear

Overwrite logfile Checked | Overwrites the existing log file with data from the last migration.

Clear Creates a new logfile for the current migration.

Default Checked

4 | Data &

tag add options

Tags and values that already exist in Historian can be overwritten if specified.

Checkbox

Description
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Overwrite | Checked | Overwrites the tag properties in Historian if the tag name already exists in Historian. Associated
existing tag properties are:

tags
« datatype

+ Sourceaddr(projectname\PointID.VALUE)
« Engineering Unit (if available).

Clear If the tag name already exists in Historian, the migrating tag's properties will not written to
Historian. Note: If the tag's properties already in Historian are different from the properties of
the tag that will be migrated, the new tag properties will not be migrated to Historian.

Default Clear

Overwrite | Checked | Overwrites the existing values for the existing Historian tag.
existing
values

Clear Appends new values for the existing Historian tag in the Historian log.

Default Checked

5 | Alarm severity mapping

* A CIMPLICITY project
Has the following default classes for its alarms.
« LOW
*« MED
* HIGH
« $SYS
*« SACAL
May have one or more user defined alarm classes.

» The OPC Alarm & Event Server defines alarm categories as integers, not strings.

During migration CIMPLICITY aarm classes are mapped to the integer value entered in the LOW,
MED and HIGH fields..

Field | Description (after migration)

LOW | The LOW alarm class is identified as the entered value.

Default 150

MED | The MED alarm class is identified as the entered value.

Default 500
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HIGH | The following alarm classes are identified as the entered value.

* HIGH
« SYS
« User defined alarm classes

Default 850

6 | Read/write options

Read/write options provides the tools to validate the migration.

Checkbox | Description

Write Checked | Writes values to Historian during the migration.
values to
server
Clear A simulation is conducted to determine if the data can get written from CIMPLICITY logging to

Historian. Values are not actually written to Historian during the migration.

Default Checked

Read Checked | Enables validating data if it was written successfully and can be read. When the migration is
values complete a window will open for validation purposes. Important: Validation reads each tag and
its data back from Historian. This process can be very time consuming.

Clear Validation is not performed for reading values.

Default Clear

Step 4. View Migration Reports

A migration progress summary displays in the historian migration utility window during the
migration session after each migration.

© Tip: Click File>Clear Display on the Historian migration utility menu bar to clear the window.

More detailed migration information is included in the following.

» Migration log file
 Data migration report

Migration Log File
1. Click File on the Historian migration utility menu bar.

2. Select View log file.

Thelog file that is named in the Migration options dialog box opens in Notepad.
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The file displays details of the last migration during the open session.

Data Migration Report

|=/ Note: Make sure you check Read Values (page 208) in the Migration Options dialog box
if you want the Migration report to open when the migration is completed

The Data migration report includes the following columns.

CIMPLICITY columns are:

* Timestamp
* Point_ID

« VAL

« QUALITY
* RES

* Project

« ENG

« ALRM

Historian columns are:

* Timestamp

» Tagname

» Value

* Quality

* QualitySub

Note: Historian quality is OPC quality.

s

Database Logging Management

About Database Logging Management

» ODBC configuration.

+ Database management for SQL Server.
* About creating tables.

* Table characteristics.

+ Database-disconnect-recovery.

(1) Important: The Microsoft Access (As-Is product) ODBC driver is only supported on Intel-
based computers.
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ODBC Configuration
ODBC Configuration

When you install CIMPLICITY if you:

* Install the (M SDE) database server option, a Microsoft SQL -compatible database server, the
ODBC driver will be SQL Server data sources.

* Do not install the server, CIMPLICITY redistributes ODBC using Microsoft data access
components.

Y ou do not need to purchase or configure additional software to use these drivers.

ﬂ Tip: Install the database server because, asa SQL server, it provides better scaling when you
want to go to amore robust SQL server to support Enterprise type solutions.

For improved performance and network extensibility, you may wish to log to a third-party database
product such as Microsoft SQL Server or Oracle.

ODBC Drivers and Data Sources for Database Logging Overview

ODBC Drivers and Data Sources for Database Logging Overview

An overview of ODBC configuration options for database logging includes:

» ODBC drivers.

* CIMPLICITY default ODBC data sources.
» Custom ODBC data sources.

» ODBC configuration and moving projects.

ODBC Drivers for Database Logging

ODBC Applications use an ODBC driver to communicate with database applications. The drivers
supported for use with the CIMPLICITY Database Logger are:

Driver Description

Microsoft Access (As-Is product) An entry-level database which requires no additional
software to use.




2012, 2014, 2016

Microsoft SQL Server or Microsoft SQL Server Express A high-performance database for larger applications.
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You must purchase SQL Server to use this driver.
Supported SQL versions are:

* SQL Server 2012, 2014, 2016
* SQL Server 2008 can be used but is no longer
supported.

Important: SQL Native Client is not currently supported.

Oracle ODBC Driver

A high-performance database for large applications.

L=

Note: These drivers are supported on CIMPLICITY supportedoperating systems.

CIMPLICITY Default ODBC Data Sources

An ODBC Data Source is a specific configuration of an ODBC driver. When you install the
CIMPLICITY Database Logger, several data sources are automatically configured:

Data Source

Description

CIMPLICITY
Logging - Alarms

If you:

« Installed the database server when you installed , this data source will use the Microsoft SQL
Server driver and log onto the local SQL server.

« Did not install the database server, the data source uses the Microsoft Access (As-Is product)
driver to log to CIMPLOG.MDB in your distribution ARC directory.

CIMPLICITY
Logging Points

If you:

« Installed the database server when you installed , this data source will use the Microsoft SQL
Server driver and log onto the local SQL server.

« Did not install the database server, the data source uses the Microsoft Access (As-Is product)
driver to log to POINTLOG.MDB in your distribution ARC directory.

CIMPLICITY SQL
Server Logging

The data source uses the Microsoft SQL Server driver to log to an on-node (local) SQL Server.

Custom ODBC Data Sources

Y ou may configure additional data sources on your computer, or customize the data sources that are
configured by CIMPLICITY installation. However, you must observe the following restrictions:

* Use only supported ODBC drivers. Other drivers may not meet the data requirements of
CIMPLICITY software.

* Because CIMPLICITY runsasaservice, it must use system data sources.

» Remember that data sources are not part of your CIMPLICITY project, and will not
automatically follow a project that is taken to a different node.

» Be aware of any driver-specific restrictions (below) which may apply.
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|5/ Note: If you want to trend Logged or Logged Point data that is stored in a remote database, you
must add a custom data source to each Viewer.

ODBC Configuration and Moving Projects

If you copy a project to another computer, the ODBC configuration associated with that project will
not be automatically copied.

« If the project uses the default CIMPLICITY data sources, you may need to modify your
configuration depending on whether the default data sources use SQL Server or Access (As-Is
product).

Note: Normally there will not be any additional configuration. However, if you install CIMPLICITY
differently on one machine from a machine to which you move the project, you may need to adjust
the new machine.

Example

Y ou installed the database server on Machine A. However, you did not install the database server on
Machine B. Y ou moved the project to machine B. CIMPLICITY logging expects to log to Access
(As-Isproduct). In fact it won't because ODBC is pointing to the SQL database server. Y ou will need
to re-configure Machine B to point to the correct data source.

« If the project uses custom data sources, these must be re-configured on the target machine.

SQL Server Data Sources Configuration

1. Click Start on the Windows task bar.
2. Select Settings>Control Panel.
3. Click the ODBC Sourcesicon .

The ODBC Data Source Administrator dialog box opens.

4. Select the System DSN tab.

5. Select either:
* CIMPLICITY Logging - Alarms or
* CIMPLICITY Logging - Points.

6. Click Configure.

A first Microsoft SQL Server DSN Configuration wizard displays.
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7. Configure the first Microsoft SQL Server DSN Configuration wizard as follows:
a. Select the Server asfollows:

For Select

The local machine | One of the following:
* (Local)
¢ Machi ne Nane\ Proficy

A remote machine | The computer name from the drop down list.

a. Click Next.

A second Microsoft SQL Server DSN Configuration wizard opens.

8. Configure the second Microsoft SQL Server DSN Configuration wizard as follows:

Feature Check
A | Authenticate the login With SQL Server authentication using a login ID and password entered by the user.
ID
B | Connect to SQL Connect to SQL Server to obtain default settings for the additional configuration
options.
Enter Description
Login ID Valid for the selected SQL Server.
Password Required with the log in ID.
9. Click Next.

10. Finish configuration leaving the defaults on the remaining dialog boxes.

Microsoft Access (As-Is Product)Data Sources Configuration

1. Run the ODBC Administrator (from the ODBC program group) or select the ODBC option
from the CIMPLICITY supportedWindows Control Panel.

2. Click System DSN to select the list of System Data Sources.
3. Click Add... to add anew data source.

4. Select Microsoft Access Driver from the list, and click OK.
5. Enter aunique Data Sour ce Name.

Use any combination of letters, numbers, and white space; but avoid punctuation characters.

6. Enter a Data Source Description, if desired.
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7. Either:
* Click Select... to select an existing database file, or
* Click Create... to create anew .MDB file.

8. Specify afile name In the Select Database or New Database dialog, and click OK.
9. From the ODBC Microsoft Access Setup dialog, click Options.
10. Verify that Exclusiveis not checked.
11. Configure separate data sources for CIMPLICITY Point Logging and Alarm Logging.

|=/ Note: Dueto file locking issues in the Microsoft Access driver, you must never request
Exclusive access to a database that is used by CIMPLICITY for logging. In addition, the Point
Logging and Alarm Logging data sources must refer to different database files.

Oracle Configuration Guidelines

» ODBC versions are neither forward nor backward compatible.
« Database aliases configured on the client node should also be configured on the server node.

Note: Configuring the aliases on both nodes helps avoid confusion about the database name.

» The Oracle server's | P address must be in the CIMPLICITY computer's HOST fileif DNS or
Wins resolution is not being used.

* In the ODBC Datasource Administrator dialog box, use the Microsoft ODBC for Oracle Driver
and enter the database alias name in the Server Name field.

« Starting with Oracle 9i, the Oracle services are started by default.

Oraclefor CIMPLICITY Configuration

Oracle for CIMPLICITY Configuration

Step 1 | Turn on Allow Service to Interact with desktop.

jpage
214)

Step 2 | Setup CIMPLICITY software to log to an Oracle database.
(page
215)

Sep 1. Turn on Allow Service to Interact with Desktop

1. Open the Control Panel.
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2. Double-click Services.

The Services dialog box opens.

3. Either:
» Double-click CIMPLICITY Servicein thelist of services, or
* Click Startup....

The (CIMPLICITY) Service dialog box opens.

4. Select System Account in the Log On As box.
5. Check Allow Serviceto Interact with Desktop.
6. Click OK.

The (CIMPLICITY) Services dialog box closes.

7. Click Close.

The Services dialog box closes.

Sep 2. Setup CIMPLICITY Software to Log to an Oracle database.

1. Install the Oracle9i or 10g Server on a clean machine.

2. Install HMI SCADA - CIMPLICITY 7.0 on adifferent machine that hasa CIMPLICITY
supported operating system.

3. Install the Oracle 9i or 10g Client on the CIMPLICITY 7.0 Server.

Important: The required Oracle client version isv9.2.08 or above. Any version lower than
9.2.08 is not supported.

Note: Theinstallation is a standard Oracle installation.

Consult Oracle documentation for details.

4. Open the ODBC Data Source Administrator through the Microsoft Control Panel.
5. Select the DSN tab.

6. Click Add.
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A Create New Datasource dialog box opens.

7. Create a data source for one of the following.

Important: Make sure the driver isinstalled before you attempt to configure the data source.

Oracle OraHome92 driver

Microsoft ODBC for Oracle driver

Data Direct 5.1 for Oracle driver

Oracle OraHome92 driver

a. Select the Oracle In OraHome92 driver in the Create New Data Source list of drivers.
b. Click Finish.

An Oracle ODBC Driver Configuration dialog box opens.
a. Enter the following.

Option Description

Data Source Name | Name that identifies the data source, e.g. Oracle_DSN_Test.

Description (Optional) Description to help users identify the data source.

TNS Service Name | <HostName>_<ServerName> selected from the drop down list. Where

HostName = SID created while installing Oracle 9i/10g server on Server machine.

ServerName = | Oracle server name.

User ID Name must be an authorized user, created during the Oracle 9i/10g server installation.

a. Click Test Connection.

An Oracle ODBC Driver Connect dialog box opens, displaying the Service Name and User
Name.

a. Enter avalid password (that goes with the user ID).

Note: The password was created during the Oracle 9i/10g Server Installation.
a. Click OK.

A Connection Successful message box opens.
a. Click OK.

A new DSN is created and listed in System DSN list.

Microsoft ODBC for Oracle driver

1. Select the Microsoft ODBC for Oracle driver in the Create New Data Source list of drivers.
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2. Click Finish,
A Microsoft ODBC for Oracle Setup dialog box opens.

1. Enter the following.

Field Description

Data Source Name | Name that identifies the data source, e.g. Oracle_DSN_Test.

Description (Optional) Description to help users identify the data source.

User Name Name must be an authorized user, created during the Oracle 9i/10g server
installation, e.g. <HostName>_<ServerName>

HostName = SID created while installing Oracle 9i/10g server on Server machine.

ServerName = | Oracle server name.

Server Name of the Oracle Server.

A new DSN is created and listed in System DSN list.

|5/ Note: A valid password will be required when the ODBC data source is selected in the Database
Logger's Logging Properties (page 130) dialog box.

Data Direct 5.1 for Oracle driver

1. Select the Data Direct 5.1 Oracle driver in the Create New Data Source list of drivers.
2. Click Finish.

An ODBC Oracle Driver Setup dialog box opens.

1. Enter the following.

Field Description

Data Source Name | Name that identifies the data source, e.g. Oracle_DSN_Test.

Description (Optional) Description to help users identify the data source.
Server Name Oracle server name, e.g. <HostName>_<ServerName>
HostName = SID created while installing Oracle 9i/10g server on Server machine.

ServerName = | Oracle server name.

Client Version Oracle version used for the client.

1. Click Test Connect.
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A Log onto Oracle dialog box opens displaying the Server Name.

1. Enter the following.

Field Description

User Name | Authorized User ID.

Password | Valid password (that goes with the user ID).

1. Click OK.
A Connection Successful message box opens.
1. Click OK.

A new DSN is created and listed in System DSN list.
Oracle Software Requirements

The Oracle client software must be installed in the same computer asthe CIMPLICITY software.

Database Management for SQL Server
Database Management for SQL Server

Database management for SQL server includes:

* Configuring additional locks.

* Checking if Microsoft SQL Server Serviceis running.
» Handling default database server limitations.

+ Handling the transaction log.

Additional Locks Configuration

If the SQL Server generates an error that looks like this on rollover:
Error #S1000 SQL SERVER hasrun out of locks. Re-run your command when ...

Y ou can do the following to increase the number of locks:

1. Open the SQL Enterprise Manager in the Microsoft SQL Manager program group.
2. From the Server menu, select SQL Server, then Configure. The Server Configuration/Options
dialog opens.
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3. Inthe Server Configuration/Options dialog, select the Configuration page.
4. Find locksin thelist.

5. Increase the number of locks.

6. Select OK.

7. Exit the SQL Enterprise Manager.

The change takes place the next time the SQL Server is restarted.

Check if Microsoft SQL Server Serviceis Running

1. Expand the Database L ogger in the Workbench left pane.
2. Double-click Service Manager.

The SQL Server Service Manager dialog box appears.
3. Click the Start/Continue button, if it is enabled, to start the Microsoft SQL Server.

Default Database Server Limitations

The default Database Server has the following limitations:

» The maximum per database is 2 Gigabytes.
« Performance begins to degrade after 5 connections.

Connections can include:

1. Alarm Logging (DLRP).
2. Point Logging (PTDL).

When forwarding data (in store and forward), forward is a separate connection to the database.

3. Alarm Logging forward connection.
4. Point Logging forward connection.

If the table is enabled for bulk insertion, bulk insertion requires a dedicated connection to the
database in order to work. As aresult, maintenance actions for bulk insert tables will need to
allocate a separate connection. Once the action is completed, it will free the connection.

5. Bulk insertion maintenance action.

6. Bulk insertion forward connection.



Advanced Features | 2 - Logging and Archiving | 220

If there are too many tables enabled for bulk insertion there, resulting in too many connections
at once, there will be a performance degrade.

If your system configuration regularly exceeds 5 connection, it is recommended that you
upgradeto CIMPLICITY SQL, which isamore robust server.

Transaction Log

All SQL Server transactions are logged to the Transaction Log file. The Transaction Log contains an
audit trail by default and can grow to be quite large. To conserve disk space consider doing one of
the following:

» Use atruncated Transaction Log by default.
» UseaCIMPLICITY maintenance action truncate the Transaction Log periodically.

Truncate the Log as a System Default

1. Open the SQL Enterprise Manager in the Microsoft SQL Manager program group.
2. From the Manage menu, select Databases. The Manage Databases dialog opens.

3. In the Manage Databases dial og, double click on the database used by the CIMPLICITY
Database Logger. The Edit Database dialog opens.

4. In the Edit Database dialog, select the Options tab.
5. Select the Truncate L og on Checkpoint option.
6. Click OK.
7. Close the Manage Databases dialog.
Result: The change takes place the next time the SQL Server is restarted.

Truncate the Log asa CIMPLICITY Maintenance Action

8. Open the Database Logger in the CIMPLICITY program group.
9. Select atable from thelist of tables.

10. Open the Table Properties dialog for the table.

11. Select the Maintenance Actions tab.

12. In the Command Action field, enter:
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dump transaction DATABASENAME with no_log
This command will dump the Transaction Log without saving the log.

If you want to save the log to afile, see your SQL Server documentation on how to do this.

13. Select the Maintenance Events page.
14. Configure the event that will trigger the action.

This change takes place the next time you update the project’s configuration and then restart the
project.

It is recommended truncating the log as a system default.

todo: To set truncatethelog as a system default:

=

15. Open the SQL Enterprise Manager.

16. Select the database you are logging to.
17. Right-click on the database.

18. Select Properties from the popup menu.
19. Select the Options tab.

20. Make sure that Truncate Log On Checkpoint is checked.

Create Tables
Create Tables

When a project is started, the Database Logger creates any tables you have configured for that
project based on the attributes you have specified. This means you don't have to know anything about
databases to log data from your CIMPLICITY project.

Specifically, when a project starts, the Database L ogger will:
* Attempt to create or repair any missing or damaged databases.
* Create any missing tables.
* Create any missing columns in the tables.

Microsoft Access (As-Is Product)Note
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To successfully create or repair tables, the Database Logger requires an exclusive lock on the Access
database. If another application is using the Access database, the Database Logger cannot exclusively
lock the database, and it will terminate. If this happens, the following message will be logged in the
Status Log for the project:

Unableto repair database

This problem occurs, for example, if auser is running reports on the Access database while a project
is being started.

Table Characteristics

The Database Logger tables have the following characteristics:

Column De€finitions

The following columns are defined for each type of log file:

« Data logging tables contain a timestamp and Point ID column, plus an additional column for
each table and point attribute you have selected. The number of columns is independent of the
number of pointsin the table. For example, if you have atable that logs the point value and
previous value for al points configured for datalogging, the table will have four columns.

« Alarm, Event, and Application logging tables have columns that are specific to that table,
plus an additional column for each table attribute you have selected. All table rowsinclude a
timestamp column and an auto-increment sequence number that ensures that each row is unique.

* Group logging tables contain a timestamp column, plus an additional column for each table and
point attribute you have selected. For example, if you have atable logging the value and alarm
state of five points, the table will have eleven columns.

Note: Points with Engineering Units conversion are stored in floating point format

Key Definitions
Thefollowing keys are defined for each type of log file:

« Group logging tables have a unique primary key index on the timestamp column. If you have
selected the project name table attribute, the primary key index also includes the project name
column.

« Datalogging tables have a primary key index on the joined timestamp and Point ID columns,
and a secondary index on the timestamp alone. If you have selected the project name table
attribute, the primary key index also includes the project name column.

« Alarm, Event, and Application logging tables have a primary key index on the joined timestamp
and sequence number columns, and a secondary index on the timestamp alone. If you have
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selected the project name table attribute, the primary key index also includes the project name
column.

(1) Important: Since the Microsoft Access (As-Is product) format and Oracle do not support
sub-second timestamp data, you cannot log points to a Data or Group table at sub-second rates.
Attempting to do so will cause the duplicate-keyed records to be dropped from the database.

Database-Disconnect-Recovery
Database-Disconnect-Recovery

If the Database L ogger |oses its connection to a database, it generatesaDB_CONN_DOWN aarm.
When it successfully reconnects to the database, the alarm is cleared.

Y ou can control the amount of:

Time to wait between connection requests. Reconnect wait period.

Data to be saved locally then forwarded to the database when the reconnection is made. | Store and forward.

Reconnect Wait Period

Y ou can use the Reconnect wait period to define the amount of time to wait between connection
regquests whenever the Database logger |oses its connection to the database. Each time a reconnect
request fails,aDB_CONN_DOWN aarm is generated.

Y ou can define a separate wait period for the Alarm Logging and Point Logging.

After the database connection is reestablished, if you have also enabled the Store and forward
feature, al of the stored datais automatically forwarded to the database.

|=/ Note: The DB_CONN_DOWN alarm is not stacked by default, but you can change it in Alarm
Configuration.

Store and Forward

Sore and Forward

The Store and Forward feature is available for supported databases. This feature lets you write
records for Alarm Logging and Point Logging to storage files whenever the Database L ogger 10ses
its connection to the database.

When the Database Logger successfully reconnects to the database and Store and Forward is
enabled when the Database L ogger starts, the Database L ogger checks for stored data files (that
is, .SQL files) in the storage directory. If it findsfiles, it generatesaDB_START_FORWARD aarm
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then checks the files for stored data. If thereis no stored datain the files, the Database L ogger logs
the following message to the Status L og:

No forward data found in <store_path>
and clearsthe DB_START_FORWARD aarm.

If there is data to forward, the Database L ogger goes through each file and forwards the data to the
database. When all the data has been forwarded, or if the Database L ogger loses its connection to the
database, it clearsthe DB_START_FORWARD aarm and stops processing the storage files.

|=! Note: Stored data and new logged data are sent in parallel to the database, and all Maintenance
actions are ignored while data is being stored.

After afileisforwarded to the database, the Database L ogger sends the following message to the
Status Log:

Forward: <file_name> succ: <no_suc> fail <no_fail>
If there are failures, the following message will also be logged:
Forward: Seelog <filename> for errors.

If the Database L ogger cannot process a SQL statement in a storage file, it generates alog file
with the same name as the storage file and the extension .LOG. The log file contains the statement
forwarded to the database and the error message returned by the database.

If the Database L ogger encounters no problems when forwarding data, no .LOG fileis generated.

|=/ Note: If you have Store and Forward enabled and storage files exist when you shut down the
Database L ogger and you then disable Store and Forwar d, the Database L ogger will not forward
records from the storage files when it restarts.

Y ou can open a storage file and examine its contents in, for example, Notepad.

(1) Important: Store and Forward is supported only for local Microsoft Access (As-Is product)
databases, not remote Access databases.

Sore and Forward Enabled

When you enable this feature, you can choose to store an unlimited, or a maximum number of
records in the storage file for the database. Y ou can define separate storage options for Alarm
Logging and Point Logging.

« If you choose to store unlimited records, the Database Logger continues to save data records
until it runs out of disk space. The following message is then logged in the Status Log:
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Unabletowriteto store and forward file, <filename>

and the Database L ogger continues to try to save additional records.

« If you choose to store a maximum number of records, the Database L ogger saves the configured
number of records then stops, and the following message is logged to the Status Log.

Number of stored records exceeded maximum <max_no>

The records are stored in one or more filesin a storage directory. The number of files depends on the
maximum number of records you select and the maximum number of records per file.

Sore and Forward File Names

For Alarm Logging and Point Logging storage files, the default directory is % SITE_ROOT%\arc,
and the default maximum number of records per fileis 100.

The filenames for the storage files have the following format:

<pr cnan®>_<dbnsi d>_<dat e>_<t i ne>
. sql
Where
<prcnam> is process name
Example
For point logging (group and data logs), the process nameis MAC_PTDL .
For alarm logging, the process nameis MAC_DL
<dbms_id> isthe database's DBMSID,
<date> is the date and
<time> isthe time the file was created.
Example
MAC_PTDL_$PTLOG_ 20000913 174548.SQL

How Maximum Number of Records Works
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Once the maximum number of records have been stored, the Database Logger will not store any
more records until it can forward some of the currently stored records.

For example, you configure Store and Forward for a maximum of five records.

« After the Database Logger loses its connection to the database, it stores five records and logs the
"Number of stored records exceeded" message to the Status L og:

* The Database L ogger then reconnects to the database and is able to forward three of the stored
records before it loses its connection again.

* The Database Logger will now store three records and log the "Number of stored records
exceeded" message to the Status Log:

If the Database Logger is shut down, and there are still records in the storage files, when the
Database logger restarts, these records are not counted against the maximum. Under these conditions,
you can have more than the maximum number of records stored to disk.

|=/ Note: Y ou specify the maximum number of stored records on the Connection tabs in the
Database Logger Logging Properties dialog box.

Change Directory and Record Defaults

The default directory for Store and Forward filesis % SITE_ROOT%\arc, and the default
number of records per fileis 100. Y ou can change both of these defaults.

(1) Important: Please consider carefully when changing the maximum number of records per
stored file. Setting too high a number will result in unmanageable files, while setting too low a
number will cause excessive disk I/0.

1. Click Tools>Command Prompt on the Workbench menu bar.
2. At the command prompt type:

cd master

idtpop dbms_def

notepad dbms_def.idt

Thefilelookslike this;

|-* IDT file generated by IDITPOP utility v1.0
* RECORD: DBMS _DEF ODBC Dat abase Definitions

[ 0 DBVS I D Nane of the database/service
for |ogging

[ 1 driver ODBC nane of DMBS dri ver

[ 2 connect _string Connection string for ODBC

dri ver



3 wait_period
4 wait_units
5 store_forward
6 store_path
7 recs_per _file
8 limted
recs

* % Xk % X

*

Advanced Features | 2 - Logging and Archiving | 227

reconnect wait period
reconnect wait period units
O=of f 1=on

path of stored file

max recs per stored file
O=unlimted store el se max num

$LOGE NG M crosoft Access Driver <*.mdb>|-
DSN=CI MPLI CI TY Al ar m Loggi ng; Ul D=adni n; DBQ=BSM ROOT: \ ar c

\ CI MPLOG. MDB| - 1| 0] 0] | 100| 0. 000000

$LOGE NG M crosoft Access Driver <*.mdb>|-
DSN=CI MPLI CI TY Poi nt Loggi ng; U D=adni n; DBQ=BSM ROOT: \ ar c

\ PO NTLOG. MDB| - 1| 0] O] | 100| 0. 000000

Note that the Alarm Logging and Point Logging databases have separate records.

3. To define anew path for the stored records for a database, enter the pathname in the store_path
field for the database. Y ou can set a different path for each database.

4. To define a new maximum number of records per stored file for a database, enter the new
maximum in therecs per_filefield for the database. Y ou can set a different maximum for each

database.

5. Exit Notepad and save the updated file.

6. Enter the following commands to regenerate the data file and close the command window:

scpop dbsm_def

exit

7. Shut down your project, perform a Configuration Update, and then restart the project.

This change to takes effect when the project restarts.

CIMPLICITY Log Files

About CIMPLICITY Log Files

CIMPLICITY software consists of alarge number of interrelated programs. Not all programs are run
interactively by users. The non-interactive programs, therefore, cannot report problems directly to a
user'sterminal. Instead, they use the various log files available on the system.
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Project log files

Y ou can find these log filesin your project's log directory. All messages related to a project are
logged to thesefiles.

These files include:

CIMPLICITY Version File File Name
Lower t than CIMPLICITY Status Log cor_recstat.clg
v9.0

CIMPLICITY v9.0 and higher | Status Log

All CIMPLICITY versions All CIMPLICITY processes other than user processes *.out and *.err
All CIMPLICITY versions Backup for all CIMPLICITY processes other than user *.out_<n> and
processes *err_<n>.
|5 Note:

« If aproject has been upgraded from an earlier CIMPLICITY version both the cor_recstat.clg
and cor_recstat.cl2 fileswill be available.

If cor_recstat.cl2 was used a new file should be cor_recstat_1.cl2, etc.

» The message |lengths (page 234) for the status log files are as follows.

cor_recstat.clg | 80 characters

cor_recstat.cl2 | 1024 characters.

« If along point ID that isbeing used in CIMPLICITY applicationsis deleted, error messages
displayed in acor_recstat.cl2 log that are associated with that long point ID will display the
internally generated short point ID (32 characters or less) instead of the long point ID created by
the user.

Notes:

» Examples of applications that might be using the long point ID are CimView, Trend, an event
in the Event Editor.

» The message will report that there is a request for a nonexistent point; the reported point 1D will
be the short point ID.
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System log files

Y ou can find the system log filesin the .\<CIMPLICITY Installation>\log directory under your
main CIMPLICITY directory. All system messages are logged to these files.

These files include:

CIMPLICITY Version File File Name

Lower t than CIMPLICITY v9.0 | System Status Log | cor_recstat.clg

CIMPLICITY v9.0 and higher System Status Log | cor_recstat.cl2

All CIMPLICITY versions Router w32rtr.out and w32rtr.err

Usethefollowing to view log files.

Use To view information in

Status Log Viewer | Status Log files for projects or the system.

Notepad .out, .out_<n>, .err, and .ERR_<n> files for projects.

Set the Maximum Records Allowed in the Cor _Recstat.clg/
Cor_Recstat.cl2

Y ou can set the maximum number of records allowed in the status log file.
1. Make sure that no CIMPLICITY processes are running.
2. Open each of the following files.

.A<CIMPLICITY Ingtallation>\data\Data\log_names.cfg
...<CIMPLICITY Installation>\bsm_data\log_names_data.cfg

..\<Project Installation>\data\log_names.cfg

Note: Thisfile needsto be edited in each project's directory, for al involved projects.

3. Add the following lines to each of the files identified above.
LOG_MAXRECORDS| S| def aul t | 10| 1000
LOG_MAXRECORDS| P| def aul t | 10| 1000

Where
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Component Description

LOG_MAXRECORDS | Command for maximum records.

S System

P Project

default Makes the entries the default.

10 Length of the string that can be changed.
Default 10

1000 Maximum number of records that can be listed in the CIMPLICITY Log Viewer window.
Note: The view can be filtered (page 237) so the records you need to review will be
listed.
Default 1000

Comment The maximum number of records has been successfully tested up to 16,000. Note:
When there are large records the Log Viewer takes time to populate this high number.

|5/ Note: If you have an existing cor_recstat.clg or cor_recstat.cl2 and:

Increase maximum
records

The existing records are retained.

Decrease maximum
records

If the log contains a greater number of records, the cor_recstat.cl2 (or cor_recstat.clg)
is re-initialized.

Examine Satus Log, Output, and Error Files

Examine Status L og, Output and Error Files

Y ou can resolve problems by examining the various log filesin order to identify

* Errors.
* Error sources.

« Other relevant logging information.

(page
231)

Step 1 | Open the Status Log Viewer.

(page
233)

Step 2 | Review Status Log Viewer tools.

(page
236)

Step 3 | Work in the Status Log Viewer
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N 92}
o
LIS

(Optional) Check System Output and Error Files

t
(page
246)

(Optional) Check Process Output and Error Files

9]
D
()]

Step 1. Open the Status Log Viewer

Sep 1. Open the Satus Log Viewer

Option Open a project Status Log.
1.1 (page
231)

Option Open the system Status Log.

1.2 (page
233)

1.1. Open a Project Satus Log

CIMPLICITY provides several methods to open a project Status Log.

» Workbench
 Start menu

Workbench

1. (Optional) Select Project>Status L og in the Workbench left-pane.
2. (Optional) Select cor_recstat.clg in the Workbench right-pane.

3. Do one of the following.

A | Click Tools>Status Log on the Workbench menu bar.

B | Click the Status Log button on the Workbench toolbar.

D | In the Workbench right-pane:

Either Or

Double-click COR_RECSTAT.cl2. a. Right-click COR_RECSTAT.CL2.
b. Select Open on the Popup menu.

|5 Note: If the project has been upgraded from a version lower than CIMPLICITY v8.2
COR_RECSTAT.CLG will also be listed in the Workbench right-pane.

E | Press Ctrl+L on the keyboard.
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10.

11.

12.

13.

Result: The Project status log displays in the Status Log viewer.

|=/ Note: The cor_recstat.cl2 file will open automatically when the Status L og button or
Tools>Status Log menu is used.

An additional option to open the COR_RECSTAT.clg (page 229) log fileis asfollows.

. Right-click COR_RECSTAT.CL2.
. Select Open on the Popup menu.

. Do either of the following.

* Select Log>Select Log onthe CIMPLICITY Log Viewer menu bar.
* Click the Open File button on the CIMPLICITY Log Viewer toolbar.

The Find CIMPLICITY Log browser opens.

. Select the project's Log folder.
. Change the .cl2 to .clg extension in the File Name field.

. Click Open.

Result: The project's COR_RECSTAT.clg file will openinthe CIMPLICITY Log Viewer.

Start Menu

Click Start on the Windows Task bar.
Select (All) Programs>Proficy HMI SCADA - CIMPLICITY version>

Result:

« If the System Log was the last |og opened.

The System L og opens.

Click Log>Select Log on the Status L og window menu bar.
Select COR_RECSTAT.cl2 in the ...\<project name>\Log directory.
The selected status log opensin the Status L og window.

Tip: Changethe.cl2to .clginthe Find CIMPLICITY Log browser>File Name field you want
to open the COR_RECSTAT.clg (page 229) file.

* If aproject status log was the last log opened.
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The last used status |og opens.

Either review the open log or select another.

1.2. Open the System Satus Log

CIMPLICITY provides severa methods to open the system Status L og.

» Workbench
» Start menu

Workbench

1. Select Computer >System L og in the Workbench |eft-pane.
2. Select COR_RECSTAT.CL 2 in the Workbench right-pane.

3. Do one of the following in the Workbench right-pane.
* Double-click COR_RECSTAT.CL2.
* Right-click COR_RECSTAT.CL 2 select Open on the Popup menu.

Result: The system Status L og opens when you use either method.

Start Menu

4. Click Start on the Windows Task bar.
5. Select (All) Programs>Proficy HMI SCADA - CIMPLICITY version> Status L og.

Result:
« If the System Log was the last log opened.

The System Log opens.
« If aproject status log was the last 1og opened.

The last used status |og opens.
Click Log>View System Log on the Status L og window menu bar.

The System L og opens.

Step 2. Review Status Log Viewer Tools

Sep 2. Review Satus Log Viewer Tools
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2.1. Satus Log Columns

The CIMPLICITY Log Viewer screen displays the following information for each record that it finds
in the status log file:

Column Description

Date/Time | Date and time the message was logged.

Status Type of message. This can be: "Failure”, "Warning" or "Success".

Red Failure

Yellow Warning

Green Success

Process Name of the process that generated the log message.

Procedure | Name of the procedure that generated the log message.

Source Symbolic name for the error class.

Code Primary value used by software for expressing the type of error.

Reference | Number that can be used to determine the location of the condition that caused the error.

Message | Explanation of the condition that caused the log message.

Message 1024 characters (cor_recstat.cl2) Important: The message length in cor_recstat.clg,
Maximum which is available in upgraded projects, continues to be 80 characters.
Length

I I
|5/ Note: Guidelines

» The Procedure, Source, Reference, and Code fields are primarily for use by CIMPLICITY
support and should be reported if you are contacting CIMPLICITY support for troubleshooting
assistance.

* Thelist of messagesisinitially sorted in descending order (newest to oldest) by Date/Time.

Y ou can click on any of the column title buttons to sort the messages alphanumerically by that
message attribute.

Example
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To view all the messages generated by the MAC_PTDL process, click the Process header.
Result: All the messages generated by MAC_PTDL will be grouped together.

2.2. Satus Log Menus, Toolbars, Shortcut Keys

* Status Log menus.
* Toolbar buttons.
« Shortcut keys.

Status Log Menus

* Log menu.
* View menu.
* Help menu.

Log Menu

Option Description

View System Log | Displays the system log file.

Select Log Selects the log file you want to view.

Clear Current Log | Clears all messages from the current log file.

Save as Text... Saves the current contents of the Status Log file as a text file.

Export to CSV File | Exports contents of the open log to a .csv file format. to a csv (but is separated by |) and the

Print... Prints the contents of the Status Log file to a printer.
Print Preview... Shows you what your print request will look like.
Print Setup... Configures the printer, form and page setup for your Status Log print request.
Exit Exits the Status Log function.
View Menu

Option Description

All Displays all entries in the Status Log.

Entries

Filter Filters the entries by Status, Process, Procedure, Source, Reference, or Code.

Entries...

Find... Locates an entry based on the Status, Process, Procedure, Source, Reference, and Code information

that you enter.

Find If you already selected Find, this command locates the next entry based on the information you entered. If
Next you have not entered any Find parameters, this command locates the next entry in the log file.
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Detail... | Displays all of the detailed information for the selected log message.

Live
Upd

Automatically updates the Status Log list as messages are generated. You cannot display message details
ate when in this mode.

Refresh | Refreshes the Status Log list on request. This option is available when Live Update is disabled. In addition,

you can display message details when in this mode.

Toolbar | Enables/Disables the display of the Toolbar at the top of the screen.

Status Enables/Disables the display of the Status Bar at the bottom of the screen.
Bar
Help Menu
Option Description
Help Topics Displays the main Help window for the Status Log Viewer.
About Log Viewer... | Displays program information, version number, and copyright for Status Log Viewer.

Toolbar Buttons

A | Open | Selects a log file to view.

B | Save | Saves the active document.
C | Export | Exports the log to a .csv file.
D | Print Prints the active document.

Shortcut Keys

Sho

rtcut | Description

Ctrl+P Prints the contents of the Status Log file.

F3

Finds the next Status Log message that fits the search criteria.

Ctrl+D Displays details for the selected message.

Ctrl+L Enables/Disables Live Updates.

Ctrl+R Refreshes the display.

Step 3. Work in the Status Log Viewer

Sep

3.4. Work in the Satus Log Viewer

The

Status Log Viewer lets you locate messages that have a warning or failure status, and provides

information to help determine the source of the problem.

N ‘w
L
D

Filter status log messages.
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3.1. Filter the Satus Log Messages

The Status Log can be filtered to display a particular set of messages. The filter selection types
correspond to the CIMPLICITY Log Viewer columns.

Click View on the status log Viewer menu bar; select Filter Entries.
The Filter System Entries dialog box opens.
Options are as follows.

rect 0, 236, 22, 259 (page 238)
rect 0, 210, 22, 233 (page 238)
rect 0, 186, 22, 209 (page 238)
rect O, 161, 22, 184 (page 238)
rect 0, 133, 22, 156 (page 238)
rect O, 109, 22, 132 (page 238)
rect 0, 54, 22, 77 (page 237)
rect 219, 46, 241, 69 (page 238)

Option Description

A | Status Check one or more message status types.
» Success

» Warning

« Failure

Important: If you do not check at least one status type, no messages will display..
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B | Process

CIMPLICITY process that may require attention (e.g. CfgCab). Tip: Click the drop-down list to display
the list of processes that are currently in the log file and can be selected.

C | Procedure

Internal procedure (software module) name/names. Enter either of the following:

» An entire procedure name (e.g. PTMAP_add_pt_list).
« The first n characters (e.g. PTMAP).

Note: Procedures, which are more specific than processes, can help narrow the search for a problem.

D | Source

Selected error class name (e.g. COR_PM_ERR). Tip: Click the drop-down list to display the list of
sources that are currently in the log file and can be selected.

E | Reference

Exact number to determine the location of the condition that caused the error (e.g. 105).

F | Code

Exact primary value used by software for expressing the type of error (e.g. 25009).

G | Message

Message text associated with a log message. Note: The entry must be exactly as it appears in the
status log.

H | Buttons

Buttons do the following.

OK Log Viewer window displays with the filtered list of messages. If no messages match the
filter, the window is blank.

Cancel Closes the dialog box without filtering.

Clear>OK | Clears filtering and re-displays all status log messages

3.2. Find Satus Log Messages

1. The Find Status L og Messagesdial og box closes.

2. The next message in the status log that matches the filter is highlighted.
If no message is found, the highlight remains at the current message.

0 Tip: Onceyou have set the filtersin the Find System Entry dialog box and found the first
message that matches the filters, you can do either of the following:

* Select View>Find Next on the status log menu bar.
* Press F3

The next message in the configured direction that matches the filter is highlighted.

3.3. Display Satus Log Message Details

Details for any message can be viewed in aread-only dialog box.

Do any of the following for a selected message.

* Double-click the message.
* Press Ctrl+D.
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* Select View>Detail on the CIMPLICITY Log Viewer menu bar.

The Detail dialog box opens.

Message details are as follows.

rect 53, 250, 74, 271 (page 239)
rect 120, 108, 141, 129 (page 239)
rect 120, 84, 141, 105 (page 239)
rect 120, 60, 141, 81 (page 239)
rect 120, 36, 141, 57 (page 239)
rect 1, 157, 22, 178 (page 239)
rect 1, 132, 22, 157 (page 239)
rect 1, 107, 22, 132 (page 239)
rect 1, 82, 22, 107 (page 239)
rect 1, 58, 22, 83 (page 239)

rect 1, 35, 22, 60 (page 239)

This dialog box displays the following information

Field Description
A | Date Date the message was generated.
B | Time Time the message was generated.
C | Status The status of the reported process/procedure/source.
* Failure
* Warning
» Success
D | Code Primary value used by the software for expressing the type of error.
E | PID Process ID of the process that logged the message. Note: The number is displayed in both decimal
and hexadecimal format.
F | Error Explanation of the condition that caused the message to be logged.
Message
G | Process Process that logged the message (e.g. MAC_PTDP).

H | Procedure

Software module that logged the message (e.g. ptmdp_config_get_info).

I | Source: Error class nhame (e.g. COR_PTMAP_ERR).

j | Reference | Number passed by the procedure to assist in determining the location of the condition that caused the
error.

K | Buttons The buttons do the following.

Close Close the dialog box and return to the Log Viewer screen.

Previous | Display the previous message in the log file. Note: If you are at the first message in the file,
you will be asked if you want to continue from the end.
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(1) Important: If you are contacting CIMPLICITY support for troubleshooting assistance about a
particular message or set of messages, the information in these fieldsis of critical importance:

Next Display the next message in the log file. Note: If you are at the last message in the file, you

will be asked if you want to continue from the beginning.

» Status

» Code

* Process

* Procedure
 Source

» Reference

* Error Message

3.4. Print the Satus Log File

Printing a status log is similar to printing any other text document. Many printing features, of course,
depend on the printer type and model.

Printing can be initiated from either of the following.

* Print Preview window.
* Print dialog box.

Print Preview Window

A status log can be printed through the Print Preview window.

A benefit to using print preview is being able to determine what pages should be printed.
Click Log>Print Preview on the CIMPLICIT Log Viewer menu bar.

The Print Preview window opens; sections are as follows.

rect 1, 18, 24, 40 (page 240)
rect -1, 147, 22, 169 (page 241)
rect 36, 339, 59, 361 (page 241)

Item Description
A | Toolbar Standard print preview toolbar buttons include:
Print Opens the Print dialog box

Next Page | Displays the page after the current page.

Prev Page | Displays the page before the current page.

Two Page | Switches to a 2-page display.
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Zoom In Magnifies the current page.

Zoom Out | Reduces the current page.

Close Closes the Print Preview window; returns to the CIMPLICITY Log Viewer window.

B | Content Status log content in print page format.

C | Status Bar | Number(s) of the displayed page(s).

Print Dialog Box

The status log can be printed directly through the CIMPLICITY Log Viewer window or through the
Print Preview window.

Do one of the following.

* Click Log>Print on the CIMPLICITY Log Viewer menu bar.
* Press Ctrl+P on the keyboard.
« Click Print on the Print Preview window toolbar.

The Print dialog box opens.

Basic options are as follows.

Option Description

Name Currently selected printer. Click the dropdown list to select from the list of available printers.

Print Range | Print all of the status log messages or select pages. Notes

« If you applied a Filter (page 237) to the Status Log display, only the filtered
messages will print.
» Use the Print Preview window to determine what pages to print.

Copies Number of copies to print.

Print to file | Check to save the printout in a file in addition to printing.

Properties Opens dialog box to display and change printer properties.

OK Prints the status log or selected pages in the status log.

Cancel Cancels print.

|5/ Note: The header line on each page of the printout shows the computer name, the full path name
for the Status Log file and a page number.

3.5. Savethe Satus Log as a Text File

The Status Log files are binary files, and cannot be viewed directly.
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Y ou can, however, copy the contents of a Status Log file to atext file that you can view with atext
editor (e.g. Notepad).

This feature can be applied to both cor_Recstat.clg and cor_recstat.cl2 files.

1. Click Log>Save as Text on the CIMPLICITY Log Viewer menu bar.

The Save As dialog box opens.

2. Select the folder in which the file will be saved.
3. Enter anamein the File namefield.

Default: SYSTEM.TXT.

4. Click OK.

The text file displays the following.

A | First line of the text file shows the computer name and the full path name for the Status Log file.

B | Other lines display messages that were listed in the CIMPLICITY Log Viewer window when the file was saved.
Note: If you applied a Filter (page 237) to the Status Log display, only the displayed messages were saved to the
text file.

© Tip: Youcan

* Configure the CIMPLICITY project to create and automatically update an ASCI| text version of
the unfiltered Project Status Log.

Edit log_names.cfgin the DATA folder under the current folder.

Add the following line:

LOG ASCI | | Pldefaul t| 2] T

Add the line anywhere in the file, e.g. under Standard Logical Names,
Make sure thereis no asterisk at the start of the line.

The next time you start the project, CIMPLICITY will create atext file version of this status |og,
COR_STATUS.LOG, inthe project's Log folder.

CIMPLICITY keeps thisfile updated with the latest project status information.
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* Log system status to atext file with the same name in the ..\<CIMPLICITY Installation>\log
folder.

Add the same linge, above, to the file LOG_NAMES.CFG inthe ..\<CIMPLICITY Installation>\data
folder.

3.6. Export to a CSV File

Y ou can, export the contents of a cor_recstat.cl2 log to a CSV format.

|5/ Note: If you applied a Filter (page 237) to the Status Log display, only the displayed
messages will be exported.

1. Click Log>Export to CSV File on the CIMPLICITY Log Viewer menu bar.

The Save As dialog box opens.

2. Select the folder to which the file will be exported.
3. Enter anamein the File namefield.

Default: SYSTEM.CSV.

4. Click OK.

Result:: The CSV file, which can be opened in Excel, displays the following.

A | First line in the file shows the computer name and the full path name for the Status Log file.

B | Other lines display messages that were listed in the CIMPLICITY Log Viewer window when the file was

exported. Note: If you applied a Filter (page 237) to the Status Log display, only the displayed messages
were saved to the text file.

C | Pipes (|)separate information to emulate column breaks.

3.7. SHect a Different Satus Log to View

CIMPLICITY includes &

» System Status Log file.

* Project Status Log file for each project.
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When launched the Status Log Viewer opens either the System Status Log file or the Project Status
Log for the current project depending on the method used (page 231) . Y ou can, however, select a
different log file for display at any time (e.g. system status, current project status, or the status log for
another project).

Do one of the following:

*» Select Log>View System Log on the CIMPLICITY Log Viewer menu bar.
The System - CIMPLICITY Log Viewer displays.

* Select Log>Select Log onthe CIMPLICITY Log Viewer menu bar.

A Find CIMPLICITY Log File dialog box opens.

The CIMPLICITY Log Viewer can display CIMPLICITY Status Log files.cl2 and older .clg files.
Y ou can search the directory structure on any drive you are connected to for log files.

The default Status Log file nameis COR_RECSTAT.CL2.

Status Log files are generally found inthe . .\ <CIMPLICITY Installation>\ | og directory and in
each project log directory.

1. Locate thefileinthe. .\ <CIMPLICITY Installation>\ | og directory or a project log directory.
2. Click OK.

Step 4. (Optional) Check System Output and Error Files

Sep 4. (Optional) Check System Output and Error Files

The current set of w32rtr.out and w32rtr.err files for the Router may contain additional information if
you are experiencing problems with your CIMPLICITY software.

1. Stop the router.
The router must be stopped to examine these files.

@ Warning: All projects on the computer stop when you stop the router.

2. Open the Windows Explorer.

3. Select the Proficy CIMPLICITY\Log.
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Note: The default directory is C:\Program Files (86)\Proficy\Proficy CIMPLICITY\Log.

4. Check for:

A | w32rtr.err files with a size greater than 0. These files have data.

Example

w32rtr.err Newest .err file
w32rtr_1l.err Next newest backup
w32rtr_2.err Oldest backup.

B | w32rtr.out files with a size greater than 0. These files have data.

Example

w32rtr.out Newest .out file
w32rtr_1.out Next newest backup
w32rtr_2.out Oldest backup

5. Use Notepad to look at the contents of these files (right-click and select Open With... Then
select Notepad in the dialog box that appears).

0 Tip: Drag any one of these files from the Workbench Computer >System L og right-pane
into atext editor, e.g. Notepad, to view the contents.

Process Names in the Satus Log

Processes that |og messages in the Status L og include:

Name Description

AB_ETH<n> | Allen-Bradley Ethernet where <n> is the port number
Av<n> Alarm Viewer session where <n> is the session nhumber
Cf gCab Configuration

COvkn> Serial Devcom where <n> is the port number

C\kn> CIMVIEW session where <n> is the session number
CWen> CWSERYV session where <n> is the session number
MAC_AM Alarm Manager

MAC_DL Data Logger

MAC_DYN Dynamic Configuration Manager

MAC_ENRP Basic Control Engine
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MAC_PTDL | Point Data Logger

MAC_PTDP Derived Point Processor

MAC_PTM Point Manager

MAC_PTX Point Translator

PB Point Bridge

PDC DS Tracker Decision Control Data Server
PM_MCP Main Control Program

PRT_DC Tracker Data Collector

PRT_DS Tracker Data Server

PRT_GRD Tracker Graphic Display

PRTCLNT PRT Client Resident process

PRTCNT PRT Count Resident process

RCODB_RP RCO Resident process

TADB_RP TADB Resident process

TCPI P<n> Series 90 Ethernet where <n> is the port number

TCPRD<n> TCP/IP Redundancy where <n> is the port number

TRK_RP Tracker Resident Process

TRKEA<id> [ Tracker Collector Service Where id is the process ID

VB2RTR Message router

Step 5. Check Process Output and Error Files

Sep 5. (Optional) Check Process Output and Error Files

1. Stop the project that has the problem.
2. Open Windows Explorer.
3. Select the <project name>Folder>Log.

4. Check for:

A | .err files with a size greater than 0. These files have data.

Example

TCPIPO.err Newest file for this process.

TCPIPO_1.err Next newest backup.
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TCPIPO_2.err Oldest backup.

B | .out files with a size greater than 0. These files have data.

Example

COMO1.out Newest file for this process.
COMO01_1.out Next newest backup.
COMO01_2.out Oldest backup.

|=/ Note: Each .err and .out file can have up to two backups.

5. Use Notepad to ook at the contents of these files.

|=/ Note: You can only examine the newest.err and .out files while the project is not running.
Y ou can examine backup .err and .out files while the project is running.

© Tip: Drag any one of these files from the Workbench Pr oject>Status L og right-paneinto a
text editor, e.g. Notepad, to view the contents.

Basic CIMPLICITY Filenames and Associated Programs

Filename Associated Process

AB_ETH<n> | Allen-Bradley Ethernet device communications where <n> is the port number

COMO<n> Serial device communications where <n> is the port number

MAC_AM Alarm Manager

MAC_DL Data Logger

MAC_DYN Dynamic Configuration

MAC_EMRP | Basic Control Engine

MAC_PTDL | Point Data Logger

MAC_PTDP | Virtual Point Processor

MAC_PTM Point Manager

MAC_PTX Point Translation

MAC_UR User Registration

PB Point Bridge

PCIM<n> Genius device communications where <n> is the port number

TCPIP<n> Series 90 TCP/IP device communications where <n> is the port number.

TCPRD<n> | Series 90 TCP/IP redundancy where <n> is the port number.
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W32RTR Message Router

In addition to these files, you may also find files for alarm log printers and device communication
drivers.



Chapter 3. System Management

Server to Viewer File Deployment

About Server to Viewer File Deployment

The CIMPLICITY file deployment system provides the tools to automatically synchronize (page
250) selected files, including CimView screens, global scripts and global parameter files, from a
CIMPLICITY deployment server to its viewers.

* Deployment corefiles.
 Deployment configuration steps.

Deployment corefiles

Server to viewer deployment is based on two core files.

File

Description

gefdepl.dplcfg

A configuration file:

* Is created or modified when the deployment configuration is saved in the CIMPLICITY
Configuration Editor.

« Includes the details of the files that should be deployed, from where they should be deployed, to
whom they should be deployed, and when they should be deployed.

» Will be copied to the Viewers that are included in the synchronization.

NOTE: The location on the Viewer is in the installation\Data folder: <localhost>\Program Files
(x86)\Proficy\Proficy CIMPLICITY\Data

cimsync.exe

» Cimsync.exe is a standalone executable running under user context.

» When starting this executable, the user must be logged into the machine for the synchronization to
occur.

» Cimsync is located on each Viewer included in the synchronization, in the exe folder:

<localhost>\Program Files (x86)\Proficy\Proficy CIMPLICITY\exe
« In Terminal/Web Space servers, the user must log in with administrator credentials before

launching the cimsync.exe file, and must remain logged in for the synchronization to occur. Only
users connected to the Terminal/Web Space servers can see the changes.:

Deployment configuration steps
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Step Number Description

Step 1 (page Plan the deployment configuration
252)

Step 2 (page Configure deployment on the server.
254)

Step 3 (page Set up a deployment viewer.
289)

Deployment Overview

A deployment server can hold one or more folders with files that are automatically deployed to one
or more viewers whenever they are modified. The deployment insures that the viewers automatically

have the latest file version.

A summary overview of one deployment server synchronizing files with one viewer is as follows.

1 Deployment server setup.

(page
250)

2 Viewer setup.

(page
251)

3 CimSync.exe source files deployment.

(page
251)

4 CimSync.exe configuration file deployment.

(page
251)

Deployment server setup

The deployment server requires two basic components.

A | A shared folder with files that are periodically updated and need to be deployed to one or more viewers. Note:
The shared folder will be accessed by the Viewer by a UNC (page 251) path that is identified (page 261) in the
Deployment Configuration Editor.
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B | A shared folder with a configuration file, gefdepl.dplcfg, that lists the details of the deployment configuration.

|5 Note: Gefdepl.dplcfg is created on a CIMPLICITY server or Viewer and is always saved to the installation
\Data directory.

...\Program Files\Proficy\Proficy CIMPLICITY\Data. However, it can be used on any server designated as the
deployment server.

» The deployment server does not have to be a CIMPLICITY server.
» The configuration file location is entered in the file when it is being configured.

Viewer setup

The viewer requires four basic components.

A | A UNC path to the server's shared files folder. Notes

» The viewer must have read access to the deployment server source files folder.
* You can also map a drive to the folder; however it is recommended that you use a UNC path, which is not
dependent on each viewer.

B | A local folder with a configuration file, gefdepl.dplcfg, that lists the details of the deployment configuration.

Note: On the Viewer, this file must always be located in the installation \Data directory.

5=

...\Program Files\Proficy\Proficy CIMPLICITY\Data.

C | Alocal folder that holds the files for the viewer to use.

D | A file, CimSync.exe, that implements the deployment.

Note: This file is installed with CIMPLICITY.

=]

CimSync.exe sour ce files deployment

CimSync.exe does the following.

A | Detects changes or additions to files using the UNC path to the deployment server's source files folder.

B | (After a specified time period) Deploys the files to a temporary folder on the Viewer. Note: The temporary folder
insures that all the source files are transferred correctly and provides a more stable environment than the network
for them to be deployed. The files are deployed at one time to the target folder or folders. Updating all of the
involved files at one time will insure that the integrity of any dependence among them is maintained.

C | Deploys the file to the viewer's target file folder where it overwrites existing files and adds new files.

CimSync.exe configuration file deployment

CimSinc.exe does the following.

A | Detects a change in the gefdepl.dplcfg file using the UNC path to the deployment server's configuration file folder.
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B | (If the viewer is set to have the configuration file synchronized with the deployment server) Deploys it immediately a
temporary folder on the viewer. Note: The temporary folder insures that all the source files are transferred correctly
and provides a more stable environment than the network for them to be deployed. The files are deployed at one
time to the target folder or folders. Updating all of the involved files at one time will insure that the integrity of any
dependence between the configuration file and other files is maintained.

C | Overwrites the existing gefdepl.dplcfg version in the viewer's installation \Data directory.

D | Reads the new configuration file version and uses the new parameters from that point on.

Sep 1. Plan the Deployment Configuration

Step 1. Plan the Deployment Configuration

The key to developing a straight-forward deployment system isto map out the system's viewer/server
reguirements and specifications before beginning configuration.

Planning includes determining specifications for:

1.1
(page
252)

Plan configuration for selected viewers.

12
(page
253)

Plan configuration for a 'COMMON' Viewer

Step 1.1. Plan Configuration for Selected Viewers

The key to developing a straight-forward deployment system is to map out the following.

1 Identify the Deployment Server and Selected Viewers.

(page

252)

2 Identify what files require synchronization on selected viewers.

(page

253)

3 Identify what Viewers should have the configuration file automatically synchronized.
(page

253

I dentify the deployment server and selected viewer names.

Make a note of the names of the viewers that will be singled out for configuration and the
deployment server name.

A

Each viewer that will be singled out in the deployment must be identified with the exact name identified on the
Computer Name tab in the Windows System properties dialog box.
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B | The deployment server name must be the exact name identified on the Computer Name tab in the Windows System

properties dialog box.

I dentify files and folder sthat will be synchronized.

|dentify the following.

A | Exactly what files and/or file types on the viewer will require synchronization.

B | The target folder path on the viewer that holds the identified files. There can be more than one local path on a
viewer. Note: The temporary (page 251) folder on the viewer is automatically created.

C | Each shared folder on the deployment server that holds the source files that will be deployed to the viewer.

« There can be more than one folder on the server.
« Subfolders that can optionally hold files to be deployed.

Identify what Viewer s should have the configuration file automatically
synchronized.

Identify the following for each viewer.

A | The UNC path on the deployment server for viewers that should have the configuration file, gefdepl.dplcfg,
automatically updated. Notes

» The viewer must have read access to the Server folder to enable synchronization.
« The target folder on the viewer is always in the Installation \Data directory.
» The temporary (page 252) folder on the viewer is automatically created.

B | Viewers can have a configuration file that can only be updated manually because it will not be synchronized with the
server.
|5/ Note: Make sure the Viewers have enough hard drive space to support deployment.

Step 1.2. Plan Configuration for a'COMMON'Viewer

When the Viewer specifications are planned out, there may be several viewers that are the same.
These viewers can be grouped under a"COMMON' Viewer designation.

Group together viewers that have the same specifications.
a

Identify files and folders that will be synchronized.

Synchronize the configuration file.

N
[
i
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Group together viewersthat have the same specifications.

A | Viewers grouped under a 'COMMON' Viewer do not have to be identified by name.

B | The deployment server name must be the exact name identified on the Computer Name tab in the Windows System
properties dialog box.

I dentify files and folder sthat will be synchronized.

A | Exactly what files and/or file types on the common viewers will require synchronization.

B | The local (target) folder path on the viewers that hold the identified files. The local path must be the same for every
viewer included in the synchronization. Note: The temporary (page 251) folder on the viewer is automatically
created.

C | Each shared folder on the deployment server that holds the source files that will be deployed to the viewer.

« There can be more than one folder on the server.
« Subfolders that can optionally hold files to be deployed.

Synchronizethe configuration file.

A 'COMMON' viewer should use an automatically synchronized configuration file.

A | The target folder on the viewer is always in the Installation \Data directory.

B | The UNC path on the deployment server for viewers that should have the configuration file, gefdepl.dplcfg,
automatically synchronized with the server. Notes

» The viewer must have read access to the Server folder to enable synchronization.
» The temporary (page 252) folder on the viewer is automatically created.

Sep 2. Configure Deployment on the Server
Step 2. Configure Deployment on the Server

When the deployment configuration has been mapped out, the organization and parameters can be
identified and written to the gefdepl.dplcfg deployment configuration file.

CIMPLICITY provides a user interface, the CIMPLICITY Configuration Editor, in which you can
identify the configuration and save it to the gefdepl.dplcfg file.

Step 2.1 | Open the CIMPLICITY (Deployment) Configuration Editor.

(page
255)
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Step 2.2 | Create a new configuration file.

Step 2.3 | Identify the deployment server and file.

Step 2.4 | Identify 'COMMON' Viewer parameters and folders.
(page

Step 2.5 | Identify a selected viewer's parameters and folders.
(page

Step 2.6 | Complete configuration on the server.

Step 2.1. Openthe CIMPLICITY (Deployment) Configuration Editor

Sep 2.1. Open the CIMPLICITY (Deployment) Configuration Editor

* Open the CIMPLICITY (Deployment) Configuration Editor
* Review the CIMPLICITY (Deployment) Configuration Editor tools.

Open the CIMPLICITY (Deployment) Configuration Editor

Do one of the following.

» Start menu
» Workbench

Start Menu

1. Click Start on the Windows Task bar.
2. Select All Programs>HMI/SCADA CIMPLICITY version>Deployment Configuration.

Workbench

3. Select Computer>Deployment Configuration in the Workbench left pane.
4. Select Deployment Configuration in the right pane.

5. Do one of the following.

A | Click Edit>Properties on the Workbench menu bar.

B | Click the Properties button on the Workbench toolbar.
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In the Workbench left pane:

Either

Or

Double click Deployment Configuration.

a. Right-click Deployment Configuration.

b. Select Properties on the Popup menu.

In the Workbench right pane:

Either

Or

Double click Deployment Configuration.

a. Right-click Deployment Configuration.

b. Select Properties on the Popup menu.

Press Alt+Enter on the keyboard.

6. Right-click Deployment Configuration.

7. Select Properties on the Popup menu.

8. Right-click Deployment Configuration.

9. Select Properties on the Popup menu.

10. Select the option (page 259) that addresses your requirements.

11. Click Next.

2.1.1. CIMPLICITY Deployment Configuration Editor: Menus

The CIMPLICITY Configuration Editor menu bar includes the following features.

Note: The features display on both the server and viewer. However, some features apply to one or

the other.

rect 4, 1, 27, 36 (page 256)
rect 34, 1, 57, 36 (page 257)
rect 66, 1, 89, 36 (page 257)

rect 100, 1, 140, 36 (page 258)
rect 144, 1, 184, 36 (page 258)
1. File menu
Item Description Server | Viewer
1| New Creates a new configuration file. X X
2 | Save Saves the current configuration file X X
3 | Fetch from Opens a Fetch From Server browser to find and open a gefdepl.dplcfg file from X X

Server

the deployment server
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4 | Reload Refreshes the CIMPLICITY Configuration Editor display. X X

5 | Exit Closes the CIMPLICITY Configuration Editor. X X

1. Edit/Popup menus

A Popup menu can be opened (right-click) that is the same as the Edit menu when an entity is
selected but is not in edit mode.

Another Popup menu opens when an value is selected in edit mode.

Edit Menu/Popup
Item Description Server | Viewer
1| Cut Cuts a selected entity, e.g. a folder; the entity can be pasted in a selection X X
location.
2 | Copy Copies a selected entity, e.g. a folder; the entity can be pasted in a selected X X
location
3 | Paste Pastes a cut or copied entity in a selected location. A number is appended to the | X X

name. Example z:\ViewAll under the 'COMMON' viewer is copied and pasted
under a z:\View101 folder. The pasted name is z:\ViewAll(1).

4 | Delete Deletes the selected entity. X X
5| Add Adds a new entity, e.g. a viewer or folder to the tree. X X

Configuration

Object
6 | Rename Makes a selected entity available for editing. X X

Edit VValue Popup menu

Item Description Server | Viewer
1| Undo | Undoes the last action. X X
2 | Cut Cuts the value being edited; the selection can be pasted in a selected location. X X
3 | Copy | Copies the value being edited; the selection can be pasted in a selected location. X X
4 | Paste | Pastes a cut or copied value in a selected location. A number is appended to the X X

name. Example c:\ViewAll under the 'COMMON' folder is copied and pasted under a z:
\View101 folder. The pasted name is z:\ViewAll(1).

5 | Delete | Deletes the selected value. X X
6 | Select | Selects the entire value for editing. X X
All

1. View menu
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Item Description Server | Viewer
1 | Toolbar Select to: X X
Check Display the toolbar.
Clear Hide the toolbar.
2 | Status Bar | Select to: X X
Check Display the status bar.
Clear Hide the status bar.
3 | Split Enables resizing the panes using the arrow keys on the keyboard. | X X
1. CimSync menu
Item Description Server | Viewer
1 | Starts | Starts synchronization with the deployment server. X
2 | Stop | Stops synchronization with the deployment server. X
1. Help menu
Item Description Server | Viewer
1 | Contents Opens the Deployment topic in the CIMPLICITY documentation. | X X
2 | Tooltips Select to: X X
Check Display tool tips
Clear Hide tool tips.
3 | About Configuration Editor. | Opens details about the CIMPLICITY version and build. X X

2.1.2. CIMPLICITY Deployment Configuration Editor: Toolbar

Description When Enabled
1 | Create a new configuration file. Always
2 | Save the configuration file. Always

3 | Reload the configuration file from the disk. | After the configuration file is saved for the first time.

4 | Cut the selected entity

When an entity, e.g. a folder or viewer, is selected.

5 | Copy a selected entity or value

. When an entity, e.g. a folder or viewer, is selected.

6 | Paste a cut/copied entity or value. When an entity, e.g. a folder or viewer, is selected.

7 | Run synchronization with the server. On a viewer when synchronization is stopped.
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8 | Stop synchronization with the server. On a viewer when synchronization is running.

9 | Open deployment documentation. Always

2.1.3. CIMPLICITY Deployment Configuration Editor: Left Pane

The left pane basically lists the sources of the deployed files.

Basic listed information is as follows.

A | Viewer names.

B | Shared folders on the server with deployable files configured for this viewer.

2.1.4. CIMPLICITY Deployment Configuration Editor: Right Pane

The CIMPLICITY Configuration Editor right pane basically defines:

» Where the files are deployed to on the viewer
» What files are deployed
» When the files should be deployed.

Step 2.2. Create a new Configuration File

Use any of the following methods to create a new configuration file.

* Open (page 255) the CIMPLICITY Configuration Editor when a configuration fileisnot in
the installation \Data directory.

* Click the New button on the CIMPLICITY Configuration Editor toolbar.

* Select File>New on the CIMPLICITY Configuration Editor menu bar.

A New Deployment Configuration window opens.

1. Check an option.
2. Click Next.
Options are as follows.

rect 21, 38, 310, 77 (page 260)
rect 23, 85, 347, 136 (page 260)
rect 23, 134, 347, 177 (page 260)
rect 304, 188, 380, 214 (page 261)
* For adeployment server
* For this viewer only
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« Fetch from server
» Cancel

(1) Important: You can create more than one configuration file when you are working on the
CIMPLICITY server and setting up your configuration and copy the version to its appropriate
viewer or the deployment server.

However, the file will always be saved to the CIMPLICITY installation \Data directory. If you
plan to create more than one version make sure that you copy the version you created from the
Data directory into another directory before creating a second version. An existing version in the
data directory will be overwritten.

Check one of the following.

For a deployment server

The file created will be included in the automatic synchronization from the server to the viewer.
Always check For a deployment server for the version that will be on the deployment server.

The deployment server configuration file template opens with the following features.

A | Run and Start buttons are disabled. Note: The buttons will be enabled when the file is deployed to a viewer.

B | A'COMMON' Viewer is available in the left pane.

C | The default Master configuration path in the right pane is: \\ <local server>\ dat a Where <local server> is the
CIMPLICITY server. dat a is the C:\Program Files\Proficy\Proficy CIMPLICITY\data folder. Note: The actual
value can be changed (page 262).

For this viewer only

A stand-alone file can be important for a viewer that requires a very specific custom
configuration that should never be automatically overridden.

When For this viewer only is checked, the viewer to which this version is copied will not be
included in an automatic configuration file synchronization with the server.

The stand-alone configuration file opens with the following features.

A | The Run button is enabled, since the template is meant for a viewer.

B | My Computer is available as the viewer in the left pane.

C | The Master configuration path field is empty, since the template is meant for a viewer.

Fetch from Server
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Fetch from Server opens a Fetch Configuration File browser that enables you to quickly find an
existing gefdepl.dplcfg file that is on the same or a different server in the network.

© Tip: If the server drive that containsthe CIMPLICITY project is mapped to the local
computer, the Fetch Configuration File browser opens to the data directory and displays the
gefdepl .dplcfg file.

Deployment also supports older versions of the configuration file, gefdepl.cimcfg files; that file
will display if *.cimcfg is selected in the Files of typefield.

Cancdl

The Cancel button closes the New Deployment Configuration window closes.

Step 2.3. Identify the Master Configuration Path

The Master configuration path is the UNC path to the server and folder from which the configuration
fileisdistributed and, if specified, updated whenever it is modified.

When the configuration is saved in the CIMPLICITY Configuration Editor, the configuration file,
gefdepl.dplcfg, issaved inthe CIMPLICITY server installation Data directory.

However, the master configuration path

CIMPLICITY does not have to be installed on the deployment server. However, the path must be a
path that has read access from the Viewer.

Select Deployment Configuration in the CIMPLICITY Configuration Editor |eft pane.
Do either of the following to select the Master configuration UNC path.

rect 174, 69, 450, 97 (page 261)
rect 175, 106, 482, 144 (page 262)

1 Default UNC path
(page
261)
2 UNC path that is not the default
(page
262)
Important guidelines

1 | Default UNC path

The default UNC path is\\<Loca Server>\Data
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Where
<Loca Server> isthe name of the CIMPLICITY server.

\Dat a isthe Datafolder in the CIMPLICITY installation path, C:\Program Files\Proficy\Proficy
CIMPLICITY\Data.

Leave the local server\data UNC path in the Master configuration path field if the local server and
CIMPLICITY\Datafolder should be the path to the deployment server.

2 | UNC path that is not the default.

Do either of the following to enter a Master configuration UNC path that is different from the
default.

Enter the Master configuration path.

Use the Browse button

Enter the Master configuration path

A UNC path can be typed in the Master configuration path field, if it is different from the default
path.

The format is \\<Server name>\<Folder Name>

Where

<Server name> is the server on which the deployment configuration file is located.
<Folder name> is the name of the folder thefileisin.

Result: The selected UNC path will be entered in the Master configuration path field.

Use the Browse button

1. Click the Browse button to the right of the Master configuration path field.

A Browse for computer browser opens.

1. Find and select the server and configuration file deployment folder on your network.
2. Click OK.

Result: The selected UNC path will be entered in the Master configuration path field.
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guide: Important Guidelines

» When you modify and save gefdepl.dplcfg, it is aways updated in the CIMPLICITY installation
Data directory. If you do not use the default location, you will have to copy and paste the
updated version into the Master configuration path in order for it to be deployed to the viewers.

« If the selected server or path is not accessible when you save the configuration file, a message
box will issue awarning . You can still save the file and continue configuration. Simply make
sure that when the configuration file needs to be available for deployment that it is placed in the
specified path.

» Make sure the selected deployment folder is available to the Viewersinvolved in the
deployment.

Example using a non-default Master configuration UNC path

1. Gefdepl.dplcfg is aways automatically created and saved in the CIMPLICITY installation data

directory onthe CIMPLICITY server.
Thedirectory is:

c:\Program Files\Proficy\Proficy CIMPLICITY\Data

2. A second server, depserv, will be used as the deployment server.

3. Gefdepl.dplcfg is copied/pasted to c:\ConfigDeploy on the deployment server

Note: If specified, gefdepl.dplcfg will be automatically updated on every viewer, whenever it is
modified

ConfigDeply will be the official master configuration share folder name on the deployment
Server..

The following is entered as the Master configuration path.
\\depServ\ConfigDeploy

Where

\\depserv is the deployment server name.

\ConfigDeploy isthe share folder name.

4. Whenever Gefdepl.dplcfg is updated, it is copied/pasted from the ...\Data folder into the folder

specified in the Master configuration path field.
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Step 2.4. Identify 'COMMON' Viewer Parameters and Folders

Sep 2.4. Identify 'COMMON' Viewer Parameters and Folders

Files that need to be deployed to severa viewers can be placed in folders on the deployment server
under a'COMMON' Viewer.

Thiswill eliminate duplication of effort and insure that the single correct file version is deployed at
one time to every required viewer.

Identification steps in the CIMPLICITY Configuration Editor are as follows.

* Select ' COMMON' Viewer
« Configure'COMMON' Viewer

Select 'COMMON' Viewer
A 'COMMON' Viewer:

* Isincluded in the CIMPLICITY Configuration Editor.
» Lists default synchronization values.

The default values:
« Are used for al viewersthat are not specifically listed in the configuration, but are included in
the synchronization.
+ Can be changed to conform to your system's requirements.

+ Can be changed on an individual viewer to conform to the viewer's requirements.

Select ' COMMON' Viewer inthe CIMPLICITY Configuration Editor |eft pane.

Configure' COMMON' Viewer

Steps to configure the'COMMON' Viewer are as follows.

Step 2.4.1 | Define Parameters for the 'COMMON' Viewer.
(page
265)

Step 2.4.2 | Enter CimView Reload Criteria for the 'COMMON' Viewer.

(page
269

Step 2.4.3 | Add a common folder for the Server/Viewer synchronization
(page
278)




Advanced Features | 3 - System Management | 265

Step 2.4.4 | Define parameters for a 'COMMON' Viewer folder.

(page
279)

Sep 2.4.1. Define Parameter s for the ' COMMON' Viewer

A 'COMMON' Viewer:

¢ Isincluded in the CIMPLICITY Configuration Editor.
* Lists default synchronization values.

The default values:

» Areused for all viewersthat are not specifically listed in the configuration, but are included in
the synchronization.

+ Can be changed to conform to your system's requirements.

+ Can be changed on an individual viewer to conform to the viewer's requirements.

Select 'COMMON' Viewer inthe CIMPLICITY Configuration Editor left pane.
Available parameters are as follows.

rect 177, 75, 426, 94 (page 265)
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Sync configuration file
age

Sync files

Delay before copying

BE"|BE |88

4 Hide CimSync when it starts
(page

268)

5 Start CimSync at system startup
(page

269

-

Sync configuration file

Select one of the following.
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yes Local copy will be synchronized with the deployment server file.

no Local copy will be stand-alone, not synchronized with the deployment server.

Default | yes

The Sync configuration file value, yes or no, in the configuration file that isin each Viewer's local
folder enables or disables synchronizing the server's configuration file with that viewer.

To insure that synchronization continues, make sure that Sync configuration fileis set to yesin all
configuration files that are deployed to the viewer. If aconfiguration file is deployed to the viewer's
local folder with Sync configuration file set to no, the Viewer will no longer look for configuration
updates.

The configuration file will have to be manually fetched on the Viewer, the value reset to yes and
synchronization restarted (page 292) , to resume configuration deployment from the server to

that viewer. At that time the viewer will only look to the server for a new configuration file; it will
not look to see if there is a non-deployed configuration file that might have been placed in its own
temporary folder.

2 | Sync files

Select one of the following.

yes Files in the Server's deployment folders will be synchronized with the files in the target folders on the Viewer.
no Files will not be synchronized, even if they are in the deployment folder.
Default | yes

3 | Delay before copying

* Is applied to deployment files only.
D) Important:

* The configuration file, gefdepl.dplcfg, is immediately deployed to the temporary folder on the
viewer and then the local folder. Available system speed is the only factor that will impact its
deployment time.

» CimView files have additional parameters (page 269) in order to insure that updated files
do not disrupt running screen activity. The total deployment time is based on the value and
conditions influencing those parameters and the CopyDelay parameter.

» Appliesto both the server and the viewer as follows.

The value entered is applied in total to each, the server and viewer.
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* Base number of seconds CIMPLICITY deployment will wait after afile has been added or
updated in the server's deployment folder before it is synchronized with the viewer.

+ Base number of seconds the files waits in the viewer's temporary folder beforeiit is copied to the
local folder.

|5/ guide: Delay before copying Guidelines
The Delay before copying value is referred to as the base number of seconds because the actual time
may exceed the minimum deployment time, which is 2x the entered value.

The actual deployment time, when only Delay befor e copying is considered (not the CimView
parameters (page 269) ), depends on when new or updated files are placed in the server's
deployment folder. The following conditions affect the total deployment time.

Important: Delay before copying affects both the configuration file and other files. If sync
configuration file is set to no, and the configuration file is updated on the server, it will be deployed
to the Temp folder on the Viewer after the Delay before copying interval. However, it will remainin
the Viewer's Temp folder; it will not overwrite the configuration file that is already in the Viewer's
local folder.

The only way to update the current local configuration file version with the version in the Temp
folder isto manualy fetch it. If sync config file isreset to yes, the version that is in the Temp folder
already on the Viewer will not overwrite the local version. Only an updated version on the Server can
automatically be deployed and synchronized.

Condition 1

1. New files are placed in the server's deployment folder and travel through the Copy/Delay cycle
on both the server and viewer

2. No new files are placed in the deployment folder during that period.

Result: Thefiles are copied from the viewer's temporary to local foldersin the specified
CopyDelay (X2) time.

Example

The Delay befor e copying parameter entered value is 300 seconds.

Deployment Activity Seconds

1 | The new files stay in the Server folder and then are deployed to the temporary folder. | 300

2 | The new files stay in the temporary folder 300

No new files are added to the server's deployment folder during this cycle.

3 | The new files are copied to the local folder(s).
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3.

| | Total deployment time ‘ 600

Condition 2

New files are placed in the server's deployment folder.

4. Additional new files are placed in the deployment folder during the deployment cycle for the

first group of files.

The first deployment cycle timing stops; the clock isreset to O; the entire cycle starts again for both
groups of files.

Example
The Delay befor e copying parameter entered value is 300 seconds.
Seconds
Deployment Activity Group | Group
1 2
1 | Group 1 files stay in the Server folder and then are deployed to the temporary folder. 300
2 | Group 1 files are in the viewer's temporary folder. 180
3 | Group 2 files are placed in the server's deployment folder while Group 1 files are still in the
viewer's temporary folder.
Group 2 stays in the deployment folder 300
Group 1 remains in the viewer's temporary folder 300
4 | Group 2 files are deployed to the viewer's temporary folder.
Both Group 1 and Group 2 stay in the viewer's temporary folder for 300 seconds. 300 300
No new files are added to the server's deployment folder.
5 | Group 1 and Group 2 are copied to the viewer's local folders.
Total deployment time 1080 | 600

Delay before copying Default: 300 seconds

4

Hide CimSync when it starts

Select one of the following.

yes

CimSync runs in the background on 'COMMON' viewers; the CimSync icon does not display.

no

A CimSync icon is placed on the Windows Task bar when CimSync is running.
The icon opens a CimSync report window, which lists the synchronization activity.

Default | yes




Advanced Features | 3 - System Management | 269

5 | Start CimSync at system startup

Select one of the following.

yes CimSync will start up when a 'COMMON' Viewer is re-booted,

no CimSync will have to be manually started from the CIMPLICITY Configuration Editor on the Viewer or by
double-clicking CimSync.exe.

Default | yes

Sep 2.4.2. Enter CimView Reload Criteria for the ' COMMON' Viewer

CIMPLICITY deployment can be instructed when an updated CimView file should be reloaded
on the'COMMON' Viewer, in order to insure the integrity of a screen that is currently running in
CimView.

(1) Important: Thereload_mode parameter does not affect the server configuration file. When the
server configuration file changes, it is automatically copied to the local directory irregardless of the
reload_mode setting.

1. Expand Deployment Configuration>Viewers>'COMMON' Viewer in the CIMPLICITY
Configuration Editor left pane.

2. Select CimView.
Available parameters are as follows.

rect 173, 70, 355, 90 (page 269)
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1 Idle reload time

(page

269)

2 Screen reload mode

(page

270

3 Sample conditions for screen reload.
(page

271

1 | Idle reload time

Idlereload time;

* Isused when the notify option is selected for the screen reload mode.
* Provides a gauge that CimSync uses to determine when it should automatically copy
CimView files from the viewer's temporary folder to its local folder(s) even though the
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selection istoinitially notify the user. This feature insures that the viewer remains up-to-
datewhenitisidle.

* Isthe number of seconds that CimView must be completely idle after CimSync sends a
reguest to copy files and does not receive a response.

The actual number of seconds that the CimView files remain in the temporary folder before
they override notify and are automatically copied to the local folders depends on several factors,
including:

» Delay before copying (page 266) time.

* Idlereload time.

» When new files are added to the server's deployment folder.
« Actual time in the deployment cycles that the screen goesidle.

Default; 600 seconds

|=/ Note: When the reload mode is set to Notify and when the configuration file on the server
changes the following happens.

3. The configuration file is automatically copied to the Viewer

4. A prompt displays.
« Confirming the prompt accepts all environment changes that CimSync performs.
» When the new configuration file is accepted a re-sync with the server will be performed to
pull down any new files specified in the new configuration file.

5. The change in the local configuration file restarts the monitoring after reading the changed
configuration file.

2 | Screen reload mode

Screen reload mode options are:

Auto

CimSync automatically copiesthefilesto the local directory during synchronization after the
number of seconds determined by the Delay before copying (page 266) parameter value.

|5/ Note: Itisrecommended that auto reload be used if CimView isrunning in Terminal
Services sessions.

Notify

CimSync:

6. Notifies the Viewer's user that new files have been in the temporary folder after the Delay
befor e copying seconds have el apsed.
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7. Asksthe user if it can copy thefilesinto the local folder(s).

Result: Exactly when CimSync copies the files from the temporary folder into the local folder
depends on the following conditions.

» Delay before copying (page 266) time.

* Idlereload time.

» When new files are added to the server's deployment folder.

+ Actual time in the deployment cycles that the screen goesidle.

Default: auto
a. Sample Conditions for Screen Reload

The following sample conditions provide examples of how the total deployment timeis
computed when Notify is selected as the Screen reload mode:

Condition User grants permission.

1 (page
71

B

Condition User denies permission.
a
72

N
D

5

Condition User denies permission/additional files are added to the Server Deployment folder.

3 (page
273)

Condition User ignores the request but the screen is active.
al
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User denies the request and then the screen becomes idle.
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CimView is not running.
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~
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ondition Terminal Services is being used.
age

~ 0

N

77

Condition 1: User Grants Permission

8. New files are placed in the server's deployment folder and travel through the Copy/Delay cycle
on both the server and viewer

9. No new files are placed in the deployment folder during that period.

10. An Environment Changed message pops up in the lower, right-hand corner of the CimView
screen.
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Note: The Environment Changed message is how CimSync sends a request to copy the files
from the temporary to the local folders.

11. The user immediately clicks Reload.
Clicking Reload grants CimSync permission to copy the filesinto the local folders.

Results:

 The Environment Changed message closes.
» CimSync copies the files from the viewer's temporary to itslocal folders.

Example

The Delay before copying (page 266) parameter value is 300 seconds.

Theidlereload time parameter value is 600 seconds.

Deployment Activity Seconds

1 | The new files stay in the Server folder and then are deployed to the temporary folder. | 300

2 | The new files stay in the temporary folder 300

3 | No new files are added to the server's deployment folder during this cycle.

The user is notified and grants permission. 0

4 | The new files are copied to the local folder(s).

Total deployment time 600

Condition 2: User Denies Permission

12. New files are placed in the server's deployment folder and travel through the Copy/Delay cycle
on both the server and viewer

13. No new files are placed in the server's deployment folder during that period.

14. An Environment Changed message pops up in the lower, right-hand corner of the CimView
screen.

Note: The Environment Changed message is how CimSync sends a request to copy the files
from the temporary to the local folders.

15. The user clicks Snooze.

Clicking Snooze denies CimSync permission to copy the filesinto the local folders.
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Results:

« The Environment Changed message closes.
» CimSync resends another request to copy after the Copy/Delay period (from the temporary
folder to the local folder) has elapsed for a second time.

CimSync continues to send requests at the Delay befor e copying interval if:

16. The user:
a. Isinteracting with the screen.
b. Continues to deny the request.

17. No other files are placed in the server's deployment folder.
Example

The Delay before copying (page 266) parameter value is 300 seconds.

Theidlereload time parameter value is 600 seconds.

Deployment Activity Seconds
1 | The new files stay in the Server folder and then are deployed to the temporary folder. 300
2 | The new files stay in the temporary folder 300

3 | No new files are added to the server's deployment folder during this cycle.

The user is notified and denies permission. 0

4 | The files continue to stay in the viewer's temporary folder.

CimSync sends another request after the Delay before copying time in the temporary folder. 300

5 | The user denies permission. New files still have not been added to the server's deployment
folder.

The files continue to stay in the viewer's temporary folder. 300

7 | CimSync sends another request after the Delay before copying time in the temporary folder.

The user grants permission 0

6 | The new files are copied to the local folder(s).

Total deployment time 1200

Condition 3: User Denies Permission/Additional files are added to the Server Deployment
Folder

18. New files are placed in the server's deployment folder and travel through the Copy/Delay cycle
on both the server and viewer
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19.

20.

21.

22.

No new files are placed in the deployment folder during that period.

An Environment Changed message pops up in the lower, right-hand corner of the CimView
screen.

Note: The Environment Changed message is how CimSync sends a request to copy the files
from the temporary to the local folders.

The user clicks Snooze.

Clicking Snooze denies CimSync permission to copy thefiles into the local folders.

New files have been placed in the server's COMMON deployment folders before CimSync
sends another copy request to the user.

Results’

« The Environment Changed message closes.
» The clock is reset so the Delay before copy second count starts again.
» CimSync notifies the user at the end of the new server/viewer cycle.

This amount of time isthe total of the number of seconds that have elapsed since the last request
plus the total secondsin the Copy/Delay cycle.

Example

The Delay before copying (page 266) parameter value is 300 seconds.

The idle reload time parameter value is 600 seconds. Seconds

Deployment Activity Group | Group
1 2

1 | Group 1 files stay in the Server folder and then are deployed to the temporary folder. 300

2 | Group 1 files are in the viewer's temporary folder. 300

3 | The user is notified and denies permission.

Group 1 files continue to stay in the viewer's temporary folder. 180

4 | Group 2 files are placed in the server's deployment folder, while Group 1 files are still in the
viewer's temporary folder.

Group 2 stays in the deployment folder 300

Group 1 remains in the viewer's temporary folder 300

4 | Group 2 files are deployed to the viewer's temporary folder.

Both Group 1 and Group 2 stay in the viewer's temporary folder. 300 300

5 | No new files are added to the server's deployment folder.
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24,

25.

26.
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CimSync sends another request to copy the files from the temporary to the local folder(s).

The user grants permission 0 0

6 | Group 1 and Group 2 are copied to the viewer's local folders.

Total deployment time 1380 | 600

Condition 4: User Ignores Request but the Screen is Active

New files are placed in the server's deployment folder and travel through the Copy/Delay cycle
on both the server and viewer

No new files are placed in the server's deployment folder during that period.

An Environment Changed message pops up in the lower, right-hand corner of the CimView
screen.

Note: The Environment Changed message is how CimSync sends a request to copy the files
from the temporary to the local folders.

The user ignores the prompt, but isinteracting with the screen.

Results:

* The Environment Changed message remains open on the screen.
» Another Environment Changed message pops up in the lower right corner of the CimEdit
screen after the next Delay before copying time period has elapsed.

Example

The Delay before copying (page 266) parameter value is 300 seconds.

Theidlereload time parameter value is 600 seconds.

Deployment Activity Seconds
1 | The new files stay in the Server folder and then are deployed to the temporary folder. 300
2 | The new files stay in the temporary folder 300

3 | No new files are added to the server's deployment folder during this cycle.

The user is notified and ignores the request. Note: The message remains on the screen.

The files continue to stay in the viewer's temporary folder.

CimSync sends another request after the Delay before copying time in the temporary folder. 300

4 | The user ignores the request. Note: The message remains on the screen. New files still have not
been added to the server's deployment folder.

The files continue to stay in the viewer's temporary folder.
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The user grants permission before the Delay before copying time has elapsed. 180

5 | The new files are copied to the local folder(s).

Total deployment time 1080

Condition 5: User Denies the Request and then the Screen Becomes Idle

27. New files are placed in the server's deployment folder and travel through the Copy/Delay cycle
on both the server and viewer

28. No new files are placed in the server's deployment folder during that period.
29. The user clicks Snooze.

Clicking Snooze denies CimSync permission to copy the filesinto the local folders.
30. The screen goes idle and remains idle after the user denies the prompt.
CimSync:
1. Resends arequest one Delay before copying time period after the first request and discovers the
screenisidle.
2. Waits the entered idle time delay.

3. Automatically copies the files from the temporary to the local folders.

Example

The Delay before copying (page 266) parameter value is 300 seconds.

Theidlereload time parameter value is 600 seconds.

Deployment Activity Seconds
1 | The new files stay in the Server folder and then are deployed to the temporary folder. 300
2 | The new files stay in the temporary folder 300

3 | No new files are added to the server's deployment folder during this cycle.

The user is notified and denies permission.

The files continue to stay in the viewer's temporary folder.

CimSync sends another request after the Delay before copying time in the temporary folder. 300

4 | The user denies permission. New files still have not been added to the server's deployment folder. The
screen goes idle before the Delay before copying time has elapsed.

The files continue to stay in the viewer's temporary folder.

CimSync sends another request after the Delay before copying time (starting from the last time the 300
user denied permission).
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5 | CimSync discovers that the screen is idle.

New files still have not been added to the server's deployment folder. The screen continues to be idle.

CimSync waits the specified idle reload time. 600

7 | The new files are copied to the local folder(s).

Total deployment time 1800

Condition 6: CimView is not Running

CimView is not running on the viewers.

CimSync will copy thefilesto the local directory automatically.
Example

The Delay before copying (page 266) parameter value is 300 seconds.

Theidlereload time parameter value is 600 seconds.

Deployment Activity Seconds

1 | The new files stay in the Server folder and then are deployed to the temporary folder. | 300

2 | The new files stay in the temporary folder 300

3 | No new files are added to the server's deployment folder during this cycle.

CimView is not running.

4 | The new files are copied to the local folder(s).

Total deployment time 600

Condition 7: Terminal Servicesisbeing Used
Terminal Servicesisbeing used for configuration deployment.

There is no clearly defined or expected behavior when CimView is running on multiple sessions and
is prompted that new files have been added to the COMMON folders.

CimSync will:

1. Check to seeif CimView isrunning on the console (Terminal Services) server only.
2. Prompt the server before copying filesto the local directory.
3. Copy or not copy the files based on the console users response to the CimView prompt.

|5/ Note: It isrecommended that auto reload be used if CimView isrunning in Terminal Services
sessions.
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Sep 2.4.3. Add a Common Folder for the Server/Viewer Synchronization

|5/ Note:

* The'COMMON' Viewer can contain folders that can deploy filesto every viewer that:

* Has read access to the shared folder on the deployment server.

« Shares the common configuration file that includes the selected folder.

+ Do not have their own viewer name included in the configuration.

* The folder name in the left pane (tree view) identifies the viewers mapped drive that contains
the sourcefiles.

1. Expand Deployment Configuration>Viewers>COMMON' Viewer in the CIMPLICITY
Configuration Editor left pane.

2. Select Folders.

Note: The Foldersitem has no parameters.

3. Do one of the following.
* Right-click Folders; select Add on the Popup menu.
» Select Edit>Add on the CIMPLICITY Configuration Editor menu bar.

An Add configuration Object dialog box opens.

4. Specify the following.

Name | The UNC path to the deployment server folder that will contain source files.

|5 Note: The viewer must have read-access to the shared folder.

Example \\ DepSer v\ DepVi ewAl | Where

DepSer v Is the deployment server
DepVi ewAl | Is the shared drive on the deployment server.
Type | Folder

Icon Select a folder.

Note: You can use amapped drive. Every viewer using the'COMMON' folder must have the
same mapped drive.

5. Click OK.

CIMPLICITY deployment adds the folder to the'COMMON' Viewer's list of foldersin the
CIMPLICITY Configuration Editor left pane.
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Sep 2.4.4. Define Parameters for a'COMMON' Viewer Folder

Select asource folder in the CIMPLICITY Configuration Editor left pane.

Parameters in the right pane will identify what files should go to what target folders on the viewers.

Available parameters are as follows.

Parameter | Description
Local The Local folder path is the actual path and folder on the Viewer that will receive the deployed files.
folder path [ Example The files that the Viewers use are in the c:\Screens folder The value entered is: c:\Screens

|5 Note: All viewers that use this folder must have a c:\screens folder.

o Tip: Click the Browse button to open the Browse for a folder browser.
Sync
these files « Any number or type of file can be put in the source folder.

However, only files that fill one or more of the entered specifications will be synchronized.

« File specifications should be separated by semi-colons ;and can contain the following wildcard
characters: *?

i All files.

No entry No files.

Default *.cim
Sync Choose one of the following.
subfolders

yes Synchronizes files in the selected folder's subfolders, if there are any.

no Does not synchronize sub-folder files.

Default no
Do not
sync these « Files in the source folder (or subfolders, if included) that fill one or more entered specifications will not
files be synchronized.

« File specifications should be separated by semi-colons ;and can contain the following wildcard
characters: *?

Add Configuration Object Dialog Box

The Add Configuration Object dialog box is used to add the following to the deployment
configuration.

Add a common folder for the 'COMMON' Viewer.
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Add a selected viewer.

Add a source folder for a selected viewer.

Step 2.5. Identify a Selected Viewer's Parameters and Folders

Sep 2.5. |dentify a Selected Viewer's Parameters and Folders

If aselected viewer has configuration requirements that are different from the "COMMON' viewers,
it can be identified and set up separately.

(1) Important: If aviewer is set up separately it will not be included in the'COMMON' viewer
deployment.

Step 2.5.1 | Add a viewer to be included in synchronization.
(page

Step 2.5.2 | Define parameters for an added viewer.
(page

Step 2.5.3 | Enter CimView reload criteria for a selected viewer.
a

Step 2.5.4 | Add a source folder for the server/viewer synchronization.

Step 2.5.5 | Define parameters for the source folder.

Sep 2.5.1. Add a Viewer to be Included in Synchronization

1. Expand Deployment Configuration in the CIMPLICITY Configuration Editor left pane.
2. Select Viewers.

3. Do one of the following.
* Click Edit>Add on the CIMPLICITY Configuration Editor menu bar.
* Right-click Viewers; select Add on the Popup menu.

An Add configuration Object dialog box opens when you use either method.

4. Enter the following.

Field | Description
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Name | The viewer name. Note: The name must be the name that displays on the Computer Name tab in the
Windows Systems Properties dialog box.

Type | Viewer

Icon Select a computer.

5. Click OK.

The Viewer is added to the list in the Configuration Window |eft pane.

Sep 2.5.2. Define Parameters for an Added Viewer

| Note:

» An added Viewer provides the parameters included with the'COMMON' Viewer plus a
parameter for identification.

« Values entered for the selected viewer's parameters override values entered for the ' COMMON'
Viewer. If aparameter valueis blank, the'COMMON' Viewer valueis used.

Select the viewer to be configured.

Available parameters are as follows.

Sync configuration file.
age

Sync files.

Delay before copying.

Hide CimSync when it starts.

Start CimSync at system startup.
age
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Sync configuration file

Select one of the following.

yes Local copy will be synchronized with the deployment server file.

no Local copy will be stand-alone, not synchronized with the deployment server.

Default | yes
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The Sync configuration file value, yes or no, in the configuration file that isin each Viewer'slocal
folder enables or disables synchronizing the server's configuration file with that viewer.

To insure that synchronization continues, make sure that Sync configuration fileis set to yesin all
configuration files that are deployed to the viewer. If a configuration file is deployed to the viewer's
local folder with Sync configuration file set to no, the Viewer will no longer look for configuration
updates.

The configuration file will have to be manually fetched on the Viewer, the value reset to yes and
synchronization restarted (page 292) , to resume configuration deployment from the server to

that viewer. At that time the viewer will only look to the server for anew configuration file; it will
not look to see if there is a non-deployed configuration file that might have been placed initsown
temporary folder.

2 | Sync files

Select one of the following.

yes Files in the Server's deployment folders will be synchronized with the files in the target folders on the Viewer.
no Files will not be synchronized, even if they are in the deployment folder.
Default | yes

3 | Delay before copying

« Isapplied to deployment files only.

Number | (Seconds) The default number of seconds CIMPLICITY deployment will wait after a file has been added
or updated in the deployment folder before it is synchronized with the viewer. Based on the steps that
deployment takes the actual time delay will be:
gefdepl.dplcfg 3x the number entered
Deployment files 2x the number entered.

Default 300
gefdepl.dplcfg 900 seconds
Deployment files 600 seconds

Note: The additional delay is necessary for the temporar (page 251)y file and configuration (page 252) file
deployment.

D) Important:
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« The configuration file, gefdepl.dplcfg, isimmediately deployed to the temporary folder on the
Viewer. Once deployed, it will prompt you before it is copied to the Viewer'sinstallation ...\data
directory.

» CimView files have additional parameters (page 269) in order to insure that updated files
do not disrupt running screen activity. The total deployment time is based on the value and
conditions influencing those parameters and the CopyDelay parameter.

+ Applies to both the server and the viewer asfollows.

The value entered is applied in total to each, the server and viewer.

* Base number of seconds CIMPLICITY deployment will wait after afile has been added or
updated in the server's deployment folder before it is synchronized with the viewer.

« Base number of seconds the files waits in the viewer's temporary folder beforeit is copied to the
local folder.

Delay before copying Guidelines

4 | Hide CimSync when it starts

Select one of the following.

yes CimSync runs in the background; the CimSync icon does not display.

no A CimSync icon is placed on the Windows Task bar when CimSync is running.
The icon opens a CimSync report window, which lists the synchronization activity.

Default | yes

5 | Start CimSync at system startup

Select one of the following.

yes CimSync will start up when a Viewer is re-booted,

no CimSync will have to be manually started from the CIMPLICITY Configuration Editor on the Viewer or by
double-clicking CimSync exe.

Default | yes

Sep 2.5.3. Enter CimView Reload Criteria for a Selected Viewer

CIMPLICITY deployment can be instructed when an updated CimView file should be reloaded on a
selected Viewer, in order to insure the integrity of a screen that is currently running in CimView.

(1) Important: The reload_mode parameter does not affect the server configuration file, . When the
server configuration file changes, it is automatically copied to the local directory irregardless of the
reload_mode setting.
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1. Expand Deployment Configuration>Viewers> <Selected Viewer> in the CIMPLICITY
Configuration Editor left pane.

2. Select CimView.
Available parameters are as follows.

rect 174, 74, 351, 92 (page 284)
rect 174, 90, 351, 109 (page 285)

1 Idle reload time
(page
284)

2 Screen reload mode
(page
285)

1 | Idle reload time

Idle reload time;

* Isused when the notify option is selected for the screen reload mode.

* Provides a gauge that CimSync uses to determine when it should automatically copy
CimView files from the viewer's temporary folder to itslocal folder(s) even though the
selection istoinitially notify the user. This feature insures that the viewer remains up-to-
datewhenitisidle.

* Isthe number of seconds that CimView must be completely idle after CimSync sends a
request to copy files and does not receive a response.

The actual number of seconds that the CimView files remain in the temporary folder before
they override notify and are automatically copied to the local folders depends on several factors,
including:

 Delay before copying (page 266) time.

* Idle reload time.

» When new files are added to the server's deployment folder.

+ Actua time in the deployment cycles that the screen goesidle.

Default: 600 seconds

(1) Important: When the reload mode is set to Notify and when only the configuration file on
the server changes the following happens.

3. The configuration file is automatically copied to Viewer
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|=/ Note: When the reload mode is set to Notify and when the configuration file on the server
changes the following happens.

4. The configuration file is automatically copied to the Viewer

5. A prompt displays.
« Confirming the prompt accepts all environment changes that CimSync performs.
» When the new configuration file is accepted a re-sync with the server will be performed to
pull down any new files specified in the new configuration file.

6. The change in the local configuration file restarts the monitoring after reading the changed
configuration file.

2 | Screen reload mode

Screen reload mode options are:
Auto

CimSync automatically copiesthe filesto the local directory during synchronization after the
number of seconds determined by the Delay before copying (page 266) parameter value.

|=/ Note: Itisrecommended that auto reload be used if CimView isrunning in Terminal
Services sessions.

Notify

CimSync:

7. Notifiesthe Viewer's user that new files have been in the temporary folder after the Delay
befor e copying seconds have elapsed.

8. Asksthe user if it can copy the files into the local folder(s).

Exactly when CimSync copies the files from the temporary folder into the local folder depends on
the following conditions.

« Delay before copying (page 266) time.

* Idlereload time.

» When new files are added to the server's deployment folder.

+ Actual time in the deployment cycles that the screen goesidle.

Default: auto

Sep 2.5.4. Add a Source Folder for the Server/Viewer Synchronization
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1. Expand Deployment Configuration>Viewers><Viewer Name> in the CIMPLICITY
Configuration Editor |eft pane.

Where

Vi ener Nane isthe viewer you are targeting for synchronization.

2. Select Folders.

Note: The Foldersitem has no parameters.

3. Do one of the following.
* Right-click Folders; select Add on the Popup menu.
» Select Edit>Add on the CIMPLICITY Configuration Editor menu bar.

An Add configuration Object dialog box opens.

4. Specify the following.

Name | The UNC path on the configuration server of the folder that will contain source files. Example \\ DepSer v
\ a nvi ew Where \\ DepSer v is the configuration server. \ ¢ nvi ewis the shared folder.

Type | Folder

Icon Select a folder.

5. Click OK.

CIMPLICITY deployment adds the folder to the viewer's list of foldersin the CIMPLICITY
Configuration Editor left pane.

Sep 2.5.5. Define Parameter s for the Source Folder

Select asource folder in the CIMPLICITY Configuration Editor |eft pane.

Available parameters are as follows.

Parameter | Description

Local The Local folder path is the actual path and folder on the selected Viewer that will receive the deployed
folder files. Example The files that the Viewer uses are in its c:\Project\PPSCimp\Screens folder The value
path entered is: c:\Project\PPSCimp\Screens

a Tip: Click the Browse button to open the Browse for a folder browser.
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Sync
these files « Any number or type of file can be put in the source folder.
However, only files that fill one or more of the entered specifications will be synchronized.
« File specifications should be separated by semi-colons ;and can contain the following wild characters:
*?
** All files.
No entry No files.
Default *.cim
Sync Choose one of the following.
subfolders
yes Synchronizes files in the selected folder's subfolders, if there are any.
no Does not synchronize sub-folder files.
Default no
Do not
sync « Files in the source folder (or subfolders, if included) that fill one or more entered specifications will not
these files be synchronized.
« File specifications should be separated by semi-colons ;and can contain the following wild characters:
*?

Step 2.6. Complete Configuration on the Server

Sep 2.6. Complete Configuration on the Server

A Save the configuration file.
(page

287)

B Set up the files and folders.
(page

288

1. Savethe configuration file.

1. Add and configure as many Viewers and folders as your system requires.

2. Do one of the following to save the configuration.
* Click the Save button on the CIMPLICITY Configuration Editor toolbar.
* Select File>Save on the CIMPLICITY Configuration Editor menu bar.
* Press Ctrl+S on the keyboard.

3. Click File>Exit on the CIMPLICITY Configuration Editor menu bar.
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The CIMPLICITY Configuration Editor closes. You are now ready to set up (or finish setting up) the

identified paths and folders.

1. Set up the files and folders.

Do the following.

Step 2.6.1
(page
288

Create the source folders on the deployment server.

Step 2.6.2
gpage
288)

Make sure that gefdepl.dplcfg is in the Master Configuration folder.

Sep 2.6.1. Create the Sour ce Folders on the Deployment Server

Make sure that all of the folders shared in the CIMPLICITY Configuration Editor are created and
shared on the deployment server.

Thisincludes the folder for the gefdepl.dplcfg file.

For example, folders should include:

A

One or more folders shared as 'COMMON' Viewer folders

Folders shared for selected viewers.

Any required sub-folders.

Folder shared as the master configuration folder.

Sep 2.6.2. Make sure that gefdepl.dplcfg isin the Master Configuration Folder

1. Find the gefdepl.dplcfg file that was just created in the CIMPLICITY instalation Data

directory.

...\Program Files\Proficy\Proficy CIMPLICITY\Data

2. Do one of the following.

Master configuration folder
is the :

Do the following:

CIMPLICITY Installation
Data folder.

Copy the file to paste in the Viewer. Note: The file can also be fetched from the
Viewer.

Another deployment server.

Copy and paste the file into the deployment server folder that is identified as the
master configuration (page 261) folder.
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Sep 3. Set up a Deployment Viewer
Step 3. Set up a Deployment Viewer

Configuration can be done on aviewer. However, it is recommended that it be done mainly on the
Server.

* Files are not automatically deployed from a viewer to the server or other viewers, so any global
changes will not be deployed.

« If the viewer is set up to automatically synchronize the configuration file, any changesto the
viewer configuration will be overwritten.

(1) Important: A Viewer must have enough disk for each local deployment folder and the
temporary directory in order to insure successful deployment.

Calculations include space that is padding and that is at |east the amount used on the server, as
follows.

Directory Viewer space and Padding Requirements

Local Free space | Free space that is at least the size of the corresponding source directories on the server

Padding
1. Whichever of the following is larger:

2.+ 1% of the deployed directories on the server.
3. 1 MB.

Temporary | Free space | A minimum free space of the sum of all the configured server directories.

Padding
1. Whichever of the following is larger:

2.+ 1% of the deployed directories on the server.
3. +<1MB.

Steps for the viewer include:

Step 3.1 | Place the correct configuration file on the viewer.
(page
290)

Step 3.2 | Open the CIMPLICITY Configuration Editor.
(page
291)

Step 3.3 | Start synchronization.

(page
292
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Step 3.4 | Review synchronization progress.

Step 3.5 | Stop synchronization.

Step 3.1. Place the Correct Configuration File on the Viewer

Use any of the following methods to place the correct configuration file on the Viewer.

* Paste gefdepl.dplcfg into the Data directory.
« Fetch gefdepl.dplcfg from the deployment server.
+ Create anew configuration file.

Paste Gefdepl.dplcfg into the Data directory

1. Open Windows Explorer.
2. Select the Viewer's installation data directory

.\Program Files\Proficy\Proficy CIMPLICITY \data

3. Paste the gefdepl.dplcfg file that was saved on the deployment server into the Viewer's
installation data directory.

|=/ Note: Make sure that cimsync.exe isin the Viewer'sinstallation exe directory.
.\Program Files\Proficy\Proficy CIMPLICITY \exe
Fetch Gefdepl.dplcfg from the deployment server

Y ou can fetch gefdepl.dplcfg through the CIMPLICITY Configuration Editor.

4. Open the CIMPLICITY Configuration Editor.
5. Click File>Fetch from Server on the CIMPLICITY Configuration Editor menu bar.

The Fetch Configuration File browser opens.

6. Do the following.

A | Look in. Find the directory on the deployment server that was assigned to deploy the gefdepl.dplcfg file.

B | Files of Select *.dplcfg Note: The file type *.cimcfg. is also available, to be backward compatible with
type older deployment configuration files
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C | File name Select gefdepl.dplcfg. Note: The file gefdepl.cimcfg is also available, to be backward
compatible with an older deployment configuration file.
D | Open as (Optional) Check to deploy the file as a read-only file.
read-only
E | Open Click Open.

Gefdepl.dplcfg is automatically deployed to the viewer's installation Data directory. If a
configuration file was in the directory, it will be overwritten.

|=/ Note: If the correct configuration does not display in the CIMPLICITY Configuration Editor,
click File>Reload on the CIMPLICITY Configuration Editor menu bar.

Create aNew Configuration File

Y ou can create a configuration file on a Viewer, the same way you do on a server.

If you do, it is recommended that you only create a stand-alone file for that viewer.

 Any configuration will not be deployed to any other computer.
« A stand-alonefile will not be overwritten by the deployment server version.

Step 3.2. Open the CIMPLICITY Configuration Editor

Do one of the following.

 Start menu
» Workbench

Start Menu

1. Click Start on the Windows Task bar.

2. Select All Programs> HMI/SCADA CIMPLICITY version>Deployment Configuration.

Workbench

3. Select Computer>Deployment Configuration in the Workbench left pane.

4. Select Deployment Configuration in the right pane.

5. Do one of the following.

A

Click Edit>Properties on the Workbench menu bar.

B

Click the Properties button on the Workbench toolbar.

C

In the Workbench left pane:
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Either

Or

Double click Deployment Configuration.

a. Right-click Deployment Configuration.
b. Select Properties on the Popup menu.

In the Workbench right pane:

Either

Or

Double click Deployment Configuration.

a. Right-click Deployment Configuration.
b. Select Properties on the Popup menu.

E

Press Alt+Enter on the keyboard.

a. Result: One of the following will happen.

A

configuration file Is: Result

In

the Installation \Data directory The CIMPLICITY Configuration Editor opens the existing gefdepl.dplcfg

file.

di

Not in the Installation \Data

rectory

You will be provided with prompts (page 259) to create a new file.

6. Right-click Deployment Configuration.

7. Select Properties on the Popup menu.

8. Right-click Deployment Configuration.

9. Select Properties on the Popup menu.

Step 3.

CIMPLICITY deployment provides several methods for starting synchronization on a viewer.

3. Start Synchronization

* Do one of the following in the CIMPLICITY Configuration Editor.

A | Clicl

k CimSync>Start on the menu bar.

B | Clic

k the Run button on the toolbar.

* (If deployment is set to start at system startup) reboot the Viewer.

Result: Synchronization will begin and run according to the specifications defined for the viewer.

Step 3.4. Review Synchronization Progress

If the Configuration File instructs deployment not to hide CimSync when it starts (page 281) , a

Deployment icon is placed on the Windows Task bar.
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1. Do one of the following.
* Double-click the Deployment icon.
* Right-click the Deployment icon; select Restore on the Popup menu.

A CimSync report window opens when you use either method.

The report provides synchronization details, enabling you to confirm that deployment is
proceeding accurately and, if not, what are the problems.

2. (Optional) Do one of the following to save the report as text.
* Click the CimSync icon on the CimSync report title bar; select Save as Text on the menu.
* Right-click the CimSync icon on the Windows Task bar; select Save as Text on the Popup
menul.

3. Click the CimSync icon on the CimSync report title bar; select Minimize on the menu to hide
the report.

Step 3.5. Stop Synchronization

1. Do any of the following if synchronization must be stopped on aviewer.
* Click the Stop button on the CIMPLICITY Configuration Editor toolbar.
* Click CimSync>Stop on the CIMPLICITY Configuration Editor menu bar.
* Click Exit in the CimSync report window.
* Right-click the CimSync icon on the Windows Task bar; select Close on the Popup menu.

A message opens when you use any method asking if you want to stop the CIMPLICITY
synchronization on this viewer.

2. Click Yes.

Synchronization with the viewer is stopped.

Deployment Configuration Error Reporting
Deployment Configuration Error Reporting

When you try to save the configuration file in the Deployment Configuration Editor, Deployment
will validate your configuration. If it finds errors a message box will open to report that thereis or
are errors in the configuration and ask you if you want to saveit.

Click one of the following.

Yes | Saves the file and...




Advanced Features | 3 - System Management | 294

‘ No ‘ Does not save the file...

Results

 The message box closes after you click either button.
* The bottom half of the Configuration Editor right-pane displays the errors.

Deployment Error M essages

Check the named Viewer in the Deployment Configuration left pane and remove any invalid
characters.Example

1. viewlislisted in the Deployment Configuration Editor left pane with two back slashes.
\\viewl

2. An error message displaysin the lower right pane as follows.
Error: "\\viewl" Viewer name containsone or moreinvalid characters: \/:*?" <>

3. \\Wiewl isrenamed and is correctly listed as view1.

Global Parameters

About Global Parameters

The CIMPLICITY Workbench provides an easy way to view and, when instructed, to add or modify
existing global parameters.

A Global Parameter:

* Defines parameters for the CIMPLICITY Base System and options that override default
parameters in the software.

« Controls either:

* The system or

* A project.

« Can be changed in one of the following ways:

* Through user interfacesin CIMPLICITY Configuration functions.

* Through the Workbench in the System or Project section.

CIMPLICITY software stores the project's global parameter valuesin agloba _parms.idt file. This
interface enables you to avoid opening and editing the file. As aresult, the Workbench application
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saves you time and helps you avoid accidental errors. However, even with this tool, you should only
edit global parameters when it is absolutely necessary.

@ Warning: Improper global parameter configuration can cause adverse system effects. Do not
add, modify or delete global parameters unless specifically instructed to by the documentation or a
GE Intelligent Platforms representative.

Global Parameter Configuration
Global Parameter Configuration

The Workbench Global Parameters application enables you to edit aglobal parameter value without
tampering with the global_parms.idt file to which the values are written. .

Y ou can:

Add a global parameter to the Workbench list.

Sk

page
95

Edit a global parameter value.

N N N
N
[¢]

Delete a global parameter from the list.

(e8]
Q
D

297)

The procedure for each of these management functionsis simple. However, the result of any
modification can have a powerful impact on the system. Therefore, you will see warning messages
every step of the way. They are there for areason.

1. Add a Global Parameter to the Workbench List

CIMPLICITY supports several global parametersthat are not in the default list when you initially
display the global parameters in the Workbench. Those global parameters do not have avalue.
Therefore, CIMPLICITY is not using them. Y ou can easily add any of the global parametersto the
Workbench list, set their values, update your configuration and, as aresult, activate them.

(1) Important: A globa parameter appliesto either the project or the system. It isimportant that
you add the parameter to the correct folder. If you add it to the wrong folder, it will not be workable.

1. Display Project or Computer parameters

Project Parameters

Select Project>Advanced>Project Parametersin the Workbench |eft pane.
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Computer (System) parameters

Select Computer>Computer Parametersin the Workbench |eft pane.

1. Add aProject or Computer parameter

Do one of the following:

A | Click File>New on the Workbench menu bar.

B | Click the New Object button on the Workbench toolbar.

C | In the Workbench left pane, double click one of the following Project Parameters or C omputer Parameters.

1. In the Workbench right pane, right-click any global parameter and select New on the Popup menu.

E | Press Ctrl+N on the keyboard.

A New Global Parameter dialog box opens when you use any method for either project or computer
parameters.

1. Enter an additional global parameter in the Parameter 1D field.
2. Click OK.

A Global Parameter - <name> dialog box opens.

3. Enter avalue that appliesto the global parameter in the Value field.
4. Click OK.

A message box opens, warning that improper configuration can cause adverse effects.

5. Click OK if you are sure you want to continue.
6. Do a project configuration update.

A message box opens asking you if you want to copy master configuration data to run-time data.
7. Click OK.

The global parameters are activated and their entered values are now the values that the
CIMPLICITY system and/or project use.



Advanced Features | 3 - System Management | 297

2. Edit a Global Parameter Value

In the Workbench left pane:

1. Right-click one of the following.
* Project Parameters.
» Computer Parameters.

2. Select Properties on the Popup menu.

3. Right-click one of the following
* Project Parameters.
» Computer Parameters.

4. Select Properties on the Popup menu.
3. Delete a Global Parameter from the List

If it is necessary to de-activate a global parameter, you can by deleting it from the Workbench list.

0 Warning: Delete aglobal parameter only when instructed to by documentation or a GE
Intelligent Platforms representative.

1. Select (page 295) either of the following.

Select To delete a:

Project Parameters Project global parameter.

Computer Parameters | System global parameter.

2. Select the global parameter(s) you want to delete.

3. Do one of the following:
* Click the Delete button on the Workbench toolbar.
« Click the right-mouse button on your selection; select Delete on the Popup menu.
* Click Edit>Delete>0Object on the Workbench menu bar.
* Press Del on the keyboard.

A message box opens asking you if you want to delete the selected items.

4. Click Yes.

A message box opens warning you that improper configuration can cause adverse effects.

5. Click OK if you are sure you want to delete the global parameter.
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The global parameter is deleted from the list.

6. Do aCIMPLICITY configuration update.

The global parameter is deleted from the list and de-activated in the CIMPLICITY system and/or

project.

Global Parameters

Global Parameters

@ Warning: Improper global parameter configuration can cause adverse system effects.

The information in this section should be used to add, modify or delete global parametersonly if you
are specifically instructed to by the documentation or GE Intelligent Platforms.
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$AM_STATUS (page 304)

AMLP_LOSTALARMSPAGE

(page 307)

ACK_TOUT (page 305)

AMLP_LOWWATERMARK
(page 308)

AE_STARTUP_CFG (page 305)

AMLP_MAX QUEUE (page
308)

ALARM_SAVE_COMMENTS (page

AMLP_USE_GEN_TIME

305)

(page 308)

ALLOW_UPDATE_WHEN_DISABLED

AMLP_USE_RESET_TIME

(page 306)

(page 308)

AM_OLD_POINT_RESET (page
306)

AMVS_BOOTPRJ (page
309)

AM_RESET_ACK_STATE (page 306)

AMVS_TIMEOUT (page

309)

AM_SAVE_ACK_STATE (page 307)

AUTO_CONFIG_AE_SRC

(page 309)

AMLP_HIGHWATERMARK (page
307)

°]
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BASIC_LOAD_SCRIPT_EXTENSION | BCO_DATA_FETCH_ERROR

(page 310) (page 312)

BASIC MULTITHREAD COM (page BCO_DFO_NOT_AUTO (page

310) 313)

BCE_ENABLE_TRACING (page BCO_SWEEP_DELAY (page

311) 314)

BCO_ARCHIVE_AFTER_N_SWEEPS | BIND_ADDR (obsolete) (page

(page 312) 314)

BCO_AUTO_ARC_DEL (page 312) BROWSE_TREE_UNDERSCORE
(page 314)

]

CE_MAX_DELAY (page 314) CE_THREAD_TIMEOUT
(page 315)

CE_MAX_THREADS (page 315) CLR_TOUT (page 315)

CE_MIN_STANDBY_THREAD_ COUNT | CONNECT _DROP_PERIOD

(page 315) (page 316)

CE_POOL_THREADS (page 315) CONNECT_RETRY_PERIOD
(page 316)
COR_LOG_RP_SCAN_TIME
(page 316)

°]

DB_CLOCK_ADJUSTMENT_MONITOR | DB_TIMESTAMP_FILTER (page

(page 316) 323)

DB _COMPACT_QUEUE_SIZE (page DB _TIMESTAMP_PRECISION

317) (page 324)

DB_COUNTER_FIELD (page 317) DB _TIMESTAMP_UTC FIELD
(page 324)

DB_DBMS_QUEUE_SIZE (page 317) DBDL_DEVICE_CHECK_PERIOD
(page 324)

DB _DEBUG (page 318) DC_CACHE_DIAGNOSTICS
(page 325)

DB _ENABLE_MSEC (page 318) DC_RETRY_ONE_DEVICE
(page 325)

DB_ENABLE_TRANSACTIONS (page DC_UNAVAIL _NAN (page 325)

319)

DB_MSEC_FIELD (page 320) DEL_OPT (page 326)

DB _POINT_ID_FIELD (page 320) DEVICE_DOWN_DEVICE_REF
(page 326)
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DB_PROJECT_FIELD (page 320)

DEVICE_TIMESTAMP_UTC
(page 326)

DB_QUEUE_OVERFLOW_DELAY
(page 321)

DGR_STOPPED_UPDT_DELAY
(page 326)

DB_QUEUE_SIZE (page 321) DONT_VERIFY_ESPOINT_FRID

(page 327)

DB_STATUS_LOG_OFF (page 321) DOWNLD_PASSWD(obsolete)

(page 327)

DB_TABLE_FAILURE_RETRY (page
322)

DT_UPD_INTERVAL (page 327)

DB_TIME_FORMAT (page 322)

DB_TIMESTAMP_FIELD (page 323)

B

EM_SCRIPT_TRACING (page 328)

EMLOG_FLUSH_LIMIT (page 328)

ENABLE MILLISEC_FOR_TREND_TIME
(page 328)

EU_AUDIT_TRAIL (page 329)

EXPRESSION_TRACE_LEVEL (page
329)

H
<FACEPLATE NAME>_ZOOM

(page 330)

FIRST_WEEK_DAYS (page
330)

FP_LEFT (page 331)

FP_TOP (page 331)

]

GSM_DEBOUNCE_OLD_EVENTS (page
336)

GSM_DELAY_PARSEEXPRESSIONS (page
336)

GSM_ANNUN_ALARM_H1 [ GSM_EXPONENT_PRECISION (page
(page 331) 336)

GSM_ANNUN_ALARM_H2
(page 332)

GSM_FRAMES_EXPOSE_POINT_TARGETS
(page 337)




GSM_ANNUN_ALARM_L1

GSM_GLOBAL_SCRIPT (page 337)

(page 332)
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GSM_ANNUN_ALARM_L2

GSM_GLOBAL_SCRIPTCFG (page 337)

(page 333)

GSM_ANNUN_DIG_OFF

GSM_LIB_CACHE_SIZE (page 338)

(page 333)

GSM_ANNUN_DIG_ON GSM_OVERRIDE_POINT_FMT (page 338)
(page 334)

GSM_ASC_FONT_NAME GSM_SPCONFIRM_DEFAULT (page 338)
(page 334)

GSM_ASC_FONT_SIZES GSM_STALE_COLOR_KEY (page 338)
(page 334)

GSM_ASC_SCALE (page GSM_TERMSERV_CACHE_SIZE (page
335) 339)

GSM_CACHE_FILE (page

GSM_UNAVAIL_COLOR_KEY (page 339)

335)

GSM_CACHE_SIZE (page

GSM_UNAVAILABLE_TIMELIMIT (page

335) 339)

]

HIST_FORCE_HIST45_TYPES

HISTALMSERVER

(page 339)

(page 342)

HIST_PREV_TAGNAME_PREFIX

HISTALMUSER (page

(page 340)

342)

HIST_PREV_TAGNAME_SUFFIX

HISTDATAPASS (page

(page 340)

342)

HIST_TAGNAME_PREFIX (page

HISTDATASERVER

340)

(page 342)

HIST_TAGNAME_SUFFIX (page

HISTDATAUSER (page

340)

342)

HISTALARMOPC (page 341)

HISTOVERWRITETAGS
(page 343)

HISTALDATAOPC (page 341)

HISTALMPASS (page 341)

|

IPC Global Memory Use Parameters

(page 343)

IPC_QUEUE_SIZE (page 344)

L
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LICENSE_HT _DEBUG
(page 344)

LOG_OPT (page 344)

LOGIN_CANCEL_OFF
(page 345)

LOGIN_NOSAVE (page
345)

LOGIN_RETRY_PERIOD
(page 345)

]

MARQ_POINT_LIMIT_LEN (page

MAX_ALARM_CLASSES

346) (page 348)
MARQ_PROC_NEW_ALARMS MAX_TREND_BUF (page
(page 346) 349)

MARQ_RESERVED_NULL_CHAR

MULTICAST_HOSTNAME

(page 346) (page 349)
MARQ_VARIABLE _NULL CHAR MULTICAST_IP_ADDR
(page 348) (page 350)
MARQ_WORD_WRAP_ON (page | MULTICAST TTL (page
348) 350)

MARQ_WRAP_HF (page 348)

°]
OPCAE_TRACE_FLAGS
(page 351)

°]

PB_DIAGS (page 351)

PTDL_QUANTIZATION (page 359)

PCM_ENH_AUDIT (page 352)

PTEXP_ANA_EQ_NACK_AND_AL (page
359)

PERF_COUNTERS_ENABLED (page | PTM_AM_DELAY_VAL_UPDATE (page 359)

352)

PPS_OPC_SCANRATE (page 352)

PTM_TIMESTAMP_FMT (page 359)

<PORT>_CACHE_DIAGNOSTICS

PTMAP_TIMED_POINTS (page 360)

(page 353)

<PORT>_DEVICE_TIMESTAMP_UTC | PTMDP_BATCH_UPDATING (page 360)

(page 353)

<PORT>_OVRD_SCAN (page 354)

PTMDP_DO_EU_CONV (page 360)




<PORT>_SYNC_ONLY (page 354)
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PTMDP_DO_SAVEPOINT_CACHE (page

361)

<PORT>_USE_OVRD_SCAN (page

PTMDP_DO_SAVEPOINT_COMPACT (page

355)

361)

PROJECT_ID (page 355)

PTMDP_MAX_RESPONSES PER_CALLBACK
(page 362)

PRT_AUTOMOVE_BY_LOCATION

PTMDP_PROC_ALL_DYNCFG (page 362)

(page 355)

PRT_BASIC_USE_EX (page 356)

PTMRP (page 362)

PRT_GUID_DISABLE_REFID (page

PTMRP_DELAY_ALARM_STATE (page 362)

357)

PRT_TADB_COMM_TOUT (page

PTMRP_EXTERNAL_ALARM_OVERRIDE

357)

(page 361)

PRT_TADB_CONN_TOUT (page

PTX_MAX_CACHED_POINTS (page 363)

)
]
N

0

RTC_TADB_SYNCHRONIZE (page

PTX_MUTE_DC_POINT_CHANGES (page

w
ul
(e}

363)

PRTC_TADB_VALIDATION (page

PW_BLOCK_SIZE (page 364)

(98]

58

PTDL_ENABLE_MEASUREMENTS

PW_BLOCK_TIMEOUT (page 364)

(page 358)

QUERY_UTC_ONLY (page 365)

QT_ENABLE_SQL_WINAUTHEN
(page 364)

B

RAW_LIMIT_ALARM (page

REDUND_PROBE_DELAY (page

365)

367)

RCO_IGNORE_INIT_PT_UDP

REDUND_PROBE_PORT (page

(page 365)

367)

RCODB_CONN_TOUT (page

REPEAT_TOUT (page 368)

366)

RCODB_QRY_TOUT (page

RTR_ACCEPT_CONN (page 368)

366)

REDUND_LINK_SLEEP
(page 366)

RTR_DISABLE_BCAST (page
368)

REDUND_PROBE_COUNT

RTR_MAX_OUTMESSAGE_COUNT

(page 367)

(page 369)

B
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SECURE_SOCKETS (page 369)

SPC_DB_CONNECT_TIMEOUT

(page 371)

SERVER_UP_INTERVAL (page

SPC_RESIZE_OUT_OF_BOUNDS

370)

(page 372)

SETPOINT_SECURITY (page 370)

STARTUP_TIMEOUT (page

372)

SHORT_FILENAMES (page 370)

SVC_RETRY_COUNT (page

372)

SECONDARY_STARTUP_TIMEOUT

SVC_RETRY_DELAY (page

(page 371)

372)

SOLVEENGINEDEBUG (page
371)

SYSNAME (page 373)

i

TERMSERV_ALLOW_SETPOINTS

TRK_RETRY_DELAY (page

(page 373)

375)

TREND_DISABLE_READNESTED

TRKCOLLECTOR_COMM_TOUT

(page 373)

(page 375)

TRK_ERROR_RETRIES (page

TRKCOLLECTOR_CONN_TOUT

374)

(page 375)

TRK_PRJMON_INTERVAL (page

TRUNCATE_OBJ_DESCRIPTION

374)

(page 375)

TRK_PRJMON_TIMEOUT (page
374)

]
UR_LOGIN_FAILURES

(page 376)

USE_HIST_TIMEFMT
(page 376)

]

VALIDATE_PASSWORD_CHANGE
(page 376)

w

WAIT_PROJECT_TIMEOUT
(page 377)

$AM_STATUS

For Alarms Project
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Purpose Enable/disable the $AM_STATUS message.

Value Enter one of the following.

Y | Enable the $AM_STATUS alarm message.

N | Disable the $AM_STATUS alarm message

Default Value | N

ACK_TOUT

For Points and Alarms Project

Purpose To specify the default time in minutes before an alarm is automatically acknowledged by the Alarm
Management Resident Process.

Default for | Acknowledge Timeout field in the Alarm Options Properties dialog box for points and alarms.

Value Number (of minutes).
Default 0 (no automatic timeout).
Value

AE_STARTUP_CFG

For A&E OPC Server System

Purpose To select when the A&E OPC Server will read the project configuration and populate the server
configuration database.

Value The A&E OPC Server populates the server configuration database:

Y | At startup time. This might take some time (a few minutes) for very large projects to connect to
Historian.

N | When alarms are generated. This option will provide instant project connection..

|5/ Note: In this case server becomes fully configured only after every alarm has been generated at
least once

Default N
Value

ALARM_SAVE_COMMENTS

For Alarms Project

Purpose | To instruct the Alarm Viewer to remove or store alarm comments.

Default | Store alarm comments checkbox in the Alarm Properties dialog box.
for

Value Enter one of the following:
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NO | Available only while an Alarm ID appears in the Alarm Viewer. When the Alarm ID has been reset,

deleted, or automatically removed, the comment ceases to exist, or

YES | Stores comments until 20 comments have been listed for one Alarm ID, regardless of whether the

alarm has been acknowledged, reset, deleted, etc. When 20 comments have accumulated, the first
comment entered is deleted to make room for the newest comment.

Default
Value

NO

ALLOW_UPDATE_WHEN_DISABLED

For Ports Project
Purpose To specify if setpoints and unsolicited data should be processed when a port is dynamically disabled.
Value Enter one of the following:
YES | Process setpoints and unsolicited data continue to be processed. Polled data will continue to
display old values.
NO [ When a port is dynamically disabled:
» The associated devices are marked Down.
« Setpoints and unsolicited data are not processed.
Default NO
Value

AM_OLD POINT RESET

For Alarm Manager Project

Purpose | To control whether the reset of a point alarm will cause Time value displayed in the AMV to change from the
alarm's generated time to the reset time. (Updating to the reset time only applies to point alarms, not general
system alarms.)
|5 Note: The generated time value is not updated to the reset time after a manual reset.

Value Enter one of the following.
Y Update the generated time to the reset time.
N Do not update the generated time to the reset time.

Default | N

Value

AM_RESET ACK_STATE

For

Alarm Management Project
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Purpose | To reset the Acknowledge state of an acknowledged alarm that has an Acknowledge and Reset deletion
requirement to No after the alarm has been cleared. This forces a user to acknowledge the alarm again
before it is deleted from the list of alarms.

Value Enter one of the following:

YES Resets the acknowledge state to No

NO Does not reset the acknowledge state to No
Default | NO
Value

AM_SAVE ACK_STATE

For Points and Alarms Project

Purpose | To retain the current Acknowledge state of an alarm when the point transitions from the HiHi (Alarm High) to
the Hi (Warning High) state or from the LoLo (Alarm Low) to the Lo (Warning Low) state

Value Y Retains the current acknowledge state

N Does not retain the current acknowledge state.
Default | N
Value

AMLP_HIGHWATERMARK

For Alarm Line Printer Project

Purpose | To stop spooling alarm messages if more than a certain number of alarm messages are in the job queue

for the alarm printer. When this global parameter is set to its default value, all alarm messages go to the
spooler for the alarm printer. If you enter a number greater than zero (0), the AMLP program will spool alarm
messages to the printer until the high watermark is reached. Subsequent alarm messages will be dropped
until the low watermark, defined by AMLP_LOWWATERMARK, is reached.

Value Number (of jobs in the print spooler)

Default | 0 (no high watermark)
Value

AMLP_LOSTALARMSPAGE

For Alarm Line Printer Project

Purpose To print a page indicating that alarm messages were
dropped because the AMLP program detected a high
watermark for the print spooler. This global parameter
is used only when AMLP_HIGHWATERMARK is set to
a non-zero value. The page is printed when the AMLP
program detects a low watermark and resumes sending
messages to the print spooler.

Enter one of the following:
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Value

Y | Print a page indicating that alarms have been dropped.

N | Do not print a page when alarms are dropped.

Default Value | N

AMLP_LOWWATERMARK

For Alarm Line Printer Project

Purpose | To restart printing alarms if the number of jobs being spooled falls below this number. This global parameter
is used only when the AMLP_HIGHWATERMARK global parameter is set to a non-zero value.

Value Number (of jobs in the print spooler)

Default | O

Value

AMLP_MAX_QUEUE

For Alarm Line Printer Project

Purpose | The Alarm Line Printer program (AMLP) assumes that there is no restriction for the size of the alarm
message queue. If the output device is disabled, a virtual memory overflow can result AMLP_MAX_QUEUE
global parameter can restrict the size of the alarm message queue. After you implement this global
parameter, if the output device is disabled and the number of alarms in the alarm queue exceeds the value
you specify, the alarm message The alarm dropped has exceeded the configured size of alarm queue is
generated.

Value Maximum number of messages in the queue.

Default | None

Value

AMLP_USE_GEN_TIME

For Alarm Line Printer Project

Purpose | To specify whether an acknowledged or deleted alarm should be printed at the generation time or the time
of the Acknowledge or Delete action.

Value Enter one of the following:
YES The generation time is printed.
NO The time of the action (acknowledge or delete) is printed.

Default YES

Value

AMLP _USE_RESET TIME

For

Alarm Line Printer Project
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Purpose | To have the alarm printer print the time an alarm was reset. Important: The global parameter,
AM_OLD_POINT_RESET must be set along with AMLP_USE_RESET_TIME, as follows:

Value Choose one of the following: To print the reset time, set: AM O.D_PQO NT_RESET = Y and AMLP_USE_RESET_TI Mt =
Y To print the generated time, set: AM OLD PO NT_RESET = Nand AM_.P_USE_RESET_TI ME = Y

Default | N
Value

AMVS BOOTPRJ

For Alarm Sound Manager System

Purpose | To make the Alarm Sound Manager wait until a specific project, (which has also been configured to auto-
start) has completely started before it (the Alarm Sound Manager) completes its startup

Value The project name that should be completely started before the Alarm Sound Manager completes its startup.
Example Project2

Comment | If more than one project is configured to start at boot time (e.g. on the Startup Options tab in the
CIMPLICITY Options dialog box) enter the project name that the Alarm Sound Manager should wait for.

|5 Note: Add these system parameters to the Computer Parameters list. The list is located in the
Workbench's Computer>Computer Parameters section.

AMVS TIMEOUT

For Alarm Sound Manager System

Purpose | To specify the amount of time that the Alarm Sound Manager should wait for any project to completely start
before it (the Alarm Sound Manager) completes its startup.

Value Values are as follows.

Min 1 minute

Max 60 minutes

Default | 10 minutes (If AMVS_TIMEOUT is not defined.)
Value

|5/ Note: The Alarm Sound Manager will completely start as soon as Windows is started if the Alarm
Sound Manager is configured to auto-start but no project is configured to auto-start.

AUTO_CONFIG_AE_SRC

For Points (alarm configured) System (computer)

Purpose To log Setpoint Audit trail events (i.e.
$DOWNLOAD alarms) for Alarm configured
points that are specified at Filter by Source
to the Historian server.
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Value

Enter one of the following.

Y Will be logged.

N Will not be logged.

Default Value

N

Comment

The format of the string for the Source
field, in this case, for the Set Point Audit
trial event is modified to match the
source of Filter, as follows. <PROJECT>/
<RESOURCE ID>/ <Ref ID>/ <Ref ID>

BASIC_LOAD_SCRIPT_EXTENSION

For

Basic Control Engine Project

Purpose

To direct Event Manager whether to run a read-only *.bclrt file or a read/write *.bcl file if both exist with
the same name

Value

Yory

EMRP will use the following sequence till a script is found.

1. Configured extension.
2. Based on the configured extension.

« .bcl if the configured extension is .bclrt.
« .bclrt if the configured extension is .bcl.
« .bcl if the configured extension is neither.

1. .bclrt.

Note: This third pass only happens if .bclrt has not already been tried.

Not defined Not one of the values indicated above

EMRP will use the following sequence till a script is found.

1. .bcl
2. .bclrt.

Default
Value

Y Note: The default value applies to new projects.

BASIC_MULTITHREAD_COM

For

Basic Script Engine Project or System

Purpose

To enable multi-thread script COM calls.
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Comments | Script COM calls prior to CIMPLICITY 7.0 occurred in a single-thread as follows.
* COM calls were marshaled over to a single script thread to be executed.
 The script thread would wait for the COM thread to complete a call.
If a thread was already making a COM call, then the next thread had to wait for it to finish before it could
make a COM call. Each thread would have to wait for completion of the prior COM call. Beginning with
CIMPLICITY 7.0:
« Each COM call can occur in its execution thread instead of being marshaled over to a single thread.
* BASIC_MULTITHREAD_COM provides the ability to choose between using the single-thread or multi-
thread COM calls in the Basic Script Engine.
The initialization routine for the Basic Script Engine includes a flag that controls the threading behavior of
the script engine. If BASIC_MULTITHREAD_COM is enabled, the flag will call COM objects in the thread
of execution instead of being marshaled over to a single thread. Note: Some limited releases before
CIMPLICITY 7.0 may also include this feature.
Value Choose either of the following.
Y | Initializes multi-thread COM calls.
N | Initializes single-thread COM calls.
Default N | Note: The default has been set to N in order to insure backward compatibility with scripts created in
Value previous CIMPLICITY versions.

BCE_ENABLE_TRACING

For

Basic Control Engine Project

Purpose

To specify if the Trace
command will output any
trace information. The
Event Manager Resident
Process (EMRP) reads
BCE_ENABLE_TRACING
when the EMRP is started
during project startup. If
BCE_ENABLE_TRACING
is set to N or n, the Trace
command does not output
any trace information.

It simply returns before
checking whether or not
TraceEnable has been
called. TraceEnable/
TraceDisable commands
only affect the output of

a single running event
script thread. However,
BCE_ENABLE_TRACING
affects all scripts run in the
EMRP on a single server.

Value

Enter one of the following.

Y | Enables the parameter
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N | Disables the parameter

Default Value | N

BCO ARCHIVE AFTER N_SWEEPS

Advantages of using BCO_ARCHIVE_AFTER_N_SWEEPS include:

1. Since these activities are carried out in two different threads (parallel processing), there will not
be any delay in posting the jobs to the device.

2. Archive/Delete can be delayed; archive/delete is not as high a priority as posting jobs. This will
be helpful thereis ahigh volume of broadcast messagesin the plant.

BCO _AUTO ARC DEL

For Broadcast (Order Execution Mgt) Project

Purpose | To perform archiving or deletion of jobs from the History folder, based on the history queue limits, which are
configurable through the Broadcast Queue Monitor Configure Device GroupsWeb page.

Value 0 [ (Or any value other than 1 or 2) Auto archive and auto delete are disabled.

1 | Auto-archive the Job from History folder to Archive folder

2 | Auto-delete the Jobs from History folder.

Default | 0
Value

BCO DATA_FETCH_ERROR

For Broadcast (Order Execution Mgt) Project

Purpose | Determines what Broadcast will do when there is a data fetch error. Broadcast does the following based on
whether you disable or enable BCO_DATA_FETCH_ERROR.

Disable BCO_DATA_FETCH_ERROR

Even when there is a data fetch error

« Jobs are sent to the device.
« An alarm and log are generated.

|5 Note: Inanormal scenario (BCO_DATA_FETCH_ERROR is disabled or enabled) the following
occurs.

Whether or not there is an error, W or A is added to the filename, as follows.

WYSIWYG W is added.
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Example 0001094033735734;W;111-11;111-11;All in One-
SOLVE_PRT_EXPRT;221;YANE;111-11;.cwf

ASCII A is added.

Example 0001094033735734;A;111-11;111-11;All in One-
SOLVE_PRT_EXPRT;221;YANE;111-11;.caf

Enable BCO_DATA_FETCH_ERROR

When there is a data fetch error the following occurs.

« Jobs:
» Do not go to the device.
» A zero is added to the filename, before the W or A. (W and A are described in the Disable

BCO_DATA_FETCH_ERROR section.)

WYSIWYG 0 is added before the W.

Example 0001094033735734;0W;111-11;111-11;All in One-
SOLVE_PRT_EXPRT;221;YANE;111-11;.cwf

ASCII 0 is added before the A.

Example 0001094033735734;0A;111-11;111-11;All in One-
SOLVE_PRT_EXPRT;221;YANE;111-11;.caf

This does not allow any of the subsequent jobs to be sent to the device.

The user must: 1. Open the file manually 2. Enter correct data for the objects / fields which had data fetch
error 3. Rename the file by removing the appended 0, Result: the jobs will start being posted to the device.

« Stay in the active folder of the device.

« Alog is generated in the cor log.
* An alarm is generated.

Value 0 [ (Or any value other than 1) Disabled
1 | Enabled

Default | 0 | Disabled

Value

BCO DFO_NOT_AUTO

To enable or disable printing fail over from the secondary printer back to the primary
printer.BCO_DFO_NOT_AUTO enabledWhen the:

1. Primary device of a device group goes down the jobs are sent to secondary device

2. Secondary device goes down broadcasts are sent to the primary device automaticaly, if itis
available.
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BCO _DFO_NOT_AUTO disabledWhen the:
3. Primary device of adevice group goes down the jobs are redirected to the secondary device.

4. Secondary goes down the jobs are not redirected to the primary automatically.
The user will have to reset the devices from Broadcast Queue Monitor Web pages.Note: The
fail over will occur when the secondary fails, e.g. runs out of paper, and the primary is back on
line.

BCO_SWEEP _DELAY

For Broadcast (Order Execution Mgt.) Project

Purpose To introduce a time delay between two
successive sweeps.

Value Number (of seconds).
Default Value | 1 second
BIND_ADDR
Obsolete

BIND_ADDR isnot used in CIMPLICITY v6.2 and higher.

To specify which | P address to use on a computer that has multiple |P addresses, and is not using
Cabling Redundancy, enter the node name and matching IP address for the computer on the Hoststab
inthe CIMPLICITY Options dialog box.

Configuration must be for 2 NIC's as well as for cable redundancy.

BROWSE_TREE_UNDERSCORE

For Project (for servers) System (for viewers)

Purpose | When viewing point data in a tree view, the tree view uses the period as the delimiter between branches.
Using this global parameter allows the underscore character to be used.

Value Any value turns BROWSE_TREE_UNDERSCORE on. CIMPLICITY code just looks to see if parameter is
defined.

Default | Undefined
Value

CE_MAX_DELAY

For Basic Control Engine Project
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Purpose | To specify the maximum delay time in seconds after which a late event will not be executed. For example,
events may be delayed when there is a heavy load on the system.

Value Number (of seconds).
Default | 60
Value

CE_MAX_THREADS

For Basic Control Engine Project
Purpose To specify the maximum number of simultaneous scripts allowed.
Value Number (of scripts).

Default Value | 30

CE_MIN_STANDBY_THREAD COUNT

For Basic Control Engine Project

Purpose Project Purpose To specify the number of threads that the Event Manager can allow to be in the idle
state indefinitely.

Value Number (of threads).
Default 0
Value

CE_POOL_THREADS

For Basic Control Engine Project
Purpose To specify the maximum number of threads in a thread pool.
Value Number (of threads).

Default Value | O (will be assigned a value that is twice the number of logical processors in the system).

CE_THREAD_TIMEOUT

For Basic Control Engine Project
Purpose To specify the idle cache time in seconds before the threads are freed.
Value Number (of seconds).

Default Value | 900

CLR_TOUT
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For Alarm Management Project

Purpose To specify a default time in minutes before an alarm is automatically reset by the Alarm Management
Resident Process.

Default for: | Reset Timeout field in the Alarm Options Properties dialog box for points and alarms

Value Number (of minutes).

Default 0

Value

CONNECT_DROP_PERIOD

For Login System

Purpose | To

specify the time in seconds before an inactive login connection is dropped by the project. The time starts

when all CIMPLICITY application windows have been exited. A user who opens a CIMPLICITY application
window during this period will not be required to log in to CIMPLICITY software again.

Value Number (of seconds).

Value

Default | 600 (Equals 10 minutes)

CONNECT_RETRY_PERIOD

For Login System
Purpose To specify the time interval for between retrying the connection to a remote project.
Value Number (of seconds).

Default Value

90 Note: 90 = Equals 1% minutes

|5/ Note: Entering a value of less than 30 seconds is not recommended.

COR_LOG_RP SCAN_TIME

For Basic Control Engine Project
Purpose To specify the periodic rate at which the Status Log file is scanned for added records.
Value Number of seconds.

Default Value

300

DB_CLOCK_ADJUSTMENT_MONITOR

For Database Logger Project

Purpose | Defines the rate at which system clock adjustments are checked. All synchronized timed events are
adjusted when a system clock adjustment occurs.
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Value Number (of seconds). Enter a value from 1 through 3600

Default Clock adjustment monitor rate in the Database Logging Properties dialog box.
For

Default 60
Value

DB_COMPACT QUEUE_SIZE

For Database Logger Project

1> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support personnel.

Purpose | For Microsoft Access (As-Is product) databases, the compact queue holds the database requests. This
global parameter defines the queue size for maintenance actions.

Value Number

Default | 1000
Value

DB_COUNTER_FIELD

For Database Logger Project

Purpose | To modify the name of the seq_num field that specified the record sequence number of each logged
transaction in the following Database Logger Tables:

« Alarm Management tables (ALARM_LOG and EVENT LOG)
» Event Manager table (EM_LOG)

* SPC tables

» HDA tables

* Tracker tables

Value An up to 80 character name. The name may include or be entirely composed of uppercase characters
(for example, SEQNUM) which is needed for certain database client applications that have problems
accessing lowercase field names from an Oracle DMBS. Note: When you use the DB_COUNTER_FIELD
global parameter, make sure that you drop all affected tables before running the project. Otherwise, the
Database Logger will not be able to recreate them with the new sequence number field name specified by
the DB_COUNTER_FIELD global parameter.

Default | seq_num(as a lowercase string)
Value

DB_DBMS QUEUE SIZE

For Database Logger Project

I> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support
personnel.
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Purpose Defines the database's queue size for non-table requests. For example, connect requests are non-table
requests
Value Enter the queue size. The minimum size is 5.
Default 1000
Value
DB_DEBUG
For Database Logger Project
Purpose | To enable the dumping of diagnostic information for the Database Logger to the MAC_DL.out and
MAC_PTDL.out files in your project's log directory.
Value Enter one of the following: A sum of any combination of:

0 Stop dumping diagnostic information—Must be explicitly specified to stop dumping diagnostic
information to the log files.

1 Print full syntax of ODBC error messages.

2 Print details of database connection when established.

4 Print syntax of ODBC statements if they fail.

256 | Print application-specific details.

512 | Print details of bulk insertion errors.

1024 | Rename/keep store and forward files after loading them. If you need additional diagnostic
information, a value of 7 (1+2+4) is recommended. Additional undocumented values should only
be used by GE Intelligent Platforms engineers as they send a great number of messages to
MAC_DL.out and MAC_PTDL.out that could quickly fill your available disk space.

Default | 0
Value

DB_ENABLE_MSEC

For

Database Logger System or Project

Purpose

To create a separate column in which the CIMPLICITY Data Logger will store the sub-second portion

of the timestamps to the nearest millisecond. This capability can be important when a database is not
capable of storing time values with a timestamp accuracy of 1/1000 of a second, which is the accuracy

that CIMPLICITY Data Logger achieves. In fact, most databases can only handle storing time values to the
nearest second. Therefore when timestamps are inserted into the database, their values are either truncated
or rounded, by the database, to a value that complies with the database's storage capabilities. You can
create DB_ENABLE_MSEC in either the Project or the System folder. The result is as follows:

Folder | Global Parameter will be used by:

System | Millisecond Logging compatible clients whom are started outside the scope of the project
environment and copied into all new CIMPLICITY projects that you create (e.g. Starting a CimView
screen outside of a project).

Project | Only the project's logging processes and Millisecond Logging compatible clients started within the
context of the project environment.
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Value Values include:

Y Creates a separate column.

N Does not create a separate column.

Default | msec is the default name of a field that CIMPLICITY creates in the database. Note: CIMPLICITY names the
Value field msec. To change this name, use the global parameter DB_MSEC_FIELD.

1) Important:

1. If you want to enable DB_ ENABLE_MSEC, create or enable the parameter before you create
any tables in the database.

CIMPLICITY creates the field as part of atable's primary key when it creates the table.
CIMPLICITY creates tables when you start your project for the first time or reconcile atable
through the Database Logger Configuration program. Therefore, you will have to drop any table
that exists before you create or enable DB_ENABLE_MSEC so CIMPLICITY can recreate
them with the new field.

2. If you want to disable DB_ENABLE_MSEC, drop existing tables and let CIMPLICITY recreate
them without the parameter enabled.

Failure to do thiswill cause logging of data to malfunction because the database will reject the
inserted data due to constraint violations.

3. If you are logging data from multiple projects to the same database then all projects must have
the feature identically configured.

4. If you are using DB_ENABLE_MSEC on more than one computer, including servers and
viewers, add DB ENABLE_MSEC on each.

5. Only Point Logging, Alarm Logging and Trending clients fully support this feature.

To dter the namethat CIMPLICITY usesto refer to or create the field in the database, create
another global parameter, name it DB_MSEC _FIELD, and provide the appropriate string value
for the field name.

DB_ENABLE_TRANSACTIONS

For Database Logger Project

Purpose | To override the default database functionality as requested by ODBC. The default functionality is determined
by the ODBC driver. If the driver supports transactions, that is the default. If you set triggers on your tables,
you should set this global parameter to N.

Value Enter one of the following:

Y Forces logging to use transactions.
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N Forces logging to not use transactions.

Default | Determined by the ODBC driver.
Value

DB_MSEC_FIELD

For Database Logger System or Project

Purpose To alter the default name that CIMPLICITY uses to refer to a field that reports the sub-second portion of
timestamps in the database.

Value String that will be the fractional portion of timestamps field name.
Default msec
Value

1. If you want to enable DB_MSEC_FIELD, create or enable the parameter before you create any
tables in the database.

CIMPLICITY creates the field as part of atable's primary key when it creates the table.
CIMPLICITY creates tables when you start your project for the first time or reconcile atable
through the Database Logger Configuration program. Therefore, you will have to drop any table
that exists before you create or enable DB_ MSEC FIELD so CIMPLICITY can recreate them
with the new field.

2. If you are logging data from multiple projects to the same database then all projects must have
the feature identically configured.

3. Only Point Logging, Alarm Logging and Trending clients fully support this feature.

DB_POINT_ID_FIELD

For Database Logger Project

Purpose | To change the name of the point_id field in the following Database Logger tables:

» Point Management data log tables

Value You can define a field name of up to 80 characters, or the maximum supported by your database. Note:
When you use the DB_POINT_ID_FIELD global parameter, make sure that you drop all affected tables
before running the project. Otherwise, the Database Logger will not be able to recreate the tables with the
new Point ID field specified by the DB_POINT_ID_FIELD global parameter.

Default | point_id (as a lowercase string).
Value

DB_PROJECT_FIELD
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For

Database Logger Project

Purpose

To change the name of the project field in the following Database Logger tables:

» Alarm Management (ALARM_LOG and EVENT_LOG)
» Event Manager table(EM_LOG)

» Point Management tables (data and group log tables)
* SPC tables

* HDA tables

* Tracker tables

Value

You can define a field name of up to 80 characters, or the maximum supported by your database. Note:
when you use the DB_PROJECT_FIELD global parameter, make sure that you drop all affected tables
before running the project. Otherwise, the Database Logger will not be able to recreate the tables with the
new project field specified by the DB_PROJECT_FIELD global parameter

Default
Value

proj ect (as a lowercase string)

DB_QUEUE_OVERFLOW_DELAY

For Database Logger Project
1> CAUTION: Do not modify this parameter unless instructed to by GE Intelligent Platforms support
personnel.

Purpose To specify the delay in seconds between logging overflow errors for the Database Logger.
Value Number (in seconds). This timeout must be configured to be:

« Greater than 5 seconds and

* Less than 86400 seconds (1 day).
Default 30
Value

DB_QUEUE_SIZE

For Database Logger System

Purpose To specify a default queue size that supports the worst-case logging during database table's logging
activity bursts.

Default for Database queue size field in the Database Logging Properties dialog box.

Value Number (for queue size).

Default 5000

Value

DB_STATUS LOG_OFF

For

Database Logger Project
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Purpose | To turn on or off the database logging messages in the Status Log. If this parameter is not defined or set to
zero (0), the messages are logged.
Value Enter for one or both of the following bits:

1 | Turns off Status Log messages that display when the logging data type has been superceded by a
column type in the database table. For examples, messages would display if a UINT point type is
changed to an UDINT point type after the table has been created.

2 | Turns off status log messages alerting a user that the Alarm Manager resident process cannot be found.
For example, messages might appear on a Viewer where there is no Alarm Manager resident process.

Default | No entry
Value

|5/ Note: Remaining bits are reserved for future use.

DB_TABLE_FAILURE_RETRY

For Database Logger Project

Purpose Defines the number of seconds to wait before attempting to reconnect to a table after a table connection
failure.

Value Number (of seconds)

Default 0 Try to reconnect immediately

Value

DB_TIME_FORMAT

For Database Logger Project

Purpose | To define the time stamp format for your database so that time and date fields will be written correctly in the
Store and Forward files. This parameter is for a database that does not use the default Microsoft Access (As-
Is product) and SQL Server time stamp format, which is used by CIMPLICITY.

Value Timestamp (is case sensitive):
Uppercase
Y Year
M Month
H Format options for the Hour specification are:

HHHH 24-hour Note: The 24-hour format is used
for Alarm logging and Point logging files
stored by default in the %SITE_ROOT%\arc
directory.

HH 12-hour Include one of the following to
specify AM or PM.

A AM

= PM
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Lowercase

d Day

m Minutes

S Seconds

t Ticks (100 ticks=1 second)
Default | Microsoft Access and SQL Server times tamp format.
Value

DB_TIMESTAMP_FIELD

For Database Logger Project
Purpose | To modify the name of the unique timestamp field which specifies the date and time of each logged
transaction in the following Database Logger tables.
« Alarm Management tables (ALARM_LOG and EVENT_LOG)
» Event manager table (EM_LOG).
« Point management tables (both data and group log tables)
» SPC tables
« HDA tables
* Tracker tables
Value An up to 80 character name. The name may include or be entirely composed of uppercase characters,
e.g. DATETIME, which is needed for certain database client applications that have problems accessing
lowercase field names from an Oracle DBMS.
When you use the DB_TIMESTAMP_FIELD global parameter, make sure that you drop all affected tables
before running the project. Otherwise, the database logger will not be able to recreate them with the new
timestamp field name specified by the DB_TIMESTAMP_FIELD global parameter.
Default | timestamp (as a lower case string).
Value

DB_TIMESTAMP_FILTER

For Database Logger Project

Purpose | To allow either rounding or truncation of all timestamps in records logged by database logging. This includes
the Point, Alarm and Event Logging, SPC and Tracker.

Default | Enable timestamp filtering field in the Parameters tab of the Logging Properties dialog box.

For

Value Enter one of the following:
A Rounds the timestamp up or down in milliseconds.
-A Truncates the timestamp at milliseconds.

Example If a timestamp filter of 30000 is specified, the following timestamps will be logged as follows:

Actual Timestamp Logged Timestamp
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3/1/99 12:22:37.730 3/1/99 12:22:30.000
3/1/99 14:37:24.102 3/1/99 14:37:30.000
3/1/99 23:59:51.107 3/2/99 00:00:00.000

If a timestamp filter of -30000 is specified, the following timestamps will be logged as follows:

Actual Timestamp Logged Timestamp
3/1/99 12:22:37.730 3/1/99 12:22:30.000
3/1/99 14:37:24.102 3/1/99 14:37:00.000
3/1/99 23:59:51.107 3/1/99 23:59:30.000
Default |0
Value

DB_TIMESTAMP_PRECISION

For Database Logger Project
1> CAUTION: Do not create or modify this option unless instructed to by GE Intelligent Platforms support

personnel.

Purpose | To specify an alternate timestamp precision for an ODBC data source that does not accept the default
provided by the CIMPLICITY Database Logger.

Value Use 22.2 unless you are instructed otherwise by GE Intelligent Platforms support personnel.

Default 22.2

Value

DB_TIMESTAMP UTC_FIELD

For Database Logging Project
Purpose To rename the existing Timestamp_utc column.
Value New name for the column.

Default Value | Timestamp_utc

DBDL_DEVICE_CHECK_PERIOD

For Database Logger Project

Purpose | To specify a default interval (in minutes) that the Database Logger should wait between disk scans for the
Disk full scan rate (min) field in the Database Logger Logging Properties dialog box.

Value Number (of minutes).

Default | 30

Value




DC_CACHE_DIAGNOSTICS

For

Device Communications Project

Purpose

To disable the caching of internal
points for all device communications
in a project.

Comments

A message is logged to the

OUT file if the diagnostics

are disabled. Configure
<PORT>_CACHE_DIAGNOSTICS
(page 353) to enable or disable
diagnostic caching for a single port.

Value

Enter one of the following:

N or n | Does not disable the caching.

Y ory | Disables the caching.

Default Value

N

DC_RETRY_ONE_DEVICE
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For Device Communications Project or System

Purpose | When an enabled device fails to respond to a read or write request from a device communications driver

for several consecutive attempts, it is said to be down and will be polled at the Retry interval rate until it
responds. By default, a device communication driver tries all down devices at each Retry interval. You can
use this global parameter to change the behavior so that the driver will retry only one down device per Retry
interval. The down devices are retried using a Round Robin algorithm (at the first Retry interval, the first
down device is retried, at the next interval, the second down device is tried, etc.). This reduces the elapsed
time for the Retry interval and is useful when many enabled devices are down.

Value Enter one of the following:

TRUE

Poll one device per Retry interval

FALSE

Poll all devices at each Retry interval

Value

Default | FALSE

DC_UNAVAIL_NAN

For Device Communications Project Level

Purpose | To enable the device communications interface to detect a floating point that has a value of NAN.

Comment | Device points with NAN value will be marked as unavailable.

Value Enter one of the following.

Y

Enables floating point with NAN value detection.
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N Does not enable floating point with NAN value detection.
Default N
DEL_OPT
For Alarms Project
Purpose To specify the default requirements for alarm deletion.

Default For Deletion requirements on the Alarm Options tab of the Alarm Definition dialog box.

Value Enter one of the following:

A Acknowledged only

R Reset only

AR Acknowledge and reset
Default Value | AR

DEVICE_DOWN_DEVICE_REF

To set the Device ID as the reference for the alarmA $DEVICE_DOWN alarm occurs when adevice
stops talking to a PL C. There are three components that make up a unique alarm

1. The Alarm ID which in this case is $DEVICE_DOWN;
2. The Resource |D, which in this case it takes it from the device's resource and

3. A Reference ID.
Asaresult, each device will have a unique alarm, regardless of its resource. The Alarm 1D
isstatic for al $DEVICE DOWN alarms; the resource changes based on the device; now the
Reference | D isthe Device ID.

DEVICE_TIMESTAMP_UTC

For Time stamp Project

Purpose | To change the default local time stamp reference that is encoded in the unsolicited communication from a
selected device that uses a UTC time base. This applies to the following communications devices: Modbus
TCP/IP or S90 Triplex.

Value Y: UTC time base is used as default. N: Local time stamp is used as default.

Default | N
Value

DGR _STOPPED UPDT DELAY
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For Dynamic Graphic Replay System

Purpose | To set a delay (in milliseconds) that the DGR waits to activate the User Interface buttons after a last point is
added from a client application.

Comment | Setting DGR_STOPPED_UPDT_DELAY helps make it less likely that an operator will press buttons before the DGR
is ready.
|5 Note: This system global parameter must be set on all viewers.

Value 2000 milliseconds or higher. Note: The value is ignored if it is less than 2000.

Default 2000

DONT_VERIFY_ESPOINT_FRID

For Enterprise Server Points Project
Purpose | To change the behavior of Setpoint Security for Enterprise Server points.
Value Enter one of the following:

Y | Setpoint Security for all points from a given provider are enforced against the Resource IDs as
configured on the provider. This means that a setpoint against any of these points with resources not
configured on the Enterprise Server project will always fail since a resource that is not configured cannot
be in a user's view.

N | If an Enterprise Server project contains the same Resource IDs as a given provider, then Setpoint
Security for points from the provider are enforced against the Enterprise Server Resource IDs. If a
resource for a given point is not configured on the Enterprise Server, then Setpoint Security for that point
is enforced against the remote project's resource.

Default | N
Value

DOWNLD_PASSWD

For increased security, this parameter is obsolete beginning with CIMPLICITY v10.0.

In prior versions of CIMPLICITY the DOWNLD_PASSWD was stored in "clear text." During a
project upgrade if CIMPLICITY findsaDOWNLD_PASSWD parameter, it creates a secure way of
storing the parameter, and fills the old DOWNLD_PASSWD parameter with random data. If you use
the setpoint password functionality you should upgrade all viewers to the most recent version. If you
decide to continue using old viewers that require setpoints, you need to put a clear text password in
the current project global parameter, but this reduces recent security enhancementsto CIMPLICITY.

DT_UPD_INTERVAL

For

Date/Time Points Project

Purpose

To set the interval in seconds to update a Project's Date & Time system points.
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Value Number (of seconds).

Default Value | 1

EM_SCRIPT_TRACING

For Event Manager Project

Purpose Automatically trace the execution of all Event Manager scripts. The trace files are:

« Located in the project's log directory and
* Named <EVENT_ID> <THREAD>.TXT

Where

» Event | Dis the event that triggered the event
* Thread is the Basic thread object that is running it.

The output file contains the following information: <time>,<script name>,<line number> Where
* ti me is the number of seconds since the start of time.

e script nane is the name of the bcl file and
* |ine nunber is the line within the file.

Value Y ory Note: Y or y =Trace values generated as the scripts run.

Default Value

|=/ Note: Enabling thisfeature will increase CPU utilization and make scripts run slower. Thisisa
diagnostic tool.

EMLOG_FLUSH_LIMIT

For Event Manager Project
Purpose To allow users to configure how many events can occur to force the log buffer to be flushed.
Value An integer from 0-10

Default Value | 0

|5/ Note: If avalue attempts to be greater than 10 it defaults to 0. Thisis due to atypical message
size where the number of segments per messageis 10.

ENABLE_MILLISEC_FOR TREND_TIME

For Trend Control Time System or Project

Purpose | To specify is the Slider Value Time should or should not display in milliseconds.

Value Enter one of the following.

Y/y/1 or Not listed | Enabled | Displays Hour: M nut e: Seconds: M | | i seconds.
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N/n/0 Disabled | Follows the regional time settings.

Default Enabled

EU_AUDIT TRAIL

For Roles Project

Purpose | To provide control over setpoint event logging results by logging the point value in the setpoint audit trail
($DOWNLOAD event) in the EU and Measurement Unit converted value. Note: Normally the point value
logged for a setpoint is the raw value of the point.

Value YES The EU converted value of the point will be logged (assuming that an EU conversion is defined
on the Conversion tab in the Point Properties dialog box.)

YESLABEL | Any defined EU label for the point will be included just after the point value in addition to
printing the EU converted value.

NO Trail is in device units; produces no action

Default | NO
Value

EXPRESSION_TRACE_LEVEL

For Historian Connection Project/System

Purpose To trace Historian related problems with connections and expressions.

Value 0 No trace file is generated.

1 A trace file is generated with any unavailable tags (incorrect tag names).

2 A trace file contains all of the errors including bad tags, which includes incorrect tag types, bad
quality and no data available.

Default None

Value

Results Results are entered in the following TRACE files.
Trace File Generated when:

CimView.TRACE | When CimView is launched.

MAC_PTDP.out | PTMDP runs

|5/ Note: The TRACE file location depends on whether or not EXPRESSI ON_TRACE_LEVEL is configured for
a selected project or as a system (computer) parameter.

The file locations are as follows.

For Location

Project ...\<project folder>\log

System ...\Proficy\Proficy CIMPLICITY\LOG
I I
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<FACEPLATE NAME>_ZOOM

For Proficy Process Systems Project
Purpose To specify the zoom size of a selected faceplate to conform to your system's resolution.
Value Number that represents the percent zoom. The acceptable range is 20 to 250. Example
70 70% of the size of the original faceplate.
50 50% of the size of the original faceplate
200 200% of the size
Default 100
Value

Comments | <Faceplate_Name> is the name of the faceplate file that will zoom to the specified size. Example Global
parameters for the following faceplate files are as follows.

Faceplate File

Global Parameter

ADV_PID_fp.cimrt

ADV_PID_fp_ZOOM

Al_fp.cimrt

Al_fp_ZOOM

ALARM_A_fp.cimrt

ALARM_A_fp_ZOOM

ALARM_D_fp.cimrt

ALARM_D _fp_ZOOM

AO_fp.cimrt

AO_fp_ZOOM

DC2S_fp.cimrt

DC2S_fp_ZOOM

DC3S_fp.cimrt

DC3S_fp_ZOOM

DI_fp.cimrt

DI_fp_ZOOM

DOUT_fp.cimrt

DOUT _fp_ZOOM

IND_A_fp.cimrt

IND_A_fp_ZOOM

IND_D_fp.cimrt

IND_D_fp_ZOOM

INTERLOCK_fp.cimrt

INTERLOCK_fp_ZOOM

MANUAL_SP_fp.cimrt

MANUAL_SP_fp_ZOOM

PBUTTON_fp.cimrt

PBUTTON_fp_ZOOM

PID_fp.cimrt

PID_fp_ZOOM

RAMPSOAK_fp.cimrt

RAMPSOAK_fp_ZOOM

TOTALIZE_fp.cimrt

TOTALIZE_fp_ZOOM

FIRST WEEK_DAYS

For Project Management System
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Purpose | To set the minimum number of days in a week in the current year required to qualify for the first week of the
year. This global parameter is used for the $PROJECT.DATE.WEEK system point.

Value Number (of days).

Default | 1

Value

FP_LEFT

For Proficy Process Systems Project

Purpose | To specify the location of the faceplate's left edge when it is opened from a mimic object. This left-coordinate
overrides positioning the left edge of the faceplate at the cursor location.

Value Number representing the Pixel location starting from left of the primary monitor screen where the left edge of
the faceplate will be positioned.

Default | Cursor location left coordinate.

Value

FP_TOP

For Proficy Process Systems Project

Purpose | To specify the location of the faceplate's top edge when it is opened from a mimic object. This top coordinate
overrides positioning the top edge of the faceplate at the cursor location.

Value Number representing the Pixel location from the top of the primary monitor screen where the top edge of the
faceplate will be positioned.

Default | Cursor location upper coordinate.

Value

GSM_ANNUN_ALARM_H1

For CimView System or Project

Purpose To specify the color and blink state to be displayed when the alarm state for an analog point is Warning
High.

Value Color Number and Blink option Format is <color_number><blink>

Color_number

A Selects a color Note: The color associated with each number is defined in the rgb.dat file.
numbger

from
0
through
15

Blink

Y | Blink




Advanced Features | 3 - System Management | 332

N

No blink.

Example 3Y Note: 3Y = Blue, Blink

Default
Value

14N

Note: 14N = Aqua, No Blink

GSM_ANNUN_ALARM_H2

For CimView System or Project
Purpose To specify the color and blink state to be displayed when the alarm state for an analog point is High.
Value Color Number and Blink option Format is <color_number><blink>
Color_number
Number | Selects the color Note: The color associated with each number is defined in the rgb.dat file.
from O
through
15
Blink
Y | Blink
N | No blink.
Example 13Y Note: 13Y = Fuschia, Blink
Default 15N Note: 15N = (Yellow, No Blink)
Value

GSM_ANNUN_ALARM L1

For CimView System or Project

Purpose To specify the color and blink state to be displayed when the alarm state for an analog point is Warning
Low.

Value Color Number and Blink option Format is <color_number><blink>

Color_number

A Selects the color Note: The color associated with each number is defined in the rgb.dat file.
numbger

from

0

through

15

Blink

Y | Blink

N | No blink.

Example 8Y Note: 8Y = Teal, Blink




Default
Value

10N Note: 10N = Green, No Blink
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GSM_ANNUN_ALARM_L2

For CimView System or Project
Purpose To specify the color and blink state to be displayed when the alarm state for an analog point is Low.
Value Color Number and Blink option Format is <color_number><blink>

Color_number

NumbeSelects the color Note: The color associated with each number is defined in the rgb.dat file.

from
0

throupgh
15

Blink

Y | Blink

N [ No blink.

Example 4Y Note: 4Y = Maroon, Blink

Default Value

13N Note: 13N = Fuchsia No Blink

GSM_ANNUN_DIG_OFF

For CimView System or Project
Purpose To specify the color and blink state to be displayed when the Boolean point is 0.
Value Color Number and Blink option Format is <color_number><blink>

Color_number

A Selects the color Note: The color associated with each number is defined in the rgb.dat file.
numier

from

0

through

15.

Blink

Y | Blink

N | No blink.

Example 13Y Note: 13Y = Fuchsia Blink

Default Value

6N Note: 6N = Purple, No Blink
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GSM_ANNUN_DIG_ON

For CimView System or Project
Purpose To specify the color and blink state to be displayed when the Boolean point is 1.
Value Color Number and Blink option Format is <color_number><blink>

Color_number

A Selects the color. Note: The color associated with each number is defined in the rgb.dat file.
numier

from

0

through

15

Blink

Y | Blink

N | No blink.

Example 6N 6N = Purple No Blink

Default Value | 7N Note: 7N = White, No Blink
[ ]

GSM_ASC_FONT_NAME

For CimEdit/CimView (Classic ASCII File Imports) System or Project
Purpose To specify the name of the font to use for text on an ASCII (.LASC) screen.
Value Font Name. Note: The font must be a TrueType font.

Default Value | MS Console.

GSM_ASC_FONT_SIZES

For CimEdit/CimView (Classic ASCII File Imports) System or Project

Purpose | To allow manipulation of (non-scalable) font sizes when a screen is imported from the Classic system to
CimView. GSM_ASC _FONT_SIZES uses a list of the 16 values to use for the 16 text sizes in an ASCII
(\ASC) file (GRE text sizes 0 to 15, which are stored in the .ASC file as -1 to 14).

Value An increase or decrease of one or all default values to increase or decrease the font display. Example You
want the fonts to display 25% larger on a CimView screen that you imported from the Classic system. Enter
values that are 25% larger than the default values as the GSM_ASC_FONT_SIZES value. 140, 175, 210,
350, 455, 700, 753, 753, 753, 753, 753, 753, 753, 753, 753, 753

Default | 112, 140, 168, 280, 364, 560, 602, 602, 602, 602, 602, 602, 602, 602, 602, 602.
Value
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GSM_ASC_SCALE

For CimEdit/CimView (Classic ASCII File Imports) System or Project

Purpose | To specify a floating-point number (for a CimView file that was imported from the Classic system) that
represents the number of document units per world coordinates when converting ASCII (.ASC) screens
to .CIM format. ASC files store screen information in floating point "world coordinates”. The screens are
100.0 world coordinates wide by 60.0 world coordinates high. Document units in .CIM files are integers in
TWIPS (twentieth of a point, 1440 TWIPS/inch).

Value Number (for doc. units/world coord) Example If you want your .ASC screens to be about six inches wide
on the display, you should use a scale factor of (1440 doc. units/inch)*(6 inches/screen)/(100 world coord./
screen) which equals 86.4 doc. units/world coord.

Default | 86.4
Value

GSM_CACHE_FILE

"<FileName>" [Lib] [Lock] [Project <ProjectName>] [Setvar <VarName> <Var Vaue>]

For CimView System or Project

Purpose | New format for each line in the cache file.

Comment
Value Filename [ Path for the cache file.
Lib Indicates that the screen should be loaded or not loaded into the library cache.
Y Load the screen.
N Do not load the screen.
Project Provides the name of the project for unqualifed points in the screen.
Lock Indicates the screen should be locked in the cache.
Y Lock the screen in cache.
N Do not lock the screen in cache.
SetVar Sets the value for the screen. A valid entry is a string with the name of the variable and the
value of the variable. There may be multiple Setvar statements for the cache entry.
VarName | Name of the variable.
VarValue | Value of the variable.

Itemsin[ ] indicate that it isan optional entry.

GSM_CACHE_SIZE

For CimView System or Project
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Purpose To increase the cache size if you require faster screen repaint times when switching between screens.

Value Number (of screens that should be kept in cache memory).

Default Value | 8

|=/ Note: Increasing this number uses additional memory and may have a negative effect on the
performance of other transactions.

GSM _DEBOUNCE_OLD_EVENTS

For CimEdit System
Purpose To disable event debouncing on CimView screens created before CIMPLICITY v7.0.
Value Enter one of the following.

Y Enables event debouncing.

N Disables event debouncing

Default Value | Y

Comment When GsM DEBOUNCE_OLD_EVENTS is set to N, the same event can be queued up
multiple times before it completes execution.

GSM_DELAY _PARSEEXPRESSIONS

For CimEdit Project or System (computer)
Purpose To delay parsing the expressions on a CimView screen until after the screen is displayed.
Value Enter one of the following.

Y Delays parsing expressions until after the screen is displayed.

N | Does not delay parsing expressions.

Default Value | N

GSM_EXPONENT_PRECISION

For CimView System or Project

Purpose | To do the following: If: A Text object on a CimView screen has a "General" format and The number of digits
exceeds this parameter, Then: The number is displayed in scientific notation with that number of significant

digits.

Value Number (of digits that will prompt a scientific notation display). Example 3 Note: The number 1234 displays
as 1.23e+3.

Default | 6

Value
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GSM_FRAMES_EXPOSE_POINT _TARGETS

For CimView System or Project

Purpose To expose objects with screen level frame containers to the point target tools as if the objects were at the
screen level.

Value Enter one of the following:

Y | Exposes the objects. All other right mouse button tools still see the same objects.

N | Preserves the frame behavior.

Default N
Value

GSM_GLOBAL_SCRIPT

For CimEdit/CimView System or Project

Purpose | To load and compile the specified scripts when CimEdit or CimView starts. You can specify multiple files
in the global parameter by separating them with semicolons (;). Any script that fails to compile will not be
available after startup.

Value String (of files that can be loaded and compiled) Example D: \ SCR M SCR. TXT; D: \ SCR\ TKSETS. TXT

Default | None
Value

GSM_GLOBAL_SCRIPTCFG

For CimEdit/CimView System or Project

Purpose | Opens a text file that contains a list of global scripts that will be loaded.
+ The file names must be enclosed in " and may contain logicals such as sI TE_RoOT, BSM ROOT etc.
» The command line option itself can contain logicals.

» Multiple files may appear on the same line.

Example "SI TE_ROOT: screens\tuning.cnmsrt” "c:\testscripts\nytest.cns" "BSM ROOT: scripts
\ C assScripts. bel "

|5 Note: If a script is not found the file name with different extensions will be tried, e.g. .cmsrt will be
substituted for .cms and .cms will be substituted for .cmsrt.

* GSM_GLOBAL_SCRIPTCFG is supported by CimEdit global script features.
* The command line argument / LoadScri pt Cf g can also be used to specify the global configuration file.

Value String File name Example GlobalScripts.txt

Default | None
Value
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GSM_LIB_CACHE_SIZE

For CimEdit/CimView System or Project

Purpose | To increase the cache size for library screens (screens that contain link source objects or class object
graphics). This is similar to GSM_CACHE_SIZE. This parameter affects console CimView sessions.

Value Number (of screens that should be kept in cache memory).

Default | 4

Value

|=) Note: Increasing this number uses additional memory and may have a negative effect on the
performance of other transactions.

GSM_OVERRIDE_POINT_FMT

For CimEdit/CimView System or Project

Purpose | To adjust the format used to display point values. This is used in most, but not all, parts of CimView. The
format is specified using a "printf" style format string, just like in the Custom display format of a text object in
CimEdit.

Value A "printf" style format string. Example % 8. 3e

Default | nothing (does not override the display)

Value

GSM_SPCONFIRM_DEFAULT

For CimView System or Project
Purpose | To specify a button other than OK to be the default in procedure or action dialog boxes. Procedure dialog
boxes contain two buttons: OK and Cancel. Action dialog boxes contain three buttons: OK, Skip, and Cancel.
Value Select one:
» OK,
« Skip or
» Cancel.
Default | OK
Value

|=/ Note: If you select adefault that is not available in the dialog box, CimView uses OK asthe
default button.

GSM_STALE_COLOR_KEY

For

CimView System or Project
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Purpose | To display a last available data value in a color rather than display the default text if a point being displayed
in a Text object on a CimView screen is unavailable and there is last available data. If no last available data
exists, the default text is displayed.

Value Numbers to specify RGB color indices. Format is: RGB(<red>,<green>,<blue>) where
<red>,<green>,<blue> are the red, green, and blue color indices from 0 to 255. Examples

RGB( 0, 0, 0) Note: The value = black

RGB( 255, 255, 255) Note: The value = white.

Default | The Text object displays the default text when the point is unavailable, regardless of whether a last available
Value value exists or not.

GSM_TERMSERV_CACHE_SIZE

For CimView using Terminal Services System or Project
Purpose To limit the CimView cache when running on a terminal server.
Value Number (of screens)

Default Value | 0

GSM_UNAVAIL_COLOR_KEY

For CimView System or Project

Purpose To specify the color index number (0 to 255) used to indicate an unavailable point value on CimView
screens.

Value Number from 0 (Black) through 255 (White) Note: The color associated with each number is defined in

the rgb.dat file.

Default 0
Value

GSM_UNAVAILABLE_TIMELIMIT

For CimEdit/CimView System or Project
Purpose To adjust how long CimView waits before displaying unknown points as unavailable.
Value Number (of milliseconds to wait)

Default Value | 2000 Note: 2000 = 2 seconds

HIST_FORCE _HIST45 TYPES

For Historian Project

Purpose | To allow the Historian v4.5 types to be forced to be created. This covers the case where the local Historian
client tools are Historian v5.0 and higher and the remote Historian archive is v4.5 or older.
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Comment | If the local client tools are Historian v4.5, this parameter is not needed; Historian v4.5 compatible types will
be used automatically.

Value Y ory Force the use of Historian v4.5 compatible tag types.

Default Not defined

Value

HIST_PREV_TAGNAME_PREFIX

For iHistOPC service Project

Purpose | To hold the previous prefix text for a Historian tag name.

Comment | HIST_PREV_TAGNAME_PREFIX will be created the first time the user stops a running project; from then
on the value will be updated accordingly.

Value Previous prefix text for a Historian tag name.

Default No default value.

Value

HIST_PREV_TAGNAME_SUFFIX

For iHistOPC service Project

Purpose [ To hold the previous suffix text for a Historian tag name.

Comment | HIST_PREV_TAGNAME_SUFFIX will be created the first time the user stops a running project; from then
on the value will be updated accordingly.

Value Previous suffix text for a Historian tag name.

Default No default value.

Value

HIST_TAGNAME_PREFIX

For Viewers (e.g. CimView, DGR) iHistOPC service for Historian Tag Generation Project

Purpose | To hold the prefix text for a Historian tag name.

Value Prefix text for a Historian tag name.

Default <PROJECTNAME> Where <PROJECTNAME> is the token which will be replaced with the actual project
Value name when this global parameter is used.

HIST_TAGNAME_SUFFIX

For Viewers (e.g. CimView, DGR iHistOPC service for Historian Tag Generation Project
Purpose To hold the Suffix text for a Historian tag name.
Value Suffix text for a Historian tag name.




Default Value
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.VALUE

HISTALARMOPC

For Viewers (e.g. CimView, DGR) Project

Purpose To hold name of the CIMPLICITY user who will have access to the corresponding OPC Server for
alarms.

Comment HISTALMOPC must be configured on the server so remote viewers can read the information.

Value CIMPLICITY user name.

Default Administrator.

Value

HISTALDATAOPC

For Viewers (e.g. CimView, DGR) Project

Purpose To identify the CIMPLICITY user who will have access to the corresponding OPC data Server.
Comment HISTALDATAOPC must be configured on the server so remote viewers can read the information.
Value CIMPLICITY user name

Default Value | Administrator.

HISTALMPASS

For

Viewers (e.g. CimView, DGR) Project

Purpose To hold the password required for the specified Historian alarm server user.
Comment HISTALMPASS must be configured on the server so remote viewers can read the information.
Value Valid password for the specified Historian alarm server user.

Default Value

Empty

HISTALMSERVER

For Viewers (e.g. CimView, DGR) Project
Purpose To hold the name of the Historian alarm server.
Comments

* The HISTALMSERVER value is used by Viewers (CimView, DGR etc.,) to connect to Historian for
Historical Data.
* HISTALMSERVER must be configured on the server so remote viewers can read the information.

Value

Historian server name.
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Default Local Server name.
Value
HISTALMUSER
For Viewers (e.g. CimView, DGR) Project
Purpose To hold the valid Historian alarm server user name.
Comment HISTALMUSER must be configured on the server so remote viewers can read the information.
Value Valid Historian alarm server user name.
Default Value | Empty.

HISTDATAPASS

For Viewers (e.g. CimView, DGR) Project

Purpose To hold the password required for the specified Historian data server user.

Comment HISTDATAPASS must be configured on the server so remote viewers can read the information.
Value Valid Historian data server user password.

Default Value | Empty.

HISTDATASERVER

For Viewers (e.g. CimView, DGR) Project
Purpose To hold the name of the Historian data server.
Comments
* The HISTDATASERVER value will be used by Viewers (e.g. CimView, DGR) to connect to the
Historian for historical point data.
« HISTDATASERVER must be configured on the server so remote viewers can read the information.
Value Historian data server name.
Default Local server name.
Value

HISTDATAUSER

For Viewers (e.g. CimView, DGR) Project
Purpose To hold the valid Historian data server user name.
Comment HISTDATAUSER must be configured on the server so remote viewers can read the information.

Value

Valid Historian data server user name.
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Default Value | Empty.

HISTOVERWRITETAGS

For Viewers (e.g. CimView, DGR) Project
Purpose To indicate whether or not tag descriptions that already exist in Historian should be overwritten.
Comment HISTOVERWRITETAGS must be configured on the server so remote viewers can read the
information.
Value Checked Overwrite tag descriptions that already exist in Historian.
Clear Do not overwrite tag description that already exists in Historian.
Default Value | Clear

IPC Global Memory Use Parameters

For CIMPLICITY Interprocess Communication (IPC) System

Purpose To modify the parameters IPC uses to determine what is "reasonable" growth in the use
of system memory. CIMPLICITY Interprocess Communication (IPC) will accommodate
"reasonable" periods of temporary growth in the use of system memory, yet try to keep
errant clients from causing IPC Memory growth to consume all resources.. There are
two sets of global parameters. The first set is for On-Node message "ports"; the other
set is for Off-Node communications through "sockets".

On-Node Message "Ports"

Global Parameter Specifies:

PORT_PERIOD_SECS The number of seconds in a calculation period. The default is 5.

PORT_GROWTH_PERIODS | The number of periods to allow that message production exceeds message
consumption. After this number of periods messages will be dropped. Defaults to 6.

PORT_NONE_CONSUMED | The number of periods to allow with no message consumption. Defaults to 3. When

the queue of port overflows and exceeds the above parameters the following message
will be logged: Router to Application queue overflow on port If you see the above
message tuning the above parameters may help. Typically the problem occurs because
data is being produced faster than it can be consumed and changing these parameters
will only delay the problem not solve it. Typically the solution to the problem is to slow
down production (e.g. reduce scan rates) or speed up production (e.g. faster computer,
more RAM)

Off node Communications through "Sockets"

Global Parameter Specifies

SOCK_PERIOD_SECS The number of seconds in a calculation period. Defaults to 15.

SOCK_GROWTH_PERIODS | The number of periods to allow that message production exceeds message
consumption. After this number of periods messages will be dropped. Defaults to 6.
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SOCK_NONE_CONSUMED | The number of periods to allow with no message consumption. Defaults to 3. When

the queue of the "socket" overflows and exceeds the above parameters the following
message will be logged: Router dropped off node message to... If you see the above
message tuning the above parameters may help. Typically the problem occurs because
data is being produced faster than it can be consumed and changing these parameters
will only delay the problem not solve it. Typically the solution to the problem is to slow
down production (e.g. reduce scan rates) or speed up production (e.g. faster network,
faster computers, more RAM).

IPC_QUEUE_SIZE

For Router System
1> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support personnel.

Purpose | To specify the maximum number of messages buffered by the Router in its Router to application queue.
The first time a queue overflows, it logs the following message to the Status Log: Router to Application
queue overflow on port <port_name> Further queue overflows on the same port do not result in any more
error messages. When the queue overflows, if the new message is not a response required message, it is
dropped. If it is a response-required message, it is not dropped and the queue size can temporarily exceed
the specified value.

Value Number (of messages).

Default | 50

Value

LICENSE_HT_DEBUG

For Router System
Purpose | To log the current hyper-threading capability in addition to the number of physical and logical processors,
which are logged at router startup.
Value Y Logs the current hyper-threading capability at router startup.
N Does not log the current hyper-threading capability at router startup.
Default N
Value
LOG_OPT
For Database Logging Project
Purpose To define the default logging conditions for an alarm. You can choose any of the following:
Value Enter any combination of the following:
G Alarm is generated.
A Alarm is acknowledged.

R Alarm is reset.
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D Alarm is deleted by a user.

Default Value

No logging options

LOGIN_CANCEL_OFF

For CIMPLICITY Login Project
Purpose _To prevent users from closing the CIMPLICITY® Login dialog box before logging in or cancelling the log
in.
Value Select one of the following.
1 | Displays the following on the CIMPLICITY® Login dialog box.
A | X button enables a user to close the dialog box without logging in.
B | Cancel enables a user to cancel the log in.
0 | (Or the global parameter does not exist.) Hides the following on the CIMPLICITY® Login dialog
box.
A | No X button prevents a user from closing the dialog box without logging in.
B | No Cancel button prevents a user from cancelling the log in.
Default 0
Value

LOGIN_NOSAVE

For CIMPLICITY Login Project

Purpose To remove the Save Username and Password checkbox from a CIMPLICITY Login dialog box.

Comments | CIMPLICITY Login dialog box when LOGIN_NOSAVE is not added to the project.
CIMPLICITY Login dialog box when LOGIN_NOSAVE is added to the project.

(computer (page 296)) level global parameter.

) Important: If you are using a Viewer LOGIN_NOSAVE must be set on the Viewer as a System

Value LOGIN_NOSAVE can be added and will function without a value.
Default None
Value

LOGIN_RETRY_PERIOD

For CIMPLICITY Login Project. Do not modify this option unless instructed to by GE Intelligent Platforms
support personnel.

Purpose To specify the retry period in seconds for connecting to a project whose User Registration program is
down.

Value Number (of seconds).
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Default 15

Value

MARQ POINT LIMIT_LEN

Purpose Defines the number of display characters for text points.

Value A number between 20 and 80.

Default Value | 80.

MARQ PROC _NEW_ALARMS

Purpose Determines how a new alarm will be displayed within the cycling marquee queues.

Value Either of the following.

YES Display new alarm messages immediately.

NO Append new alarms to the end of the marquee queues.

Default Value | YES

MARQ RESERVED NULL_CHAR

Purpose Defjnes
the
ASCII

character
that
will
be
reserved
to
spegify
the
NULL

character.

Value ASCII
character
betyveen
1
and
255,




Comment
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‘Default Value| | |

MARQ VARIABLE _NULL_CHAR

Purpose | Enables the use of a variable or changing NULL termination character on a message by message basis.

Value An ASCII character between 1 and 255.

Comment | The code is expects a sequence of characters ~$xx, where xx is the hex representation of the NULL
termination character zero filled (e.g. of ), on the beginning of a message. This new NULL termination
character will be used until another message changes it.

Default 0
Value

MARQ WORD_WRAP_ON

Purpose | Enables or disables the word wrap feature.

Value Either of the following.

YES | To cause a character counter to count the characters in the message to be displayed. The character
counter will insert a newline character when a word will be broken across lines of a marquee. Note
that not all marquees support the word wrap feature.

NO | Disable the word wrap feature.

Default | NO
Value

MARQ WRAP _HF

Purpose Enable or disable the word wrap feature for header and footer messages.

Value Either of the following.

YES | Include the characters within the header and footer messages for the word wrap feature.

NO [ Disable the word wrap feature for header and footer messages.

Default Value | NO

MAX_ALARM_CLASSES

For Alarm Classes System
Purpose To specify the maximum number of alarm classes that can be created in a system.
Value Number (of classes).

Default Value | 550

Y ou activate this parameter by creating a globals.ini file.
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todo: Toactivate MAX ALARM_ CLASSES.

1. Open Microsoft Notepad (or another text editor).
2. Enter the following two lines.

[ COUNTERS]

MAX_ALARM CLASSES =<number>

Where

<number>= The maximum number of alarm classes allowed for the CIMPLICITY computer.

3. Save thefile as Globals.ini.
4. Place Globals.ini in the ...\Proficy\Proficy CIMPLICITY \Data directory.

5. Restart CIMPLICITY for the new maximum number of alarm classes to take effect.

@ Warning:

+ Do not change the globals.ini value once you have any CIMPLICITY process running.
Changing the globals.ini once any CIMPLICITY processis running could cause memory
corruption, or an access violation.

* It isrecommended that you reboot after changing the value in the globals.ini, sinceit is
used to set up the shared memory file for the performance counters used in all the projects
on a computer.

MAX_TREND_ BUF

Be aware that increasing this parameter will affect system performance.

For Trending Project

Purpose | To specify the maximum number of point values a point buffers for Trending. Point buffering is used when a
chart is first displayed and there is some initial data. Note: If a value is entered in the Max samples field on
the General tab in the Point Properties dialog box, the lower number ( or MAX_TREND_BUF) determines the
ceiling of buffered values.

Value Number (of point values).
Default | 200
Value

MULTICAST_HOSTNAME

For IP Address Traffic System
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Purpose | To change the name used in the DNS lookup. MULTICAST_HOSTNAME takes the host name of the
multicast host machine as input and returns its IP address.

Value IP address.
= Note: If the multicast host machine does not have an IP address, the value of the
MULTICAST_IP_ADDR global parameter is returned.

Default | a wvPmuLTIP

Value

MULTICAST_IP_ADDR

For IP Address Traffic System
Purpose | To select different multicast addresses.
Value IP address Guidelines
« I[P multicast addresses, also known as group addresses, are in the class D range of 224.0.0.0 to
239.255.255.255 as defined by setting the first four high order bits to 1110.
In network prefix or Classless Inter-Domain Routing ( CIDR) notation, IP multicast addresses are
summarized as 224.0.0.0/4. Multicast addresses in the range 224.0.0.0 to 224.0.0.255 (224.0.0.0/24) are
reserved for the local subnet and are not forwarded by IP routers regardless of the Time to Live (TTL) in the
IP header.
* The IP multicast addresses from:
» 224.0.1.0 to 238.255.255.255 are either reserved or assigned to a multicasting application.
+ 239.0.0.0 to 239.255.255.255 (239.0.0.0/8) are reserved for applications that can be administratively
scoped.
» The following are examples of reserved IP multicast addresses:
+ 224.0.0.1—all hosts on this subnet.
+ 224.0.0.2—all routers on this subnet.
» 224.0.0.5-Open Shortest Path First (OSPF) Version 2, designed to reach all OSPF routers on a
network.
» 224.0.0.6—OSPF Version 2, designed to reach all OSPF designated routers on a network.
» 224.0.0.9-Routing Information Protocol (RIP) Version 2.
» 224.0.1.1-Network Time Protocol.
For the latest list of reserved multicast addresses, visit the Information Sciences Institute web site.
Default | 224.0.0.29
Value

1> CAUTION: If you change the address, make sure that you change it on al the machines, in
order to insure that they will continue "talking” with each other.

MULTICAST_TTL

For

IP Address Traffic System

Purpose

To specify the time a multicast message lives. This can be used to control how many routers will forward the
message.
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Value Number (of routers). Note: Every time a message goes through a router one unit is deducted from the value.
When the value reaches 0, the data transmission stops.

Default | 10

Value

OPCAE_TRACE_FLAGS

For A&E OPC Client Project
Purpose To control tracing for an A&E OPC client.
Value Bit mask values are as follows.
1 | Basic Errors/warnings only.
2 | Notifications From the OPC server.
4 | Actions User ACKs and processing of the Event Queue so it will also record OPC
events from the server.
7 | Most comprehensive | Includes 1 +2 + 4.
trace
Default No tracing.
Value
PB_DIAGS
For Point Bridge Project
Purpose | To enable or disable Point Bridge diagnostics.
Value Numeric values in the following format:
LEVEL=<num1> FILECLOSE=<num2>,DBGCHK_SECS=<num3>,DUMPPOINT where:
<numl1> controls the amount/detail of diagnostic output. The value ranges from 0 to 9, where 0
means no debugging output, and 9 means the maximum amount of debugging output.
<num2> is a value for NT operating systems that may handle output files in a manner that prohibits
multiple process access (as sometimes occurs with NT on DEC Alpha platforms). This
value controls approximately how often the output file will actually be closed/re-opened,
in seconds. A value of 0 (zero) means that this period closing will not occur. Any non-zero
value of less than 60 will be forced to 60.
<num3> provides a number of seconds for an internal timer that rechecks the parameters in the
Global Parameters file. This value cannot be less than zero. The default value is equivalent
to five minutes.
DUMPPOINT | initiates a one-shot dump of the Point Bridge internal information regarding the state
of points it is servicing. This parameter is only acted upon once when any of the other
arguments are changed, and the resulting change leaves LEVEL with a non-zero value.
Default
Value
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PCM_ENH_AUDIT

For

Change Management System

Purpose

To enable or disable enhanced auditing

Comment

PCM _ENH_AUDI T:

« Is added automatically if you check Enable enhanced auditing on the Project Properties dialog
box>Change Management tab.
» Can be added manually.

Value

Enter one of the following:

Y | Enables enhanced auditing

N | Disables enhanced auditing

Default
Value

One of the following.

Does|

exist

hEnable enhanced auditing has never been checked on the Project Properties dialog box>Change
Management tab.

Y

Enable enhanced auditing is checked on the Project Properties dialog box>Change Management
tab.

PERF_COUNTERS_ENABLED

For

InterProcess Communications System

Purpose

To enable or disable performance counters.

PERF_COUNTERS_ENABLED should
be defined on nodes that lack support
for performance counters, such as XP
embedded, which may not have support
installed for performance counters.

Value

Enter one of the following:

Y

Enables performance counters.

N

Disables performance counters.

Default Value | Y

PPS OPC_SCANRATE

For

Proficy
Procesg
Systems$
Project




Purpose

To set
the
scan
rate
for all
configured
PPS
OPC
Group
settings
in the
project.

Value

Scan
rate
time in
microseconds
(ms).

Default Value

0| ms

<PORT> CACHE_DIAGNOSTICS

For Device Communications Project

Purpose To enable or disable diagnostics cache on a single port.

Comments DC_CACHE_DIAGNOSTICS (page 325) is evaluated
first and then <PORT>_CACHE_DIAGNOSTICS. A
message is logged to the OUT file if the diagnostics are
disabled.

Value Enter one of the following:
Norn Disables diagnostics.
Yory Enables diagnostics

Default Value | N

<PORT> DEVICE_TIMESTAMP_UTC

For

Time stamp Project Port

Purpose

To change the default local
time stamp to a UTC time
base for all unsolicited
messages coming to a port.
that have the time stamp
embedded. This applies to
the following communications
devices.

Modbus TCP/IP

S90 Triplex

Value

Y | UTC time base is used.
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N | Local time stamp is used.

Default Value | N

<PORT> OVRD_SCAN

For Scan Rate Project
Purpose | To define the scan rate scale and unit for a selected port.
Comment | The port level has the highest precedence for the base scan rate.
Value Point ID Of a configured INT array point that has 2 elements
Elements are:
Element_1 Scale Between 1 and 1000 inclusively.
Element_2 Units Between 1 and 4
1 TICKS (1/100 seconds)
2 Seconds
3 Minutes
4 Hours
Note: The scale and units and be changed during runtime.
Default No point ID is identified.

<PORT> SYNC_ONLY

For Device Communications that support asynchronous polling by default, including:
Triplex
AB Ethernet
Mitsubishi TCP/IP
Sharp
Purpose To disable asynchronous polling for all devices on a port if poll after setis required. Note: Check Poll after
seton the Device tab in the Point Properties dialog box to enable the functionality.
Comments | Replace <PORT> with the actual port name. Example S90TRI1_SYNC_ONLY
Value Y | Polling for all devices on the port is synchronous only.
N | Asynchronous polling for all devices on the port, where the feature is supported by the device
communication interface, is enabled.
Default N
Value
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|5/ Note: Whereit is available, asynchronous polling typically provides better data collection
performance than does synchronous polling.

<PORT> USE_OVRD_SCAN

For Scan Rate Project
Purpose To enable the override of the scan rate for a selected port.
Value Point ID

» Of a configured Boolean virtual point.
» Set to 1 enables the base scan rate override.

Note: The point ID can be set to 1 during runtime.

Default Value | No point ID is identified.

PROJECT_ID

For Multiple Projects Option Project

1> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support

personnel.
Purpose To specify the one character Project ID for the project.
Value Enter a letter A through Z, or number 0 through 9.
Default None

Value

PRT_AUTOMOVE_BY_LOCATION

For PRT Project

Purpose | To include an additional string_80 array point named<existing auto move point name>.LOC for each
region with an auto move point; the array point provides a single update when the entire move operation has
finished.

Value Values are as follows.

1 Populates the string_80 array point with point IDs

) Important: The string_80 array point must be configured by the user ahead of time or a
warning message will be logged on project startup.

0 or Not Does not incorporate the string_80 array point, if it exists.
created

Default | Not
Value created




Advanced Features | 3 - System Management | 356

Note:

L=

* Vaues that were in the regular auto-move point sequence, will be in the same sequence in the
string_80 array point'sarray elements.

» The number of elementsin the new location based auto-move point will match the number of
configured items per location for that region.

* A new location based point will be updated with the ID of each item moved in its own array
element in the same order that they transitioned as a single update.

« If no auto-move point updates occur as aresult of a move operation, the new point will not be
updated.

PRT BASIC_USE EX

For PRT Project

Purpose To change the way the CIMPLICITY behaves with regard to getting a list from a project. If the user
wants ALL PRT Basic scripts used the new EXtended PRT_APIs they can define a Project level Global
Parameter.

Value Enter one of the following.
0 Use old PRT API methods.
1 Use new Extended methods and allow across project lists properly.
2 Use new Extended methods.

Default 0

Value

Comments | In addition to this global parameter you can specify these parameters on a script basis. This is done

through the following methods:

' Use old PRT_API nethods

Prt Set Proj ect Sear ch PRT_PRQIECT_SEARCH OLD

' Use new Extended nethods with search restricted in |ocal project
Prt Set Proj ect Sear ch PRT_PRQJECT_SEARCH CURRENT

' Use new Extended nethods with search in all connected projects
Prt Set Proj ect Sear ch PRT_PRQIECT_SEARCH GLOBAL

This change will affect all of the follow ng calls:

Af fects:

PRT. Get | t enLi st

PRT. Get Regi onlLi st

PRT. Get G ouplLi st

PRT. Get Ser vi celLi st

PRTSer vi ce. Get | t enli st

PRTSer vi ce. Get Regi onLi st

PRTSer vi ce. Get Gr oupLi st

PRTG oup. Get | tenlLi st

PRTG oup. Get Regi onlLi st

PRTRegi on. Get | t enli st

Example

This example script assumes that GRP1 exists in both projects.




Sub Mai n()
Dim nmain As New Prtgroup

Prt Set Proj ect Sear ch PRT_PRQIECT_SEARCH CURRENT
Associ ated with appropriate project
mai n. proj ectid = " TRACKERL"
main. ld = "CGRP1"
Get a list of items fromgroup "NMAIN'
and di splay them one by one in a nessage box.
mai n. Get | tenLi st
for j =0 to main.ltenCount - 1
return all itenms from TRACKERL in GRP1
MsgBox main.lten(j).ltemd
next j
Associate with different project
mai n. proj ectid = " TRACKER2"
nain. ld = "GRPL"
Get a list of items fromgroup "MAIN'
and di splay them one by one in a nessage box.
mai n. Get | tenLi st
for j =0 to main.ltenCount - 1
return all items from TRACKER 2 in GRP1
MsgBox main.lten(j).ltemd
next j
End Sub

Use new Extended nmethods with search restricted in |local project
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In this example:

except it will use the new Extended APl methods.

« If you change "PrtSetProjectSearch PRT_PROJECT_SEARCH_OLD" then the:

» Second association of putting the main.projectid to "TRACKER2" will have no impact.

» Subsequent Getltemlist would be against the original project "TRACKER1".

» The same can be said for changing to "PrtSetProjectSearch PRT_PROJECT_SEARCH_GLOBAL"

PRT_GUID_DISABLE_REFID

For PRT Project

Purpose To stop PRT from generating reference ID's.

Value 1 PRT will not generate reference ID's.
0 PRT will generate reference ID's.

Default Value | None | PRT will generate reference ID's.

PRT_TADB_COMM_TOUT

For PRT/TADB Project

Purpose | Number of seconds PRT can take for a command to be successful in the TADB before it times out. Time out
will trigger an alarm to alert the user that the command failed.

Value Number (of seconds to wait before command time out)

Default | 60
Value
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PRT_TADB_CONN_TOUT

For PRT/TADB Project

Purpose | Number of seconds PRT can take to make a connection with the TADB before it times out. Time out will
trigger an alarm to alert the user that the connection failed.

Value Number (of seconds to wait before connection time out)
Default | 60
Value

PRTC_TADB_SYNCHRONIZE

For PRT/TADB Project
Purpose Controls whether or not prtc.exe will perform synchronization of PRT and TADB during startup.
Value Enter one of the following:
Y Will perform synchronization during startup.
N Will not perform synchronization during startup.
Default Value | N

PRTC_TADB_VALIDATION

For PRT/TADB Project
Purpose Controls whether or not the PRT Collector will generate the XML report
Value Enter one of the following:

0 | Do not generate a report.

1 | Generate a report before synchronization.

2 | Generate a report before and after synchronization.

3 | Generate a report after synchronization.

Default Value | 0

PTDL_ENABLE_MEASUREMENTS

For Measurement System (Data logging) Project

Purpose To specify whether point values are to be logged in the currently active measurement system.

Default For Enable measurement systems field on the Parameters tab of the Logging Properties dialog box.

Value Enter one of the following:

0 Don't use a measurement system.
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1 Use the currently active measurement system.

Default Value

PTDL_QUANTIZATION

For Data Logging Project
Purpose To specify the rate in ticks at which the Point Data Logger submits data for logging.
Default for: Point data logging scan rate field in the Database Logger Logging Properties dialog box.
Value Number (of ticks) that is:
. Fast_er than the fastest table scan rate in ticks at which the Point Data Logger will submit data for
. :_Oa?rglg?a-nough so that all the data for a PLC scan comes into the database together.
(100 ticks=1 second)
Default 100
Value

PTEXP ANA_EQ NACK_AND AL

For Application expressions Project

Purpose | ANA behavior changed in CIMPLICITY V.6.1
PTEXP_ANA EQ NACK_AND AL can control which ANA behavior is used.

Value n, N, f or F then ANA displayed TRUE if an alarm is not acknowledged. y, Y, t or T then ANA displays
TRUE only if a point is in alarm state and has not been acknowledged.

Default | for new Projects (V9.5 and higher) y, Y, tor T for older Projects (prior to V9.5) n, N, f

Value or F Note: ANA displayed TRUE if an alarm is not acknowledged i.e same as NACK, irrespective of
PTEXP_ANA_EQ_NACK_AND

PTM_AM_DELAY VAL_UPDATE

For Point Management

Purpose If point alarms are configured to update the point value in the message the updates will be delayed by
this amount

Value Number (of seconds)

Default 0

Value

PTM_TIMESTAMP FMT

For

Points Project
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Purpose To define the time format for timestamps that are converted to strings.
Value m d/yy HHHH: MM SS. TTTTTT A Where
m month
d day
yy year
HHHH hour
MM minute
SS seconds
TTTTTT milliseconds
A microseconds
Default Value | md/yy HHHH: MM SS. TTT A
Examples m/dlyy HHHH:MM:SS.TTTTTT A m/dfyy HHHH:MM:SS A

PTMAP_TIMED_POINTS

For Points Project

Purpose Allow the user to have off node ON_CHANGE requests updated only after a specified number of
seconds.

Value Number (of seconds)

Default No entry

Value

PTMDP_BATCH_UPDATING

For Derived Points Project

Purpose | To control updating of derived points with batch processing or a memory-efficient approach.

Value Enter one of the following.
Y Batch processing
N Memory-efficient approach.
Default Y

PTMDP_DO_EU_CONV

For

Point Configuration Project

Purpose

To automatically convert Virtual Point ID values that you use in the Expression
Editor to engineering units without having to use the EU_CONV(<point_id>)
function.
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Value Enter one of the following:
0 | Do not automatically convert Point ID values to engineering units in expressions.
1 | Automatically convert Point ID values to engineering units in expressions.
Default Value | O

PTMDP_DO_SAVEPOINT _CACHE

For Point Configuration System and Project
Purpose To define when virtual point values will be stored.
Default For Store values radio buttons in the Point Setup dialog box.
Value Enter one of the following:

0 | Point values will be stored on point update.

1 | Point values will be stored on project shutdown
Default Value | 1

PTMDP_DO_SAVEPOINT_COMPACT

For Point Configuration Project
Purpose To define whether virtual point storage is to be compacted on project startup.
Default For Compact on project startup check box in the Point Setup dialog box.
Value Enter one of the following:
0 | Do not compact the point storage on project startup
1 | Compact the storage on project startup
Default Value | 0

PTMRP_EXTERNAL_ALARM_OVERRIDE

For Enterprise Project System

Purpose | To enable external point alarm states to be reset (e.g. Point Bridge or Enterprise points).

Value Values are:

1

Enables PTMRP_EXTERNAL ALARM OVERRI DE.

Not 1

Does not enable PTVRP_EXTERNAL_ALARM OVERRI DE. If @ Source project point was in an alarm state
and was reset, the external point will not be reset; it will continue to display in an alarm state.

Default

Not 1




Advanced Features | 3 - System Management | 362

PTMDP_MAX_RESPONSES PER CALLBACK

For Point Management

Purpose | To control the number of point updates the Derived Point Process will process at a given time. The Derived
Point Process will process up to this number of point updates before performing calculations on configured
derived points.

Value Number (of updates)

Default | 100

Value

PTMDP_PROC_ALL_DYNCFG

For Point Configuration Project
Purpose | To ensure that when class objects are created in dynamic mode, all expressions will be updated,
Comment | This global parameter is available for the rare instances when it is found that some calculated expressions
are not evaluated and updated.
Value Enter the following.
Y Ensures that all expressions will be updated.
N Does not ensure that all expressions will be updated.
Default N
Value
PTMRP
For Point Management Project
! CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support
personnel.
Purpose To define the default Point Manager to be used for point processing.
Value Name (of the default Point Manager).
Default MASTER _PTMD_RP
Value

PTMRP_DELAY_ALARM_STATE

For

Point Management Project
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Purpose To delay the alarm states that the Point Manager sends to all the applications with point value
updates using the PTMAP API.
|5 Note: The state update can be seen in:

» CimView using the AL, A1, A2, AL1, AL2, AH1 and AH2 functions.
» The Point Control Panel with the coloration of the text line that is used to display the point and its
data.

Comment Setting PTVRP_DELAY_ALARM STATE is not required for the Alarm Manager, for both point and event
alarms. The Point Manager always delays notification of alarms to the Alarm Manager regardless of
this parameter setting. The Alarm Manager then sends alarms to both the alarm client API's and the
Alarm Viewer.

Value Enter one of the following:

Y Do not enable the alarm state delay; the alarm state changes immediately

N (or does not exis.) Enable the alarm state delay.

Default Value | Parameter does not exist.

PTMRP_EXTERNAL_ALARM_OVERRIDE

For Enterprise Project System
Purpose | To enable external point alarm states to be reset (e.g. Point Bridge or Enterprise points).
Value Values are:

1 Enables PTVRP_EXTERNAL_ALARM OVERRI DE.

Not 1 Does not enable PTVRP_EXTERNAL_ALARM OVERRI DE. If @ Source project point was in an alarm state
and was reset, the external point will not be reset; it will continue to display in an alarm state.

Default | Not 1

PTX_MAX_CACHED POINTS

For Point Translation Project

Purpose | To limit the size of the Point Translation cache on systems that have a large number of points. Point
Translation adds points to the cache when Point Management applications (for example, scripts, CimView
windows, Point Control Panel, etc.) requests point information.

1> CAUTION: If the applications on a project are likely to cycle through all the points, limiting the cache

size may cause point information to update more slowly than expected.

Value Enter 0 or delete the global parameter if you do not want to limit the cache size. Otherwise, enter the number
of points to be put into the cache.

Default | O

Value

PTX_MUTE_DC_POINT_CHANGES
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For Point Project

Purpose | To stop sending point configuration change requests to the device communications, thus allowing them to
operate in an efficient manner while dynamic configuration is occurring.

Value Select one of the following.

Y Stops configuration change notifications.
N Allows configuration change notifications.
Default | N
Value

PW_BLOCK_SIZE

PW_BLOCK_SIZE defines the | P address block size that the Project Wizard uses to determine how
many | P address requests to make at one time. Thisis particularly useful in Windows XP SP2 and
Windows 2003 Server SP1, whose security enhancements limit the number of outgoing unanswered
TCP/IP requests. The security limitation can prevent the Project Wizard from finding existing PLC's
in a network.If the Project Wizard does not find any PLC's that you know are on your network do the
following.

1. Open the Windows Administrative Tools>Event Viewer

2. Review the Event Viewer to seeif thereisa TCP/IP error.
If thereisa TCP/IP error the Windows security enhancements are interfering with the Project
Wizard's functionality.

3. Add PW_BLOCK_SIZE to the project.

4. Assign avalue from 1 through 64.
Recommended: Assign avaluethat islessthan 5. The slower the network, the lower the
number must be.

PW_BLOCK_TIMEOUT

For Project Wizard Project

Purpose | To adjust the time out value for each block of IP's that the Project Wizard scans. Note: Adjusting the time out
can help configure slower networks.

Value The number of seconds as an unsigned integer within the valid range of 0 - 4,294,967. Note: If a negative
number is entered, it will be converted to it's corresponding unsigned number.

Default | 2 seconds
Value

QT_ENABLE_SQL_WINAUTHEN

For Windows Authentication Project




Purpose
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To support Windows Authentication with Quick Trends.

Value

Enter one of the following.

lorY Supports Windows Authentication with Quick Trends.

N or NA | Does not support Windows Authentication with Quick Trends.

Default Value

NA

QUERY_UTC_ONLY

|5/ Note: QUERY_UTC_ONLY should be used only for projects that were created for
CIMPLICITY v8.0 or higher; for projects that were created in CIMPLICITY versions lower than
v8.0, old datawill contain NULLs in the timestamp_utc column; in most cases set the value to N.

When using the Historical Alarm Viewer on Viewers that have CIMPLICITY versions lower than
v8.0 set the QUERY_UTC_ONLY global parameter valueto X, asfollows.

1. On the Server

2. For aCIMPLICITY v6.2 project
3. At the project level.

4. Before the project is started.

RAW_LIMIT_ALARM

For Point Alarms Project

Purpose To enable or disable the generation of alarms for point values that are outside their raw limits. The
options are:

Value Enter one of the following:
YES Raw limit alarms are enabled.
NO Raw limit alarms are disabled.

Default YES

Value

RCO_IGNORE_INIT_PT_UDP

For RCO Project

Purpose To set the RCO trigger functionality to what it was in CIMPLICITY versions that were lower than
CIMPLICITY 6.2.

Comments | The initial point update in:

6.2 | Is used to prime the initial value of TRANS-HIGH and TRANS-LOW points.
and
higher
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Less| Is read and thrown away.
than
6.2

If a point is unavailable, then the initial point will not come until the point becomes available. Therefore in:

6.2 | RCO site will ignore the point values that are set before the RCO site started.
and
higher

Less| RCO does not ignore the first update; RCO uses the first unavailable to available point as a trigger.
than

6.2
Value 0 | Ignore the initial point value before RCO started.

1 | Do not ignore the initial point value before RCO started. (Use the less than 6.2 behavior).
Default 0
Value

RCODB_CONN_TOUT

For RCO Project

Purpose To specify the wait time during project startup for RCO to connect with the database. Time out will occur at
the end of the specified time.

Comments | If it takes longer than the default 15 seconds to connect to the database. an error message will display
that the data source is invalid. Assigning RCODB_CONN_TOUT a longer connection time overcomes this
issue.

Value Number of seconds before RCO connection to the database times out.

Default 15 seconds

Value

RCODB_QRY_TOUT

For RCO Project

Purpose To specify the wait time for RCO to get a query result.

Comments | With SQL Server 2005, it might take longer than the default 15 seconds to query the database. If it does
take longer, an error message will display that the database is invalid. Assigning RCODB_QRY_TOUT a
longer connection time overcomes this issue.

Value Number of seconds for RCO to get a query result from the database, if getting a query result takes longer
than the default 15 seconds.

Default 15 seconds

Value

REDUND_LINK_SLEEP

For

Server Redundancy System
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Purpose To make the Router wait a period of time before creating the link to the standby node.

Comments | The User Registration (UR) processes on the primary and secondary nodes need to synchronize with
each other at startup. This can normally occur within a 30-second period. On slower computers this might
not be enough time. REDUND_LI NK_SLEEP provides the ability to make the appropriate adjustments.

Value Number (of seconds).
Default 5
Value

REDUND_PROBE_COUNT

For Server Redundancy Project (On both primary and secondary computer)

Purpose To specify the number of missed probes (within a failover period) before an application is failed over.

0 Warning: The failover rate should never be modified to less than 3 seconds.

Comments The failover period is defined as: REDUND_PROBE_DELAY (page 367) * (REDUND_PROBE_COUNT + 1) If
more than the REDUND_PROBE_COUNT probes are missed, a failover is started.

Value Number (of probes)
Default Value | Count 5
Failover period 15 seconds

REDUND_PROBE_DELAY

For Server Redundancy Project (On both primary and secondary computer)

Purpose To specify the number of milliseconds between probes to contact an application.

0 Warning: The fail over rate should never be modified to less than 3 seconds.

Comments | The fail over period is defined as: REDUND_PROBE_DELAY * ( REDUND_PROBE_COUNT (page 367) + 1) If more
than the REDUND_PROBE_COUNT probes are missed, a failover is started.

Value Number of milliseconds
Default Delay 3000 milliseconds
Value

Failover period 15 seconds

REDUND_PROBE_PORT

For Server Redundancy Project (On both primary and secondary computer)

Purpose To specify the TCP/IP port number used to implement the server redundancy probe mechanism.

Comments | Change this parameter only if it conflicts with other software. The number of missed probes before a
failover can be specified using the REDUND_PROBE_COUNT (page 367) and REDUND_PROBE DELAY (page 367)
global parameters.
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Value Port number
Default 4000
Value
REPEAT _TOUT
For Alarm Management Project
Purpose | To specify the time in minutes before an alarm is automatically repeated to all interested processes by the
Alarm Management Resident Process.
Default Minutes field in the Alarm Options tab of the Alarm Definition dialog box when Auto repeat is set to Timed.
for
Value Number (of minutes)
Default 0 (alarms are not repeated).
Value

RTR_ACCEPT_CONN

For Network Options System

Purpose To specify whether or not you want to connect to other projects in your enterprise and you want other
projects to connect to this project.

Default Use the Accept Connections field in the CIMPLICITY® Options dialog box.

for

Value Enter one of the following:
Y Accept the connections.
N Stand alone.

Default Y

Value

RTR_DISABLE BCAST

For Router System

Purpose | To specify if you want to disable broadcast of the project name on the network. When you broadcast the
project name, users on other nodes that request point data can use the project name in fully qualified points.
Otherwise, they can only use the node name in fully qualified points. Your specification is used as the default
in the Enable Project Broadcast field in the Workbench Project Properties dialog box.

Value Enter one of the following:
Y Disable broadcast.
N Do not disable broadcast.

Default | N

Value
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RTR_MAX_OUTMESSAGE_COUNT

For Router System

L CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support personnel.

Purpose | To specify the maximum number of messages buffered by the Router for a Router to Router link. If the
gueue overflows, the Router drops new messages. When it drops the first message, it logs the following
error to the Status Log: Router dropped offnode message to <remote_node_name> Further dropping
of messages to the same node do not result in additional error messages as long as the remote node stays
active.

Value (maximum) Number (of messages).

Default | 1000
Value

SECURE_SOCKETS

For Network System

Purpose | To secure a PC with encryption. When you activate SECURE SOCKETS encryption on one PC, then only
PCs that support this parameter (PCs that have CIMPLICITY 4.01-Service Pack 2 or higher installed) will be
able to communicate with the secure PC. All data transfer to the secure PC will be encrypted.

Y ou activate this parameter by creating aglobals.ini file.

todo: To activate SECURE_SOCKETS:

1. Open Microsoft Notepad (or another text editor).
2. Enter the following two lines.

[ ROUTER]

SECURE_SOCKETS=Y

Where

Y=Y es, activate encryption

N= No, de-activate encryption

3. Savethefile as Globals.ini.
4. Place Globals.ini in the ...\Proficy\Proficy CIMPLICITY\Data directory.

5. Restart CIMPLICITY for encryption to take effect.
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|=/ Note: Only computers that have CIMPLICITY 4.01 service pack 2 or higher installed will
be able to communicate with a SECURE_SOCKET encrypted PC.

SERVER_UP_INTERVAL

For Router System and Project

1> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support

personnel.
Purpose To specify the Router (IPC) System Name Broadcast Period in seconds.
Value Number (of seconds).
Default 75

Value

SETPOINT_SECURITY

For Point Management Security Project

Purpose | To specify if a user can perform setpoints on only those points whose resources are in the user's view. This
is the default for the Use the Enable Setpoint Security check box in the Project Properties box.

Value Enter one of the following:

YES Enable setpoint security.

NO Do not enable setpoint security.
Default | NO
Value

SHORT_FILENAMES

For Filenames Project
! CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support
personnel.
Purpose To enable or disable support for short (8 characters or less) filenames.
Value Enter one of the following:
YES Users cannot use filenames greater than 8 characters.
NO Users can use any length filenames.
Default NO
Value
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SECONDARY_STARTUP_TIMEOUT

For Server Redundancy Project

Purpose To delay starting the project on the secondary server until after the project on the primary server starts if
the project on both the primary (active) and secondary (standby) servers is configured to start at boot.

Comments | SECONDARY_STARTUP_TI MEQUT helps avoid race conditions between the two servers when they are trying to
determine which server is the active time out server.

Value Number (of minutes).

Default 0

Value

SOLVEENGINEDEBUG

For Order Execution Mgt Query Engine System and Project
Purpose To display debug information about a query failure in a HMN\log\Solvelnterface.out file.
Value Enter one of the following:
0 | A query message will report that a query has failed. Debug information will be discarded.
1 | A query message will report that a query has failed. Debug information will be displayed in HMI\log
\Solvelnterface.out
Default 0
Value

SPC_DB_CONNECT_TIMEOUT

For CIMPLICITY Statistical Process Control Project

Purpose | To reduce the number of milliseconds CimView will wait to connect to an SPC database (for an inserted
SPC ActiveX control) before the wait times out.

Comment | SQL Express 2005 and higher require a user name and password to connect to the database. If SPC has
not been configured with the correct user name and password and one or a group of CimView screens
includes an SPC Control CimView will appear to be hanging for the default time (60 seconds) while trying to
connect. Do either of the following.

 Enter the correct credentials in the SPC Document Properties dialog box.
* Use SPC_DB_CONNECT_TIMEOUT to reduce the wait time.
Value Number (of milliseconds)
Minimum 250 ms
Maximum 60000 ms
Default 60000
Value
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SPC_RESIZE_OUT_OF BOUNDS

For CIMPLICITY Statistical Process Control Project

Purpose | To re-scale and re-center the graph when extremely out of control points are plotted so the values won't be
drawn outside the bounds of the graph.

Value Enter one of the following.
Yory Enables the parameter
Norn Disables the parameter

Default Y

Value

STARTUP_TIMEOUT

For Project Project
Purpose To set the number of minutes to wait before timing out when starting up a project.
Value Number (of minutes).

Default Value

10

SVC_RETRY_COUNT

For External Services Project
I> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support
personnel.
Purpose To set the number of retries waiting for an external service to start up.
Value Number (of retries).
Default 30
Value

SVC_RETRY_DELAY

For External Services Project
1> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support
personnel.
Purpose To set the delay in ticks between retries waiting for an external service to start up.
Value Number (of ticks). Note: 100 ticks=1 second
Default 100
Value




SYSNAME
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For

Project Project

personnel.

I> CAUTION: Do not modify this option unless instructed to by GE Intelligent Platforms support

Purpose To specify the project name.

Value Name (for the project).

Default The name that was assigned to the project when it was created.
Value

TERMSERV_ALLOW_SETPOINTS

For Points using remote connections or WebSpace sessions System or Project
Purpose | To enable or disable setpoints from user-authenticated CIMPLICITY tools that are launched through remote
desktop or WebSpace sessions.
Value Enter any of the following.
Any value except F, This will enable setpoints for remote desktop or WebSpace sessions.
FALSE, N, or NO.
|5 Note: Setpoints will also be enabled if the TERMSERV_ALLOW_SETPOINTS
parameter does not exist or contains an unexpected value.
This will disable setpoints for remote desktop or WebSpace sessions, but not for
- F physical console sessions.
« FALSE » .
«N |5 Note: The values specified are not case-sensitive.
- NO
Default | T
Value

TREND_DISABLE_READNESTED

For Trending System / Project
TREND_DISABLE_READNESTED is assigned to the system or project,
as follows.
Computer Assign to | When
Viewer System Always
Server System CimView is started outside a project.
Server Project CimView is started inside a project.
Purpose To disable database sub-queries for time stamps.
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Value

Enter one of the following:

0 | Enable time stamps.

1 | Disable time stamps.

Default Value | 0

TRK_ERROR_RETRIES

For Tracker System

Purpose To specify how many times the Extended Attributes database access will be retried if the first attempt
returns an error.

Value Number from 0-10 retries
0 Minimum retries (None)
10 Maximum retries

Default 0

Value

TRK_PRIMON_INTERVAL

For Tracker System

Purpose To specify how frequently, in seconds, the Tracker Collector checks to see if any projects have
abnormally terminated.

Value Number from 3-60 seconds
3 Minimum seconds
60 Maximum seconds

Default 15

Value

TRK_PRIMON_TIMEOUT

For Tracker System

Purpose To specify how long a project has to check in with the Tracker Collector before the Collector declares that
it has abnormally terminated.

Value Number from 2-30 seconds
2 Minimum seconds
30 Maximum seconds

Default 10

Value




TRK_RETRY_DELAY
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For Tracker System

Purpose To specify the delay, in milliseconds, between retry attempts when access to the Extended Attribute
database fails.

Value Number from 100-3000 milliseconds
100 Minimum milliseconds
3000 Maximum milliseconds

Default 1000

Value

TRKCOLLECTOR_COMM_TOUT

For Tracker System
Purpose To specify the number of seconds before TrkCollector gives up on a SQL command.
Value Enter an integer value to specify the number of seconds.

*kk

No maximum

1 Minimum
0 No time out
Default Value | 3

TRKCOLLECTOR_CONN_TOUT

For Tracker System
Purpose To specify the number of seconds TrkCollector can take to get a SQL connection.
Value Enter an integer value to specify the number of seconds.

*k*k

No maximum

1 Minimum
0 No time out
Default Value | 3

TRUNCATE_OBJ DESCRIPTION

For Proficy Process Systems Project

Purpose

Enable PPS Object Builder to create PPS objects by truncating user created data item descriptions to the 80
character limit, when the limit is exceeded.
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Value Values are:

Yory Truncate user created descriptions that replace the data item default SDESCRIPTION, so
the object can be built. Note: An error is logged to the status log reporting that the data-item
description has been truncated to the allowed maximum length.

N or no Does not create the class object if the user created description exceeds 80 characters.
parameter
Default N or no parameter

UR_LOGIN_FAILURES

For User Interface Project
Purpose To define the consecutive number of login failures before the user is locked out of the Login dialog box.
Value Number greater than 1.

Default Value | 3

USE_HIST_TIMEFMT

1. Whether or not to display milliseconds.
Note: Milliseconds are truncated and display as .000.
2. What to display when atimestamp value is not available.
3. 24-hour format.
4. milliseconds.

5. A blank field if thereis no timestamp.

6. Does not display milliseconds.

7. Displays.
a Localized format (e.g. AM/PM
b. The earliest value that could be displayed for a timestamp (e.g. around 1/1/1970; the
actual value being 1/1/1970 with the Time Zone offset from UTC applied.) if thereisno
timestamp value recorded.

VALIDATE_PASSWORD_CHANGE

Script filename without the extension and without a path.Note: CIMPLICITY looks for the script file
in the following order.

1. .bcl



2. .bclrt

WAIT_PROJECT_TIMEOUT
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For CimView Project

Purpose | To increase the time before a project times out when a CimView script logs into a project that is not running
to get a point value and it take longer than the default time to start the Router.

Value Number of seconds.
Default | 20 Seconds
Value

Device Communications Parameters

The following global parameters are modified on a per-project basis for particular Communications

options.

Allen-Bradley Communications

Allen-Bradley DF1 Communications

CCM2 Communications

DDE Communications (As-Is-Local only))

FloPro/FloNet Communications

Honeywell IPC 620 Communications

Marquee network configuration

Mitsubishi Serial Communication

Mitsubishi TCP/IP Communications

Modbus RTU Communications

Modbus TCP/IP Communications

OMRON Host Link Communications

OMRON TCP/IP Communications

Series 90 TCP/IP Triplex Communications

Smarteye Communications

SNP Communications

SNPX Communications

Square D SY/MAX Communications

Toyopuc Ethernet Device Communications
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Allen-Bradley Communications

AB_WS_UNSO_PLC5_FLOAT

ABI_MAXDEF

ABETH_PLC_POLL_TIMEOUT

ABETH_PLC_REQUEST_TIMEOUT

ABETH_PLC_RESPONSE_TIMEOUT

ABETH_UNSO_QUEUE_SIZE

Allen-Bradley DF1 Communications

ABDF1_<PORT> USESPFP

CCM 2 Communications

<PORT>_TURN_AROUND_DELAY

DDE Communications (L egacy)

DDE_UNAVAIL_ON_ILLEGAL_VAL

FloPro/FloNet Communications

DC_RETRY_ONE_DEVICE

FLOPRO_RESPONSE_TIMEOUT

FLOPRO_STATIC_MODEL

Honeywell | PC 620 Communications

HWABC_DEBUG

<PORT>_DEBUG

Mar quee networ k configuration

TSERV_<PORT>

TSERV_<COM>

Note: Other Marguee global parameters are in the main list (page 302) .

Mitsubishi Serial Communication



COM<PORT>_TO

Mitsubishi TCP/IP Communications

DC_CONNECT_MS

DC_TCP_POLL_MS

DCQ_CONNECT_URETRY_CNT

DCQ_DEAD_TIME

MMAX_SYNC_TICKS

MSYNC_TICKS

<PORT>_DC_CONNECT_MS

<PORT>_DC_TCP_POLL_MS

<PORT>_DCQ_DEAD_TIME

<PORT>_MSYNC_TICKS

<PORT>_SOCKET_PORT

Modbus RTU Communications

MB_COMM_TIMEOUT

MB_LOG_PROTOCOL

MDBC

<PORT>_LOG_PROTOCOL

M odbus TCP/I P Communications

<DEVICE> READ REQUEST_TIMEOUT

<DEVICE> REQ_RETRY

<DEVICE>_TIMEOUT_RETRY_DELAY

Deviceld_CONN_SECONDARY

Deviceld_CONSERVES_CONN

Deviceld_ONE_COIL_WRITE

Deviceld ONE_REG_WRITE

MBEDC_<device_id>

MBETH_ASYNC_CONNECTION

MBETH_DISABLE_IO_ERRLOG

MBETH_DISABLE_UNSO_DATA
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MBETH_ENABLE_PROTOCOL_DEBUG

MBETH_READ_REQUEST_TIMEOUT

MBETH_REQ_MILLISECOND_TIMEOUT

MBETH_REQ_RETRY

MBETH_REQ_TIMEOUT

MBETH_SOCKET_PORT

MBETH_TIMEOUT_RETRY_DELAY

MBETH_UNSO_DATA_QUEUE_SIZE

<PORT>_ASYNC_CONNECTION

<PORT>_DISABLE_IO_ERRLOG

<PORT>_DISABLE_UNSO_DATA

<PORT>_ENABLE_PROTOCOL_DEBUG

<PORT>_MAX_BUFFER_SIZE

<PORT>_READ_REQUEST_TIMEOUT

<PORT>_REQ_MILLISECOND_TIMEOUT

<PORT>_REQ_RETRY

<PORT>_REQ_TIMEOUT

<PORT>_SOCKET_PORT

<PORT>_TIMEOUT_RETRY_DELAY

<PORT> UNSO_DATA_QUEUE_SIZE

OMRON Host Link Communications

COM<PORT>_TO

OMRON_MAX_BUFFER_SIZE

OMRON TCP/IP Communications

OMRON_MAX_BUFFER_SIZE

<PORT>_OMRON_SA1

<PORT>_OMRON_SERVICE

<PORT> OMRON_SNA

<PORT>_SEQUENCE_SID

<PORT>_TO




Series 90 TCP/IP Triplex Communications

<DEVICE> MAX_POLL_MSG

<DEVICE> MAX_REQUEST_CACHE

<PORT>_ALLOW_MULTIMSG

<PORT>_DISABLE_KEEPALIVE

<PORT>_MAX_CACHE

<PORT>_MAX_POLL_MSG

<PORT>_MAX_REQUEST_CACHE

SO90TCP_ALLOW_MULTIMSG

S90TCP_ALLOW_UNSO

S90TCP_DC_BIT_REVERSE

S90TCP_<DEVICE_ID>_IS_SE

S90TCP_DISABLE_KEEPALIVE

S90TCP_MAX_CACHE

S90TCP_MAX_POLL_MSG

S90TCP_MAX_REQUEST_CACHE

S90TCP_RECONNECT_DELAY

Smarteye Communications

<PORT>_LOG_WARNING

<PORT> MODE

<PORT>_POLL_LIMIT

<PORT> RESTART_SEA

<PORT>_SEA_HANDSHAKE_TIMEOUT

SE_LABEL_LEN

SEA_HANDSHAKE_TIMEOUT

SNP Communications

SNP_SEND_BREAK

SNP_IDLE_TIME

SNPX Communications
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<DEVICE>_VALIDATE

SNPX_BROADCAST_TIME

SNPX_VALIDATE

Square D SY/MAX Communications

SYMAX_<PORT> WORD_SWAP

Toyopuc Ethernet Device Communications

<PRCNAM>_CONNECTION_TIMEOUT

<PRCNAM>_READ_WRITE_TIMEOUT

<PORT>_BIND_ADDR

Global Parameter Files
Global Parameter Files

When you modify the global parameter list in the Workbench and perform a configuration update,
CIMPLICITY modifies the system or project's globa parametersfile (glb_parms.idt).

Y ou can view aglobal parameter file by opening it in Windows Notepad through an MS DOS
window.

Locate a Globa Parameter File

You can locatethe glb_parms.idt file through an MS DOS window.

1. Click Tools on the Workbench menu bar.
2. Select Command Prompt.

An MS DOS window opens.

3. Enter the following commands in the Command Prompt window:
cd <dir>
where
<dir> isthe directory where you need to make the changes.

For global parameters that apply to the:
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» System (all projects), enter cd %BSM ROOT%glat a
* Current project, enter cd %8I TE_ROOT%rast er

i dt pop gl b_par s
not epad gl b_parns. i dt

A Windows Notepad opens displaying arecord of the global parametersin the al projects or
specified project directory. Thelist of global parametersin thisfile corresponds to the list that
displays in the Workbench.

4. Find the parameter you want to check.

You can edit the value in thisfile if you need to.

5. Save thefileif you have modified it.
6. Exit Notepad.

7. Typescpop gl b_par ns at the DOS prompt. A new binary version of the Global Parameters
file will be produced and put in the master directory.

8. ypeexi t to exit the Command Prompt window.

When you are ready to implement the change in the run-time system, you will have to

stop the project(s), perform a Configuration Update, and restart the project(s). The Global
Parametersfile that is used on aViewer islocated in the CIMPLICITY installation directory in
asubdirectory called data (e.g., c:\cimplicity\hmi\data).

|=/ Note: The Global Parameters file that is used on a Viewer islocated in the CIMPLICITY
installation directory in a subdirectory called data (e.g., c:\cimplicity\hmi\data

Sample GLB_PARMS.IDT File

The following isasample glb_parms.idtfile:

|-* IDT file generated by IDTPOP utility v1.0

* RECORD: GLB_PARMS SYSTEM GLOBAL PARAMETERS
*

* OPARM_ID Global Parameter Identifier

* 1parm_type CH-0,5-1,1S-2,1-3,BT-4,WRD-5,LG-6,BL-7
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* 2 parm_value Parameter Value up to 80 chars
*

ACK_TOUT|3[0

CLR_TOUT|3|0
CONNECT_DROP_PERIOD|3|600
CONNECT_RETRY_PERIOD|3|90
DBDL_ABORT_TIMEOUT|1/50
DBDL_DEVICE_CHECK_PERIODI1/30
DB_QUEUE_OVERFLOW_DELAY|1]30
DB_QUEUE_SIZE|1[20

DEL_OPT|1JAR

DOWNLD_PASSWD

DYN_CFG|1|YES
GSM_UNAVAIL_COLOR_KEY|1/0
IPC_BCAST_INTERVAL|1]90
LOGIN_RETRY_PERIODJ|3|15
LOG_OPT[]]
PTDL_QUANTIZATION|1|100
PTMRP|I1J]MASTER_PTMO_RP
RAW_LIMIT_ALARMI[1IYES
REPEAT_TOUT|3|0
RTR_ACCEPT_CONNIJ1]Y
RTR_DISABLE_BCASTJ1]Y
SETPOINT_SECURITY|1|NO

SHORT_FILENAMES|1|NO



Advanced Features | 3 - System Management | 385

SVC_RETRY_COUNT]1/30
SVC_RETRY_DELAY/|1/100

SYSNAME[1]MMI_ONE

Process Health Parameters

About Process Health Parameters

Process Health Parameters enables you to have any selected CIMPLICITY project process
automatically monitored.

0 Warning: Keep in mind, restarting a process can have serious consegquences, for example losing
point values or disconnecting users who are logged in from other locations.

If selected, monitoring can include attempted process restarts, process failure and/or project failure.

Step 1 | Open the Process Health dialog box.
(page

w
o9}
1

tep 2 | Enter Process Monitor specifications.

O8]

86

|5/ Note: If Configuration Securityis enabled, only roles that have Projectschecked on the
Configuration tab in the Roles dialog box will have access to the Process Health parameters
configuration.

Sep 1. Open a Process Health Dialog Box

1. Startthe CIMPLICITY project.

Note: Do not enable dynamic configuration.

=

2. Select Project>Advanced>Pr ocess Health Parameter sin the Workbench left pane.
3. Select a process in the Workbench right pane.

Note: All the processes that are included in the CIMPLICITY project are listed in the
Workbench right pane, including device communications processes.
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4. Do one of the following.

A | Click Edit>Properties on the Workbench menu bar.

B | Click the Properties button on the Workbench toolbar.

C | In the Workbench left pane:
a. Right-click Process Health Parameters.
b. Select Properties on the Popup menu.

D | In the Workbench right pane:

Either Or

Double-click a process. a. Right-click a process.
b. Select Properties on the Popup menu.

E | Press Alt+Enter on the keyboard.

5. Right-click Process Health Parameters.
6. Select Properties on the Popup menu.
7. Right-click a process.

8. Select Properties on the Popup menu.
Sep 2. Enter Process Monitor Specifications

* Process Health configuration.
* process_dependents.cfg file.

Process Health configuration

Check any of the following groups to enable the feature for the selected process.

rect 11, 28, 322, 86 (page 387)
rect 7, 94, 318, 193 (page 387)
rect 7, 193, 318, 239 (page 387)

Field Description
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Restart Restarts the process a specified number of times within a selected number of seconds.

|5 Note: The process you are configuring may have dependent processes (processes that start after
the selected process starts). If it does, you must configure a process_dependents.cfg (page 387) file to
insure that the dependent processes will stop and restart based on the selected process behavior.

Example 1. Process #2 (e.g. Derived Point Process)

* |Is dependent on another process #1 (e.g, Point Manager).
« Assumes that process #1 is started first.

2. Process #1 fails and is restarted 3. Dependent process #2 must be stopped and restarted
immediately following Process #1.

Threshold | Number of times the process can be restarted, within the number of seconds specified by
the Restart period, before it is failed.

Period Number of seconds in which the restart threshold is operational.

Default Disabled.

Check Send messages to the process to determine if it is running correctly. For example, a process may
health appear to be running when, in fact, it is hung.
Poll interval Number of seconds that

elapse between polls.

Kill process on no response If the process does not
respond when it is polled, it
will be stopped.

Default Disabled

Note: Check health is enabled only if the process supports active health checks.

L=

Fail project (For clusters only) The project stops when the selected process fails.
on process
failure Default Disabled

) Important:

* Process health does not support dynamic configuration. Specifications for the process must be
entered when the project is stopped, then incorporated through a project configuration update.
« If you change a process name you must identify the processin the process_dependents.cfg file.

Process Dependents.cfg file

* The process_dependents.cfg file must be edited if:

* Default PRT service names have been changed.

« Customized processes that have dependencies are configured to restart.

* The default process_dependents.cfg islocated in the ...\Proficy CIMPLICITY\bsm_data folder.
* The default process_dependents.cfg fileis as follows.
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|_*
* Thefirst field is the name of the process that has died

* The remaining fields are the names of processes that will be stopped and restarted if they are
currently running

PRT_DC|PRT_DS

Process Control

About Process Control

Program Control is an interactive process that lets you start, stop, and display the current state of
CIMPLICITY processes. This section describes the functions available in Program Control and
procedures for running it.

9]
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Open the CIMPLICITY Process Control window.

W 92}
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® o

Connect to a Project in CIMPLICITY Process Control.

Determine the CIMPLICITY process status.
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Determine the correct startup/shutdown order.
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Start/stop processes.
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Sep 1. Open the CIMPLICITY Process Control Window

CIMPLICITY provides several methods to open the CIMPLICITY Process Control Window.

» Workbench
 Start menu

Workbench
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1. Select Project>Runtime>Process Control in the Workbench left pane.
2. Select Process Control in the Workbench right pane.

3. Do one of the following.

A | Click Edit>Properties on the Workbench menu bar.

B | Click the Properties button on the Workbench toolbar.

C | In the Workbench left pane:

Either Or

Double click Process Control. a. Right-click Process Control.
b. Select Properties on the Popup menu.

D | In the Workbench right pane:

Either Or

Double click Process Control. a. Right-click Process Control.
b. Select Properties on the Popup menu.

E | Press Alt+Enter on the keyboard.

Start Menu

4. Right-click Process Control.

5. Select Properties on the Popup menu.

6. Right-click Process Control.

7. Select Properties on the Popup menu.

8. Click Start on the Windows task bar.

9. Select (All) Programs>Proficy HMI SCADA CIMPLICITY version>Process Control.

Result:

* If no project is running:
The CIMPLICITY® Project dialog box opens.
Select aCIMPLICITY project to run.

The CIMPLICITY Process Control dialog box opens.

» When a project is running:
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The CIMPLICITY Process Control dialog box opens.

Sep 2. Connect to a Project in CIMPLICITY Process Control

Connect to a project as follows.

1 | Select the project to connect to.

1. Click the drop-down list button to the right of the Project field.
2. Select the project you want to connect to.

2 | Click Connect.

|5/ Note: If you are not currently logged in to the project, a CIMPLICITY® Login dialog box
opens.

1. Enter avalid User 1D and Password.

2. Click OK.

When CIMPLICITY processes a saved login or the login just entered, the CIMPLICITY Process
Control dialog box displays with the list of process names and statuses for the project you sel ected.

(1) Important: Thisisnot the recommended way to start or stop CIMPLICITY software. Y ou
should only use CIMPLICITY Program Control to start and stop processes if you have been
instructed to do so by GE Intelligent Platforms support personnel, or if you are testing an API
application. In the latter case, you should only be starting and stopping your APl application.

Sep 3. Determine the CIMPLICITY Process Satus

CIMPLICITY processes display in the left column of the CIMPLICITY Process Control dialog box.
The status appears on the row, to the right of the process.

A process status can be:

* Halted or
* Running.

The following table lists background Process IDs for all base system and product options for
CIMPLICITY processes. The set of options running on a node depends on the communication
protocols, printers, and product options you have installed.

AMRP Alarm Management Resident Process
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APSM_RP APSM Resident Process
CAL_RP Action Calendar

CNCALM CNC Alarm Process

DL_RP Data Logger Resident Process
DYNCFG Dynamic Configuration Process
EM_RP Event Manager Resident Process
MTCPSI_RP Modbus TCP Client Interface
MRTUSI_RP Modbus RTU Client Interface

MASTER_<port>

Device Communications Interfaces

MASTER_<printer_name>

Alarm Manager Line Printer Process

MASTER_PTDP_RP

Point Management Virtual Point Resident Process

MASTER_PTM<n> RP

Point Management Resident Process

PASH SOA resident process creates the SOA host component and launches CIMPLICITY
Service Provider.

PDC_DS Tracker - Decision Control Data Server

PROF_RP Profile Trending

PRT_CNT Tracker—Tracking Attribute Counts

PRT_CLNT Tracker—Client (communicates from one project to another)

PRT_DC Tracker—Data Collector

PRT_DS Tracker—Tracking Data Server

PRT_GRD Tracker—Tracking Graphic Display

PTDL_RP Point Data Logger Resident Process

PTX_RP Point Translation Resident Process

<rcositename>

Tracker—Tracker Routing Control Objects Site

RCODB_RP

RCO Configuration Provider to RCO Runtime User Interface

SPC_<group file name>

Statistical Process Control

UR_RP

User Registration Resident Process

Sep 4. Determine the Correct Sartup and Shutdown Order

The order in which some processes should be started and stopped is critical to their operation. If you
are attempting to start or stop individual processes, and you want to make sure you are doing so in an
orderly manner, you can check the master.mcp file in your project's Master directory. Thisfilelists,

in correct order, the files that are started up for your project.
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Example

The master.mcp file for a project is on a computer whose Node ID is Master.

Sep 5. Sart/Sop Processes

Options for starting and stopping processesin the CIMPLICITY Process Control window include
the following.

rect 101, 258, 186, 287 (page 394)
rect 285, 216, 370, 245 (page 394)
rect 286, 183, 371, 212 (page 394)
rect 286, 52, 371, 81 (page 393)
rect 284, 125, 369, 154 (page 393)
rect 286, 154, 371, 183 (page 393)
rect 285, 97, 370, 126 (page 393)
rect 286, 25, 371, 54 (page 392)

1 Connect
(page

392)

2 Release
(page

393

3 Start Process
(page

393

4 Stop Process
(page

393

5 Start All
(page

393)

6 Stop All
(page

394)

7 Refresh
(page

394)

8 Exit
(page

394

1 | Connect
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Connects (page 390) the Process Control to a project.

2 | Release

Click Release to releases the Process Control from the connected project.

Result: When the project is released the Process Control window isemptied. Y ou can either select
another project to connect (page 390) to or exit the Process Control.

3 | Start Process

1. Select aprocessthat is halted.
1. Click Start Process.

A message displays to confirm the start.

1. Click Yes.

Result: If the process starts successfully the process status changes to Running.

4 | Stop Process

1. Select aprocessthat is running.
1. Click Stop Process.

A message displays to confirm the stop.

1. Click Yes.

Result: If the process stops successfully the process status changes to Halted.

5 | Start All

1. Click Start All.

A message displays to confirm starting all processes.

1. Click Yes.

Result: All halted processes are started; the status for all processes that start successfully changes to
Running.
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6 | Stop All

1. Click Stop All.

A message displays to confirm stopping all processes.

1. Click Yes.

Result: All halted processes are stopped; the status for all processes that stop successfully changesto
Halted.

Note: Even though all of the processes are halted, Process Control continues to control the project.
You must click Release in order to release the project.

7 | Refresh

The process list displays the process statuses at the time you connected to the project. These statuses
are updated automatically only when you perform a startup or shutdown operation.

Click Refresh.

Result: CIMPLICITY refreshesthe list to display the status of all processes on the list.

8 | Exit

Click Exit to close the Process Control window.

Results: Process Control releases the project if it has not already been released; the Process Control
window closes.

OEM Key

About the OEM Key

OEM Key: Use

The OEM Key:

» Isused for systems that do not have devel opment servers and, more often than not, do not have
development viewers.
* Enables OEMs to:
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1. Remotely connect to a CIMPLICITY system or get directly onto the system.
2. Perform whatever configuration changes are needed.
OEM KEY': Limitations

The OEM Key:

» Automatically ends devel opment mode on the runtime server in two hours.
* Requires stopping any running projects twice.

Any projects that are running must be stopped:

3. Before the OEM Key can be activated.
4. When the OEM Key terminates (automatically or if it is exited before the two hours).

Note: Projects are stopped automatically when the OEM Key terminates or is exited.

» Makes the runtime server a stand-alone machine; it cannot communicate at al with its
viewers while the OEM Key is active.

OEM Key Activation

OEM Key Activation

1. Open the Explorer or a Command Prompt window
2. Locatethe CIMPLICITY exe directory.

(If you accepted the default location for CIMPLICITY software during installation, it is C:
\Program Files\Proficy\Proficy CIMPLICITY\ )

3. Run oemkey.exe.

The CIMPLICITY License Agreement dialog box opens.
4. Click Yesto accept al the terms of the license agreement.
The next dialog box that opens depends on your computer status:

« If any projects are running, the OEM Key dialog box opens.
* If no projects are running, the CIMPLICITY OEM Key dialog box opens.
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Note: If you click No, OEM Key terminates.

=

Projects Stopped for OEM Key Activation

If OEM Key findsthat CIMPLICITY projects are running on your computer, the OEM Key dialog
box opens. This dialog box gives you the opportunity to exit OEM Key or terminate the projects and
activate OEM Key.

Do the following.

1 | Click Stop CIMPLICITY HMI.

2 | Click Next, which is enabled when all CIMPLICITY projects stop running.

Result: The CIMPLICITY OEM Key dialog box opens.

Note: Click Cancel to exit OEM Key without stopping the running projects.

=l

OEM Key Status

The CIMPLICITY OEM Key dialog box shows you the time |eft for the OEM Key.

Y ou can optionally do the following.

1 | Check the Show status window check box to display the time left. This status window displays on top of all the
windows on your screen.

N

Click Quit to cancel installation.

Note: If you exit the dialog box or click Quit, the OEM Key terminates immediately.

L=

OEM Key Termination

OEM Key terminates at the end of two hours. Y ou can terminate it earlier by exiting the
CIMPLICITY OEM Key dialog box. When OEM Key terminates it:

* Displays adialog box warning you that it will stop all running projects.
* Stops al running projects.
« Converts your temporary Development System License back to your Runtime System License.

Y ou can now restart your projects.
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